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Introduction 

 

e-Parcel Corporation consistently offers such services as digital data delivery service since 1996. It 

was introduced into more than 5,000 enterprises all over the world. 

 

As companies embrace the Internet to reduce costs, improve communications and generate new 

revenue, they expose core digital assets and intellectual property to an increasingly unsecured 

channel. Breaches in security and control of these assets can cost a company millions of dollars, 

and potentially damage its franchise and brand. 

 

The e-Parcel provides outsourced services for secure and controlled Internet communications, 

enabling clients to protect, control and manage digital assets more effectively than any other 

solution available. Security components and processes, digital rights management, and network 

infrastructure have been integrated into a comprehensive set of services that can be deployed 

quickly and easily into common applications. 

 

The e-Parcel is an epoch-making secure data delivery service for large-volume digital data via the 

Internet easily, safely, securely at low cost and high security level. 

 

With e-Parcel service, companies now have a way to establish global communications networks 

using software instead of traditional hardware-based alternatives. The e-Parcel’s patent-protected 

technology allows any-size file to be delivered over any network, across any platform, creating 

intra- and extra-enterprise communications and data delivery channels. 

 

This e-Parcel users manual will introduce the e-Parcel VCN-CommCenter 8.0 that is one of new 

products for e-Parcel Secure Data Delivery Service based on the newly-developed next-generation 

data delivery engine, and inherited the software operation just as simple as e-mailing from e-Parcel 

VCN CommCenter 6.0 as predecessors. 
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Product Concept 

 

The e-Parcel VCN-CommCenter 8.0 of e-Parcel Secure Data Delivery Service - Enterprise – Software 

is developed for the product concept of digital data delivery service to deliver large-volume and 

confidential digital data easily, safely, securely the same as predecessors the e-Parcel VCN 

CommCenter 6.0, via the Internet by just installing client software based on the newly-developed 

next-generation data delivery engine for enterprise users at high quality and security level. The 

data includes three-dimensional CAD/CAE, design/technical data, software source code and highly 

confidential data such as customer's personal information. 

 

The e-Parcel VCN-CommCenter 8.0 are the standard client software for e-Parcel Secure Data 

Delivery Service. 

 

Just install a client digital certificate and software are given in your PC! Only with this operation, 

you can easily start e-Parcel secure data delivery service with other e-Parcel clients via the Internet. 

 

The e-Parcel client software operation is just as simple as e-mailing. It allows you to send and 

receive large-volume and confidential digital data easily, safely, securely. 

 

 

* The products supported by the new e-Parcel server; the e-Parcel VCN-CommCenter 8.0 / 7.0 are 
available data communication with the e-Parcel VCN-AX 4.0 or later / 3.0 (Client software), and 
the e-Parcel VCN-Web Enterprise (Web browser client). 
Attention: We are afraid that it is not compatible with the e-Parcel VCN CommCenter 6.0 which is 
the product supported by the existing e-Parcel server. 
*However, we have released the e-Parcel Bridge Server in October 2014. Therefore, in spite of 

using the e-Parcel VCN-CommCenter 6.0, once their e-Parcel ID registrations have been 
migrated to the new e-Parcel server without any complicated setting (the necessary operation 
required at our side only), the VCN-CommCenter 6.0 will be validated to communicate with the 
client software (VCN-CommCenter 8.0 / 7.0, VCN-AX 4.0 or later) supported by the new 
e-Parcel server. 
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Overview 

 

The e-Parcel Users Manual will introduce and assist you with each operation of the e-Parcel 

VCN-CommCenter 8.0. Additionally, we have provided alerts and tips throughout this document to 

aid in assuring successful installation and a positive user experience. 

 

You will find using the e-Parcel VCN-CommCenter 8.0 are not different than your existing e-mail 

application. Simply create your message, add attachments, enter a new e-Parcel ID of recipient or 

select a recipient from your existing address book and click the Send button to securely deliver 

messages and attachments from desktop-to-desktop.   

 

The e-Parcel combines many powerful features with the ease of standard email.  Below, we have 

highlighted some of e-Parcel’s exciting features and capabilities. 

 

 Adoption of SSL/TLS 

Security such as authentication, encryption and integrity has been ensured by the use of SSL/TLS 

as communication protocol between the server and a client. 

 

 The digital certificate based on X.509 (Authentication) 

The e-Parcel is adopted the digital certificate based on X.509 for both the server and a client. The 

pretender is prevented strongly using the automatic operation of mutual recognition between the 

server and a client. (Encryption: AES256 bits) 

 

 End to End data encryption (Encryption) 

In addition to encryption between the server and a client, End to End encryption between clients 

with AES256 bits (AES: Advanced Encryption Standard) is adopted. Furthermore, Secret sharing 

scheme based on PKI（Public Key Infrastructure）rest assured that sender and recipient are sharing 

temporary secret key for the data encryption safely. 

 

 End to End HMAC (Integrity / Audit) 

HMAC（Keyed-Hashing for Message Authentication Code）is a specific construction for calculating 

a message authentication code involving a cryptographic hash function in combination with a 

secret key. As with HMAC, it must be used to simultaneously verify both the data integrity and the 

authenticity of a message End to End. Cryptographic hash function is also used in the calculation of 

HMAC on the server. Accordingly, it can be proven the transaction was generated by 

newly-developed audit scheme. 
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 Newly-developed Micro-block Data Stream 

The e-Parcel is adopted newly-developed Micro-block Data Stream technology for the data delivery 

between the server and a client, which is seamlessly-delivered data and put the appropriate 

markers on data for tracking the progress of data delivery in a block between a marker and a 

marker. It enables to recover for the data corruption without detriment to the performance of data 

delivery in spite of under the unstable network circumstances by using this technology. 

 

 Tracking 

The e-Parcel provides the ability track your sent messages and attachments beyond delivery. The 

e-Parcel lets you have visibility into when your transmission was received, opened, moved, 

cancelled, aborted, or deleted. 

 

 Enabling large file size delivery 

Large data can be delivered at once according to the streaming communication that doesn't put the 

load on the streaming communication terminal and the server in Intranet and doesn't accumulate 

data in the route on the way. 

 

 Automatic restart function (intermission delivery and auto resume function) when the 

internet line is intercepted and then recovered. 

 

 The GUI for e-Parcel client software provides operation just as simple as e-mailing. 

 

 Enabling to cancel sending 

 

 Enabling to resend an item 

 

 Enabling to set priority uploading and downloading 
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System Requirements 

The section below describes the system specifications for the e-Parcel VCN-CommCenter for 

Windows. 

 

Software Name  e-Parcel VCN-CommCenter 8.0 

Operating System 

Microsoft Windows  

XP or later / 2000 Server or later 

64bit or 32bit 
 
*VCN-CommCenter 8.0.8023 (Released on April 1, 2022) or later 

is compatible with Windows11 / Windows server 2022. 

 
*Available display languages are listed below  

for VCN-CommCenter GUI: 
[Japanese, English, French, German, Spanish, 
Chinese-simplified, Chinese-traditional] 

Network 

Internet Connection to the e-Parcel servers 
*If your computer or network environment (the proxy server, 

firewall, any applications for security measures or etc.) 
have any access control such as block or analysis of SSL 
connections, you need to allow (exclude from target) 
HTTPS protocol communications [Port=443] to the e-Parcel 
service domains as of [https://*.e-parcel.ne.jp] and 
[https://*.e-parcel.com] (Wildcard domain: Asterisk 
mark [*] would be replaced with name of multiple servers 
via the e-Parcel service.). 

Computer Memory (RAM) 64 MB RAM or more for application 

Disk Space 
15 MB Disk Space or more for installation 
*Plus, additional disk space required for delivery items while 

sending and receiving. 

Recommended 
*To use efficiently, recommend near the latest version of OS 

and browser application, computer memory and disk space 
as much as possible. 
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About VCN-CommCenter GUI 

This guide will help navigate your way through the e-Parcel VCN-CommCenter and available option 

settings. Several references are made to describe the e-parcel features and options. The 

VCN-CommCenter GUI is displayed. The term GUI – Graphical User Interface will be used often in 

this manual to describe the main e-Parcel application view. Other references are made in respect to 

the VCN-CommCenter GUI, including the figure below.  

*Refer to P69 2.VCN-CommCenter View 

 

 

 

 

[VCN-CommCenter GUI] 

 

 

 

Tree view 
(P120) 

Menu Bar (P77) 

Tool Bar (P114) 

Folder Tree: Switch to display on the list view.  
*Tree view shows Folder Trees by each e-Parcel ID which you set up. 
・Display name (P122/P134): “User Configuration” pane 

*Your e-Parcel ID is assigned to the initial “Display Name”. 
*Click this to display the “User Configuration” on the list view. 

 ・Inbox/Outbox 
*Click either to list up the inbox or outbox items on the list view. 

 

List view (P132 User Configuration / P334 Outbox / P358 Inbox) 
*Each window which is selected on the folder tree will be displayed. 

Favorites view 
(P129) 

*Favorite 
addresses 
displayed. 

Click  ×   (P73) 
Just close VCN-CommCenter GUI (window). 
*Run as background application. 
 

To change width of pane, drag here. 
*If you click × to hide Tree view, also 

drag here to show it again. 
 

Check the system status “Online” displayed! 
*Sending / Receiving available. 
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Attention on using software 

One e-Parcel ID is NOT validated in multiple computers 
Please carefully note the attention below for using the e-Parcel client software in advance. 

 

Attention Customers: 

One e-Parcel ID must be available to use 

in only one computer. 
 

Please carefully note: 

You can NOT set up a same e-Parcel ID (e-Parcel client digital certificate) to the e-Parcel 

VCN-CommCenter in multiple computers. 
 

High security level (Authentication): The e-Parcel secure data delivery service has adopted 

the client digital certificate based on X.509 on both the server and a client. The pretender is 

prevented strongly using the automatic operation of mutual recognition between the server and a 

client. 
 
Therefore, if a same e-Parcel ID (e-Parcel client digital certificate) is set up to the e-Parcel client 

software in one computer, it is made unavailable in the other computer. That must cause the 
previous installation dysfunctional (offline). Also, the unreceived items which 

are not started to download during the previous installation will be the delivery status 
"Download aborted" and no longer possible to download. 

(For the reason of security through the e-Parcel service, downloading is available in only one 

computer activated at the time of item created.) 
 
When replacing your computer with another, after installing and auto-setup software to new 

computer, be sure to uninstall (delete) the existing e-Parcel client software (offline) from the previous 

computer. (On the previous computer, select Windows “Start” > e-Parcel > Uninstall 

VCN-CommCenter x.x.) *Refer to P452 12. Uninstalling Software (Delete) 
 
If you have set up a same e-Parcel ID (e-Parcel client certificate) to the e-Parcel client software in 

multiple computers, we are afraid that any problems caused by multiple installations above are 

NOT included in the e-Parcel Customer Support. Accordingly, you need to clearly 

understand the installation with your e-Parcel ID for appropriate use. 
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If one e-Parcel ID has been setup in multiple computers 
If you have carelessly set up a same e-Parcel ID (a same e-Parcel client certificate) to 
the e-Parcel client software in multiple computers, take the following necessary 
operations by yourself for the appropriate use. 
*It is also placed in the FAQ webpage (URL：https://www.e-parcel.ne.jp/epvcn/en/FAQ/answer6.php). 

 

 

* At the time of multiple installations with a same e-Parcel ID, the unreceived items which are not 

started to download during the previous installation will be the delivery status "Download aborted" 

and no longer possible to download. In that case, after you confirm the e-Parcel client software to 

be activated (online) in a computer which you use in future, please ask senders to resend the items. 

 

 

* In the situation of multiple installations with a same e-Parcel ID, to use the software in only one 

computer, uninstall the unnecessary e-Parcel client software from the other computers. 

Select from Windows “Start” menu > e-Parcel > “Uninstall VCN-CommCenter x.x” 
[For Windows 8 or earlier] Windows “Start” menu > All Programs > e-Parcel > VCN-CommCenter x.x  
> “Uninstall VCN-CommCenter x.x” 

 

 

* In the situation of multiple installations with a same e-Parcel ID, if the e-Parcel client software has 

been dysfunctional (offline) in a computer which you use in future, auto-setup the software 

auto-setup (or import certificate) to be activated (online).  

On the VCN-CommCenter GUI, click the menu Tools > Auto Setup. 
* At the beginning of auto-setup, if the "Select a Certificate" or the "Confirm Certificate" dialog is 

opened, confirm your e-Parcel ID, select a correct digital certificate, and then click the "OK" button. 
it will begin to auto-setup. 

 

While auto-setup, when the confirmation dialog shows "Previous installation found…" below, click 

the "OK" button to proceed. When auto-setup complete, confirm that the software shows the 

system status "Online". 
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１．Preparations for the e-Parcel Service 

Before using the e-Parcel Secure Data Delivery Service, you must download and install your client 

digital certificate and the e-Parcel VCN-CommCenter client software. Please take the STEP1 to 

STEP6 following: 

 

 

《The flow chart of advance preparations for starting e-Parcel service》 
 

[e-Parcel Corporation side] 

1. Registration (P20) 

Upon your application for the e-Parcel service, we register your e-mail address as an e-Parcel ID. 

When registration complete, you will get the e-mail notification. 

 

 

 

[Our Customers side] 

2. Downloading & Installing (P21) 

Access the e-Parcel software download site (P22) 

STEP1. Login (P23) 

STEP2. Select e-Parcel client software (P24) 

STEP3. Check the security of web site (P25) 

STEP4. Download client digital certificate (P26) 

Install client digital certificate (P28) 

STEP5. Access “The e-Parcel Secure Enterprise – Web Browser” / Change default password (P37) 

STEP6. Download e-Parcel client software (P50) 

Installing e-Parcel client software (P53) 

Auto-setup e-Parcel Client Software (P61) 

 

 

 

 

Start the e-Parcel Secure Data Delivery Service！ 
 

１ 
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1. Registration 

 

At the beginning, to start the e-Parcel Secure Data Delivery Service, our customers must apply the 

registration form to register your own e-Parcel ID.  

 

Upon your application, e-Parcel Corporation usually registers your e-mail address as 

e-Parcel ID within 5 business days.  

 

When your e-Parcel ID registration is completed, you will be notified of it by e-mail with credentials 

which you need to login to “The e-Parcel Secure Enterprise - Software Download Site”. 

 

 

Note: If user credentials have not been supplied, or have been misplaced, 

please contact the e-Parcel Customer Support (support@e-parcel.co.jp) by 

e-mail. 

Our Business hours：9：00am～17：00pm JST / Mon-Fri 
(Not including Saturdays, Sundays and national holidays) 
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2. Downloading & Installing 

 

When e-Parcel ID registered, start the following procedures for downloading and 

installing in a PC to run the application for the e-Parcel Secure Data Delivery Service. 

 

In the beginning, download the e-Parcel client digital certificate from e-Parcel download 

site, and then install (import) it in Widows before the e-Parcel client software installation. 

 

 

Note: This manual will guide you to download and install the e-parcel 

certificate and software using Microsoft Edge as a browser application 

recommended. The “Auto Setup” function of e-Parcel software (P61 STEP6) 

will attempt to automatically detect a client digital certificate and your network 

settings from Windows at later step. Therefore, the “Auto Setup” function 

requires to install (import) a client digital certificate in Windows in advance. 

 

 

 

Caution: When you install (import) the client digital certificate to 

Windows, it requires to sign in Windows with a user account which runs 

the e-Parcel VCN-CommCenter. 

 

Caution: The software installation requires administrative privilege. 

If you sign in Windows with a standard user account without the 

administrative privilege, you are required to input an administrator 

account name (administrator ID) and password to User Account Control 

(UAC) dialog when executing installation. Prepare information in advance. 

[For Windows 2000, XP, 2003]  
Log on Windows with either an administrator account or a user account with the 
administrative privilege in advance. 
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Access the e-Parcel software download site 
 

①First, sign in Windows with a user account which runs the VCN-CommCenter. Launch 

browser application (Microsoft Edge is recommended). Visit URL just below.  
* To launch Edge, click icon on the taskbar, double-click the desktop shortcut icon, or access 

Windows "Start" menu > M > Microsoft Edge. 
 

“The e-Parcel Secure Enterprise - Software Download Site” URL: https://www.e-parcel.ne.jp/ 

 

See the page appeared, select the site menu “Download & Install Software” and then click the 

“Download e-Parcel Software” button on the bottom of this webpage.  

*To proceed to “Auto Setup” at the later step, a client digital certificate is required to install (import) in Windows 
in advance when you sign in Windows with a user account which runs the e-Parcel VCN-CommCenter.  

 

 

 

 

 

 

 

Click the button 
on the bottom of 

this webpage! 

Select this menu. 
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STEP1. Login 
 

②The Download a Client digital certificate & Software “STEP1. Login” page appears. Enter your 

e-Parcel ID and default password [*as notified by e-mail when e-Parcel ID registered] and then 

click the “Login” button. 

 
*For new users, a password has been set the default password at beginning. Please be advised you 

to change a password through “The e-Parcel Secure Enterprise - Web Browser” after you 
complete to install a client digital certificate in Windows at later STEP5 of the Web site. 

 
*For existing users, if you have already changed a password to your own password in the case of 

re-downloading a client digital certificate when you change PC etc., enter your own password and 
then click the “Login” button. 

 
 

 

 

 

 

When entered, 
Login! 
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STEP2. Select e-Parcel client software 
 

③The “STEP2. Select e-Parcel client software.” page appears. The latest versions of the 

software available for download are listed. Select one of the e-Parcel VCN-CommCenter8.0 

which conforms to Windows operating system type (either 64bit or 32bit) of your computer.  

And then, click the “Next” button. 
*If you are not clear about your computer, to check the “System type”, view the version information of Windows 

OS. Refer to the quick operation below how to view the version information in Windows. 
[For Windows 10 or later] Windows “Start” menu > Settings > System > About. The “About” dialog shows 
Device specifications. Check the “System type” field. 
[For Windows 8 or earlier] Control Panel > System and Security > System. View basic information about your 
computer. Check the "System type" field. 
*For more information, get help out of Microsoft Windows. 

 

 
 

 

 

 

 

 Next! 

Select the e-Parcel 
VCN-CommCenter 

64bit or 32bit. 
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STEP3. Check the security of web site 
 
④The “STEP3. Check the security of web site …” page appears. Confirm the security of the 

web site for your secure downloading.  
 
In this webpage which you are visiting, do you see the Trusted Web Seal that Cybertrust (The 
certificate authority which validate EV SSL certificate) issued to “e-Parcel Corporation” (The 
organization name of the web site)? 
* If the Trusted Web seal is not shown in this webpage because of JavaScript disabled, click the lock icon (View 

site information) in the URL address bar to confirm the validation result. 

 

 

 

 

 
 

 

 

 

 

When your confirmation is made, click the “Next” button. 

 

 

 

Check the web seal! 

Next! 
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STEP4-1. Download client digital certificate 
 
The “STEP4. Download and install your client digital certificate.” page appears.  

 

 

①On the “Client Digital Certificate” field, make sure the “For new users” selected. Usually, leave 

this field with initial choice and then click the “Download” button. 
*When the “For new users” selected, the SHA2 signed digital certificate will be downloaded. Note 

that e-Parcel VCN-CommCenter 7.0.7015 (released in Jan. 1. 2015) or later is compatible with the 
SHA2 signed digital certificate.  

 
*When the “For users of previous versions” selected, the SHA1 signed digital certificate will be 

downloaded. (*Recommendation for users of the previous versions: Updating the e-Parcel 
VCN-CommCenter to the latest version is highly recommended.) 

 

Download! 

Make 
sure! 
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②Upon clicking the “Download” button, browser application prompts you for what to do with 

download. In the download notification bar, select “Open file” or "Open". 

*To proceed to “Auto Setup” at the later step, a client digital certificate is required to install (import) in Windows 
in advance when you sign in Windows with a user account which runs the e-Parcel VCN-CommCenter. 

 

File name of the client digital certificate: e-Parcel_your e-Parcel ID.p12 

 

 

[For Microsoft Edge] 

 

 

 

 

 

OR 
 

 

 

 

 

Open! 

Open file! 

A file name of  
your certificate 
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STEP4-2. Install client digital certificate 
Execute to install (import) the e-Parcel client digital certificate in Windows. 

 

③The Certificate Import Wizard opens. click the “Next” button to proceed. 
*For Windows 10 or later, choose the “Current user” as a storage location. 

 

[For Windows 10 or later] 

 

 

 

 

Next! 

Windows 10 or later: 
Choose “Current User” 
in the Store Location and 
then Next. 
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[For Windows 8 or earlier] 

 

 

 

 

 

 

Next! 
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④The File to Import dialog appears. Specify the file you want to import. (*Leave the default file 

name of your certificate.) Click the “Next” button to proceed. 

 

 

 

Warning: 
Don’t change a file name. 

Next! 
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⑤When password is required, enter default password [*as notified by e-mail when e-Parcel ID 
registered] or your own password (*You must enter the same password as you previously applied 
at STEP 1. Login to the web site.). And, please be aware that you must place a check in the 
checkbox “Make this key as exportable. This will allow you to back up or transport your keys 
at a later time.”.  

 
*For new users, a password has been set the default password at beginning. Please be advised you 

to change a password through “The e-Parcel Secure Enterprise - Web Browser” after you 
complete to install a client digital certificate in Windows at later STEP5 of the Web site. 

 
*For existing users, if you have already changed a password to your own password in the case of 

re-downloading a client digital certificate when you change PC etc., enter your own password and 
then click the “Login” button. 

 
Confirm to be validated (set checked: on) in the checkbox “Make this key as…”, then 
click the “Next” button to proceed. 
*Attention: With the checkbox “Make this key as exportable. …” invalidated (set unchecked: off), 

you will fail in auto-setup a client digital certificate on the e-Parcel software at the later step. The 
applications will come up with the error while auto-setup. 

 

 

 

Attention: 
You must place a check 
in the “Make this key as 
exportable…” checkbox. 

Next! 

Enter password! 
*This must be the 

same password 
as you enter at 
STEP 1. Login. 
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⑥The Certificate Store dialog appears. Confirm that the “Automatically select the certificate 

store based on the type of certificate” is selected as the initial choice. Just leave it, click the 

“Next” button.  

 

 

 

Next! 

Attention: 
You must select this! 
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⑦When “Completing the Certificate Import Wizard” is shown, click the “Finish” button to proceed.  

 

 Finish! 
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⑧The Security Warning dialog may appear. Therefore, CA certificate is installed at the same time, 

click the “Yes” button to allow it.  

 
 

 

 

⑨The “The import was successful.” dialog appears. Click the “OK” button to exit the Wizard.  

 

 

 

 

The Certificate Import Wizard closes. You have done to install (import) a client digital certificate in 

Windows. 

  

Yes! 

OK! 
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⑩Return to web site the “STEP4. Download and install a client digital certificate.” page.  

 

 

 

 

 

 

On the STEP 4, scroll down to the bottom of the web page. Then click the “Next” button to proceed.  

 

 
Next! 
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If you are not allowed to import certificate in Windows 
 

While the installation of the e-Parcel client digital certificate through the Certificate Import Wizard, 

when it shows "Completing the Certificate Import Wizard" upon the "Finish" button, some of the 

customers may fail in the certificate installation with the error message. It happens often that the 

local security policy or domain security policy of your company may not allow the 

certificate installation in Windows. 

 (For example, the error message "An error occurred during the addition of a certificate to the 

Trusted Root Certification Authorities store.")  

However, you may have some difficulty to change the security policy of you. To get started the 

e-Parcel software, we show you another procedure (manual setup) which the software directly 

imports your certificate instead auto setup. Pleas carefully take the following procedures. 

 

STEP4 of Web site:  

P27② Just “Save” a file of the e-Parcel client digital certificate in a computer. →P35⑩Next! 

 

STEP5 of Web site:  

Skip! →P49⑥Next!  
*Note: You cannot access URL of "The e-Parcel - Web Browser" without certificate installation in 

Windows or browser applications. (The "User Info" menu on that site is not available to view 
and edit user information.) 

 

STEP6 of Web site:  

P50① Install software.  

Attention: P58～60⑭ at STEP 6, while software installation, when the InstallShield Wizard shows 

message "InstallShield Wizard Completed", you must set unchecked (off) in the checkbox 

"Launch the program". Then click the "Finish" button. (Auto setup function is invalidated without 

certificate installation. If set checked (on), it will launch the program and start auto-setup. 

However, it will come up with error message.) 

 

Next, let's begin to import your certificate directly on the client software. 

[For Windows 10 or later] Select from Windows “Start” menu > e-Parcel > Import Certificate. 
[For Windows 8 or earlier] Select from Windows “Start” menu > All Programs > e-Parcel > 
VCN-CommCenter x.x > Import Certificate. 
Then, select a file of the e-Parcel client digital certificate saved at the previous STEP4 of Web site: 

P27②.  

 

*For more details, refer to the Q&A site（URL：https://www.e-parcel.ne.jp/epvcn/en/FAQ/answer3-10.php） 
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STEP5. Access “The e-Parcel Secure Enterprise - Web Browser” 
 
The “STEP5. Access the URL of e-Parcel Secure Enterprise - Web Browser…” page 
appears.  

 

 

 
Access “The e-Parcel Secure Enterprise - Web Browser” to ensure a client digital certificate 
imported in Windows appropriately. Also, you can change a password on the web site. Once “The 
e-Parcel Secure Enterprise - Web Browser” window opens, you have successfully installed the 
e-Parcel client digital certificate in Windows. 

 

 

 
 
 
①Scroll down to the middle of the web page and then click the red button below.  

 

 

Click! 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

38 
Copyright© e-Parcel Corporation All rights reserved. 

 

②The site requires your certificate for authentication. Select your e-Parcel client digital certificate 
installed in Windows previously and then click the “OK” button. 

 

 

 
* If multiple e-Parcel client digital certificates are shown on the "Select a certificate" window, 

select a certificate of your e-Parcel ID and then click the “OK” button. 

And then 
click "OK"! 

Click to select 
a certificate. 
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③“The e-Parcel Secure Enterprise - Web Browser” new window is opened. 

“The e-Parcel Secure Enterprise - Web Browser” URL: https://secure.e-parcel.ne.jp/ 

 

When you succeed it, view the “User Info” menu and proceed to the next ④ (P46) of this 

section.  

 

 

 

 

 

 

 

 

* Attention: Don’t send any data if 
the menu "Create New" appears. 
This menu is provided for only users 
of the e-Parcel web browser client. 
(For users of the e-Parcel client 
software, we provide the higher 
security and the lager data delivery 
service) In addition, once the 
software has installed, the menu 
"Create New" is no longer shown. 

User Info 

× 
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If failed in access “The e-Parcel Secure Enterprise - Web Browser” 
 

If you fail in accessing to URL of “The e-Parcel Secure Enterprise - Web Browser”: 

 

Caution: If you were rejected to access URL of “The e-Parcel Secure 

Enterprise - Web Browser”, although the client digital certificate has been 

installed, your client digital certificate may not have been installed in Windows 

appropriately. Or, confirm your computer’s proxy settings or network 

environment not to configure the access control such as block or analysis of 

HTTPS request to the e-Parcel service domains as of [https://*.e-parcel.ne.jp] 

and [https://*.e-parcel.com].  

 

First, ensure that a client digital certificate has been correctly installed in Windows by reviewing the 

diagram [Verify your certificate installation status] indicates from the next page of this manual.  

 

OR on web site STEP 5, click the “Access Failure” button and carefully read the description in the 

Q&A page of the site（URL：https://www.e-parcel.ne.jp/epvcn/en/FAQ/answer1.php）. It is also 

described additionally check points about browser applications, the security settings and the proxy 

server settings in network environment. 

  

 

 

 

 

 

 

 

 

Access Failure 
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[Verify your certificate installation status] 

1. To verify your client digital certificate using the Windows interface, 

For Windows 10 or later, access the “Start” menu > Windows System > Control Panel > Network 

and Internet > "Internet Options". 

On the “Internet Properties” dialog, select the “Content” tab and click the "Certificates" button in 

the Certificates category. The "Certificates" dialog is opened. 

 
To open the “Certificates” dialog from Microsoft Edge 
Launch Microsoft Edge. On toolbar at the upper-right, click […] (Settings and more) > Settings (gear 
mark) > Privacy, search, services > Security > Manage certificates > [Certificates] dialog 

 

 

 

Certificates 

Content tab 
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2. On the “Certificates” dialog, click the “Personal” tab and then select your e-Parcel client digital 

certificate listed.  

The “Issued To” column shows your e-Parcel ID 

The “Issued By” column shows “e-Parcel Global Service Authority” 

Select your certificate, and then click the “View” button. 

 

 

 

View! 

Personal 

Select! 
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3. The “Certificate” dialog appears. Select the “Certification Path” tab. 

 

Certification Path 
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4. Ensure your client digital certificate is displayed correctly as shown below in the “Certification 

Path” tab. If a hierarchical tree with three layers is shown, you have successfully installed an 

e-Parcel client digital certificate in Windows. 

 

 

Certification Path 
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5. Close all dialogs opened after confirmation. Click the “OK” button on the “Certificate” dialog. 

Return to the “Certificates” dialog and then click the “Close” button. Return to the “Internet 

Properties (Internet Options)” dialog and then click the “OK” button to close. 

 

 

6. If your instillation has been failed, you must need to download and install the client digital 

certificate appropriately. Click the “Back” button to Return to web site the “STEP4. Download and 

install a client digital certificate.” Page and try again. 

 

 

If it still doesn't work, although your e-Parcel client digital certificate has been correctly installed, 

check additionally your network environment. If you are unclear on your computer or network 

environment, would you please consult your network administrator to modify settings? 

(It is happened often that your computer or network environment may have any access control 

such as block or analysis of SSL connections to the e-Parcel service domains. Check your computer 

or network environment including the settings of your proxy server, firewall, any applications for 

security measures or etc. You may need the setting changes to allow (exclude from target) 

HTTPS protocol communications [Port=443] to the e-Parcel service domains as of 

[https://*.e-parcel.ne.jp] and [https://*.e-parcel.com] (The wildcard domain: The asterisk 

mark [*] would be replaced with a name of multiple servers via the e-Parcel service.).) 
*For more details, visit the Q&A page of the site（URL：https://www.e-parcel.ne.jp/epvcn/en/FAQ/answer1.php）

and carefully read the description. It is also described additionally check points about the security settings and the 
proxy server settings in Windows. 

 
*If you are getting failed again in accessing URL of “The e-Parcel Secure Enterprise - Web Browser” although your 

client digital certificate has been re-installed correctly, please contact the e-Parcel Customer Support by e-mail 
(support@e-parcel.co.jp) with specifying your e-Parcel ID. 
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④The “User Info” page appears. It allows you to modify your e-Parcel Profile and change a 

password.  

 

 

 

 

 

About New password 

If a password should be changed, enter the new password in the New Password field and the 

New Password (re-enter) field, and then click the “Update” button. A password must be between 

8 - 20 half-width alphanumeric characters. Note that password is case-sensitive, and contains no 

spaces.  
*For new users, a password has been set the default password we inform you by e-mail 

notification at beginning. Please be advised you to change a password through “The e-Parcel 
Secure Enterprise - Web Browser”. 

 

A password  
must be 

between 8 - 20 
half-width 

alphanumeric 
characters. 

Enter new password! 

When entered, 
click "Update"! 

User Info 

* Attention: Don’t send any data if 
the menu "Create New" appears. 
This menu is provided for only users 
of the e-Parcel web browser client. 
(For users of the e-Parcel client 
software, we provide the higher 
security and the lager data delivery 
service) In addition, once the 
software has installed, the menu 
"Create New" is no longer shown. 

× 
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About User Name 

The "User Name" of User Info is automatically shown as "Sender name" and "Recipient name" on 

inbox, outbox and address book of the e-Parcel client software. When you wish to change "User 

Name", edit a user name on both fields "first name (the upper field)" and "last name (the lower 

field)", and then click the "Update" button. The fields "first name" and "last name" of a user name 

must be input using less than 60 characters each. (For example, John Parcel as "first name" and 

Design department as "last name" are inputted.) 

 

 
*Attention: Don’t send any data if the menu "Create New" appears. This menu is provided for users 

of e-Parcel web browser client. (Therefore, we provide the higher security and the lager data 
delivery service for users of the e-Parcel client software.) 

 
*The Password Protect field usually is set "No" with initial choice. If the “Password Protect” function 

will change to be enabled ("Yes") through “The e-Parcel Secure Enterprise - Web Browser”, you 
also must set a login password on your e-Parcel client software. Therefore, the VCN-CommCenter 
is required to authenticate a login password when login to the e-Parcel server upon installation, 
startup, auto-setup, import certificate and etc. 
Refer to P385 10. Password Protect function 

 
*Warning: For users who the Password Protect field already has been set "Yes". 

When you change your password through “The e-Parcel Secure Enterprise - Web Browser”, you 
also make sure to change to the new login password on your e-Parcel client software. Therefore, 
you are required to re-authenticate new password in the e-Parcel server when login password 
updated. 
Refer to P147 3. User Configuration - 5. Login Password Authentication 

 
*When you wish to view / edit user information or change password, launch browser application in 

a computer which has been imported the e-Parcel client digital certificate of your e-Parcel ID. And 
then, access URL of "The e-Parcel Secure Enterprise - Web Browser" at 
https://secure.e-parcel.ne.jp/. On the "User Info" menu, you can view / edit user information 
registered and change password. Also, it is available to inquire into "Inbox" / "Outbox" histories 
recorded for the selected period (until month before last or target date) online. (Please be 
advised to add to favorites on browser application.) 
Refer to P458 Appendix 1. e-Parcel Secure Enterprise - Web Browser  
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⑤The process result “OK” should usually appear. Your password has been updated successfully. 

Close this new tab of the browser as needed. 

 

 

 

 

 

Close 
this tab! 
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⑥Return to web site the “STEP5. Access the URL…” page.  

 

 

 

 

 

On the STEP5, scroll down to the bottom of the web page and then click the “Next” button to 

proceed.  

 

 
Next! 
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STEP6-1. Download e-Parcel client software 
 
The “STEP6. the e-Parcel Client Software” page appears. Proceed to download and install.  
 

 
 

①Pleas be aware that you must read carefully the attentions described on the webpage. When you 

confirm the software name “e-Parcel VCN-CommCenter x.x” shown on the Client software name 

field, click the “Download” button. 

 
 

 

Caution: The software installation requires administrative privilege. 

If you sign in Windows with a standard user account without the 

administrative privilege, you are required to input an administrator 

account name (administrator ID) and password to User Account Control 

(UAC) dialog when executing installation. Prepare information in advance. 

[For Windows 2000, XP, 2003]  
Log on Windows with either an administrator account or a user account with the 
administrative privilege in advance. 
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②To download the e-Parcel client software, click the “Download” button to save the e-Parcel 

VCN-CommCenter 8.0 executable file in your computer. 
*If you select “Save as” from the pull-down menu, leave the default file name. Save it to another 

location where is easy to access such as Desktop on your PC.  
 

 
 

 

 

③In Windows, the executable file is often saved automatically to This PC > “Downloads” folder 

with the default setting. 

(Or in the download notification bar of the browser window, select "Save as") 

 

[Executable file] 

Download location (Default): C:¥Users¥(Windows user account name)¥Downloads 

File name: [For 64bit: SetupVcnCC_8.0.xxxx_x64.exe] or [For 32bit: SetupVcnCC_8.0.xxxx.exe] 
*If you have changed Download Location in the browser settings “Downloads”, it might be 

saved to another location where you specified. 
 

 

 

Download! 
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[For Microsoft Edge] 

 

When the Downloads setting “Ask me what to do with each download” is disabled, it promptly 

starts to download the executable file. See the download notification bar below. After downloaded, 

confirm the executable file in the download location. 

 

 

 

 

OR 
 

When the Downloads setting “Ask me what to do with each download” is enabled, on the download 

notification bar, select "Save as" or “Save” to download the executable file. See the download 

notification bar below. After downloaded, confirm the executable file in the download location. 

 

 

 

 

 
Caution: It is recommended that you leave the default file name and type of 

the installation packaged. 

[During downloading] 

“Save as” 
or 

“Save” 
↓ 

[downloading] 

[Downloaded] 
Executable file name 

[Downloaded] 
Executable file name 
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STEP6-2. Install e-Parcel client software 
Execute to install the e-Parcel client software downloaded at STEP 6-1. 

 

 

   OR    

 

 

 

④To start InstallShield Wizard, double-click the executable file in the download location to open. 
*If the Security Warning appears prompting you to install this application, allow executing.  
 

⑤Select the display language for this application from the pull-down menu.  

And then, click the “OK” button. 

 

 

 

 

 

 

 

 

 

 

 
*You will be able to change the setting of the display language for the VCN-CommCenter GUI 

after the VCN-CommCenter gets started.  
Refer to P162 4. Option Configuration – 2. Language Setting 

 

Open  
the executable file! 

32bit 64bit 

Select the language for the installation from the choices below.  

English 

Cancel 

Select the language 
from the pull-down 

menu! 
↓ 

OK! 
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⑥The “VCN-CommCenter - Install Shield Wizard” will guide you through the installation processes. 

Click the “Next” button to continue.  

 

 

 

⑦When it shows the Software “License Agreement”, as necessary, print the license agreement for 

your records. After you carefully read, to continue, choose “I accept…” and click the “Next” 

button. 

 

 

Choose! 

Next! 

Next! 
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⑧On the “Customer Information”, it usually shows the User Name and Organization which you 

have configured to a current computer. Review it and click the “Next” button. 

 

 

 

 

⑨When it shows the “Destination Folder” Location, to install the program in a destination folder by 

default, click the “Next” button. If you want to install to a different folder, click the “Change” 

button.  

 

 

 

Next! 

Next! 
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⑩When it shows the “Database Folder” Location, to save the database in a folder by default, click 

the “Next” button. If you want to install to a different folder, click the “Change” button. 

 

 

 

 

⑪When it shows the “Data Folder” Location, to save data in a folder by default, click the “Next” 

button. If you want to install to a different folder, click the “Change” button. 

 

 Next! 

Next! 
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⑫When it shows the “Ready to Install the Program”, select either for “all users” or “Only for me 

(Windows user account)” button to begin to install the e-Parcel software with your installation 

settings.  

 
*To use VCN-CommCenter 8.0 in a same computer with multiple Windows user accounts, choose 

the “Anyone who uses this computer (all users)” button. The software must be installed just once 
by the first Windows user account. When any other user accounts sign in Windows, install the 
client digital certificate only, and then launch the existing VCN-CommCenter to auto-setup. (For 
more details, refer to P66) 

 

 
 
*[For Windows Vista or later] The ”User Account Control (UAC)” dialog appears. In the case of sign 

in Windows with an administrator account, select the “Yes (Allow)” button to allow. Or, in the case 
of sign in Windows with a standard account without the administrative privilege, an administrator 
account name (administrator ID) and password are required to input.  
[For Windows 2000, XP, 2003] Log on Windows with an administrator account or a user account with the 
administrative privilege. And then, try to install again. 

 
*If the Security Warning dialog appears prompting you to install this application, click the “Run” 

button to allow executing. 
 
 

 

⑬When it shows the “Installing…”, please wait while software installation processing. 

 

 

Click 
either one 
to begin 

installation. 
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⑭When the e-Parcel client software installation finished, it shows the “InstallShield Wizard 

Completed”. 

 

In the normal case that you launch and use the e-Parcel software with the current Windows user 

account, just confirm the checkbox “Launch the program” validated (set checked: on) by default, 

and then click the “Finish” button. 
*If you launch and use the e-Parcel software with another Windows user account which is 

different from the current Windows user account for software installation. be sure that the 
checkbox “Launch the program” should be invalidated (set unchecked: off), and then click the 
“Finish” button. For more details, refer to the next page. 

 

When you click the “Finish” button, the e-Parcel VCN-CommCenter gets started, and then 

proceeds to auto-setup promptly. The “Auto Setup” function attempts automatically to detect 

your certificate installed and your network settings from Windows. 

 

 

 

Finish! 

When you use the software with the 
current Windows user account,  

set checked! 
*If you use the e-Parcel software 

with another Windows user account, 
set unchecked. 

→ Refer to the next page. 
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Caution:  
[To use the software with another Windows user account after installed] 
In the case that you launch and use the e-Parcel software with another 
Windows user account which is different from the current user account for 
software installation, take this procedure below. 
For example, in the case of [Windows 2000, XP, 2003] 

If you sign in Windows temporarily with either an administrator account or a user account 
with the administrative privilege for only software installation, but you launch and use the 
software with another user account, take this procedure below. 

 
1. Set unchecked (off) in the checkbox “Launch the program” while the 
“InstallShield Wizard Completed” shown. Then, click the “Finish” button to 
complete just software installation without launching VCN-CommCenter. 
 
2. Sign out from the current Windows user account and then sing in with 
another Windows user account which you use the e-Parcel software.  
(Attention: Another Windows user account is required to install(import) a client 

digital certificate in Windows in advance.) 
*Before auto-setup, you must sign in Windows with a user account which runs the 

e-Parcel software and complete to install (import) a client digital certificate in 
Windows in advance. 

 
3. When you sign in Windows, to launch the program, double-click the “e-Parcel 
x.x” shortcut icon on the desktop.  

Or, [For Windows 10 or later] Select from Windows “Start” menu > e-Parcel > 
e-Parcel VCN-CommCenter x.x.  

[For Windows 8 or earlier] Select from Windows “Start” menu > All Program > 
e-Parcel > VCN-CommCenter x.x > e-Parcel VCN-CommCenter x.x.  

 

The VCN-CommCenter will launch and auto-setup. 

Proceed to the next procedure for auto-setup of this manual. 
* If the auto-setup function doesn’t start when the client software gets started, 

access the VCN-CommCenter GUI menu bar “Tools” > “Auto Setup”. 
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Caution: If the local security policy or domain security policy of your company 
may not allow the certificate installation in Windows or web browser 
applications, you may fail in the certificate installation in Windows at the 
previous step. In this case, you cannot auto-setup the e-Parcel client software. 
*Before auto-setup, you must sign in Windows with a user account which runs the 

e-Parcel software and complete to install (import) a client digital certificate in 
Windows in advance. 

Accordingly, set unchecked (off) in the checkbox “Launch the program” 
while the “InstallShield Wizard Completed” shown. Then, click the “Finish” 
button. It just ends to complete the software installation without launching the 
VCN-CommCenter. Try another way just below to import certificate directly on 
the client software. 
 
How to import the client digital certificate on the e-Parcel client software 
*Before import certificate, you must save a file of the e-Parcel client digital 

certificate in your computer in advance at STEP4 of Web site：P27②. 
1. [For Windows 10 or later] Select from Windows “Start” menu > e-Parcel > 

Import Certificate. 
[For Windows 8 or earlier] Select from Windows “Start” menu > All Program > 
e-Parcel > VCN-CommCenter x.x > Import Certificate. 

2. The "Certificate" dialog is opened. Locate a file of your certificate saved in 
your computer at the previous STEP4 of web site. A file name of the e-Parcel 
client digital certificate must be "e-Parcel_ [your e-Parcel ID].p12". 
Select it and then click the "Open" button to start importing. 

3. The "Password" required dialog appears. Input your password, and then click 
the "OK" button. 

4. While configuring your certificate on the e-Parcel client software, it shows 
“Setup is Proceeding…”. Proceed to P57 of this manual. 
* Once importing a certificate has been completed, a certificate file will be 

removed automatically from your computer. 
* For more details, refer to the Q&A page of the “e-Parcel software download site” at  

URL：https://www.e-parcel.ne.jp/epvcn/en/FAQ/answer3-10.php 

 

 

Caution: If the "Register ID Sharing" dialog is opened without 
proceeding to auto-setup upon click the “Finish” button while the 
“InstallShield Wizard Completed” shown, you cannot auto-setup the e-Parcel 
client software. Because, no certificate installation found in Windows. 
*Before auto-setup, you must sign in Windows with a user account which runs the 

e-Parcel software and complete to install (import) a client digital certificate in 
Windows in advance. 

In this case of normal use (without the "ID Sharing" function), click the 
"Cancel" button to close the "Register ID Sharing" dialog. It just ends to 
complete the software installation without launching the VCN-CommCenter. 
Firstly, install (import) the e-Parcel client digital certificate in 
Windows in advance. And then, to start the software, double-click the 
"e-Parcel 8.0" shortcut icon on the desktop. It normally starts to auto-setup. 
(If it cannot start to auto-setup and VCN-CommCenter GUI is just opened, 
select from the menu "Tools" > "Auto Setup" on GUI.) 
* For more details, refer to the Q&A page of the “e-Parcel software download site” at  

URL：https://www.e-parcel.ne.jp/epvcn/en/FAQ/answer3-71.php 
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Auto-setup e-Parcel Client Software 
Starting auto-setup just after installed the e-Parcel client software at STEP 6-2. 
*Caution: If the "Register ID Sharing" dialog is opened without proceeding to auto-setup, click the 
“Cancel” button. No certificate installation found in Windows. For more details, refer to the 
previous page. 

 

Just after the e-Parcel VCN-CommCenter installation is completed, it should be automatically 

configured itself for use. The “Auto Setup” function attempts to automatically detect the 

e-Parcel client digital certificate installed (imported) and your computer’s proxy settings. 

*Refer to P88 2. VCN-CommCenter View - 2. Menu Bar - 2-3. Tools – 2-3-3. Auto Setup 

 

⑮The e-Parcel VCN-CommCenter usually gets started and then automatically proceeds to 

auto-setup just after software installation completed.  

 
(In the case of one e-Parcel client digital certificate installed in Windows, the dialog as below 
won’t appear.) 

 
*If the "Confirm Certificate" or the "Select a Certificate" dialog appears, select an e-Parcel client 

digital certificate of your e-Parcel ID and then click the “OK” button to begin auto-setup. 
[For Windows 10 or later] Click “More choices” on the “Select a Certificate” dialog to view all 
certificates. Then, select one. 

 

 

 

If a “Select a 
Certificate” 

dialog appears,  
click to view all! 

When selected, 
OK! 
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If the proxy server configured to your computer’s proxy settings (Windows) requires user 

authentication, the "Proxy Authentication Required" dialog may appear upon auto-setup.  

Take either one below depending on the proxy authentication methods. 
Refer to P138 3. User Configuration – 4. Proxy Settings – 4-1. Automatic Proxy Settings 
Refer to P143 3. User Configuration – 4. Proxy Settings – 4-3. Proxy Authentication 
 

[In the case of NTLM Authentication or Integrated Windows Authentication] 

Leave blank in the proxy credentials (User name, Password, Checkbox “Remember this…”). Then, 

click "OK" button.  
*Because when it is not given any proxy credentials, Windows Single Sign On function will work to 
automatically apply Windows user account name and password for proxy authentication.  

 

[In the cases of the other authentication methods than the above] 

Input the proxy credentials (User name, Password). 

Once you place a check in the checkbox “Remember this authentication info.”, the “Proxy 

Authentication Required” dialog no longer appear whenever login upon start software, auto-setup, 

import certificate or etc. Then, click “OK” button to authenticate.  

 
*If you are not sure of your computer’s proxy settings and the proxy credentials (user name and 
password), to obtain the correct information, please contact your system/firewall administrator or 
service provider. 

 
*It is also available to manually configure the proxy server settings after starting the e-Parcel 
VCN-CommCenter. Details of the manual proxy settings can be found in the section below.  
Refer to P141 3. User Configuration – 4. Proxy Settings – 4-2. Manual Proxy Settings 

 

 

 

 

 

*If using the proxy 
server with NTLM or 
Integrated Windows 

Authentication,  
leave all fields blank. 

↓ 
OK! 
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⑯While auto-setup for the VCN-CommCenter, it shows “Setup is Proceeding…”. The e-Parcel client 

software attempts automatically to detect your certificate and network settings from Windows. 

When auto-setup completed successfully, the “VCN-CommCenter is starting” is usually shown. 

 

 

 

 

 

 
*If the Confirmation "Previous installation found…" dialog below is shown, there may exist another 

client in which a same e-Parcel ID (a same digital certificate) has been set up. Proceeding setup 
may cause it dysfunctional such as download aborted. For example, the unreceived items during 
the previous installation may be no longer delivered. Click the “OK” button to allow proceeding. 
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⑰When the e-Parcel software starts running, the “VCN-CommCenter” GUI is opened on the 

desktop. Once the setup and login to the e-parcel server have completed successfully on the 

e-Parcel software, it should come online. Check that the system status “Online” is shown on the 

bottom-right of the VCN-CommCenter GUI. The e-Parcel service is ready for use. 
*If the “VCN-CommCenter” GUI won't be opened, double-click the “e-Parcel 8.0” shortcut icon on 

the desktop. 
[VCN-CommCenter GUI] 

 
In addition, it is recommended that Windows always shows the e-Parcel icon (e-Parcel 

CommCenter 8.0) in the notification area on the taskbar. This e-Parcel icon will flash up and show 

the balloon messages (toast notifications) in the notification area when data received (When the 

status “Delivery Confirmed”). 

[How to make Windows show icon in the notification area on the taskbar] 
(By default, Windows does not show this icon on the taskbar: “Off”) 
[For Windows 10 or later] 
1. Right-click on the taskbar, then select “Taskbar settings” from menu.  
(Or, click Windows “Start” menu > Windows System > Control Panel > Appearance and 
Personalization > Taskbar and Navigation)  

2. On the Settings "Taskbar" window, under "Notifications Area", click “Select which icons appear on 
the taskbar".  

3. The icons list is displayed. Turn on the “VCN-CommCenter 8.0” toggle to apply change to "On". 
*For more information, get help out of Windows. 
Refer to P68 Icon of the e-Parcel VCN-CommCenter – Taskbar notification area icon 

Attention 
This e-Parcel ID has been 
validated in just one PC. 

(Multiple PC are invalidated) 

Check 
“Online”! 
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Warning: The e-Parcel service has adopted the client digital certificate for 
mutual recognition between the server and a client. (Authentication) Therefore, 
you can NOT set up a same e-Parcel ID (e-Parcel client digital certificate) to the 
e-Parcel VCN-CommCenter in multiple computers. 
One e-Parcel ID must be available to use in only one 
computer. 
If a same e-Parcel ID (e-Parcel client digital certificate) is set up to the e-Parcel 
client software in one computer, it is made unavailable in the other computer. 
That must cause the previous installation dysfunctional (offline). Also, the 
unreceived items which are not started to download during the previous 
installation will be the delivery status "Download aborted" and no longer 
possible to download. 
* If you have set up a same e-Parcel ID (e-Parcel client certificate) to the 

e-Parcel client software in multiple computers, we are afraid that any 
problems caused by multiple installations above are NOT included in the 
e-Parcel Customer Support. Accordingly, you need to clearly understand 
the installation with your e-Parcel ID for appropriate use.  
Refer to P17 Attention on using software 
 

 

 

Warning: Before sending and receiving data via the e-Parcel service, both 
sender and recipient must register an e-Parcel ID each with the e-Parcel service 
and must complete to install the e-Parcel client certificate and software in a 
computer each in order to ensure the high security levels in advance. 
Therefore, you can NOT send data to the e-Parcel ID that is not 
registered or has not completed installation yet. If addresses include 
such an e-parcel ID without satisfaction of the above conditions, the delivery 
status will be "Unknown Recipient" in outbox to fail in sending. (In the case 
of multiple destination e-Parcel ID including the correct ID, you fail in sending 
this item to all recipients when the delivery status "Unknown Recipient".) 
[How to confirm the error message in the case of the status "Unknown Recipient"] 
1. In outbox, double-click on an item showing the status "Unknown Recipient". 
2. The Parcel Detail dialog opens. Click the Error Detail button. 
3. The Error Detail dialog opens. Confirm the error message and the invalid ID.  
 

 

 

Caution: If your computer or network environment (the proxy server, firewall, 
any applications for security measures or etc.) have any access control such as 
block or analysis of SSL connections, you need to allow (exclude from 
target) HTTPS protocol communications [Port=443] to the e-Parcel service 
domains as of [https://*.e-parcel.ne.jp] and [https://*.e-parcel.com] 
(The wildcard domain: The asterisk mark [*] would be replaced with a name of 
multiple servers via the e-Parcel service.). 

If you are not clear about that, please consult your network administrator to 
modify the network settings. 
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Note: The application provides the ability to set up multiple client digital 
certificates (multiple e-Parcel ID) to one VCN-CommCenter. If you wish to use 
multiple e-Parcel ID on same VCN-CommCenter GUI, you need to install the 
client digital certificate of another new e-Parcel ID registered in Windows and 
then set up to add new e-Parcel ID on the existing VCN-CommCenter. (Access 
the menu Tools > Auto Setup) 
*Before auto-setup, you must sign in Windows with a user account which runs the 

e-Parcel software and complete to install (import) a client digital certificate in 
Windows in advance. 

Please carefully read and take the procedures below. 
Refer to P387 11. Edit / Exchange / Add Digital Certificate 

[Case 3. When you want to add new e-Parcel ID and use multiple e-Parcel ID] 
*Also, refer to the Q&A page of the “e-Parcel software download site” at 

URL：https://www.e-parcel.ne.jp/epvcn/en/FAQ/answer3-8.php 

 

 

Note: In the case that multiple Windows user accounts use the 
VCN-CommCenter in one computer, while software installation, the first 
Windows user account must choose the “Anyone who uses this computer (all 
users)” button. (P57) 
This description just briefly explains how to install and configure. 
 
First, sign in Windows with "user account A" and complete to install both the 
client digital certificate and software (e-Parcel VCN-CommCenter) as usual. 
Then exit (shutdown) the software. (Access the menu File >Exit)  
*Attention: The software must be installed just once by the first 

Windows user account in a computer. 
 
Next, sign in Windows with another "user account B" and import only the client 
digital certificate in Windows. Then, to start the existing VCN-CommCenter, 
double-click the shortcut icon “e-Parcel x.x” on the desktop. It will usually start 
auto-setup. (Or, you may access the menu Tools > Auto Setup) (*Whenever 
switching another Windows user account, must access the menu File >Exit 
(shutdown) the software.) 
*Upon sign in Windows with another "user account B", either the same 

e-Parcel ID as "user account A" or another e-Parcel ID is available to set up 
the client digital certificate in one computer. 

 
At the end, please carefully read below for appropriate use. 
*Caution: Please be sure that double startup of a program is NOT available when 

multiple Windows user accounts use VCN-CommCenter within one computer. 
For example, while VCN-CommCenter is running with user account A, if a user will try to start 
VCN-CommCenter with user account B in a same computer by means of user switching in 
Windows or multiple sign-in function in Windows Server OS, VCN-CommCenter with user 
account B does NOT get started with just showing the Information dialog "VCN-CommCenter 
is already running". Therefore, only the first user can get started VCN-CommCenter as a 
program in one computer.  
(Solution: After the first user sign out or exits (shutdown) VCN-CommCenter (End the 
application process from a current user), another logon user account can start the 
application within a same computer.) 

*For more details, refer to the Q&A page of the “e-Parcel software download site” at  
URL：https://www.e-parcel.ne.jp/epvcn/en/FAQ/answer3-7.php 
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Icon of the e-Parcel VCN-CommCenter 
When the client software; e-Parcel VCN-CommCenter has been installed successfully, the shortcut 

icon is created on the desktop. Also, it is recommended that Windows always shows the  

e-Parcel icon (e-Parcel CommCenter 8.0) in the notification area on the taskbar. By default, 

Windows does not show this icon in the notification area on the taskbar. You can change the 

Settings “Taskbar” using the Windows interface. 

 

 

 

Shortcut Icon 
When software installation complete, the “e-Parcel x.x” shortcut icon is created on the desktop of 

Windows. 
*Refer to P70 2. VCN-CommCenter View – 1. Start/Exit/Open/Close the VCN-CommCenter 
 

 

 
 

 

 

 

 

 

 

Shortcut icon 
on the desktop 
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Taskbar notification area icon 
When software installation complete, it gets started. In addition, it is recommended that 

Windows always shows the  e-Parcel icon (e-Parcel CommCenter 8.0) in the notification area 

on the taskbar (at the bottom right of Windows). 
*Note: [For users of Windows] 
[How to make Windows show icon in the notification area on the taskbar] 
(By default, Windows does not show this icon on the taskbar: “Off”) 
[For Windows 10 or later] 
1. Right-click on the taskbar, then select “Taskbar settings” from menu.  
(Or, click Windows “Start” menu > Windows System > Control Panel > Appearance and 
Personalization > Taskbar and Navigation)  

2. On the Settings "Taskbar" window, under "Notifications Area", click “Select which icons 
appear on the taskbar".  

3. The icons list is displayed. Turn on the “VCN-CommCenter 8.0” toggle to apply change to 
"On". 

*For more information, get help out of Windows. 
[For Windows 8 or earlier] Click the arrow next to the notification area on the taskbar. (Or, click 
Windows “Start” menu > Control Panel > Appearance and Personalization > “Customize icons on the 
taskbar”.) On the "Notifications Area Icons" dialog, change the “VCN-CommCenter 8.0” to "Show 
icon and notifications" as the behavior. 

 

[The  e-Parcel notification area icon on the taskbar] 

In the case of “Online”, the colored e-Parcel icon is shown as the diagram just below. 

In the case of “Offline”, the e-Parcel icon will be grayed-out as the diagram (*) just below. 

In the case of the status “Delivery Confirmed” in inbox when received items, the colored e-Parcel 
icon will flash up and show the balloon messages (toast notifications). 
*Refer to P172 4. Option Configuration – 10. Balloon Message in the taskbar notification area 

 
 

 

 

 

 

Right-click the  e-Parcel notification area icon on the taskbar to open the pop-up menu. 
*Refer to P70 2. VCN-CommCenter View – 1. Start/Exit/Open/Close the VCN-CommCenter 
*Refer to P106 2. VCN-CommCenter View – 2. Menu Bar – 2-4. Help 

 

Online: 
Taskbar notification 

area icon 
 

*Offline: 
grayed-out 

Right-click 
notification area icon 

on the taskbar. 
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２．VCN-CommCenter View 

When the e-Parcel application has installed successfully, the main application GUI 

“VCN-CommCenter” will open on the desktop. You can operate to send data, move (save) data 

from inbox and etc. on this GUI.  

 

The following sections will guide you in the VCN-CommCenter GUI for your operation. 

 

 

 

 

[VCN-CommCenter GUI] 

 
 

２ 

Tree view 
(P120) 

Menu Bar (P77) 

Tool Bar (P114) 

Folder Tree: Switch to display on the list view.  
*Tree view shows Folder Trees by each e-Parcel ID which you set up. 
・Display name (P122/P134): “User Configuration” pane 

*Your e-Parcel ID is assigned to the initial “Display Name”. 
*Click this to display the “User Configuration” on the list view. 

 ・Inbox/Outbox 
*Click either to list up the inbox or outbox items on the list view. 

 

List view (P132 User Configuration / P334 Outbox / P358 Inbox) 
*Each window which is selected on the folder tree will be displayed. 

Favorites view 
(P129) 

*Favorite 
addresses 
displayed. 

Click  ×   (P73) 
Just close VCN-CommCenter GUI (window). 
*Run as background application. 
 

To change width of pane, drag here. 
*If you click × to hide Tree view, also 

drag here to show it again. 
 

Check the system status “Online” displayed! 
*Sending / Receiving available. 
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1. Start/Exit/Open/Close the VCN-CommCenter 

 

1-1. How to start the VCN-CommCenter 
Usually, when you start a computer and sign in Windows with a user account, the e-Parcel 

VCN-CommCenter gets started as background application. (by default) 

VCN-CommCenter GUI is not opened while starting as background application. 

*In the case of just after application installed and auto-setup, VCN-CommCenter GUI is 
automatically opened on startup. 

 

To restart application after exit (shutdown) from the menu “File” > “Exit”, you can start the e-Parcel 

VCN-CommCenter in either of two (2) ways below. 

 

 

Start by the Shortcut icon 

To start the e-Parcel VCN-CommCenter, double-click the “e-Parcel x.x” shortcut icon on the 

desktop. 

 

 
 

 

 

Way1. 
Double-click 
the shortcut 
on desktop! 
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Start from Windows “Start” menu 

In addition, to start the e-Parcel VCN-CommCenter, select from Windows “Start” menu. 

 

[For Windows 10 or later]  

 Select from Windows “Start” menu > e-Parcel > “      e-Parcel VCN-CommCenter x.x” 

 

[For Windows 8 or earlier]  

Select from Windows “Start” menu > All Programs > e-Parcel > VCN-CommCenter x.x  >  

 “  e-Parcel VCN-CommCenter x.x” 

 

 

[For Windows 10 or later] 

 

 

 

Way2. 
Select from 
Windows 

“Start” menu! 
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1-2. How to exit the VCN-CommCenter 
When you wish to exit (shutdown) the e-Parcel application, you can exit the e-Parcel 

VCN-CommCenter in either of two (2) ways below. Once you have exit (shutdown) the e-Parcel 

application, you no longer receive the transmitted data until the next time the e-Parcel application 

gets started. 

 

Exit from menu of VCN-CommCenter 

To exit (shutdown) the e-Parcel VCN-CommCenter, click the menu “File” > “Exit” on the 

VCN-CommCenter GUI. 

 
 

 

 

 

Exit from menu of taskbar notification area icon 

While the application is running, the  e-Parcel icon is shown in Windows taskbar notification 

area (at the bottom right of Windows). 
*Refer to P68 Icon of the e-Parcel VCN-CommCenter – Taskbar notification area icon 
 

To exit (shutdown) the e-Parcel VCN-CommCenter, right-click the  e-Parcel icon in Windows 

taskbar notification area to open the pop-up menu, and then select “Exit”. 

 

 

 

Way2. 
Right-click, then 
Exit! 

Way1. 
File > Exit! 
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1-3. How to close the window of VCN-CommCenter 
Also, to just close the VCN-CommCenter GUI (window), you can run the e-Parcel 

VCN-CommCenter as background application without opening the VCN-CommCenter GUI. 

In this case, it could be available tracking and downloading items automatically according to 

keep running the e-Parcel application. (The  e-Parcel icon is continuously shown in 

Windows taskbar notification area.) 

 

Usually, when the e-Parcel application has installed successfully, the e-Parcel 

VCN-CommCenter must be running. The VCN-CommCenter GUI automatically opens on the 

desktop. Also, when you restart the e-Parcel application, the VCN-CommCenter GUI usually 

opens on the desktop with the default option configuration. 

At this point, if you wish the e-Parcel VCN-CommCenter to run as background application, just close 

the VCN-CommCenter GUI in either of two (2) ways below. 

(The  e-Parcel icon is continuously shown in Windows taskbar notification area.) 
*Refer to P68 Icon of the e-Parcel VCN-CommCenter – Taskbar notification area icon 
 

Close by the button on VCN-CommCenter GUI 
To just close the VCN-CommCenter GUI, click the  Ｘ  button at the top right corner of the 

VCN-CommCenter GUI. 

 

 

Close from the menu bar of VCN-CommCenter 

To just close the VCN-CommCenter GUI, click the menu “File” > “Close Window” on the 

VCN-CommCenter GUI. 

 
 

Way1. 
Close Window! 
*Run as background 

application. 
 

Way2. 
File > Close Window! 
*Run as background 

application. 
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The  e-Parcel icon is continuously shown in Windows taskbar notification area.  

(at the bottom right of Windows) The program is running as background application. 

 

 

 

Caution: When the VCN-CommCenter GUI is just closed by above 

ways, the application does NOT exit (shutdown). 

The e-Parcel VCN-CommCenter must be running as background application. 

Therefore, the  e-Parcel icon is continuously shown in Windows taskbar 

notification area, representing the availability of e-Parcel service. It will start 

automatically to download the transmitted items as usual. Also, it will 

automatically update the delivery status in inbox and outbox items 

(Tracking). You can view inbox and outbox items by restoring the 

VCN-CommCenter GUI.  
*If you wish the e-Parcel VCN-CommCenter to run as background 

application whenever startup, change the setting of the Option 
Configuration on the VCN-CommCenter. 
Refer to P169 4. Option Configuration – 7. Background Application 
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1-4. How to open the window of VCN-CommCenter 
To restore the VCN-CommCenter GUI (window) while running as background application, open the 

VCN-CommCenter GUI in any of three (3) ways below. 
* Usually, when you launch a computer and sign in Windows with a user account, the e-Parcel 

application gets started as background application by default. At this point, the 
VCN-CommCenter GUI is not opened while running as background application.  
Refer to P68 Icon of the e-Parcel VCN-CommCenter – Taskbar notification area icon 

 

Open from taskbar notification area icon 

To open the VCN-CommCenter GUI while running as background application, just double-click the 

 e-Parcel icon in Windows taskbar notification area (at the bottom right of Windows). 

 
 

 

 

Or, right-click the  e-Parcel icon in Windows taskbar notification area (at the bottom right of 

Windows) to open the pop-up menu, and then select the menu “Open”. 

 

 

 

 

Way2. 
Right-click, then 
Open! 

Way1. 
Double-click! 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

76 
Copyright© e-Parcel Corporation All rights reserved. 

 

Start the VCN-CommCenter 

In addition, you can also open the VCN-CommCenter GUI by the same ways as starting the 

VCN-CommCenter. (Double-click the “e-Parcel x.x” shortcut icon on the desktop. OR, access from 

Windows “Start” menu.) 

*Refer to P70 2. VCN-CommCenter View – 1-1. How to start the VCN-CommCenter 

 

 

 

 
 
 
 
*In this case, the “Information” dialog appears as below because the e-Parcel application has 

already started as background application. Click the “OK” button on the “Information” dialog to 
open the VCN-CommCenter GUI. 

 

Way3. 
Start 
VCN-CommCenter! 

OK！ 
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2. Menu Bar 

 

There are four (4) menu choices available in the menu bar of the VCN-CommCenter GUI, including 

File, Message, Tools and Help. 

 

[VCN-CommCenter GUI] 

 

 

 

１．File (F) ２．Message (M) 

To direct the VCN-CommCenter to reload, open, 

close window, exit and setup for printing page. 

To direct the VCN-CommCenter to perform 

sending items. 

  

 

３．Tools (T) ４．Help (H) 

To direct the VCN-CommCenter to perform setup 

and option configurations, including address 

book. 

Provide you with the manuals, application log 

and general information about the e-Parcel 

software version info etc. 

 

 

[Menu bar] 
Click to open the pull-down menus! 
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2-1. File 
 

This menu selection features commands to direct the VCN-CommCenter to reload, open/close GUI 

and exit (shutdown) the application. The following commands are available.  

 

 
 

 

 

2-1-1. Reload 
This command will promptly check for any items pending delivery and track the latest status by 

polling to the e-Parcel server. 

*This behaves similarly to the “Reload” button on the tool bar of VCN-CommCenter. 

 

 

 

2-1-2. Open 
This command will provide three (3) sub-menu choices for each e-Parcel ID which you wish to 

show in the list view (in the right pane). 

 

Display Name (P122/P134 Default: e-Parcel ID is displayed)： 

This command will open the “User Configuration” pane on the VCN-CommCenter GUI, 

allowing you to configure the VCN-CommCenter for individual e-Parcel ID. 

 

Inbox：This command will display inbox items on the VCN-CommCenter GUI. 

 

Outbox：This command will display outbox items on the VCN-CommCenter GUI. 

 

Click to open 
the pull-down 

menu! 
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2-1-3. Page Setup 
This command will open the “Page Setup” dialog. 

On this dialog, you can modify the page setting for printing message (on the “Parcel Detail” dialog 

and the “Send Dialog”). When changed, click the “OK” button to close the “Page Setup” dialog for 

the changes to take effect.  
*This behaves similarly to the right-click menu “Page Setup” of message box on the Parcel Detail. 
*This behaves similarly to the right-click menu “Page Setup” of message box on the Send Dialog. 

 
*The “Message printing” function has been provided since e-Parcel VCN-CommCenter 8.0.8023 (Released in March 

2022). The “Page Setup” and “Print” dialog opens additionally.  
*To print the message, click the “Print” button on the Parcel Detail dialog. On the Send Dialog, right-click on the 

message box and select the “Print” menu. The “Print” dialog opens. 
Refer to P309 8. Sending - 1. New Item Creation – 1-2. Enter Subject and Message – Printing message 
Refer to P352 8. Sending - 3. Outbox Parcel Detail - Tool Bar 3-3-5. Print 
Refer to P381 9. Receiving - 3. Inbox Parcel Detail - Tool Bar 3-3-8. Print 
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2-1-4. Close Window 
This command will just close the VCN-CommCenter GUI (window). It does NOT exit (shutdown) 

the application. The  e-Parcel icon is continuously shown in Windows taskbar notification area, 

representing the availability of e-Parcel service. You can receive items, and view them by 

restoring the VCN-CommCenter GUI. 
*Refer to P73 2. VCN-CommCenter View – 1-3. How to close the window of VCN-CommCenter 

 

How to restore the VCN-CommCenter GUI (window) 
To open the VCN-CommCenter GUI when running as background application, just double-click 
the  e-Parcel icon in Windows taskbar notification area. (Or, right-click the e-Parcel icon in 
Windows taskbar notification area to open the pop-up menu, and then select “Open”.) 
In addition, double-click the “e-Parcel x.x” shortcut icon on the desktop to start. 
*Refer to P75 2. VCN-CommCenter View – 1-4. How to open the window of VCN-CommCenter 

 

 

 

 

 

2-1-5. Exit (Shutdown) 

This command will exit (shutdown) the e-Parcel application. The  e-parcel icon will disappear 

from Windows taskbar notification area. Once you have exit (shutdown) the e-Parcel application, 

you no longer receive the transmitted data until the next time the e-Parcel application gets 

started running. 
*This behaves similarly to the right-click menu “Exit” of Windows taskbar notification area icon. 
*Refer to P72 2. VCN-CommCenter View – 1-2. How to exit the VCN-CommCenter 
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2-2. Message 
This menu selection features commands to direct the VCN-CommCenter to perform sending items. 

 

 

 

Click to open 
the pull-down 

menu! 
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2-2-1. Create New 
 This command will open the “Send Dialog” to create a new item. 

*This behaves similarly to the “Create New” button on the tool bar of VCN-CommCenter. 
*Refer to P291 8. Sending 

 

 

 

 
*The “Message decoration with rich text format” function has been provided since e-Parcel VCN-CommCenter 

8.0.8023 (Released in March 2022). When the setting “Sending message decoration (disabled by default)” is 
enabled, the message decoration tool bar is shown additionally at the top of the message box on Send dialog.  
Refer to P174 4. Option Configuration – 12. Sending message decoration with rich text format 
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2-2-2. Resend 
This command will resend the same items to same recipients within the resend period from date 

created. This command will be enabled only when you select outbox items which are confirmed 

to upload (from the status “Waiting Download” onward). Once the items have been resent, this 

command will be disabled for these outbox items with grayed-out effect. 
*This behaves similarly to the “Resend” button on the tool bar of VCN-CommCenter. 
*This behaves similarly to the “Resend” button on the outbox Parcel Detail dialog. 
*This behaves similarly to the right-click menu “Resend Selected Parcels” of outbox items. 
*Attention: Items which are canceled to send while encrypting will NOT be able to resend. 
*Attention: On the Option Config (the menu bar “Tools” > “Option”), The “Resend” function 

requires the setting “Enable Resend” to be enabled (set checked: Yes) with initial choice. 
(Default: Enable Resend: Yes / Resend Period: For 14 days) 
Refer to P165 4. Option Configuration - 4. Resend Setting 

 

2-2-3. Reply 
This command will create an item to respond to a sender. This command will be enabled only 

when you select an inbox item (from the status “Delivery Confirmed” onward). Upon selecting the 

“Reply” menu, the “Send Dialog” box will open with the original message. 

*This behaves similarly to the “Reply” button on the tool bar of VCN-CommCenter. 

 

2-2-4. Reply All 
This command will create an item to respond to senders including TO, CC recipients. This 

command will be enabled only when you select an inbox item (from the status “Delivery 

Confirmed” onward). Upon selecting the “Reply All” menu, the “Send Dialog” box will open with 

the original message.  

*This behaves similarly to the “Reply All” button on the tool bar of VCN-CommCenter. 

 

2-2-5. Forward 
This command will create an item to forward an inbox item to other recipients. This command will 

be enabled only when you select an inbox item (from the status “Delivery Confirmed” onward). 

Upon selecting the “Forward” menu, the “Send Dialog” box will open with the original message. 

Enter e-Parcel ID of recipients to forward. 

*This behaves similarly to the “Forward” button on the tool bar of VCN-CommCenter. 

 

Caution: When you want to forward the attachments from inbox, please be 

advised you to forward the attachments before operation “Move File”.  

Once you have moved the attached files and folders (“Item Moved”), upon 

clicking the “Forward” menu/button, the “Send Dialog” for forwarding will open 

without attachments. You can no longer forward these attachments from inbox.  

(When forwarding inbox items, if attachments already have been moved, attach 

files and folders saved in a destination folder specified.) 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

84 
Copyright© e-Parcel Corporation All rights reserved. 

 

2-2-6. Delete 
This command will delete items from inbox and outbox. This command will be enabled only when 

you select outbox items which are uploaded (from the status “Upload Complete” onward) or 

inbox items which are confirmed to download (from the status “Delivery Confirmed” onward). 

The outbox items deleted are not listed up in outbox any longer. 

The inbox items deleted are not listed up in inbox any longer. If the attached files and folders 

have not been moved from inbox yet, these are also deleted. 
*In the case that recipients delete inbox items which have not been opened or moved yet (the 

status “Delivery Confirmed”), the delivery status will be updated to “Item Deleted” only in the 
sender’s outbox. 

 
Note that once items have been deleted, these items never been restored. 

*This behaves similarly to the “Delete” button on the tool bar of VCN-CommCenter. 
*For your information: Despite deleting items from inbox/outbox on application, Web pages for 

each user are available to just view the inbox/outbox histories recorded in the e-Parcel server 
for the selected period (until month before last or target date). Launch a computer in which you 
imported the e-Parcel client digital certificate in advance, and then access URL of “The e-Parcel 
Secure Enterprise - Web Browser” at https://secure.e-parcel.ne.jp/. 
Refer to P458 Appendix 1. e-Parcel Secure Enterprise - Web Browser  

 

 

Warning: If the attached files/folders have not been moved from 

inbox yet (the status is “Delivery Confirmed” or “Item Opened”.), upon clicking 

the “Delete” menu/button, the attached files/folders promptly are also 

deleted at the same time. Therefore, please be advised you to move (save) 

the attached files/folders from inbox before operation “Delete”. 
*Refer to P366 9. Receiving - 3. Inbox Parcel Detail - 3-2. Move Attached Files(Save) 

 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

85 
Copyright© e-Parcel Corporation All rights reserved. 

 

2-3. Tools 
This menu selection features commands to direct the VCN-CommCenter to perform setup and 

configuration options, including your address book. 

 
*【Register ID Sharing】The “Register ID Sharing” menu has been provided since e-Parcel VCN-CommCenter 

8.0.8021(Released in October 1, 2019). This new function is interlocked with the automation client software; 
e-Parcel VCN-AX 6.0 / 5.0.5011(Released in June 1, 2020) or later. It could enable the multiple client software 
VCN-CommCenter 8.0 to share one e-Parcel ID which has been set up to the VCN-AX. The separate volume of “ID 
Sharing function Operation Guide” will describe that in greater detail. For any inquiry or request about new 
function “ID Sharing”, consult your company's system administrator or contact our sales representatives (Email: 
sales@e-parcel.co.jp). 

 

 

 

 

 

Click to open 
the pull-down 

menu! 
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2-3-1. Address Book 
This command will open the “Address Book” dialog. 
*This behaves similarly to the “Address Book” button on the tool bar of VCN-CommCenter. 
*Refer to P200 7. Address Book 

 

 

 

 

 

 

Note: [Attention users of e-Parcel VCN-CommCenter 7.0.7019 or earlier] 
The “Grouping” function has been provided on the Address Book since e-Parcel 
VCN-CommCenter 7.0.7020 (Released in August 2018). If users of ver.7.0.7019 
or earlier wish the “Grouping” function, update the program. It is available to 
obtain the latest VCN-CommCenter from the e-Parcel download site below.  
URL：https://www.e-parcel.ne.jp/ 
*Refer to P433 12. Updating Software 
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2-3-2. Certificate 
This command will allow you to verify the certificate information which has been installed on the 

e-Parcel application. The “Certificate” dialog appears. This dialog just shows your certificate 

information, not to configure.  
*This behaves similarly to the “Certificate” button on the tool bar of VCN-CommCenter. 
 

When verified, click the “OK” button to close. 

 

  

 

Your e-Parcel ID 
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2-3-3. Auto Setup 
This command will automatically configure to the e-Parcel VCN-CommCenter. The auto setup 

function requires in advance to install (import) a client digital certificate in Windows when you 

sign in Windows with a user account which runs the e-Parcel software. 
*Usually, you have completed to install your e-Parcel client digital certificate in Windows at the 

beginning of the software installation. 
 

*For your reference: [How to confirm your client digital certificate imported to Windows] 
Access Windows “Start” menu > Windows System > Control Panel > Network and Internet > 
"Internet Options".  
In the “Internet Properties” dialog, on the “Content” tab, under the “Certificates” category, click 
the "Certificates" button.  
In the "Certificates" dialog, on the "Personal" tab, confirm your client digital certificate. Your 
e-Parcel ID is shown in the "Issued To" column. (“e-Parcel Global Service Authority” is shown in 
the "Issued By" column.) 
 
[How to open the “Certificates” dialog using Microsoft Edge]  
Launch Microsoft Edge. On toolbar at the upper-right, click […] (Settings and more) > Settings 
(gear icon) > Privacy, search, services > Security > Manage certificates > the “Certificates” 
dialog. 

 

The e-Parcel application provides auto setup function to attempt to automatically detect and the 

e-Parcel client digital certificate installed and your computer’s proxy settings. To auto setup, 

follow the procedure ①～④ below. 

 

 

Warning: Please be advised that you should not configure the e-Parcel 

client digital certificate by “Auto Setup” while the e-Parcel 

VCN-CommCenter is processing to upload and download data. Wait for 

the delivery status to be “Waiting Download” in outbox or “Delivery Confirmed” 

in inbox. 

 

 

 

How to Auto Setup 

①[Preparation] In advance, sign in Windows with a user account which runs the e-Parcel client 

software. The e-Parcel client digital certificate of your e-Parcel ID must be installed in Windows. 

*Refer to P399～414 11. Edit / Exchange / Add Digital Certificate – 2～3. 

 

If your e-Parcel ID and PC have not been changed since the beginning, you have already installed 

the e-Parcel client digital certificate of your e-Parcel ID when installing the e-Parcel application. 

Proceed to next ② without take this step ①. 
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②Access the menu “Tools” > “Auto Setup” on the VCN-CommCenter GUI. Usually, the auto-setup 

function starts automatically. 

 

 

 
(In the case of one e-Parcel client digital certificate installed in Windows, the dialog below will not 
appear.) 

 
*If the "Confirm Certificate" or the "Select a Certificate" dialog appears, select an e-Parcel client 

digital certificate of your e-Parcel ID and then click the “OK” button to begin auto-setup. 
[For Windows 10 or later] Click “More choices” on the “Select a Certificate” dialog to view all 
certificates. Then, select one. 

 

 

 

 

 

Click the menu 
Tools > Auto Setup! 

If the “Select a 
Certificate” 

dialog appears,  
click here 

to view all! When selected, 
OK! 
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Attention1:  

If the proxy server configured to your computer’s proxy settings (Windows) requires user 

authentication, the "Proxy Authentication Required" dialog may appear upon auto-setup.  

Take either one below depending on the proxy authentication methods. 
Refer to P143 3. User Configuration – 4. Proxy Settings – 4-3. Proxy Authentication 
 
*However, when your proxy credentials (user name and password) are applied automatically and 
correctly or when your proxy credentials (user name and password) have been saved in software 
(P145), the “Proxy Authentication Required” dialog won’t appear. 
 

[In the case of NTLM Authentication or Integrated Windows Authentication] 

Leave blank in the proxy credentials (User name, Password, Checkbox “Remember this…”). Then, 

click "OK" button.  
*Because when it is not given any proxy credentials, Windows Single Sign On function will work to 
automatically apply Windows user account name and password for proxy authentication.  

 

[In the cases of the other authentication methods than the above] 

Input the proxy credentials (User name, Password). 

Once you place a check in the checkbox “Remember this authentication info.”, the “Proxy 

Authentication Required” dialog no longer appear whenever login upon start software, auto-setup, 

import certificate or etc. Then, click “OK” button to authenticate.  

 
*If you are not sure of your computer’s proxy settings and the proxy credentials (user name and 
password), to obtain the correct information, please contact your system/firewall administrator or 
service provider. 

 
*More details of the proxy server settings can be found in the section below.  
Refer to P137 3. User Configuration – 4. Proxy Settings 

 

 

 

 

*If using the proxy 
server with NTLM or 
Integrated Windows 

Authentication,  
leave all fields blank. 

↓ 
OK! 
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Attention2:  

Only if the “Password Protect” function is enabled, the e-Parcel “Server Login Required” dialog must 

appear. Enter your login password and click the “OK” button to authenticate. 

 

If your login password have been saved （P148）, the e-Parcel “Server Login Required” dialog will 

not appear. 

 

Once you place a check in the “Remember this authentication info.” checkbox, the “Server Login 

Required” dialog no longer appear whenever login to the e-Parcel server upon auto-setup etc. 
*Refer to P147 3. User Configuration - 5. Login Password Authentication 
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③While auto-setup, it shows “Setup is Proceeding…”. The VCN-CommCenter attempts to 

automatically detect the e-Parcel client digital certificate and your proxy server information such 

as the LAN settings from Windows. 

 

 

 
*If the Confirmation "Previous installation found…" dialog below is shown, there may exist another 

client in which a same e-Parcel ID (a same digital certificate) has been set up. Proceeding setup 
may cause it dysfunctional such as download aborted. For example, the unreceived items during 
the previous installation may be no longer delivered. Click the “OK” button to allow proceeding. 

 

 

 

 

④When auto-setup complete successfully, it should come online. Check that the system status 

“Online” is shown on the bottom-right of the VCN-CommCenter GUI. 
*In the case of “Offline”, verify your network environment and proxy settings are correctly 

configured to Windows Internet Connections (Internet Options). 
Refer to P137 3. User Configuration – 4. Proxy Settings 

 

 

 
 

Check 
“Online”! 
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2-3-4. Import Certificate 
This command will display prompting to import a certificate to the e-Parcel VCN-CommCenter 

(manual setup). For the preparation, a file of your e-Parcel client digital certificate is required to 

download (save) in a computer from the e-Parcel site in advance.  

 

For example, in the case that the local security policy or domain security policy of your company 

has not allowed the certificate installation in Windows or web browser applications, you may fail 

in the certificate installation with the error message dialog shown. (For your information: One of 

the error messages: "An error occurred during the addition of a certificate to the Trusted Root 

Certification Authorities store.") 

 

In the case of the above example error message, it seems that you are not allowed to import 

Root CA certificate by the local security policy or domain security policy of your company. 

However, you may have some difficulty to change the security policy of you. To promptly get 

started the e-Parcel software, we show you another procedure (manual setup) which the e-Parcel 

client software directly imports your certificate instead of auto setup. Please be sure to read the 

followings and then take the procedures. 
*This “Import Certificate” function provides to set up manually a certificate to the e-Parcel 

software. It is different from “Auto Setup” function which the application automatically detects 
the e-Parcel certificate from Windows. 

 

 

Warning: Please be advised that you should not configure the e-Parcel 

client digital certificate by “Import Certificate” while the e-Parcel 

VCN-CommCenter is processing to upload and download data. Wait for 

the delivery status to be “Waiting Download” in outbox or “Delivery Confirmed” 

in inbox. 
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How to Import Certificate 

 

①[Preparation] In advance, you must download (save) a file of the e-Parcel client digital certificate 

in your computer. First, visit the e-Parcel download site URL (https://www.e-parcel.ne.jp/), click 

the menu “e-Parcel Enterprise Service Menu”, see the page appeared and then click the 

“Download Client Certificate” button. Proceed to the “STEP4. Download and install a client digital 

certificate.” page and then click the “Download” button to save a certificate file. 

*Refer to P399～408 11. Edit / Exchange / Add Digital Certificate – 2. 

 

[For Microsoft Edge] 

In Windows, the certificate file is often saved automatically to This PC > “Downloads” folder with 

the default setting. 

(Or in the download notification bar of the browser window, select "Save as") 
*If you select “Save as” in the download notification bar, leave the default file name. 
*Note: When downloading, please be aware that you must save a file of your client digital 
certificate in your computer in advance. In this case, you do not need to install it in Windows. 
(No need to “Open file”.) 

 

 

 

 

 

OR 
 

 

 

Save as! 

File saved automatically 

File name of  
your certificate 
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[Certificate file] 

Download location (Default): C:¥Users¥(Windows user account name)¥Downloads 

File name: e-Parcel_your e-Parcel ID.p12 
*If you have changed Download Location in the browser settings “Downloads”, it might be saved 

to another location where you specified. 
 

Confirm a file of your client digital certificate saved in the “Downloads” folder. It is recommended 

that you move a certificate file to another location where is easy to find such as Desktop in your 

computer. 

 

 

 

 

 

 

Move (Save) 
a certificate file 

from the 
“Downloads” 

folder to desktop 
in your PC! 
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②Access the menu “Tools” > “Import Certificate” on the VCN-CommCenter GUI.  

 

 

 

 

 
*If you have not set up (import) the e-Parcel certificate to the application ever, take the operation 

below to access from Windows “Start” menu. 
 

 

 

OR 

 

 

Click the menu 
Tools > Import Certificate! 
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OR select from Windows “Start” menu. 

 

[For Windows 10 or later]  

Select from Windows “Start” menu > e-Parcel > “Import Certificate” 

 

[For Windows 8 or earlier]  

Select from Windows “Start” menu > All Programs > e-Parcel > VCN-CommCenter x.x > 

“Import Certificate” 

 

[For Windows 10 or later] 

 

 

 

 

 
*Upon this operation, if the VCN-CommCenter GUI just opens instead the “Certificate” dialog 

shown, access the menu “Tools” > “Import Certificate” on the VCN-CommCenter GUI. 
 

OR 
Select from 
Windows 

“Start” menu! 

Select E > e-Parcel > 
 > Import Certificate! 
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③The “Certificate” dialog is opened. Locate a file of your certificate which you have saved at the 

previous step ①. Select a certificate and then click the “Open” button to start importing. 

[A file name of the e-Parcel client digital certificate is “e-Parcel_ your e-Parcel ID.p12”] 

*Attention: It is not recommended that a file name of your certificate is changed. 

 
 

 

 

④The “Password Required” dialog appears. Enter your password and click the “OK” button.  

 

Select 
a file of client 

digital 
certificate! 

This password must be entered by the same 
password as before when you input to login to the 
e-Parcel download site for saving a certificate file.  
*Usually, this password is the default password or 
your own password which you register with the 
User Info webpage of the e-Parcel Web Browser 
site when starting the e-Parcel service. 

OK! 

Open! 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

99 
Copyright© e-Parcel Corporation All rights reserved. 

 

Attention1:  

If the proxy server configured to your computer’s proxy settings (Windows) requires user 

authentication, the "Proxy Authentication Required" dialog may appear upon importing certificate.  

Take either one below depending on the proxy authentication methods. 
Refer to P143 3. User Configuration – 4. Proxy Settings – 4-3. Proxy Authentication 
 
*However, when your proxy credentials (user name and password) are applied correctly or when 
your proxy credentials (user name and password) have been saved (P145), the “Proxy 
Authentication Required” dialog won’t appear. 
 

[In the case of NTLM Authentication or Integrated Windows Authentication] 

Leave blank in the proxy credentials (User name, Password, Checkbox “Remember this…”). Then, 

click "OK" button.  
*Because when it is not given any proxy credentials, Windows Single Sign On function will work to 
automatically apply Windows user account name and password for proxy authentication.  

 

[In the cases of the other authentication methods than the above] 

Input the proxy credentials (User name, Password). 

Once you place a check in the checkbox “Remember this authentication info.”, the “Proxy 

Authentication Required” dialog no longer appear whenever login upon start software, auto-setup, 

import certificate or etc. Then, click “OK” button to authenticate.  

 
*If you are not sure of your computer’s proxy settings and the proxy credentials (user name and 
password), to obtain the correct information, please contact your system/firewall administrator or 
service provider. 

 
*More details of the proxy server settings can be found in the section below.  
Refer to P137 3. User Configuration – 4. Proxy Settings 

 

 

 

 

*If using the proxy 
server with NTLM or 
Integrated Windows 

Authentication,  
leave all fields blank. 

↓ 
OK! 
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Attention2:  

Only if the “Password Protect” function is enabled, the e-Parcel “Server Login Required” dialog must 

appear. Enter your login password and click the “OK” button to authenticate. 

 

If your login password have been saved （P148）, the e-Parcel “Server Login Required” dialog will 

not appear. 

 

Once you place a check in the “Remember this authentication info.” checkbox, the “Server Login 

Required” dialog no longer appear whenever login to the e-Parcel server upon import certificate 

etc. 
*Refer to P147 3. User Configuration - 5. Login Password Authentication 
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⑤While configuring a client digital certificate on the e-Parcel software, it shows “Setup is 

Proceeding…”. 
*Once Import Certificate complete, a certificate file will be automatically removed from your 

computer. 

 

 

 
*If the Confirmation "Previous installation found…" dialog below is shown, there may exist another 

client in which a same e-Parcel ID (a same digital certificate) has been set up. Proceeding setup 
may cause it dysfunctional such as download aborted. For example, the unreceived items during 
the previous installation may be no longer delivered. Click the “OK” button to allow proceeding. 

 

 

 

 

 

⑥When importing certificate complete successfully, it should come online. Check that the system 

status “Online” is shown on the bottom-right of the VCN-CommCenter GUI. 
*In the case of “Offline”, verify your network environment and proxy settings are correctly 

configured to Windows Internet Connections (Internet Options). 
Refer to P137 3. User Configuration – 4. Proxy Settings 

 

 

 
 

Check 
“Online”! 
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2-3-5. Register ID Sharing 
This command will open the “Register ID Sharing” dialog. It is provided for users of “ID Sharing” 

function. According to the new function “ID Sharing”, an e-parcel ID set up to the e-Parcel 

VCN-AX 5.0 can be interlocked with the multiple e-Parcel VCN-CommCenter 8.0. 
For more details, refer to the separate volume of “ID Sharing function Operation Guide” 

 
*【Register ID Sharing】The “Register ID Sharing” menu has been provided since e-Parcel VCN-CommCenter 

8.0.8021(Released in October 1, 2019). This new function is interlocked with the automation client software; 
e-Parcel VCN-AX 6.0 / 5.0.5011(Released in June 1, 2020) or later. It could enable the multiple client software 
VCN-CommCenter 8.0 to share one e-Parcel ID which has been set up to the VCN-AX. The separate volume of “ID 
Sharing function Operation Guide” will describe that in greater detail. For any inquiry or request about new 
function “ID Sharing”, consult your company's system administrator or contact our sales representatives (Email: 
sales@e-parcel.co.jp). 
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2-3-6. Option 
This command will open the “Option Config” dialog including three tabs of “General” “e-Mail 

Notification” and “Automation”.  
*The “Automation (HotFolder and Receive Automation)” function has been provided since e-Parcel 

VCN-CommCenter 8.0.8022 (Released in September 2020). The “Automation” tab has been shown additionally on 
the Option Config dialog. For more details, refer to P180 6. Automation (Option Config). 

 

On the “General” tab, these option configurations for the VCN-CommCenter have been pre-set 

by default in the beginning. If necessary, you have the ability to modify the option configurations. 

*Refer to P157 4. Option Configuration 
 
 

[Option Config> “General” tab (by default)] 

 

 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

104 
Copyright© e-Parcel Corporation All rights reserved. 

 

On the “e-Mail Notification” tab, this option configuration is required your SMTP server 

configurations only when you wish to activate the “e-Mail Notification” function. (As necessary) 

 

The “e-Mail Notification” function of VCN-CommCenter enables individuals to notify by e-mail at 

the time of new items sent/received. The e-mail notifications contain same subjects, messages 

and just files/folders name of new items sent/received. 

*Refer to P176 5. E-mail Notification (Option Config) 

 

[Option Config> “e-Mail Notification” tab (by default)] 
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On the “Automation” tab, this option configuration is required only when you wish to activate 

the HotFolder function and Receive Automation function. (As necessary) 
*The “Automation (HotFolder and Receive Automation)” function has been provided since e-Parcel 

VCN-CommCenter 8.0.8022 (Released in September 2020). The “Automation” tab has been shown additionally on 
the Option Config dialog.  

 

The “Automation” function of VCN-CommCenter 8.0 enables to automate the sending/receiving of 

data. HotFolder function enables to automatically send the files and folders from a folder assigned 

with HotFolder configuration. Receive Automation function enables to automatically move the 

received files and folders to a folder assigned with Receive Automation configuration. 

*Refer to P185 6. Automation (Option Config) 

 

[Option Config> “Automation” tab (by default)] 
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2-4. Help 
This set of Help command(s) will provide you with manuals, application log and general information 

about the e-Parcel VCN-CommCenter. 

 

 

 

 

 

Click to open 
the pull-down 

menu! 
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2-4-1. Online Manual 
This command will provide to display the user manuals providing webpage of the e-Parcel 

software download site (https://www.e-parcel.ne.jp/) on your browser application. The online 

manuals (.pdf) are available to view and download from the above website. The user manuals 

will comprehensively introduce and explain about configurations, functions and operations 

including the software installation procedures for the e-Parcel VCN-CommCenter. 
*This behaves similarly to the right-click menu “Online Manual” of the  e-Parcel icon in 

Windows taskbar notification area. 
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2-4-2. Show Log 
This command will show the Application Log dialog. The e-parcel VCN-CommCenter often output 

the application message log to the file (vcncc.log) with the default Log Level setting of Option 

Config. The “Application Log” dialog shows the log file which may provide insight as to why 

certain issues are occurring. Also, you can export the log as a file if need arises. 
*This behaves similarly to the right-click menu “Show Log” of the  e-Parcel icon in Windows 

taskbar notification area. 
[Log Level (default)]: Detailed Log *A log file is archived once a week. 
*Refer to P160 4. Option Configuration – 1. Log Level 

 

How to Show Current Log 

To show a current log fie (vcncc.log), access the menu “Help” > “Show Log” on the 

VCN-CommCenter GUI. The “Application Log” dialog opens to show the current log. 

The “Current Log” button promptly reloads a current log file. In addition, if the archive log has 

been shown at this point, the current log will be restored on the “Application Log” dialog. 
*Current log file (vcncc.log) is output to: C:¥e-Parcel¥VCN-CommCenter 

 

[For example: Current Log] Application Log dialog (in detailed log) 

  

Reload  
a current log file. 

Current Log 
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How to Show Archive Log 

This function is activated when once an archive log is made. 

A current log file will be archived periodically by the Log Level setting of Option Config. To show 

the past log files in the archive folder as one of the e-Parcel system folders is available on the 

“Application Log” dialog. 
*Past log files are archived in: C:¥e-Parcel¥VCN-CommCenter¥logs 

 

①Click the file icon next to the “Archives” field on the “Application Log” dialog. 
*This button is activated by the archive folder of the past log files. 

 
 

 

②The “Archives” dialog opens. Select a past log file from the archive folder “logs”. A log file 

name will be shown in the “File name” field. 

 

③When selected, click the “Open” button to show an archive log. 

 

 
 

 

①Click! 

②Select a file 

③Open! 
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④An archive log specified will be shown on the “Application Log” dialog. At this point, a log file 

name will appear in the “Archives” field. 

 

To restore the current log while the archive log shown on the “Application Log” dialog, just 

click the “Current Log” button. 

 

 

[For example: Archives] Application Log dialog (in detailed log) 

 

 
 

 

④The specified 
archive log is 

shown. 

A file name 
of archive log 
 

Restore  
current log. 
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How to Export Log 

When a current or archive log is shown on the “Application Log” dialog, this log is available to 

export as a file. 

 

①On the “Application Log” dialog, show either current or archive log which you want to export 

and then click the “Export Log” button. 

*Refer to P108 How to Show Current Log / P109 How to Show Archive Log 

 

 

 

 

②The “Export Log” dialog appears. Select the desktop or another destination folder to save a 

file. The “File name” field shows the original log file name by default. You may change to a file 

name in the “File name” field as needed. 

 

③To begin exporting a file, click the “Save” button. 

 
 

①-1. Show log which 
you want to export. 

②-1. Select a destination folder 
to export. 

③Save! 

②-2. Confirm a file name. 
*Change a file name 

as needed. 

①-2. Export log! 
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④When exporting complete, locate a log file in the destination folder specified. If you want to 

export the multiple log files, repeat the step ①～③. 

 

 
 

 

 

④A log file exported 
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2-4-3. About VCN-CommCenter 
This command will open the “VCN-CommCenter x.x” dialog which displays the application name, 

version information, our web site URL and e-mail address of e-Parcel Customer Support (Business 

Hours: 9:00-17:00JST/Mon-Fri).  

*This behaves similarly to the right-click menu “About VCN-CommCenter” of the  e-Parcel 

icon in Windows taskbar notification area. 
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3. Tool Bar 

 

On the tool bar of VCN-CommCenter GUI, the buttons are provided to execute quick commands 

including [Create New]・[Resend]・[Reply]・[Reply All]・[Forward]・[Delete]・[Address 

Book]・[Certificate]・[Reload]. Nine (9) options parallel the menu commands detailed in the 

menu bar section of this manual.  

 

[VCN-CommCenter GUI]  

 

 

 

When inbox or outbox items are selected, the operation of tool buttons will be activated depending 

on the delivery status. 

 

[For example: Inbox] Tool Bar in the case of the “Delivery Confirmed” inbox item selected 

 

 

[For example: Outbox] Tool Bar in the case of the “Waiting Download” outbox item selected 

 

 

[Tool Bar] 
Click button 

on the tool bar! 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

115 
Copyright© e-Parcel Corporation All rights reserved. 

 

3-1. Create New 
The “Create New” button will open the “Send Dialog” to create a new item. 

*This behaves similarly to the menu bar Message > “Create New”. 

*Refer to P291 8. Sending 

 

 

 

3-2. Resend 
The “Resend” button will resend the same items to same recipients within the resend period from 

date created. This button will be enabled only when you select outbox items which are confirmed to 

upload (from the status “Waiting Download” onward). Once the items have been resent, the 

“Resend” button will be disabled for these outbox items with grayed-out effect. 
*This behaves similarly to the menu bar Message > “Resend”. 
*This behaves similarly to the “Resend” button on the outbox Parcel Detail dialog. 
*This behaves similarly to the right-click menu “Resend Selected Parcels” of outbox items. 
*Attention: Items which are canceled to send while encrypting will NOT be able to resend. 
*Attention: On the Option Config (the menu bar “Tools” > “Option”), The “Resend” function 

requires the setting “Enable Resend” to be enabled (set checked: Yes) with initial choice. 
(Default: Enable Resend: Yes / Resend Period: For 14 days) 
Refer to P165 4. Option Configuration - 4. Resend Setting 
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3-3. Reply 
The “Reply” button will create an item to respond to a sender. This button will be enabled only 

when you select an inbox item (from the status “Delivery Confirmed” onward). Simply click the 

“Reply” button. The “Send Dialog” box will open with the original message. 

*This behaves similarly to the menu bar Message > “Reply”. 

 

 

 

3-4. Reply All 
The “Reply All” button will create an item to respond to senders including TO, CC recipients. This 

button will be enabled only when you select an inbox item (from the status “Delivery Confirmed” 

onward). Simply click the “Reply All” button. The “Send Dialog” box will open with the original 

message.  

*This behaves similarly to the menu bar Message > “Reply All”. 

 

 

 

3-5. Forward 
The “Forward” button will create an item to forward an inbox item to other recipients. This button 

will be enabled only when you select an inbox item (from the status “Delivery Confirmed” onward). 

Simply click the “Reply All” button. The “Send Dialog” box will open with the original message. 

Enter e-Parcel ID of recipients to forward. 

*This behaves similarly to the menu bar Message > “Forward”. 

 

 

Caution: When you want to forward the attachments from inbox, please be 

advised you to forward the attachments before operation “Move File”.  

Once you have moved the attached files and folders (“Item Moved”), upon 

clicking the “Forward” menu/button, the “Send Dialog” for forwarding will open 

without attachments. You can no longer forward these attachments from inbox.  

(When forwarding inbox items, if attachments already have been moved, attach 

files and folders saved in a destination directory specified.) 
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3-6. Delete 
The “Delete” button will delete items from inbox and outbox. This button will be enabled only when 

you select outbox items which are uploaded (from the status “Upload Complete” onward) or inbox 

items which are confirmed to download (from the status “Delivery Confirmed” onward). 

The outbox items deleted are not listed up in outbox any longer. 

The inbox items deleted are not listed up in inbox any longer. If the attached files and folders have 

not been moved from inbox yet, those are also deleted. 
*In the case that recipients delete inbox items which have not been opened or moved yet (the 

status “Delivery Confirmed”), the delivery status will be updated to “Item Deleted” only in the 
sender’s outbox. 

 
Note that once items have been deleted, these items never been restored. 

*This behaves similarly to the menu bar Message > “Delete”. 
*For your information: Despite deleting items from inbox/outbox on application, Web pages for 

each user are available to just view the inbox/outbox histories recorded in the e-Parcel server for 
the selected period (until month before last or target date). Launch a computer in which you 
imported the e-Parcel client digital certificate in advance, and then access URL of “The e-Parcel 
Secure Enterprise - Web Browser” at https://secure.e-parcel.ne.jp/. 
Refer to P458 Appendix 1. e-Parcel Secure Enterprise - Web Browser  

 

 

Warning: If the attached files/folders have not been moved from 

inbox yet (the status is “Delivery Confirmed” or “Item Opened”.), upon clicking 

the “Delete” menu/button, the attached files/folders promptly are also 

deleted at the same time. Therefore, please be advised you to move (save) 

the attached files/folders from inbox before operation “Delete”. 
*Refer to P366 9. Receiving - 3. Inbox Parcel Detail - 3-2. Move Attached Files(Save) 
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3-7. Address Book 
The “Address Book” button will open the “Address Book” dialog. 

*This behaves similarly to the menu bar Tools > “Address Book”. 

*Refer to P200 7. Address Book 

 

 

 

Note: [Attention users of e-Parcel VCN-CommCenter 7.0.7019 or earlier] 
The “Grouping” function has been provided on the Address Book since e-Parcel 
VCN-CommCenter 7.0.7020 (Released in August 2018). If users of ver.7.0.7019 
or earlier wish the “Grouping” function, update the program. It is available to 
obtain the latest VCN-CommCenter from the e-Parcel download site below.  
URL：https://www.e-parcel.ne.jp/ 
*Refer to P433 12. Updating Software 
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3-8. Certificate 
The “Certificate” button will allow you to verify the certificate information which has been installed 

on the e-Parcel application. The “Certificate” dialog appears. (P87) This dialog just shows your 

certificate information, not to configure.  

*This behaves similarly to the menu bar Tools > “Certificate”. 

 

 

 

 

3-9. Reload 
The “Reload” button will promptly check for any items pending delivery and track the latest status 

by polling to the e-Parcel server. 

*This behaves similarly to the menu bar File > “Reload”. 
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4. Tree View 

 

The “Tree view” is at the upper-left pane on the VCN-CommCenter GUI. This pane shows the folder 

trees by each e-Parcel ID (client digital certificate) configured to the e-Parcel application. A folder 

tree includes user’s [Display Name], [Inbox] and [Outbox]. When you perform an operation to 

change the choice in the tree view, the display of the list view (the right pane) is changed. 

 

 

 

Tree view  
*It shows Folder Trees 

of each e-Parcel ID 

Folder Tree: Switch to display on the list view.  
*Tree view shows Folder Trees by each e-Parcel ID which you set up. 
・Display name (P122/P134): “User Configuration” pane 

*Your e-Parcel ID is assigned to the initial “Display Name”. 
*Click this to display the “User Configuration” on the list view. 

 ・Inbox/Outbox 
*Click either to list up the inbox or outbox items on the list view. 

 

To change width of pane, drag here. 
*If you click × to hide Tree view, also 

drag here to show it again. 
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[Tree View] 

 

[For example] Folder tree (Default: Open) 

 

 

 

 

[For example] Folder tree (Close) 

 

 

 

 

[For example] Folder tree (In the case of offline) 

 

 

 

 

Click 
to close a tree. 

Click 
to open a tree. 

When offline,  
this icon will be 

grayed-out. 
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4-1. Display Name 
On the just right of certificate icon of the folder tree, [Display name] is an identification name 

(e-Parcel ID) configured to the VCN-CommCenter. 

Display Name: Your e-Parcel ID is set by default. 

 

4-1-1. User Configuration pane 
When you click the [Display Name] field, the “User Configuration” pane appears in the list view of 

the VCN-CommCenter GUI. On this pane, you can edit the [Display Name] which is shown on the 

folder tree etc. 

*Refer to P134 3. User Configuration – 1. Display Name 
 
The User Configurations are included the significant settings for use of the VCN-CommCenter in 
each e-Parcel ID. If any settings are changed on the User Configuration pane, you must click the 
“Save” button to take effect. For more details will be followed in the section below. 
*Refer to P132 3. User Configuration 
 

[User Configuration] 

 

 

[Display Name] 
To show  

“User Configuration”, 
click here! 

. 
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4-1-2. Disable e-Parcel ID 
The e-Parcel ID (client digital certificate) configured to the VCN-CommCenter can be disabled. 

Once e-Parcel ID disabled, it will display the folder tree of this e-Parcel ID no longer in the 

VCN-CommCenter GUI. 

For example, when a new e-Parcel ID has been registered instead of the existing e-Parcel ID, and 

you don’t use the existing e-Parcel ID any longer, we will revoke from the e-Parcel server upon 

your request. In this case, you must disable the existing e-Parcel ID configured to the e-parcel 

application. 

 

How to disable e-Parcel ID 
To disable an e-Parcel ID configured to the VCN-CommCenter, follow the procedure ①～③ 

below. 

 

①Right-click on the [Display name] of the tree view to open the pop-up menu. Select the 

“Disable this ID” menu.  

 
 

 

 

②While being disabled, it shows “Setup is Proceeding…”. on the VCN-CommCenter GUI. 

 

 

 

Right-click to 
open the menu! 
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③When an e-Parcel ID disabled, it will disappear from the tree view on the VCN-CommCenter 

GUI. 

 

If you want to use continuously the VCN-CommCenter with another new e-Parcel ID, install a 

new client digital certificate in Windows in advance, and then auto-setup new one on the 

VCN-CommCenter. (Access menu bar, Tool > Auto Setup) For more details will be followed in 

the section below. 

*Refer to P396 11．Edit / Exchange / Add Digital Certificate 
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4-1-3. Move Up/Down e-Parcel ID position 
When multiple e-Parcel ID (client digital certificates) have been configured to the 

VCN-CommCenter, the tree view shows multiple folder trees in order ID configured. The display 

order for multiple folder trees can be changed in the tree view. 

 

For example, when another new e-Parcel ID has been registered (Add), and then a new client 

digital certificate is configured to the VCN-CommCenter with the existing e-Parcel ID, a new 

folder tree will be added in the bottom of tree view. (P432)  

In this case of using multiple e-Parcel ID on the VCN-CommCenter GUI, if you want to change the 

display order of new folder tree to the top of tree view, you can move it up. See just below. 

 

How to change the display order of e-Parcel ID  

In the case of multiple e-Parcel ID configured to the VCN-CommCenter, To change the display 

order in the tree view, follow the procedure ①～③ below. 

 

 

 

 

 

[Tree View] 
In the case of multiple 
e-Parcel ID configured 
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①Right-click on an e-Parcel ID [Display name] shown in the tree view to open the pop-up menu. 

Select the either menu “Move Up” or “Move Down”. 

 

Move Up 

 

 

OR 

 

Move Down 

 

 

Right-click to 
open the menu! 

Right-click to 
open the menu! 
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②While processing, it shows “Setup is Proceeding…” on the VCN-CommCenter. 

 

 

 

 

 

③When setup completed, the specified e-Parcel ID has been moved up/down in the tree view. 

Confirm the display position on the VCN-CommCenter GUI. 

 

 

 

 

[Tree View] 
Confirm 

the display order 
changed! 
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4-2. Display Inbox 
When click [Inbox] on the tree view, the inbox item list of entries appears in the list view (the right 

pane). On inbox, the recipients can operate to open items, move (save) the attachments, reply, 

forward and etc. 

*Refer to P358 9. Receiving - 2. Inbox 

 

 

 

 

 

 

 

4-3. Display Outbox 
When click [Outbox] on the tree view, the outbox item list of entries appears in the list view (the 

right pane). On outbox, the senders can operate to track the delivery status of items, resend, 

cancel and etc.  

*Refer to P334 8. Sending - 2. Outbox 

 

 

 

 

 

[Inbox] 
To view your 
inbox items, 
click here! 

 

[Outbox] 
To view your 
outbox items, 

click here! 
! 
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5. Favorites View 

 

The “Favorites view” is at the lower-left pane on the VCN-CommCenter GUI. This pane shows the 

favorite addresses (user name <e-Parcel ID>) of the address book. (User name must automatically 

show first name and last name of the user info registered with the e-Parcel server.) 

*Refer to P200 7. Address Book 

 

 

 

 

Favorites view  
*It shows 

Favorites of 
address book. 
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Use of the Favorites View 
 

Add as TO 

Without opening the Address Book, you can simply add the favorite addresses to the “Send Dialog”.  

*Refer to P303 8. Sending - 1-1. Enter the recipients - 1-1-3. Select from Favorites 

 

Way A-1. 

Double-click an address on the “Favorites” view to add an address in the “To” field on the “Send 

Dialog”. 

 

Way A-2. 

Right-click on addresses of the “Favorites” view to open the pop-up menu, then select any of the 

“Add as TO”, “Add as CC” or “Add as BCC” to add addresses in the “To”, “CC” or “BCC” field on the 

“Send Dialog”. 

 

 

 

 

 

 
 

 

Way A-1.  
Double-click  
an address! 

(Just add it as T0) 

Way A-2.  
Right-click on addresses! 

Select from the pop-up menu. 
(Add as TO, CC or BCC.) 
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Show on/ Hide from the Favorites View 
When you want to change the display to show addresses on / hide addresses from the “Favorites” 

view, the address book provides the menu to manage the “Favorites” list.  

 

Usually, upon a new address added to the address book, a new address is shown on both the “All 

Addresses” and “Favorites” list on the address book.  

 

To change list on the address book, right-click on addresses of the “All Addresses” list to open the 

pop-up menu, then select the menu “Favorites”. The checkbox “Favorites” which has been already 

validated (set checked: show on) is invalidated (set unchecked: hide from) according as you select 

this menu. The changes of the “Favorites” list on the address book promptly affect the “Favorites” 

view on the VCN-CommCenter GUI. 

*Refer to P209 7. Address Book - 3. Show on / Hide from Favorites list 
 

 
 

Right-click on addresses! 
↓ 

 [Favorites] 
Show on/ Hide from the Favorites 
(Default: Show on (set checked)） 
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３．User Configuration 

When the e-Parcel VCN-CommCenter has been installed and auto-setup successfully, the e-Parcel 

service is ready for use. However, the additional configuration may be required depending on your 

network environment.  

 

The following steps will guide you in user configuring the VCN-CommCenter for individual e-Parcel 

ID. 

 

 

How to open User Configuration pane 
To operate the user configuration on the VCN-CommCenter, the application must be running. Click 

the “Display Name” field (Default: your e-Parcel ID) on the tree view.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

３ 

[Display Name] 
Click 

to show  
“User Configuration”. 
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The User Configuration pane 
The User Configuration pane appears by the above way.  

These configurations are included some significant settings for use of the VCN-CommCenter. The 

following section will explain each configuration in greater detail.  

 

When settings are changed on the User Configuration pane, you must click the “Save” button to 

take effect. 

 

[User Configuration] 

 
 

 

Warning: Please be advised that you should not change the settings on 
the User Configuration while the e-Parcel VCN-CommCenter is 
processing to upload and download data. Wait for the delivery status to 
be “Waiting Download” in outbox or “Delivery Confirmed” in inbox. 
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1. Display Name 

 

The value of “Display Name” is displayed on the tree view of the VCN-CommCenter GUI. Your 

e-Parcel ID is pre-filled in this field with initial value. 

 (Default: Your e-Parcel ID)  

 
 

 

 

How to change the Display Name 
When you want to change the “Display Name”, follow the procedure ①～④ below. 

 

 

①Enter a name in the “Display Name” field. An easy-to-understand name is recommended. 

 
 

 

 

②Click the “Save” button at the bottom right to take effect. 

 
 

 

 
③The “Configuration Saved” dialog appears. Click the “OK” button. 

 

 

Display name 

Enter! 

Save! 

OK! 
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④When change saved, new display name will be displayed on the tree view.  

 
 

 
*Once a display name has been changed, the menu bar File > Open > “Display Name” (P78) of 

VCN-CommCenter GUI is also affected by this change. (Your e-Parcel ID is assigned by default.) 

 
 

New display name! 
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2. e-Parcel ID 

 

This field displays the current e-Parcel ID which is set up to the VCN-CommCenter. 

 

 

 

 

3. Certificate Authority 

 

This field displays the Certificate Authority of the e-Parcel client digital certificate and the domain 

name which is set up to the VCN-CommCenter. 

 

 

 
 

 

 

 

 

Check! 
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4. Proxy Settings 

 

The Proxy Settings are your network configurations which a proxy server is used for your LAN to set 

up Internet connection. The initial choice is “Automatic” proxy setting. The VCN-CommCenter 

automatically detects your network settings when you start the e-Parcel software, auto-setup, 

import certificate or etc. 

(Default: Automatic) 
 

 
Caution: To successfully run the VCN-CommCenter, the correct proxy server 
settings must be supplied. When you manually configure the proxy settings, it 
is strongly recommended that you contact your company's network 
administrator or service provider to obtain the correct network information. 

 

 

 
 

 

 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

138 
Copyright© e-Parcel Corporation All rights reserved. 

 

4-1. Automatic Proxy Settings 
In the case of “Not using Proxy” or “Automatic Proxy Detection”, leave the initial choice “Automatic”. 

(“Automatic” proxy setting by default) The VCN-CommCenter attempts to automatically detect your 

computer’s proxy settings (Windows) upon start software, auto-setup, import certificate or etc. 

Then, your computer’s proxy settings detected such as “Host Name”, “Port Number” and etc. will be 

configured to the “Proxy Settings” fields of User Configuration. 
*For your reference: [How to confirm your computer’s proxy settings (Windows)] 
Access Windows “Start” menu > Windows System > Control Panel > Network and Internet > 
Internet Options. In the “Internet Properties” dialog, on the “Connections” tab, under the “Local 
Area Network (LAN) Settings”, click “LAN settings” button. Confirm the “Proxy server” settings. 
 
[How to open your computer’s proxy settings using Microsoft Edge] 
Launch Microsoft Edge. On toolbar at the upper-right, click […] (Settings and more) > Settings 
(gear icon) > System and performance > System > Open your computer’s proxy settings > the 
“Proxy” dialog. 

 
If the proxy server configured to your computer’s proxy settings (Windows) requires user 

authentication, the "Proxy Authentication Required" dialog may appear upon start software, 

auto-setup, import certificate or etc.  

Take either one below depending on the proxy authentication methods. 
*Note: If your proxy credentials (user name and password) with proxy-authorization are changed, 

the “Proxy Authentication Required” dialog may appear upon start software. Under this situation, 
your new proxy credentials (user name and password) must be applied to re-authenticate. 

 
[In the case of NTLM Authentication or Integrated Windows Authentication] 

Leave blank in the proxy credentials (User name, Password, Checkbox “Remember this…”). Then, 
click "OK" button.  
*Attention: Refer to the description as follows P140 for NTLM or Integrated Windows Authentication. 

 

[In the cases of the other authentication methods than the above] 

Input the proxy credentials (User name, Password), then, click “OK” button. 
*If you are not sure of your computer’s proxy settings and the proxy credentials (user name and 
password), to obtain the correct information, please contact your system/firewall administrator or 
service provider. 

 

*If using the proxy 
server with NTLM or 
Integrated Windows 

Authentication,  
leave all fields blank. 

↓ 
OK! 
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[Proxy Settings：Automatic] 

 
 

 

 
Note: The password field will not display the password in clear text. Instead, 

you will simply see asterisks (*). 

 

 

Caution: If your computer’s proxy settings (Windows) are changed, 
Your new proxy settings must be re-configured to VCN-CommCenter. When 
the initial choice “Automatic” proxy setting, just restart software; 
VCN-CommCenter to configure.  
1. To exit (shutdown) software, on VCN-CommCenter GUI, select File > Exit.  
2. To restart software, double-click the "e-Parcel x.x" shortcut icon on the 
desktop.  

3. Your new proxy server settings detected automatically are shown in the 
“Proxy Setting” fields of User Configuration. At last, confirm that the system 
status "Online" is shown on the bottom-right of VCN-CommCenter GUI. 

 

 

Caution: If your proxy credentials (user name and password) with 
proxy-authorization are changed, the “Proxy Authentication 
Required” dialog may appear upon start software etc. Under this situation, 
your new proxy credentials (user name and password) must be 
applied to re-authenticate. If you are not sure of your proxy credentials (user 
name and password), please contact your system/firewall administrator or 
service provider to obtain the correct information. 
*However, in the case of NTLM Authentication or Integrated Windows 
Authentication, leave blank in the proxy credentials (User name, Password). 
For more details, refer to the next page. 

 

[Automatic] 
Your computer’s proxy settings 

detected automatically are 
displayed. 

Automatic 
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Attention NTLM or Integrated Windows Authentication in the proxy server 
When using the proxy server with NTLM or Integrated Windows Authentication (Windows domain 

/ Authentication with active directory), carefully read the descriptions just below and then take 

the appropriate configuration. 

 

 

Warning: In the case of using NTLM Authentication or Integrated 
Windows Authentication (Windows domain / Authentication with active 
directory) as the proxy authentication methods, leave blank in the proxy 
credentials (user name and password).  
For the e-Parcel VCN-CommCenter 7.0.7013 or later: Leave blank in the “User 
Name” and “Password” fields. Set unchecked (off) in the checkbox 
"Remember/Save this authentication info.".  
(Because when it is not given any proxy credentials, Windows Single Sign On 
function will work to automatically apply Windows user account name and 
password as the proxy credentials for proxy authentication.) 
*Attention: However, if using the previous version 7.0.7012 or earlier, you must 
input both proxy user name and password.  
Please be sure to input into the “User Name” field as below. 
For Windows domain (～Windows2000): Domain name¥Windows user account name 
For Active directory(Windows2000～): Windows user account name@Domain name 
 

 

 
*For the e-Parcel VCN-CommCenter 7.0.7013 or later: Additionally, if using the proxy server with 

NTLM or Integrated Windows Authentication, leave blank in the proxy credentials (User name, 
Password, Checkbox “Remember this…”) in the “Proxy Settings” category of User Configuration or 
on the "Proxy Authentication Required" dialog. Because when it is not given any proxy credentials, 
Windows Single Sign On function will work to automatically apply Windows user account name 
and password for proxy authentication. 

 
 

 

*If using the proxy 
server with NTLM or 
Integrated Windows 

Authentication,  
leave blank 

in User Name and 
Password fields! 
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4-2. Manual Proxy Settings 
To manually configure the proxy settings, choose the “Manual”, then input into the “Proxy 

Settings” fields such as “Host Name”, “Port Number”, “proxy types” and “Bypass proxy server…”.  
*For your information, when the initial choice “Automatic” proxy setting, VCN-CommCenter 

attempts to automatically detect your computer’s proxy settings (Windows). Then, your 
computer’s proxy settings detected such as “Host Name”, “Port Number” and etc. will be 
configured to the “Proxy Settings” fields of User Configuration. 

 

If your proxy server requires user authentication, the proxy credentials (“User Name” and 

“Password”) are needed to authenticate depending on the proxy authentication methods. Details of 

the proxy authentication can be found in the section below. 
Refer to P143 3. User Configuration – 4. Proxy Settings – 4-3. Proxy Authentication 
 

When the proxy settings are made, click the “Save” button at the bottom right of the User 

Configuration pane. Then, confirm that the system status "Online" is shown on the bottom-right of 

VCN-CommCenter GUI. 
 

[Proxy Settings：Manual] 

 
 

Host Name 
Input host name of your proxy server into the “Host Name” * field. 

Warning: When the “Manual” Proxy Settings, the “Host Name” field must be 

entered as * just IP address or server name. 

(In your computer’s proxy settings (Windows), Host Address may be set up in 

[http://IP Address] format. However, please note that you must enter it without 

“http://” in the “Host Name” field.) 

 

Port Number 
Input port number of your proxy server into the “Port Number” field. 

[Manual] 
When the “Manual” checked, 
input into the “Proxy Settings” 
fields. 

Choose 
Manual! 
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HTTPS/SOCKS 
Select either “HTTPS” or “SOCKS” as the proxy server type. 

 

 

Bypass proxy server for local addresses 
Place a check in the “Bypass proxy server for local addresses” box as necessary. 
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4-3. Proxy Authentication 
When your proxy server requires user authentication, the proxy credentials (“User Name” and 

“Password”) are needed to authenticate depending on the proxy authentication methods. If you 

are not sure of your computer’s proxy settings and the proxy credentials (user name and password), 

to obtain the correct information, please contact your system/firewall administrator. 
*The first time software is installed with the initial choice “Automatic” proxy setting,  
VCN-CommCenter attempts to automatically detect your computer’s proxy settings (Windows). If 
the proxy server configured to your computer’s proxy settings (Windows) requires user 
authentication, the "Proxy Authentication Required" dialog may appear upon start software, 
auto-setup, import certificate or etc.  

 

[Proxy Authentication] 

 
 

 

 

 

If your proxy server requires user authentication, take either one below depending on the proxy 

authentication methods. 

 

[In the case of NTLM Authentication or Integrated Windows Authentication] 

Leave blank in the proxy credentials (User name, Password, Checkbox “Save proxy…”).  
*Attention: For NTLM or Integrated Windows Authentication, refer to the next page. 
*Because when it is not given any proxy credentials, Windows Single Sign On function will work to 
automatically apply Windows user account name and password for proxy authentication.  

 

[In the cases of the other authentication methods than the above] 

Input the proxy credentials (User name, Password). 
*If you are not sure of the proxy credentials (user name and password), to obtain the correct 
information, please contact your system/firewall administrator or service provider. 

 

Set checked to 
save a user name 
and password! 

[Proxy Authentication] 
When your proxy server requires 
user authentication, the proxy 
credentials (User Name, Password) 
are needed. 
*Attention: If using the proxy server 

with NTLM or Integrated Windows 
Authentication, leave blank in 
User Name and Password fields. 
Refer to the next page. 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

144 
Copyright© e-Parcel Corporation All rights reserved. 

 

User Name 
If your proxy server requires user authentication, the “User Name” with proxy-authorization is 

needed. *Attention: For NTLM or Integrated Windows Authentication, see below. 

 

Password 
If your proxy server requires user authentication, the “Password” with proxy-authorization is 

needed. *Attention: For NTLM or Integrated Windows Authentication, see below. 

 

 
Note: The password field will not display the password in clear text. Instead, 

you will simply see asterisks (*). 

 

 

 

Attention NTLM or Integrated Windows Authentication in the proxy server 
When using the proxy server with NTLM or Integrated Windows Authentication (Windows domain 

/ Authentication with active directory), carefully read the descriptions just below and then take 

the appropriate configuration. 

 

 

Warning: In the case of using NTLM Authentication or Integrated 
Windows Authentication (Windows domain / Authentication with active 
directory) as the proxy authentication methods, leave blank in the proxy 
credentials (user name and password).  
For the e-Parcel VCN-CommCenter 7.0.7013 or later: Leave blank in the “User 
Name” and “Password” fields. Set unchecked (off) in the checkbox 
"Remember/Save this authentication info.".  
(Because when it is not given any proxy credentials, Windows Single Sign On 
function will work to automatically apply Windows user account name and 
password as the proxy credentials for proxy authentication.) 
*Attention: However, if using the previous version 7.0.7012 or earlier, you must 
input both proxy user name and password.  
Please be sure to input into the “User Name” field as below. 
For Windows domain (～Windows2000): Domain name¥Windows user account name 
For Active directory(Windows2000～): Windows user account name@Domain name 
 

 

 

Caution: To successfully run VCN-CommCenter, the correct proxy server 
settings must be supplied to set up Internet connection. When you manually 
configure the proxy settings, it is strongly recommended that you contact your 
company's network administrator or service provider to obtain the correct 
network information. 
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Save proxy user name and password 
The Proxy Settings allow you to save (remember) the proxy credentials (proxy user name and 

password) in the VCN-CommCenter. When it set checked in the checkbox “Save proxy user name 

and password”, your proxy user name and password entered in the Proxy Authentication fields or 

dialog will be saved in the VCN-CommCenter. 

 

 

[Saving (set checked: on)] 

The proxy credentials (user name and password) are saved in the VCN-CommCenter. 

It could be automatically authenticated with the proxy credentials saved whenever the proxy 

server requires to authenticate user. 

 

 

[Not Saving (set unchecked: off)] 

The proxy credentials (user name and password) are not saved in the VCN-CommCenter. 

You need to enter the proxy credentials whenever the proxy server requires to authenticate user. 

For example, when you install or start the e-Parcel software, auto-setup, import certificate and 

etc., the “Proxy Authentication Required” dialog may appear. Input the proxy credentials (user 

name and password) every time. 

 

 

 

[Proxy Authentication Required] 
Once user name and password saved, 
this dialog no longer appear upon the 
proxy authentication required when 
restarting VCN-CommCenter etc. 
*If using the proxy server with NTLM 
or Integrated Windows Authentication, 
refer to the next page. 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

146 
Copyright© e-Parcel Corporation All rights reserved. 

 
*For the e-Parcel VCN-CommCenter 7.0.7013 or later: Additionally, if using the proxy server with 

NTLM or Integrated Windows Authentication, leave blank in the proxy credentials (User name, 
Password, Checkbox “Remember this…”) in the “Proxy Settings” category of User Configuration or 
on the "Proxy Authentication Required" dialog. Because when it is not given any proxy credentials, 
Windows Single Sign On function will work to automatically apply Windows user account name 
and password for proxy authentication. 

 

 

*If using the proxy 
server with NTLM or 
Integrated Windows 

Authentication,  
leave all fields blank. 

↓ 
OK! 
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5. Login Password Authentication 

 

This setting will be validated once the “Password Protect” function is enabled (set 

“Yes”) according as the User Info is changed on “The e-Parcel Secure Enterprise - Web 

Browser”. In this case (set “Yes”), you are required to enter your password in the “Login 

Password” field on the e-Parcel VCN-CommCenter. 

 
 (Default: No need * Not apply login password authentication) 
 

The “Password Protect” function is disabled (set “No”) with the default setting.  

It doesn’t authenticate login password when the e-Parcel VCN-CommCenter login to the e-Parcel 

server. In this case (set “No”), a login password is not required in the “Login Password” field on the 

e-Parcel VCN-CommCenter. The e-Parcel client software is able to login to the e-Parcel server 

without login password. 
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5-1. Password Protect function 
The purpose of the “Password Protect” function is to authenticate the user based on password 

when the e-Parcel VCN-CommCenter login to the e-Parcel server. 

 

Whenever the e-Parcel VCN-CommCenter login to the e-Parcel server, it is required login password 

authentication. 

For example, when you install or start the e-Parcel software, auto-setup, import certificate and etc., 

the e-Parcel “Server Login Required” dialog will appear to authenticate. 

(In addition, once a login password is saved in the VCN-CommCenter, it could be automatically 

authenticated with credential whenever login to the e-Parcel server.) 

*Refer to P385 10. Password Protect function 

 

Login Password 
Once the “Password Protect” function is enabled (set “Yes”), you are required to enter the “Login 

Password” to authenticate user in the e-Parcel server. This login password should be your own 

e-Parcel password which has been registered with the e-Parcel service. 

 

 
Note: The password field will not display the password in clear text. Instead, 

you will simply see asterisks (*). 

 

Save login password 
The Login Password settings allow you to save (remember) your e-Parcel password in the 

VCN-CommCenter. When it set checked in the “Save login password” checkbox, your login 

password entered in this field or dialog will be saved in the VCN-CommCenter. 

 

[Saving (set checked: on)]  

The login password is saved in the VCN-CommCenter. 

The “Server Login Required” dialog will appear no longer whenever the e-Parcel server requires 

to authenticate login password. It could be automatically authenticated with credential whenever 

login to the e-Parcel server. 

 

[Not Saving (set unchecked: off)] 

The login password is not saved in the VCN-CommCenter. 

The “Server Login Required” dialog will appear whenever the e-Parcel server requires to 

authenticate login password. For example, when you install or start the e-Parcel software, 

auto-setup, import certificate and etc., you must enter login password. 
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Warning: When the “Password Protect” function is enabled (set 
“Yes”) according as the User Info is changed on “The e-Parcel Secure 
Enterprise - Web Browser”, you are required to enter your password in the 
“Login Password” field on the e-Parcel software. If you don’t, the 
e-parcel software will be shutdown with fail in login to the e-Parcel server. In 
this situation, enter login password in the e-Parcel “Server Login Required” 
dialog which will appear when the e-Parcel software gets started. 

 

 

Warning: When users who the “Password Protect” function has been 
already enabled (set “Yes”) will change password according to the User 
Info on the “The e-Parcel Secure Enterprise - Web Browser”, please be aware 
that you are also required to change your password to new one in the 
“Login Password” field on the e-Parcel software. If you don’t, the 
e-parcel software will be shutdown with fail in login to the e-Parcel server. In 
this situation, enter login password in the e-Parcel “Server Login Required” 
dialog which will appear when the e-Parcel software gets started. 
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5-2. How to set login password 
The descriptions of this page just briefly explain two steps how to configure login password 

authentication.  

For more details about the “Password Protect” function will be following in the later 

section below. 

*Refer to P385 10. Password Protect function 

 

 

[1. Advance Preparation: Enable “Password Protect” function (set “Yes”)] 

When you want to validate the “Password Protect” function to authenticate login password, 

access URL of “The e-Parcel Secure Enterprise - Web Browser” and then change the “Password 

Protect” setting from “No” as default value to “Yes” on the User Info to be enabled in advance. 
 

“The e-Parcel Secure Enterprise - Web Browser” URL: https://secure.e-parcel.ne.jp/ 
 
*Attention: To access URL of “The e-Parcel Secure Enterprise - Web Browser”, your e-Parcel client 

digital certificate is required to install in OS or browser application in advance when you sign in 
Windows with a user account which use the e-Parcel service. Usually, you have already installed 
a certificate in Windows when starting the e-Parcel service in a computer. 
 (Refer to P399 the section for Downloading and Installing client digital certificate.) 

*Caution: Please be sure that you are required to install your e-Parcel client digital certificate 
again if Windows user account is changed in spite of a same computer. 
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[2. e-Parcel VCN-CommCenter: Set (Save) “Login Password”] 

Next, click your e-Parcel ID (Display Name) shown on the tree view at the upper-left pane of the 

e-Parcel VCN-CommCenter GUI. The User Configuration appears in the right pane. Set (save) 

login password in the e-parcel software. 
*If the e-Parcel VCN-CommCenter has been shut down, when restarting the program, the 

e-Parcel “Server Login Required” dialog below may appear authenticating login password. 
Enter a password, set checked to remember this and then click the “OK” button. Those will be 
also set (saved) in the User Configuration.  

 

①Enter your own password in the “Login Password” field. 

②When you save login password, place a check in the checkbox “Save login password”. 

*Refer to P148: Once saved, the “Server Login Required” dialog will appear no longer. 

③When entered, click the “Save” button at the bottom right to take effect. 
*For e-Parcel VCN-CommCenter 7.0.7020 or earlier, if set unchecked in the “Save login 

password”, upon click the “Save” button, the e-Parcel “Server Login Required” dialog appears 
prompting to enter login password. Enter and then click the “OK” button. 

 

 

 

 
*If set unchecked in the “Save login password (Remember this authentication info.)”, whenever 

login to the e-Parcel server in restarting the VCN-CommCenter etc., the “Server Login 
Required” dialog below appears prompting to enter login password. Enter and then click the 
“OK” button. 

 

[Login Password Authentication] 
①Enter login password! 

②Set checked to save 
login password! 

③When entered, 
Save! 

*If you don’t save login password, 
Server Login Required. 
Enter login password! 

↓ 
OK! 
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6. Default Account 

 

 

What’s Account? 
 

When e-Parcel ID registration, your e-Parcel ID must belong to at least one account in which we 

charge for the data transmissions (uploading) through the e-Parcel service. the account also has 

been numbered automatically by the individual account ID at the e-Parcel Corporation. 

 

 

 

 

Default Account 
 

The “Default Account” field displays the current account information (account name, parcel size 

limit and account ID) which your e-Parcel ID belongs to. 

 

In addition, this default account is also shown in the “Account” field on the Send Dialog (P329). 

Every time data is uploaded, the account specified on the Send Dialog will be charged for the data 

transmission through the e-Parcel service. 

 

In the case the e-Parcel ID belongs to multiple accounts, the “Default Account” field with the 

pull-down menu shows all account information which the e-Parcel ID belongs to. The current 

default account is listed on the top of the pull-down menu. To change the default account, select 

another account, and then click the “Save” button to take effect. 
*When the default account is changed, it also affects the “Account” field on the Send Dialog. 
*In the case the e-Parcel ID belongs to multiple accounts, to change the account with every data 

transmission, on the Send Dialog (P329), select another account from the pull-down menu in the 
“Account” field every time you create new item. 
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Parcel Size Limit 
 

In the “Default Account” field, verify the maximum data volume that you can transmit a delivery if 

the account or the e-parcel ID is limited. 

(Parcel Size Limit: ○○） 
*According to the contract between us, if the e-Parcel ID or the account is limited by maximum 

data volume a delivery, a value might be shown as “Parcel Size Limit: xx” in the “Default Account” 
field. 

 

 

 

 

 

If without limit a delivery, it is shown as “Parcel Size Limit: Unlimited” below. 

 

 

[Default Account] 
Current account information 
which e-Parcel ID belongs to. 

* Parcel Size Limit a delivery 
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7. Data Storage Path 

 

The “Data Storage Path” shows one of the system folder locations where the transactions data are 

stored for the e-Parcel VCN-CommCenter. It includes the upload, download and inprogress sub 

folders. The upload folder is a location where the uploaded data in compression and decryption are 

stored to resend for the resend period. The download folder is a location where the delivered data 

are stored before moving. The inprogress folder is a location where will be used temporarily in 

processing while uploading and downloading. The default location provided below or your specified 

folder at the software installation has been shown. 

（Default：C:¥e-Parcel¥VCN-CommCenter¥data） 
 

Warning: Don't obtain any data directly from the folder specified as the 
"Data storage path". Because this system folder is managed by the e-Parcel 
system. When you wish to change the setting, move files from inbox or etc., please 
be sure that you must operate through the VCN-CommCenter GUI. 

 

 

 

 

 

 

 

Data Storage Path 
(Default location) 
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How to change the Data Storage Path 
 

Warning: When the setting “Data Storage Path” changed, the existing data stored 
in the data storage folder also will be moved to a new folder assigned automatically. 
Please be advised that you should not change the Data Storage Path while 
the e-Parcel VCN-CommCenter is processing to upload and download 
data. Wait for the delivery status to be “Waiting Download” in outbox or “Delivery 
Confirmed” in inbox.  
In addition, it is recommended that you should move (save) files of inbox items 
which the status is “Delivery Confirmed” or “Item opened” before the setting “Data 
Storage Path” changed. 

 

 

When you want to change the setting “Data Storage Path”, follow the procedure ①～④ below. 

 

①Click the folder icon at the right of the “Data Storage Path” field. 
*You can also directly enter the full path of a folder in the “Data Storage Path” field. 

 

②The “Select Folder” dialog appears to browse for folder. Select a folder to store your data and 

then click the “Select Folder” button. 
*Note: When you change a folder specified as the "Data storage path", make sure that your 

Windows user account must hold permissions to "Modify" the folder specified. 
 

③The new location specified will be shown in the “Data Storage Path” field. Click the “Save” 

button at the bottom right to take effect. 
*Attention: This change of the setting “Data Storage Path” affects the data delivery processes 

of the e-Parcel system. Please be advised that you should verify that there is enough disk 
space for data storage in a computer. For your information, more than the following 
minimum disc space must be prepared in advance. The minimum of [Required disc space] = 
[twice disk space as much as an uploading / downloading data] + [more than 10% space 
available on Windows C drive disc (default “Data Storage Path”)] 

 

 

 ③Save! 

①Click this icon! 
②Select a folder! 
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④Your stored data will be moved to a new folder specified automatically. When completed to 

move your stored data, the “Configuration Saved” dialog appears. Click the “OK” button. 
*Depending on the existing stored data volume and your PC spec, it may take time to move 

those data to a folder specified as the "Data storage path". 

 

 
④OK! 
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４．Option Configuration 

 

The VCN-CommCenter provides you the Option menu with the ability to customize some functions 

as necessary.  

 

The following steps will guide you in the option configurations for the optimal performance when 

using the VCN-CommCenter in your computer. 

 

How to open Option Config dialog 
To begin the option configurations, the application must be running. Access the VCN-CommCenter 

menu bar “Tools” > “Option”.  

 

 

 

 

 

 

 

４ 

Option Config 
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General tab on Option Config dialog 
The “Option Config” dialog opens by the above way. 

On the “General” tab, the option configurations for the functions of VCN-CommCenter have been 

pre-set with the default value from the beginning. You can customize some functions appropriately 

as necessary. 
*The “Display Period” setting has been no longer provided since e-Parcel VCN- CommCenter 8.0.8021 (Released in 

October 2019). It could display all histories recorded at all the times. 
*The “Parallel Connection” setting has been no longer provided since e-Parcel VCN- CommCenter 8.0.8021 

(Released in October 2019). It could enable the parallel connection function at all the times. 
 

[Option Config> “General” tab (Default settings)] 
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When changes are made on the Option Config dialog, the “Save” button will be enabled. Click the 

“Save” button to take effect.  

To exit the Option Config dialog, click the “Close” button. 
 
*Attention: The changes for some settings in the Option Config dialog requires restarting the 

software to take effect. When it shows the Information below prompting you for that, click the 
“OK” button and click the “Close” button to exit the Option Config dialog. Then, to take effect, on 
the VCN-CommCenter GUI, access menu bar "File" > "Exit". After you shut it down, double-click 
the "e-Parcel x.x" shortcut icon on the desktop to restart the VCN-CommCenter. 
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1. Log Level 

The choice made is the level of application and session log message which is output to a log file 

(vcncc.log). There are a few choices below for the log level. Also, a log file will be archived 

periodically depending on the log level. This setting can be modified accordingly as follows. 

*Current log file (vcncc.log) is output to: C:¥e-Parcel¥VCN-CommCenter 
*Past log files are archived in: C:¥e-Parcel¥VCN-CommCenter¥logs 

（Default: Detailed Log） 
 

In addition, to view the output log message on the VCN-CommCenter GUI, access the menu bar 

“Help” > “Show Log”. The “Application Log” dialog will open. 

*Refer to P108 2. VCN-CommCenter View – 2. Menu Bar – 2-4. Help – 2-4-2. Show Log 

 

 

 

 

 

[Normal Log]  

The normal application and session log message are output to vcncc.log as a file.  

A log file is not archived. 

 

 

[Detailed Log] （Default） 

The detailed application and session log message are output to vcncc.log as a file.  

When upload confirmed (“Waiting Download”) and download confirmed (“Delivery Conformed”), 

the log message is also output. 

A log file is archived once a week. 
*When the e-Parcel software is running, a log file is archived at 0:00am on every Monday. If you shut down the 

e-Parcel software, a log file will be archived next time it gets started running. 

 

 

[Log Level] 
Click and select  

from the pull-down menu! 
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[Debug Log]  

For debug, the more detailed application and session log message is output to vcncc.log as a file.  

When items are sending and receiving, each delivery status is output in detail. 

A log file is archived every day. 
*When the e-Parcel software is running, a log file is archived at 0:00am every day. If you shut down the e-Parcel 

software, a log file will be archived next time it gets started running. 

 

 

 

[All]  

For debug, the more detailed application and session log message is output to vcncc.log as a file.  

When items are sending and receiving, each delivery status is output in greater detail. 

Additionally, the file names of all attachments are listed in the log message. 
*Attention: Upon the log level “All”, it may take time to show log in the “Application Log” dialog depending on the 

amount of message in a log file. We recommend that you should set the log level down above when the 
application runs normally. 

A log file is archived every day. 
*When the e-Parcel software is running, a log file is archived at 0:00am every day. If you shut down the e-Parcel 

software, a log file will be archived next time it gets started running. 
*The log level “All” has been provided since e-Parcel VCN- CommCenter 7.0.7020 (Released in August 2018). 
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2. Language Setting 

The choice made is the display language on the e-Parcel VCN-CommCenter GUI. The available 

languages are listed on the pull-down menu. This setting can be set up accordingly. 

（Default: Language selected when software installation） 
*Attention: If the Language Setting is changed, you are required to start the VCN-CommCenter 

as Administrative privilege in advance. 
*Attention: When this setting is changed, you are required to restart the VCN-CommCenter to 

take effect. 
 

 
 

 

Display Language 
The VCN-CommCenter GUI is able to display in any of the seven (7) languages below.  

 

[Chinese-simplified] Display in Chinese-simplified. 
 

[Chinese-traditional] Display in Chinese-traditional. 
 

[English] Display in English. (*Default choice when software installation in English (P53)) 
 

[French] Display in French. 
 

[German] Display in German. 
 

[Japanese] Display in Japanese. 
 
[Spanish] Display in Spanish. 

 

[Language Setting] 
Click and select 

from the pull-down menu! 
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How to change Language Setting 
If you want to change the Language Setting, follow the procedure ①～⑤ below. 

① Access the VCN-CommCenter menu bar “Tools” > “Option”. The “Option Config” dialog is 

opened. On the “General” tab, in the “Language Setting”, select a display language from the 

pull-down menu. 

 

②When change is made in the “Language Setting” field, click the “Save” button. 
*Attention: Administrative privilege is required to change the Language Setting. 
・[For Windows Vista or later] The ”User Account Control (UAC)” dialog appears. In the case of 

sign in Windows with an administrator account, select the “Yes” button to allow. Or, in the 
case of sign in Windows with a standard account without the administrative privilege, 
administrator ID (account name) and password are required to input. 

 
・[For Windows 2000, XP, 2003] If the Warning dialog appears as just below, click “OK” to close. To change the 

language setting, it is required to restart VCN-CommCenter as Administrative privilege in advance. In this 
case, to shut down, access VCN-CommCenter menu bar “File” > “Exit”. Then, right-click on the “e-Parcel x.x” 
shortcut icon of the desktop to open the pop-up menu. Select “Run as administrator”. (Or, select from 
Windows “Start” menu > (All Program) > e-Parcel > (VCN-CommCenter x.x) > “e-Parcel VCN-CommCenter 
x.x”, and then right-click to open the pop-up menu. Select “More” > “Run as administrator”.) 
VCN-CommCenter gets started as Administrative privilege. Then, try again to change the language setting. 

 

 

③The Information “Please restart…” dialog will appears. Click the “OK” button and then click the 

“Close” button to exit the “Option Config”. To restart the VCN-CommCenter, firstly access the 

menu bar “File” > “Exit” to shut down.  

 

 

④Double-click the “e-Parcel x.x” shortcut icon on the desktop to restart the VCN-CommCenter 

as usual. (*In this time, Administrative privilege is NOT needed.) 

 

⑤The e-Parcel software should get started with new language setting. Confirm the display 

language changed on the VCN-CommCenter GUI. 
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3. Polling Interval 
When the VCN-CommCenter is running and online, the application normally polls to the e-Parcel 
server at regular intervals automatically for checking external events such as a parcel delivery and 
status. 
The “Polling Interval” to the e-Parcel server is available to set in minutes on the VCN-CommCenter. 

（Default: 5 minutes polling interval） 
 

 

 

 

Minimum polling interval for [5 minutes] (Default) 

～ 

Maximum polling interval for [120 minutes] 

 

The polling interval for 5 to 120 minutes is available to set in minutes.  
*Note: If your network bandwidth resource has been very restricted, it may be recommended to 

set to higher interval, such as every 10-30 minutes. 
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4. Resend Settings 

The Resend function provides you to resend same items within the specified resend period from 

date when items have been sent (item created). It enables easily to resend same items (same 

recipients, subject, message and attached files/folders) as transmitted items without operation of 

the send dialog.  

（Default: Enable Resend / For 14 days） 
 

 

 

 

 

4-1. Enable Resend 
You can choose whether enable or disable the resend function to resend items which you have 

been sent. This setting can be set up accordingly. 
 

[Enable Resend (set checked: on)] (Default) 

Place a check in the checkbox to enable to resend same items which you have sent items ever for 

the resend period. Whenever items sent, the uploaded data in compression and encryption will 

be stored in a data storage folder for the specified period. To resend items, select appropriate 

outbox items, and then click the “Resend” button on the tool bar of VCN-CommCenter GUI. In 

another way, double-click an appropriate outbox item to open the “Parcel Detail” dialog, and then 

click the “Resend” button.  
*The resend period has been specified for 14 days as default. If you want to change the resend 

period, proceed to the “Resend Period” section in the next page. 
 

[Disable Resend (set unchecked: off)]  

Clear a check from the checkbox to disable the resend function. The uploaded data will NOT be 

stored any longer when items sent. The “Resend” button will be also dysfunctional with 

grayed-out effect. 
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4-2. Resend Period 
This setting is enabled only when the setting “Enable Resend” is validated (set checked: Yes). You 

can specify the resend period in the next box. This setting is in days. 
 

Minimum for [0 day] *in the case that you don’t resend, 

(Default) for [14 days] 

Maximum for [1,000 days] 

 

The resend period is available to set a value for 0 to 1,000 days. It has been already set for 14 days 

as default.  

For example, when the “Resend Period” is set a value for “1 day”, you can resend the items by 

today when items have been sent (item created).  

 

The uploaded data in compression and decryption will be stored in a system folder (the "Data 

storage path") for the specified resend period. It is advised that you should verify that there is 

enough disk space in your computer for data storage in advance. 

*Refer to P154 3. User Configuration – 7. Data Storage Path 
*Note: Please be aware that you don't obtain any data directly within a folder specified as the "Data 

storage path". Therefore, this system folder has been managed by the e-Parcel system. When 
you wish to change the setting, move (save) files from inbox or etc., please be sure that you must 
operate through the VCN-CommCenter GUI. 
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5. Overwrite setting when moving files 

The setting “Allow overwrite when move files” 

For inbox items which the status is “Delivery Confirmed” or “Item Opened”, when you move (save) 

the attached files and folders, you must determine whether allow overwrite the existing files in a 

destination directory. This setting can be set up accordingly. 
*Refer to P193 6. Automation (Option Config) - 2. Receive Automation Configuration 
*Refer to P366 9. Receiving - 3. Inbox Parcel Detail - 3-2. Move Attached Files (Save) 
（Default: Allow overwrite） 

 

 

 

 

[Allow overwrite (set checked: on)] (Default) 

Place a check in the checkbox to allow overwrite. When you move (save) the attached files and 

folders of inbox items to a destination directory specified, the existing files of same name (same 

relative path) in a destination directory must be overwritten. 

 

 

[Disallow overwrite (set unchecked: off)]  

Clear a check from the checkbox to disallow overwrite. If at least one existing file of same name 

(same relative path) has been already stored in a destination directory where you want to move 

(save) to, the existing file cannot be overwritten. In this case occurred, the following “Error 

Detail” dialog will appear and then the attached files and folders of an item will not be moved to 

a destination directory.  
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6. Reset window size and position 

The setting “Reset window size and position when restart application” 

The last window size and position of VCN-CommCenter GUI can be memorized, including each 

dialog size and position such as the Send Dialog, Address Book, Application Log dialog and Parcel 

Detail dialog opened from inbox/outbox. Each time restarting application, these window size and 

position are not reset by default.  

You can choose whether enable or disable the reset window function when restarting application. 

This setting can be set up accordingly. 

（Default: Disable reset window） 
*Attention: When this setting is changed, you are required to restart the VCN-CommCenter to take 

effect.  
 

 

 

 

[Disable reset window (set unchecked: off)] (Default) 

NOT to reset the window size and position when restarting application, clear a check from the 

checkbox. Each time restarting application, the VCN-CommCenter GUI and those dialogs will 

open by the last window size and position prior to shutting down.  

 

 

[Enable reset window (set checked: on)]  

To reset the window size and position when restarting application, place a check in the checkbox. 

Whenever restarting application, the VCN-CommCenter GUI and those dialogs will open by 

default window size and position. 
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7. Run as Background Application 

The setting “Run as background application on startup”  

The VCN-CommCenter GUI usually opens on startup. This setting can be changed to run as 

background application (  taskbar notification area icon appears) on startup. This setting can be 

set up accordingly. 

*Refer to P68 Icon of the e-Parcel VCN-CommCenter – Taskbar notification area icon 

（Default: Not run as background application） 
*Attention: When this setting is changed, you are required to restart the VCN-CommCenter to take 

effect.  
 

 

 

 

[Not run as background application on startup (set unchecked: off)] (Default) 

Clear a check from the checkbox NOT to run as background application on startup. The 

VCN-CommCenter GUI will open whenever restarting application. The  e-Parcel icon will also 

appear in Windows taskbar notification area.  
*In addition, when starting your computer and sign in Windows with a user account, the 

application normally startup by default. At this point, in spite of this setting disabled (set 
unchecked) by default, be sure that the VCN-CommCenter GUI dose not open. The application 
is running in the background at once. Please restore window manually as needed. 
Refer to P173 4. Option Configuration – 11. Startup application on user logon 

 

 

[Run as background application on startup (set checked: on)]  

Place a check in the checkbox to run as background application on startup. The 

VCN-CommCenter GUI will NOT open when restarting application. The application must be 

running in the background, the  e-Parcel icon will appear in Windows taskbar notification area, 

representing the availability of e-Parcel service. Therefore, the VCN-CommCenter can receive 

incoming items. You can view them in inbox by manually restoring the VCN-CommCenter GUI. 

 

Restore the VCN-CommCenter GUI 

To manually restore (open) the VCN-CommCenter GUI during run as background application, just 
double-click the  e-Parcel icon in Windows taskbar notification area.  
(Or, right-click the e-Parcel icon in Windows taskbar notification area to show the pop-up menu, 
and then select “Open”.) 
In addition, double-click the shortcut “e-Parcel x.x” on the desktop to restore. 
*Refer to P75 2. VCN-CommCenter View – 1-4. How to open the window of VCN-CommCenter 
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8. File Compression 

The setting “Disable File Compression” 

When sending an item at the VCN-CommCenter, the attached files and folders are automatically 
compressed by default. You can choose whether enable or disable the file compression function. 
This setting can be set up accordingly. 

（Default: Enable File Compression） 
*Attention: When this setting is changed, you are required to restart the VCN-CommCenter to take 

effect.  
 

 

 

 

[Enable file compression (set unchecked: on)] (Default) 

Clear a check from the checkbox to enable the file compression function. 

When sending an item on the application of a sender, the attached files and folders are 

automatically compressed just before starting to upload to the e-Parcel server.  

(For your information, the compressed files and folders will be automatically decompressed just 

after downloading on the application of recipients, and then the delivery status will be “Delivery 

Confirmed” when all delivery processes have been successfully done.) 
*Note that the compressed files (zip, lzh, cab, jpeg, etc.) are NOT compressed in spite of this 

setting enabled (set unchecked). 
 

 

[Disable file compression (set checked: off)]  

Place a check in checkbox to disable the file compression function.  

When sending an item on the application of a sender, the attached files and folders are NOT 

compressed. 
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9. Show sender/recipient e-Parcel ID or name 

The setting “Show sender/recipient name instead of e-Parcel ID” 

The VCN-CommCenter GUI usually shows sender/recipient e-Parcel ID on the sender/recipient 
fields of inbox/outbox by default. This setting can be changed to show sender/recipient name. This 
setting can be set up accordingly. 
*Once this setting is changed, it also affects the display of the balloon messages (toast 

notifications) in Windows taskbar notification area. (Refer to P172) 
（Default: Show e-Parcel ID） 
*Attention: When this setting is changed, you are required to restart the VCN-CommCenter to take 

effect.  
 

 

 

 

[Show sender/recipient e-Parcel ID (set unchecked: off)] (Default) 

Clear a check from the checkbox to show sender/recipient e-Parcel ID.  

The VCN-CommCenter GUI shows e-Parcel ID on the “Recipient” field of outbox, the “Sender” 

field of inbox and the “Recipient” field of the Parcel Detail dialog. 

 

 

[Show sender/recipient name (set checked: on)]  

Place a check in the checkbox to show sender/recipient name. 

The VCN-CommCenter GUI shows user name registered with the User Information for the 

e-Parcel service on the “Recipient” field of outbox, the “Sender” field of inbox and the “Recipient” 

field of the Parcel Detail dialog. 
*Refer to P462 Appendix 1. The e-Parcel Secure Enterprise - Web Browser –  

2.Edit User info / Change Password 
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10. Balloon Message in the taskbar notification area 

The setting “Disable Balloon Message” 

While the e-Parcel VCN-CommCenter is running, upon the events arise, the balloon messages 

(toast notifications) are usually shown on the  e-Parcel icon in Windows taskbar notification 

area. This function has been enabled the balloon messages (toast notifications) by default. You can 

choose whether enable or disable to show the balloon messages (toast notifications). This setting 

can be set up accordingly. 

*Refer to P68 Icon of the e-Parcel VCN-CommCenter – Taskbar notification area icon 

（Default: Enable Balloon Message） 
 

 

 

[Enable balloon message (set unchecked: on)] (Default) 

Clear a check from the checkbox to enable the balloon messages (toast notifications). 
The balloon messages (toast notifications) have been shown in Windows taskbar notification area 
with the default setting. 
For example, when downloading processes have been successfully done (“Delivery Confirmed”) 
while the VCN-CommCenter is running, the  e-Parcel icon will flash up in Windows taskbar 
notification area with the balloon message (notification) “New Parcel Arrived” including an inbox 
item information [Sender, Subject]. (The display of sender will show in e-Parcel ID (with the 
default value) or name depending on the option configuration (P171).) 
*Attention: [For Windows 11] 

If the Windows System Settings “Do Not Disturb” toggle is turned “On”, the balloon messages (toast 
notifications) won’t be shown in Windows taskbar notification area in spite of this setting enabled (set 
unchecked) by default. Be sure to turn “Off” the “Do Not Disturb” toggle. 
*For more information, get help out of Microsoft Windows. 

 
*Attention: [For Windows 8 or earlier] 

If you choose “Hide icon and notifications” at the Windows Settings “Notification Area Icons on the taskbar”, 
the balloon messages (toast notifications) won’t be shown in Windows taskbar notification area in spite of this 
setting enabled (set unchecked) by default. Be sure to change to “Show icon and notifications”. 

 

[Disable balloon message (set checked: off)]  

Place a check in the checkbox to disable the balloon messages (toast notifications). 
The balloon messages (toast notifications) are not shown in Windows taskbar notification area. 
For example, when downloading processes have been successfully done (“Delivery Confirmed”) 
while the VCN-CommCenter is running, the balloon messages (toast notifications) are no longer 
shown in Windows taskbar notification area. 
*[For Windows 10 or later] 

If you turn “On” the “VCN-CommCenter 8.0” toggle at the Windows Settings “Taskbar” > “Notification Area” >  
“Select which icons appear on the taskbar”, when downloading processes have been done successfully 
(“Delivery Confirmed”), the e-Parcel icon will flash up in Windows taskbar notification area. 

*[For Windows 8 or earlier] 
If you choose “Show icon and notifications” at the Windows Settings “Notification Area Icons on the taskbar”, 
when downloading processes have been done successfully (“Delivery Confirmed”), the e-Parcel icon will flash 
up in Windows taskbar notification area. 
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11. Startup application on user logon 

The setting “Start application automatically on user logon” 

The VCN-CommCenter application usually starts automatically when user logon to (sign in) 

Windows by default. You can choose whether enable or disable to startup application on user logon 

(sign in). This setting can be set up accordingly. 

（The first time starting application : Automatically startup enabled） 
 

 

 

[Start application automatically on user logon (set checked: on)] （*Recommended） 

Place a check in the checkbox to start the application automatically on user logon (sign in).  

(Automatically startup enabled) 

When installing application, the first time the VCN-CommCenter gets started, this setting is usually 

enabled (set checked: on).  

*It is recommended that startup application on Windows user logon (sign in) is enabled as usual. 
Refer to P169 4. Option Configuration – 7. Background application 

 
Whenever user logon to (sign in) Windows, the VCN-CommCenter will start and then download 

the items automatically. (The  e-Parcel icon will appear in Windows taskbar notification area 

when starting application.) 
*Attention: [For users of Windows] 

Although the application gets started, Windows does not show the e-Parcel icon in the 
notification area on the taskbar (“Off” by default). To make Windows show icon in the 
notification area on the taskbar, turn “On” the “VCN-CommCenter 8.0” toggle at the Windows 
Settings “Taskbar” > “Notification Area” > “Select which icons appear on the taskbar”.  
(For Windows 8 or earlier: Change the Windows Settings “Notification Area Icons on the 
taskbar” from “Hide icon and notifications” or “Only show notifications” to “Show icon and 
notifications”.) 
Refer to P68 Icon of the e-Parcel VCN-CommCenter – Taskbar notification area icon 

 

 

[Not start application automatically on user logon (set unchecked: off)]  

Clear a check from the checkbox NOT to start the application automatically on user logon (sign 

in). 

(Automatically startup disabled)  

Next time user logon to (sign in) Windows, the VCN-CommCenter will not start automatically. The 

incoming items won’t be downloaded without running application.  
*To start the VCN-CommCenter manually after sign in Windows, double-click the “e-Parcel x.x” 

shortcut icon on the desktop. Or, select from Windows “Start” menu > (All Program) > e-Parcel 
> (VCN-CommCenter x.x) > e-Parcel VCN-CommCenter x.x. 
Refer to P70 2. VCN-CommCenter View – 1. Start/Exit/Open/Close the VCN-CommCenter 
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12. Sending message decoration with rich text format 
*The “Message decoration with rich text format” function has been provided since e-Parcel VCN-CommCenter 

8.0.8023 (Released in March 2022). The setting for sending message decoration is shown additionally on the 
General tab of Option Config dialog. 

 
*[For users of “ID Sharing” function] The “Message decoration with rich text format” function has been provided for 

VCN-CommCenter 8.0 ID Sharing Client interlocked with e-Parcel VCN-AX 6.0 / 5.0.5013 (Released in August 
2022) or later. 
Refer to P102 2. VCN-CommCenter View - 2. Menu Bar - 2-3. Tools - 2-3-5. Register ID Sharing 

 

 

The setting “Enable message decoration with rich text format” 

The VCN-CommCenter usually send message in simple text format by default. This setting can be 
changed to enable sending message decoration with rich text format when using the Send Dialog. 

（Default: Disable sending message decoration） 
 

 

 

[Disable sending message decoration (set unchecked: off)] (Default) 

Clear a check from the checkbox to disable sending message decoration function when using the 

Send Dialog. The VCN-CommCenter usually send message in simple text format by default. 
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[Enable sending message decoration with rich text format (set checked: on)]  

Place a check in the checkbox to enable sending message decoration function when using the 

Send Dialog. When you click the “Create New” button on the VCN-CommCenter GUI, the Send 

Dialog opens with the message decoration tool bar. The message decorated in rich text format 

can be sent. 
*Attention: [Sending by HotFolder function] 
Even though when this setting is enabled, in the case of sending files and folders by 
HotFolder function, the message is always in simple text format. Because the template 
(Subject and Message) pre-set for a destination e-Parcel ID in Address Book is automatically 
applied each time sending by HotFolder. the message of the template in Address Book can 
be set in only simple text format without message decoration function. 
Refer to P190 6. Automation (Option Config) – 1. HotFolder configuration 

 

 

 

 

【About the text format of receiving message in inbox items】 
*Refer to P363 9. Receiving - 3. Inbox Parcel Detail 

 
For recipients who use the e-Parcel products supporting the “Message decoration function”： 
*e-Parcel VCN-CommCenter 8.0.8023 (Released in March 2022) or later supports this function. 
*[For users of “ID Sharing” function] VCN-CommCenter 8.0 ID Sharing Client interlocked with e-Parcel VCN-AX 6.0 

/ 5.0.5013 (Released in August 2022) or later supports this function. 
The inbox “Parcel Detail” dialog will display the message in either simple or rich text format 
according to the text format of message at the sender side. This setting (disabled /enabled) at the 
recipient side doesn’t affect the text format of receiving message in inbox items. 
 

For recipients who use the e-Parcel products Non-supporting the “Message decoration function”： 
The inbox “Parcel Detail” dialog will display the message in only simple text format regardless of 
the text format of message at the sender side. 

 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

176 
Copyright© e-Parcel Corporation All rights reserved. 

５．E-mail Notification (Option Config) 

Configuring how the “e-Mail Notification” function is started using Option Config. 

The “e-Mail Notification” function enables individuals to notify by e-mail when new items are sent 

and received on the e-Parcel VCN-CommCenter. The e-mail notifications contain same subjects, 

messages and files/folders name of new sent and received items.  

To configure the “e-Mail Notification” function, first you must have a SMTP mail server. 

 

 

Caution: Note that both subjects and messages along with e-mail 

notifications are not encrypted by the “e-Mail Notification” function.  

Also, the e-mail notifications are not attached any files and folders. Instead, the 

maximum 120 number of letters of the attached files and folders name are 

additionally described in the end of messages of the e-mail notifications. 

 

 

Note: When enabled the “e-Mail Notification” function successfully, the correct 

SMTP server configurations must be supplied in advance. It is strongly 

recommended that you contact your system administrator to obtain the correct 

information. Also, you may find your SMTP mail server configurations from your 

email application settings. 

 

The following sections will guide you in configuring your SMTP mail server and send/receipt 

notification settings for the e-Mail Notification function. 

 

How to open e-Mail Notification tab on Option Config dialog 
To begin configuring the “e-Mail Notification” function, the application must be running. Access the 

menu bar “Tools” > “Option” on the VCN-CommCenter GUI.  

 

 

５ 

Option Config 
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e-Mail Notification tab on Option Config dialog 
The “Option Config” dialog opens by the above way. Click the “e-Mail Notification” tab. 

The “e-Mail Notification” function can be configured on the “e-Mail Notification” tab. 

 

When the “e-Mail Notification” configurations are made, click the “Save” button and then restart 

the VCN-CommCenter to take effect. 
*Attention: When the “e-Mail Notification” configurations are changed, to take effect, you are 

required to restart the application. 
 

[Option Config > “e-Mail Notification” tab (Default settings)] 
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How to configure e-Mail Notification 
When you want to use the e-Mail Notification function, follow the procedure ①～⑦ below. 

 

① Access the menu bar “Tools” > “Option” on the VCN-CommCenter GUI. The “Option Config” 

dialog is opened. Click the “e-Mail Notification” tab to show. 

 

②In the “SMTP Server Configuration” category, enter your SMTP mail server to the fields. 

(*Required) 
*Further details about configuring the “SMTP Server Configuration” category can be found in 

the following pages of this manual. 
Refer to P179 5. E-mail Notification (Option Config) - 1. SMTP Server Configuration 

 

③In the “Send Notification” and/or the “Receipt Notification” category, 

when you set checked in the “Send Notification” and/or the “Receipt Notification”, the each 

“Notifier Name” and “Mail To” fields will be enabled to input. 
*Further details about configuring the “Send Notification” “Receipt Notification” category can 

be found in the following pages of this manual. 
Refer to P181 5. E-mail Notification (Option Config) - 2.Send Notification・Receipt Notification 

 

④When the “e-Mail Notification” configurations are changed, the “Save” button will be activated. 

Click it to save. At this point, the Information “Please restart…” dialog will appear. Click the “OK” 

button and then click the “Close” button to exit the “Option Config” dialog. 

 

 

⑤To restart the application, first access the menu bar “File” > “Exit” on the VCN-CommCenter 

GUI to shut down. 

 

⑥Double-click the “e-Parcel x.x” shortcut icon to restart the VCN-CommCenter. 
*Refer to P70 2. VCN-CommCenter View – 1. Start/Exit/Open/Close the VCN-CommCenter 

 

⑦The “e-Mail Notification” configurations are completed when the VCN-CommCenter gets 

started. Perform the operation check of the e-Mail Notification by sending and/or receiving 

items. 
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1. SMTP Server Configuration 

To configure the “e-Mail Notification” function, first you must enter your SMTP mail server 

information to the “SMTP Server Configuration” category. (*Required) 

 

 

Caution: To successfully configure the “e-Mail Notification” function, the 

correct SMTP server information is required. It is strongly recommended that 

you contact your system administrator to obtain the correct information. Also, 

you may find your SMTP mail server configurations from the existing email 

application settings. 

 

 

[Option Config > “e-Mail Notification” tab > “SMTP Server Configuration”] 

 

 

[SMTP Server Configuration] 
Enter your SMTP server information. 
(Host Name・Port Number) 
*If your SMTP server requires user 

authentication, enter the followings. 

[SMTP Server Authentication] 
If your SMTP server requires user 
authentication, must enter user name 
and password. 

[SSL Protection] 
If your SMTP server requires protection, 
select a type from the pull-down menu. 
*When SSL Protection is changed, also Port 

Number will be changed automatically. 
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1-1. Host Name 
Enter a correct SMTP server host name or IP address into the “Host Name” field. 

 

1-2. Port Number 
Enter a correct SMTP server port number into the “Port Number” field. 

（Default: 25） 
 

1-3. User Name 
If your SMTP server requires user authentication, a correct user name with authorization is required 

to enter into the “User Name” field. 

 

1-4. Password 
If your SMTP server requires user authentication, a correct password with authorization is required 

to enter into the “Password” field. 

 

 
Note: The password field will not display the password in clear text. Instead, 

you will simply see asterisks (*). 

 

1-5. SSL Protection 
If your SMTP server requires secure connections with protection, select either STARTTLS or 

SSL/TLS from the pull-down menu. 

（Default: None） 
*When SSL Protection setting is changed, Port Number below will also be assigned automatically. 

[None] (Default) → Port Number：25 
[STARTTLS] → Port Number：587 
[SSL/TLS] → Port Number：465 
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2. Send Notification・Receipt Notification 

When you set checked in the “Send Notification” and/or the “Receipt Notification”, the “Notifier 

Name” and “Mail To” fields will be enabled to input.  

*Attention: When the “e-Mail Notification” function enabled, the “SMTP Server Configuration” 
category is required to configure your SMTP mail server information. 

 

 

Caution: Note that both subjects and messages along with e-mail 

notifications are not encrypted by the “e-Mail Notification” function.  

Also, the e-mail notifications are not attached any files and folders. Instead, the 

maximum 120 number of letters of the attached files and folders name are 

additionally described in the end of messages of the e-mail notifications. 

 

[Option Config > “e-Mail Notification” tab > “Send/Receipt Notification”] 

  

 When configurations 
are made, click the 

“Save” button. 
↓ 

And then, restarting 
application is required. 

[Send Notification] 
Set checked here to 
enable the e-mail 
notification when 

new items are sent. 

[Receipt Notification] 
Set checked here to 
enable the e-mail 
notification when 

new items are 
received. 

[Notifier Name] 
Enter a sender’s name of 

e-mail Notification. 

[Mail To] 
Enter destination e-mail 

address of e-mail Notification. 
(Multiple e-mil addresses: 

comma-delimited) 

[SMTP Server Configuration] 
Your SMTP mail server information 

(*Required) 
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2-1. Notifier Name 
To apply a notifier name to each e-Mail Notification when sending and/or receiving new items, 

enter a name into each “Notifier Name” field. It is highly recommended to configure a recognizable 

name. 

 

[Example entry] 

 

 

 

 

 

For your information, when the “e-Mail Notification” function enabled, a sender’s e-Parcel ID of 

items automatically applies to each e-Mail Notification as a notifier e-mail address.  

(Refer to [A. Default] below.) 

 

 

 

[Additional references] About Notifier e-mail address 
 

[A. Default setting: Non (A sender’s e-Parcel ID of items automatically applies.)] 

Each time sending and/or receiving new items, a sender’s e-Parcel ID of items automatically 

applies to each e-Mail Notification as a notifier e-mail address by default. 
 
○Notifier information of the e-Mail Notification 

Notifier name: a name entered in the “Notifier Name” fields 

Notifier e-mail address: a sender’s e-Parcel ID of items automatically applies each time. 

(by default) 

[Example entry] See figure above 
 
*If your SMTP server restricts domains of the notifier e-mail address, it is recommended that 
you assign the allowed sender’s e-mail address to the notifier e-mail address in the 
“Notifier Name” fields additionally. For more details about the additional setting, refer to [B] in the 
next page. 
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[B. To fix the notifier e-mail address of the e-Mail Notification] 

If you want to fix the notifier e-mail address in the e-Mail Notification whenever sending 

and/or receiving new items, enter a name followed by one <e-mail address> in the “Notifier 

Name” fields.  

(×Multiple e-mail addresses: Not available) 
 
○Notifier information of the e-Mail Notification 

Notifier name: a name entered in the “Notifier Name” fields 

Notifier e-mail address: <e-mail address> added in the “Notifier Name” fields 

[Example entry] 

 

In the case of [B], the e-mail address specified additionally in the “Notifier Name” fields will apply 

to all e-Mail Notification as the notifier e-mail address. 
*For example, if your SMTP server restricts domains of the notifier e-mail address, assign the allowed 
sender’s e-mail address to the notifier <e-mail address> in the “Notifier Name” fields additionally. You 
will send the e-Mail Notification successfully. 

 

 

Note: *Additional References: If you enter only <e-mail address> without a 
name in the “Notifier Name” fields, carefully read below about difference 
between Send Notification and Receipt Notification.  
[Example entry] <email-address456@x-xxx.co.jp> 
○Notifier information of the Send Notification 
Notifier name: (Non) 
Notifier e-mail address: <e-mail address> added in the “Notifier Name” field 

○Notifier information of the Receipt Notification 
Notifier name: a sender’s name of inbox items automatically applies each 
time. This name has been registered with the e-Parcel service (User Info). 

Notifier e-mail address: <e-mail address> added in the “Notifier Name” field 

 

Note: *Additional References: If you leave blank the “Notifier Name” fields, 
each time new items are sent and/or received, only a sender’s e-Parcel ID of 
items will be automatically applied as a notifier e-mail address in the e-Mail 
Notification. 
[Example entry] *leave blank 
○Notifier information of the e-Mail Notification 
Notifier name: (Non) 
Notifier e-mail address: a sender’s e-Parcel ID of items automatically applies each 
time. (by default) 

 

Caution: If the “Notifier Name” includes characters of symbols, you must 
enclose only “notifier name” in half size double quotation marks (“”). 
[Example entry] *In the case of the semicolon (;) included,   
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2-2. Mail To 
To apply the destination e-mail addresses to each e-Mail Notification when sending and/or 

receiving new items, enter the e-mail addresses into each “Mail To” field. 

(Multiple e-mail addresses: comma-delimited [,]) 

 

 

[Example entry 1: Mail to an e-mail address]  

 

 

 

[Example entry 2: Mail to multiple e-mail addresses] 
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６．Automation (Option Config) 

Configuring how the “Automation” function is started using Option Config dialog. 

The e-Parcel VCN-CommCenter 8.0 provides the “Automation” function such as HotFolder and 

Receive Automation functions which enable to automate the sending/receiving of data. 

 

HotFolder function enables to automatically send the files and folders from a folder assigned with 

HotFolder configuration. 

 

Receive Automation function enables to automatically move the received files and folders to a 

folder assigned with Receive Automation configuration. 

 
*The “Automation (HotFolder and Receive Automation)” function has been provided since e-Parcel 

VCN-CommCenter 8.0.8022 (Released in September 2020). The “Automation” tab has been shown additionally on 
the Option Config dialog.  

 

 

Note: When configuring the “Automation” function which has been provided by 

VCN-CommCenter 8.0, note that it can assign a folder each to HotFolder and 

Receive Automation functions.  
*We also provide the e-Parcel VCN-AX (Automation client software) which can 
assign multiple folders to HotFolder and Receive Automation functions. If need 
arises, please firstly consult your company's system administrator or contact 
us by e-mail with your e-Parcel ID specified. 

 

 

 

The following sections will guide you in configuring the Automation for HotFolder and Receive 

Automation functions. 

 

 

 

６ 
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Advance preparation：Create HotFolder and Automation Folder 

For advance preparation, create a new folder for using as HotFolder and/or a new folder for using 

as Receive Automation folder as needed in the location where is easy to find in a computer.  

 

 

Warning: When you create new folders in a computer to enable Automation 

function, please be sure that Windows user account must be authorized to 

“Modify” those folders for using as HotFolder and Receive Automation folder.  

 

 

 

[For example: Create a new folder for HotFolder function] 

 

 

 

[For example: HotFolder] 
Create a new folder for using as HotFolder 
C:\CC8.0_HotFolder\Company A 
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[For example: Creating new Receive Automation folder] 

 

 

 

 

 

 

 

 

 

 

 

[For example: Receive Automation] 
Create a new folder for using as  
Receive Automation folder 
C:\CC8.0_Automation\Move_to_1 
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How to open Automation tab on Option Config dialog 
To configure the “Automation” function such as HotFolder and Receive Automation functions, the 

application must be running.  

 

Access the menu bar “Tools” > “Option” on the VCN-CommCenter GUI.  

 

 

 

 

 

Option Config 
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Automation tab of Option Config dialog 
The “Option Config” dialog opens by the above way. Click the “Automation” tab. 

HotFolder and Receive Automation functions can be configured on the “Automation” tab. 

 

The following descriptions will guide you in configuring HotFolder and/or Receive Automation 

functions as you need. 

 

When the “Automation” configurations are made, click the “Save” button to take effect. 

 

[Option Config > “Automation” tab (Default settings)] 
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1. HotFolder configuration 

HotFolder function enables to automatically send the files and folders from a folder predetermined 

in HotFolder configuration. To configure the “HotFolder” function, enter in the “HotFolder” category.  

 

Caution: For advance preparation, create a new folder for using as HotFolder 

in the location where is easy to find in a computer. 

*When you create a new folder in a computer to enable Automation function, 
please be sure that Windows user account must be authorized to “Modify” a 
folder. 

The check box “HotFolder” which has been invalidated (set unchecked: off) is validated according 

as ☑ a check enters (set checked: on). To send the files and folders automatically from a folder as 

HotFolder, configure into “To”, “Edit Template”, “Account” and “HotFolder” fields. The details of 

HotFolder configuration can be found in the next page. 

 

[Option Config > “Automation” tab > “HotFolder”] 

 

[TO] *Required 
Enter or select a destination e-Parcel ID 
from the pulldown menu in the TO field. 
(Multiple ID are unsupported.) 
*The pulldown menu shows the All 

Addresses of Address Book. 

[Account] 
An account charged for data delivery. 
Default Account of the “User Config” is 
shown by default. 
*Only for the e-Parcel ID belonging to 

the multiple accounts, the pull-down 
menu is provided to change. 

[HotFolder (full path)] *Required 
To specify a folder as HotFolder, click the folder icon! 
Select a folder in the Select Folder dialog. 
*For advance preparation, create a new folder for 

using as HotFolder in the location where is easy to 
find in a computer. 

[Edit Template] 
When a destination e-Parcel ID in 
Address Book is entered, Edit Template 
icon is enabled. If edit, click icon! 
*Each time items are sent by 

HotFolder, the Template (Subject and 
Message) is applied automatically. 

When configurations 
are made, click the 

“Save” button. 
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1-1. TO 
A destination e-Parcel ID as a recipient *Required 

Enter or select an e-Parcel ID from the pull-down menu in the “TO” field. 

(Multiple destination e-Parcel ID are unsupported.) 
*The pull-down menu shows the All Addresses of Address Book. (Hidden addresses not included)  

 

 

1-2. Edit Template 
Each time files and folders are sent by HotFolder function, the Template (Subject and Message) 

of a destination e-Parcel ID in Address Book is applied automatically. 

When a destination e-Parcel ID in Address Book is entered in the “TO” field, Edit Template icon 

will be enabled (in color). You can edit a template of Address Book. 
*On the other hand, a destination e-parcel ID has not added to Address Book yet, Edit 

Template icon is disabled with grayed-out effect. In this case, you should add new address to 
Address Book in advance, and then edit a template. 

 

To edit a template (Subject and Message) of Address Book, click the icon at the right side of 

the “TO” field, and then edit a template in the “Edit Template” dialog. When a template is 

changed, click the “Save” button to take effect in Address Book. 
*The parameter “%FILENAME” can be used to substitute for a string of attached files/folders 

name in subject and message of a template when items are sent by HotFolder function. 
(Multiple files/folders: comma separated value) Maximum 120 characters of a subject can be 
sent by HotFolder function. Note that a subject followed by 121 or more characters will be 
omitted. (Please be aware that the parameter “%FILENAME” is unsupported when items are 
sent manually by Send Dialog.) 
 

*Attention: [For HotFolder function] 
Message of the Template in Address Book is in simple text format every time files and folders 
are sent by HotFolder function. Even though if the setting “Sending message decoration 
(disabled by default)” is enabled, message can’t be decorated on the “Edit Template” dialog. 
Refer to P174 4. Option Configuration – 12. Sending message decoration with rich text format 
Refer to P255 7. Address Book – 7. Edit Template 

 

 

1-3. Account 
An account charged for each data delivery  
(The Default Account configured to the “User Config” window is shown in this field by default.) 
*Only for the e-Parcel ID belonging to the multiple accounts, to change to another account 

charged for sending by HotFolder function, select an account from the pull-down menu. 
(This change must affect only data deliveries which are sent by HotFolder function.) 
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1-4. HotFolder 
A folder assigned as HotFolder (full path) *Required 

Click the folder icon at the right side of the “HotFolder” field. In the “Select Folder” dialog, 

specify a folder which has already created in the location where is easy to find in a computer, and 

then click the “Select Folder” button. Verify a folder name specified in the “HotFolder” field. 
*Once HotFolder configuration has been saved, a system folder (…¥e-Parcel Temporary Folder) will 

be created in a folder specified as HotFolder. Please be aware that you don't obtain any data 
directly within this folder. Therefore, this system folder has been managed by the e-Parcel 
system.  

 

 

 

Warning: In the case of the multiple e-Parcel ID configured to one 

VCN-CommCenter 8.0, please be aware that the folder assigned as a 

HotFolder could not be shared with the other e-Parcel ID as senders. 

You must create new folders for each e-parcel ID, and then specify those as 

HotFolder appropriately. 

 

 

 

 

 

When any of the fields in the “Automation” tab is changed, the “Save” button will be enabled 

(in color). When you are finished, click “Save” button to take effect. 
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2. Receive Automation configuration 

Receive Automation function enables to automatically move (save) the received files and folders to 

a destination folder predetermined in Receive Automation configuration. To configure the “Receive 

Automation” function, enter in the “Receive Automation” category.  

 

 

Caution: For advance preparation, create a new folder for using as Receive 

Automation folder in the location where is easy to find in a computer. 

*When you create a new folder in a computer to enable Automation function, 
please be sure that Windows user account must be authorized to “Modify” a 
folder. 

 

 

[Option Config > “Automation” tab > “Receive Automation”] 

  

 

[Receive Automation folder (full path)] *Required 
To specify a folder as Receive Automation folder,  
click the folder icon! 
Select a folder in the Select Folder dialog. 
*For advance preparation, create a new folder for 

using as Receive Automation folder in the location 
where is easy to find in a computer. 

When configurations 
are made, click the 

“Save” button. 
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2-1. Move to 
A destination folder assigned as Receive Automation folder (full path) *Required 

Click the folder icon at the right side of the “Move to” field. In the “Select Folder” dialog, specify 

a folder which has already created in the location where is easy to find in a computer, and then 

click the “Select Folder” button. Confirm a folder name specified in the “Move to” field. 

 

 

Note: In addition, you can configure whether allow overwrite the existing same 

named files in the destination folder assigned as Receive Automation folder 

when Receive Automation function gets started to move files and folders. 

(Default: Allow overwrite when move files)  
*Refer to P167. 4. Option Configuration - 5. Overwrite setting when moving files 
 

 

 

Note: In the case of the multiple e-Parcel ID configured to one 

VCN-CommCenter 8.0, the folder assigned as a Receive Automation folder 

could be shared with the other e-Parcel ID as recipients.  

Also, you can create new folders for each e-parcel ID to specify as Receive 

Automation folders. 

 

 

 

 

 

When any of the fields in the “Automation” tab is changed, the “Save” button will be enabled 

(in color). When you are finished, click “Save” button to take effect. 
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3. Attention: folder location for Automation function 

 

It is supported that a shared folder on a network computer is assigned as a HotFolder and/or a 

Receive Automation folder. In this case, you must give the full path of a folder in UNC (Universal 

Naming Convention), NOT in network drive assignment. 

 

[For example: Option Config > “Automation” tab > “HotFolder” and “Receive Automation”] 

¥¥NetworkServer¥Data456¥CC8.0_HotFolder¥Company A 

¥¥NetworkServer¥Data123¥CC8.0_Automation¥Move_to_1 

 

 

 

Warning: If you specify a shared folder as a HotFolder and/or Receive 

Automation folder in a network computer where only a domain user or a local 

user of a network computer has been authorized to access, the HotFolder and 

Automation functions might be dysfunctional.  

Please be sure that Windows user account must be authorized to 

“Modify” the folders assigned as HotFolder and Receive Automation 

folder. To be authorized, set permission to Windows user account. 
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4. Operation check for Automation function 

 

When the “Automation (HotFolder and Receive Automation)” configurations have been saved, click 

the “Close” button to exit the Option Config dialog. Then, verify the operation of Automation 

function to work appropriately for sending and receiving files/folders automatically. 

 

4-1. Send by HotFolder function 
HotFolder function enables to send the files and folders automatically from a folder assigned with 

HotFolder configuration. To check the configuration of the “HotFolder” function, operate in the 

following descriptions. 

 

① Copy the files and folders to a folder [For example: C:¥CC8.0_HotFolder¥Company A] 

assigned with HotFolder configuration. 

 

[For example：files/folders which you wish to send] 

Folder_A¥ 

File_A.txt 

 

 

 

 

[HotFolder] 
Copy files and folders  
to a folder specified  
as a HotFolder. 
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② When the files and folders have completely copied to a HotFolder, the e-Parcel 

VCN-CommCenter 8.0 automatically starts the sending processes for a new item. According to 

the Option Config > “Automation (HotFolder)”, it will send the attached files/folders 

[Folder_A] and [File_A.txt] to a destination e-Parcel ID [TO] with a template of Address Book 

[Subject] and [Message]. 

 

 

 

 
*Note: Once a folder has been assigned with HotFolder configuration in the Automation of Option 

Config, the system folder (…¥e-Parcel Temporary Folder) will be automatically created within a 
folder specified as HotFolder. Please be aware that you don't obtain any data directly within this 
system folder. Therefore, this system folder has been managed by the e-Parcel system. 

 

 

③The sending item by HotFolder function will be listed up in Outbox of the VCN-CommCenter GUI. 

You can view the delivery status of sending item (Tracking) in Outbox. 

*Refer to P334 8. Sending – 2. Outbox 

 

 

 

When it starts the sending 
processes, files and folders 
will disappear from a 
HotFolder specified. 

[Outbox] 
Check delivery status of  
a sending item (Tracking)! 
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4-2. Receive by Receive Automation function 
Receive Automation function enables to automatically move (save) the received files and folders to 

a folder assigned with Receive Automation configuration. To check the configuration of the 

“Receive Automation” function, operate in the following descriptions. 

 

① When the e-Parcel VCN-CommCenter 8.0 has confirmed to receive an item, the attached 

files/folders [Folder_B] and [File_B.txt] automatically move to a folder [For example: 

C:¥CC8.0_Automation¥Move_to_1] assigned with Receive Automation configuration. 

 

[For example：files/folders which are attached in a received item] 

Folder_B¥ 

File_B.txt 

 

 

 

 

 

 

[Receive Automation] 
A folder specified  
as Receive Automation folder. 
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Note: It can be configured whether allow overwrite the existing same files in a 

folder specified as Receive Automation folder when files and folders are moved 

by Receive Automation function. (Default: Allow overwrite when move files)  
*Refer to P167. 4. Option Configuration - 5. Overwrite setting when moving files 
 

 

② The received item by Receive Automation function will be listed up in Inbox of the 

VCN-CommCenter GUI. You can confirm the delivery status “Item Moved” in Inbox.  

(In the case that the overwrite setting on move is set unchecked (off), if it disallows overwrite the 

existing same files in a folder specified as Receive Automation folder when the attached files and 

folders are moved by Receive Automation function, the delivery status will be “Delivery 

Confirmed” in Inbox. You should move the attached files and folders by using the “Move File” 

button.) 

*Refer to P358 9. Receiving - 2. Inbox 

 

 

 

When it has confirmed to receive an item,  
the attached files and folders will be moved  
to a folder specified as Receive Automation folder. 

[Inbox] 
Check delivery status of 
received item “Item Moved”! 
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７．Address Book 

The e-Parcel VCN-CommCenter provides the “Address Book” including the “Grouping” function and 

the “Template” function as a tool for sending items. The following steps will guide you in the 

Address Book for your operation. 
*The “Hidden” list has not been shown on the Address Book since e-Parcel VCN-CommCenter 8.0.8021 (Released in 

October 2019). When hidden, the specified addresses are promptly disappeared from the Address Book. 

 

 

Note: [Attention users of e-Parcel VCN-CommCenter 7.0.7019 or earlier] 
The “Grouping” function has been provided on the Address Book since e-Parcel 
VCN-CommCenter 7.0.7020 (Released in August 2018). If users of ver.7.0.7019 
or earlier wish the “Grouping” function, update the program. It is available to 
obtain the latest VCN-CommCenter from the e-Parcel download site below.  
URL：https://www.e-parcel.ne.jp/ 
*Refer to P433 12. Updating Software 

 

 

 

７ 
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1. Open Address Book 

 

1-1. How to open Address Book 
To open the “Address Book” dialog, take the operation in any of four (4) ways below. 

 

 

 

Open from VCN-CommCenter GUI 
 

 

Way 1. Open from the tool button 

On the tool bar of VCN-CommCenter GUI, click the “Address Book” button. 

 

 

 

 

 

 

Way 2. Open from the menu 

On the menu bar of VCN-CommCenter GUI, select the menu “Tools” > “Address Book”. 

 

 

 

Way1 
Click the button 
“Address Book”! 

Way2 
Select the menu  

“Tools” > “Address Book”! 
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Open from Send Dialog 
To open the “Send Dialog”, click the “Create New” button on the tool bar of VCN-CommCenter. 

 

 

Way 3. Open from the button on the “Send Dialog” 

On the Send Dialog, click the “Address Book” button. 

 

 

 

 

 

Way 4. Open from the pop-up menu on the address box of “Send Dialog” 

On the Send Dialog, right-click on the address box and select the “Open Address Book” from the 

pop-up menu. 

 

 

Way3 
On Send Dialog, 

click the button 
“Address Book”! 

Way4 
On Send Dialog, 
right-click on the 

address box! 
↓ 

Select  
“Open AddressBook” 

from the pop-up 
menu! 
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1-2. The Address Book dialog 
The “Address Book” dialog opens by any of the above ways.  

When the VCN-CommCenter gets started and the “Address Book” dialog opens, the “All addresses” 

will be listed on the Address Book by default. The Address Book function provides some types of 

the address lists including “All Addresses”, “Favorites”. 
*The “Hidden” list has not been shown on the Address Book since e-Parcel VCN-CommCenter 8.0.8021 (Released in 

October 2019). When hidden, the specified addresses are promptly disappeared from the Address Book. 

Additionally, it provides the “Group” function (Grouping) which is able to categorize addresses into 

the maximum 30 “Group” lists as sub folders under the “All Addresses” list as needed. The following 

sections will introduce to operate and use each address lists on the Address Book in details.  

 

Note: [Attention users of e-Parcel VCN-CommCenter 7.0.7019 or earlier] 
The “Grouping” function has been provided on the Address Book since e-Parcel 
VCN-CommCenter 7.0.7020 (Released in August 2018). If users of ver.7.0.7019 
or earlier wish the “Grouping” function, update the program. It is available to 
obtain the latest VCN-CommCenter from the e-Parcel download site below.  
URL：https://www.e-parcel.ne.jp/ 
*Refer to P433 12. Updating Software 

 
*To sort the addresses in the registered user name order (in ascending order/in descending order), 

click the bar marked “Address List” on the Address Book. 
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2. Add New Address 

 

The first time you open the Address Book, your own address (e-Parcel ID) has been shown both 

address lists “All Addresses” and “Favorites”. 

 

To add new address (e-Parcel ID) to the “Address Book”, the VCN-CommCenter must be online. 

New address (e-Parcel ID) can be added by either of the following two (2) ways (the addition 

automatically or manually). 

 

 
Warning: When you add new address to the Address Book, the 

VCN-CommCenter is required to be online because it will be polling to the 

e-Parcel server to verify the registration of new address (e-Parcel ID). 

 

 

Caution: Unregistered e-Parcel ID and unknown ID will NOT be added to the 

Address Book. 

 

 

Note: First Name and Last Name of User Info registered with e-Parcel server 

will be automatically assigned to the addresses (e-Parcel) on the Address Book. 
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2-1. Add automatically when sending and receiving 
Once you have sent or received items through the VCN-CommCenter, new addresses (e-Parcel ID) 

will be automatically added to both address lists “All Addresses” and “Favorites” as the initial lists to 

which those belong on the Address Book. 

 

 

Note: If recipients (e-Parcel ID) which have been added to the Address Book 

edit their first name and last name registered with the e-Parcel server, the 

changes will also automatically affect your “Address Book” after sending an 

item to the applicable e-Parcel ID or receiving an item from the applicable 

e-Parcel ID. 

 

 

Add automatically when receiving 

Once you receive an item through the VCN-CommCenter, new address (e-Parcel ID) of a sender 

will be automatically added to the Address Book. 

 

 

Add automatically when sending 

Once you send an item through the VCN-CommCenter, new addresses (e-Parcel ID) of all 

recipients which are entered in any of the “TO”, “CC” and “BCC” fields on the Send Dialog will be 

automatically added to the Address Book.  
*However, if the delivery status "Unknown Recipient" in outbox is caused by the invalid e-Parcel 

ID that is not registered (misspelled) or has not completed installation yet, those addresses 
won’t be automatically added to the Address Book. 

 

 

Warning: Warning: Before sending and receiving data via the e-Parcel 
service, both sender and recipient must register an e-Parcel ID each with the 
e-Parcel service and must complete to install the e-Parcel client certificate and 
software in a computer each in order to ensure the high security levels in 
advance. Therefore, you can NOT send data to the e-Parcel ID that is 
not registered or has not completed installation yet. If addresses 
include such an e-parcel ID without satisfaction of the above conditions, the 
delivery status will be "Unknown Recipient" in outbox to fail in sending. (In 
the case of multiple destination e-Parcel ID including the correct ID, you fail in 
sending this item to all recipients when the delivery status "Unknown 
Recipient".) 
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2-2. Add manually on Address Book 
To manually add new address (e-Parcel ID) to the Address Book, take the procedures below. 

 

 
Warning: When you add new address to the Address Book, the 

VCN-CommCenter is required to be online because it will be polling to the 

e-Parcel server to verify the registration of new address (e-Parcel ID). 

 

①Click the “New Address” button on the Address Book. 
 

Or, select the “All Addresses” list at the left pane of Address Book dialog and then right-click on 

the Address List in the right pane of Address Book dialog to open the pop-up menu. Select the 

“Add New Address” menu. 

 

 
 

Way1 
Click button 

on Address Book! 

Way2 
Display “All Addresses” list. 
Right-click on the Address List pane. 
Select from the pop-up menu. 
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②The “Global Directory Search” dialog appears, requesting a New Address (e-Parcel ID) 

registered. 

 

 

 

 

 

 

 

 

 

③When a New Address (e-Parcel ID) input, confirm that a new address matches the registered 

e-Parcel ID. It must not include full-sized English character, full-sized numeral and any space. 

Once a correct new address is entered, click the “OK” button to add to the Address Book. 
(Online required) 
*Unregistered e-Parcel ID or unknown ID won’t be added to the Address Book. 

 

 

 

 

 

Enter  
a registered 
e-Parcel ID! 

OK！ 
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*Unregistered e-Parcel ID and unknown ID will NOT be added. If it is entered and you click the 

“OK” button, the “Warning” dialog below will appear. 

 

 

 
*When new address is added to the “Address Book”, the VCN-CommCenter will be polling to the 

e-Parcel server for verifying the registration of new address (e-Parcel ID). Therefore, the 
VCN-CommCenter is required being online. If offline, the “Warning” dialog below will appear. 

 

 
However, other dialog may appear depending on the causes of offline situation. 
For example, if the proxy server configured to your computer’s proxy settings (Windows) 
requires user authentication, the “Error/…Proxy Authentication Failed.” dialog may appear with  
the wrong proxy credentials (user name and password) in VCN-CommCeneter. In this case, 
check whether proxy credentials (user name and password) are correctly configured to the 
“Proxy Settings” category of User Configuration. 
Additionally, if using the proxy server with NTLM or Integrated Windows Authentication, leave 
blank in the proxy credentials (User name, Password, Checkbox “Remember this…”) in the 
“Proxy Settings” category of User Configuration. (However, in the case of the previous version 
7.0.7012 or earlier, you must input both proxy user name and password. Please be sure to input 
into the “User Name” field as follows “Windows user account name@Domain name”.) 
Refer to P137 3. User Configuration – 4. Proxy Settings 

 

 

 

④New address (e-Parcel ID) is added to both address lists “All Addresses” and “Favorites” of 

Address Book. 
*First Name and Last Name of User Info registered with e-Parcel server will be automatically 

assigned to the addresses (e-Parcel) on the Address Book. 
Refer to P462 Appendix 1. The e-Parcel Secure Enterprise - Web Browser –  

2.Edit User info / Change Password 
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3. Show on / Hide from Favorites list 

 

Upon a new address added to the Address Book, a new address (e-Parcel ID) is usually shown on 

both the “All Addresses” and “Favorites” list on the Address Book.  

 

The addresses of the “Favorites” list also show on the Favorites view on the VCN-CommCenter GUI. 

It may be used often to create new items when sending. When you want to change to show 

addresses on / hide addresses from the “Favorites” list, the Address Book provides the menu to 

manage the “Favorites” list.  

 

 

Note: The addresses of the “Favorites” list on the Address Book are shown on 

the Favorites view on the VCN-CommCenter GUI and the right-click menu 

“Select from List” of TO, CC, BCC fields on the Send Dialog.  

Once you hide addresses from the “Favorites” list on the Address Book, those 

addressees won’t be shown on both view and menu.  

*Refer to P226 6. Address Book - 5-2. Select from Favorites list 
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3-1. Hide from Favorites list 
To hide the addresses from the “Favorites” list on the Address Book, take the procedures below. 

 

①Select the “Favorites” list at the left pane of Address Book dialog to show the addresses. 
*1 It is also available to select the “All Addresses” or “Group” lists. 

 

②Select the favorite addresses (icon with ★Favorite mark) from the Address List at the right pane 

of Address Book dialog (Multiple choices allowed), and then right-click to open the pop-up menu.  

(The checkbox “Favorites” which has been already validated (set checked: show on) by default.) 

Select the menu “Favorites” to set unchecked.  

 

 
 

 

 

Note: At the Address List (the lists “All Addresses”, “Favorites” or “Group”) at 
the right pane of Address Book dialog, to select multiple addresses (e-Parcel 
ID) at once, hold down the <Shift> or <Ctrl> key while selecting the addresses 
(e-Parcel ID) by using your mouse button.  
Or, to select all addresses (e-Parcel ID) at once, right-click on the Address List 
in the right pane of Address Book dialog and then select the “Select All” from 
the pop-up menu. 

 

①Show “Favorites” list  *1 
on Address Book! 

②Right-click on an 
address with “★”and 

then select 
“Favorites” from the 

pop-up menu. 
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③The specified addresses are no longer shown on the “Favorites” list of Address Book. Confirm the 

specified addresses (icon without ★Favorite mark) on the “All Addresses” list. 
*Once you hide addresses from the “Favorites” list on the Address Book, those addressees won’t 

be shown on the Favorites view on the VCN-CommCenter GUI and the right-click menu “Select 
from List” of TO, CC, BCC fields on the Send Dialog. 
Refer to P226 7. Address Book - 5-2. Select from Favorites list 

 

[Favorites] list 

 

 

 

 

 

 

 

[All Addresses] list 

 

 

 

 

 

 

 

③An address is 
no longer listed 

on the “Favorites” list. 

An address 
without “★” is listed 

on the “All Addresses” list. 
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3-2. Show on Favorites list 
To show the addresses on the “Favorites” list of Address Book, take the procedures below. 

 

①Select the “All Addresses” list at the left pane of Address Book dialog to show the addresses. 
*1 It is also available to select the “Group” list. 

 

②Select the addresses (icon without ★Favorite mark) from the Address List at the right pane of 

Address Book dialog (Multiple choices allowed), and then right-click to open the pop-up menu.  

(At this point, the checkbox “Favorites” which has been invalidated (set unchecked: hide from).) 

Select the menu “Favorites” to set checked. 

 

 

 

 

 

Note: At the Address List (the lists “All Addresses” or “Group”) at the right pane 
of Address Book dialog, to select multiple addresses (e-Parcel ID) at once, hold 
down the <Shift> or <Ctrl> key while selecting the addresses (e-Parcel ID) by 
using your mouse button.  
Or, to select all addresses (e-Parcel ID) at once, right-click on the Address List 
in the right pane of Address Book dialog and then select the “Select All” from 
the pop-up menu. 

 

①Show “All Addresses”  *1 
list on Address Book! 

②Right-click on an 
address without 

“★”and then select 
“Favorites” from the 

pop-up menu. 
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③The specified addresses are shown on the “Favorites” list of Address Book. Confirm the specified 

addresses (icon with ★Favorite mark) on the “All Addresses” list. 
*Once you show addresses on the “Favorites” list of Address Book, those addressees will be 

shown on the Favorites view on the VCN-CommCenter GUI and the right-click menu “Select 
from List” of TO, CC, BCC fields on the Send Dialog. 
Refer to P226 7. Address Book - 5-2. Select from Favorites list 

 

[All Addresses] list 

 

 

 

 

 

 

 

 

 

[Favorites] list 

 

 

 

 

 

An address 
with “★” is listed 

on the “All Addresses” list. 

③An address is listed 
on the “Favorites” list. 
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4. Show / Hide Address 

 

Upon a new address added to the Address Book, a new address (e-Parcel ID) is usually shown on 

both the “All Addresses” and “Favorites” list on the Address Book. 

 

In the case that the recipient’s e-Parcel ID is revoked, new e-Parcel ID as recipient is registered 

instead of the existing e-Parcel ID, or etc. if any e-Parcel ID which are no longer used as recipients 

exists in the Address Book, please be advised that you should hide addresses from the all lists (the 

“All Addresses”, “Favorites” or “Group” list) to prevent miss-sending. 

 

 

Note: Once you have sent or received items through the VCN-CommCenter, 

new addresses (e-Parcel ID) will be automatically added to the Address Book. 

For your information, the e-Parcel system applies information of those 

addresses on the Address Book not only to send and receive items but also to 

display the inbox and outbox histories recorded. 

Accordingly, the VCN-CommCenter provides the “Hidden” function to hide the 

unnecessary addresses from all lists (the “All Addresses”, “Favorites” or “Group” 

list) of the Address Book, instead of completely removing information of those 

addresses from the Address Book. In addition, if miss-sending to the 

dysfunctional ID which has been revoked or edited, the delivery status will be 

“Unknown Recipient” in outbox, and then this recipient’s address will be 

“Hidden” from the Address Book automatically. 
*The “Hidden” list has not been shown on the Address Book since e-Parcel 

VCN-CommCenter 8.0.8021 (Released in October 2019). When hidden, the specified 
addresses are promptly disappeared from the Address Book. 
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4-1. Hide Address 
To hide the addresses from the all lists (the “All Addresses”, “Favorites” or “Group” list) on the 

Address Book, take the procedures below. 
*The “Hidden” list has not been shown on the Address Book since e-Parcel VCN-CommCenter 8.0.8021 (Released in 

October 2019). When hidden, the specified addresses are promptly disappeared from the Address Book. 

 

①Select one of the lists “All Addresses”, “Favorites” or “Group” at the left pane of Address Book 

dialog to show the addresses. 

 

②Select the addresses from the Address List at the right pane of Address Book dialog (Multiple 

choices allowed), and then right-click to open the pop-up menu.  

(The checkbox “Hidden” which has been invalidated (set unchecked: show on) by default.) 

Select the menu “Hidden” to set checked.  

 

 

 

 

Note: At the Address List (the lists “All Addresses”, “Favorites” or “Group”) at 
the right pane of Address Book dialog, to select multiple addresses (e-Parcel 
ID) at once, hold down the <Shift> or <Ctrl> key while selecting the addresses 
(e-Parcel ID) by using your mouse button.  
Or, to select all addresses (e-Parcel ID) at once, right-click on the Address List 
in the right pane of Address Book dialog and then select the “Select All” from 
the pop-up menu. 

 

①Show either one  
of the lists  

on Address Book! 

②Right-click on an 
address and then 

select “Hidden” from 
the pop-up menu. 
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③The specified addresses are hidden from the all lists (the “All Addresses”, “Favorites” or “Group” 

list). It is no longer shown on the Address Book afterward. 

 

[All Addresses] list 

 

 

 

 

 

 

 

 

 

 

 

③An address is  
no longer listed  

on Address Book. 
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4-2. Show Address 
To show again the hidden addresses on any of the lists (the “All Addresses”, “Favorites” or “Group” 

list) on the Address Book, add an address manually by the “New Address” button. The hidden 

addresses will promptly return to any of the previous lists (the “All Addresses”, “Favorites” or 

“Group” list) to which those belonged. 
*The “Hidden” list has not been shown on the Address Book since e-Parcel VCN-CommCenter 8.0.8021 (Released in 

October 2019). When hidden, the specified addresses are promptly disappeared from the Address Book. To 
unhide, add address by the “New Address” button. 

 
Warning: When you add new address to the Address Book, the 

VCN-CommCenter is required to be online because it will be polling to the 

e-Parcel server to verify the registration of new address (e-Parcel ID). 

 

①Click the “New Address” button on the address book. 

Or select the “All Addresses” list at the left pane of Address Book dialog and then right-click on 

the Address List in the right pane of Address Book dialog to open the pop-up menu. Select the 

“Add New Address” menu. 

*Refer to P206 7. Address Book - 2. Add New Address - 2-2. Add manually on Address Book 

 

Way1 
Click button 

on Address Book! 

Way2 
Display “All Addresses” list. 
Right-click on the Address List pane. 
Select from the pop-up menu. 
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*For e-Parcel VCN-CommCenter 7.0.7020 (Released in August 2018), the “Hidden” list is shown on the Address 

Book by default. To show again the hidden addresses, select the “Hidden” list, right-click on the hidden addresses 
to open the pop-up menu. Select the “Hidden” menu to set unchecked. The hidden addresses specified will 
promptly return to any of the previous lists (the “All Addresses”, “Favorites” or “Group” list). 
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5. Use Address Book when sending 

 

Once new addresses (e-Parcel ID) have been added to the “Address Book”, those addresses can be 

used to select addresses (e-Parcel ID) as recipients on the Send Dialog when you create new items. 

This section introduces the various useful ways how to simply apply the addresses on the Send 

Dialog by using not only the Address Book but also the Favorites.  

*Refer to P291 8. Sending 
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5-1. Select from Address Book 
 

5-1-1. Select an address from Address Book 
*By this way below to select from Address Book, you can simply set e-Parcel ID as recipients 

without operation to open the Send Dialog. Just double-click an e-Parcel ID on the Address Book 
to open the Send Dialog with address as TO. 

 

①Select one of the lists “All Addresses”, “Favorites” or “Group” at the left pane of Address Book 

dialog to show the addresses. Double-click one e-Parcel ID as a recipient. 

(Single choice only & add as To only) 

 

 

 

 

 

 

②The Address Book dialog closes and the Send Dialog opens automatically. The specified 

e-Parcel ID as a recipient has been set into the “TO” input field on the Send Dialog. 
*At this point, if the Send Dialog has opened, the Address Book dialog doesn’t close 

automatically.  
 

 

 

 

 

①Double-click 
one address on 
Address Book! 

②Send Dialog 
opens with TO! 
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5-1-2. Select addresses from Address Book 
*By this way below to select from Address Book, you can simply set e-Parcel ID as recipients 

without operation to open the Send Dialog. Select e-Parcel ID on the Address Book to open the 
Send Dialog with addresses as TO, CC or BCC. 

 

①Select one of the lists “All Addresses”, “Favorites” or “Group” at the left pane of Address Book 

dialog to show the addresses. Select e-Parcel ID as recipients. 

(Multiple choices allowed) 
*To select multiple e-Parcel ID at once, hold down the <Shift> or <Ctrl> key while selecting 

e-Parcel ID by using your mouse button. 
 

 
 

 

 

 

 

 

 

Tip: To select all addresses (e-Parcel ID) at once on the lists “All Addresses”, 
“Favorites” or “Group”, right-click on the Address List in the right pane of 
Address Book dialog and then select the “Select All” from the pop-up menu. 
Additionally, the Address Book provides the “Group” function (Grouping) which 
is able to categorize addresses into the multiple “Group” lists as sub folders 
under the “All Addresses” list as needed. You can apply the multiple addresses 
of the pre-created “Group” lists to create new item easily by using the menu 
“Select All” on a group. 
*Refer to P246 6-6-2. Select all addresses from Group list 
*The “Grouping” function has been provided on the Address Book since 

e-Parcel VCN-CommCenter 7.0.7020 (Released in August 2018). 

 

①Select 
addresses on 
Address Book! 
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②When addresses are selected, the “Add as TO” button will be activated. Click ▼ at the right of 

the “Add as TO” button to open the pull-down menu. Select any of the “Add as TO”, “Add as CC” 

or “Add as BCC” from the pull-down menu. 

 

 

 

OR 
 

 

Or when addresses are selected, right-click to open the pop-up menu and then select any of the 

“Add as TO”, “Add as CC” or “Add as BCC”.  

 
 

②Click! 
Add from the 

pull-down 
menu. 

②Right-click and 
add from the 
pop-up menu! 

* To select all e-Parcel ID of 
address list displayed, 
①”Select All” and 
②Add from the pop-up menu! 
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③The Address Book dialog closes and the Send Dialog opens automatically. The specified 

e-Parcel ID as recipients have been set into any of the “TO”, “CC” or “BCC” input fields of Send 

Dialog depending on the previous choice. 
*At this point, if the Send Dialog has opened in advance, the Address Book dialog doesn’t close 

automatically.  
 

 

 

 

 

 

③Send Dialog 
opens with  

TO, CC or BCC! 
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5-1-3. Drag & Drop addresses from Address Book 
*By this way below to select from Address Book, it may useful in the case that the Send Dialog 

already has opened. Select e-Parcel ID on the Address Book to set the addresses as TO, CC or 
BCC on the Send Dialog. 

 

①Click the “Create New” button on the VCN-CommCenter GUI to open the Send Dialog in 

advance. 

 

②Select one of the lists “All Addresses”, “Favorites” or “Group” at the left pane of Address Book 

dialog to show the addresses. Select e-Parcel ID as recipients. 

(Multiple choices allowed) 
*To select multiple e-Parcel ID at once, hold down the <Shift> or <Ctrl> key while selecting 

e-Parcel ID by using your mouse button. 
 

③Drag the selected addresses to any of the “TO”, “CC”, “BCC” fields (in gray) on the Send Dialog. 

When the envelope icon shows ＋plus mark (in green), drop on the field of the Send Dialog. 

 

  

 

 

 

 

 

 

 

 

①On VCN-CommCenter, 
click “Create New” to 
open Send Dialog! 

②Select 
addresses on 
Address Book! 

③Drag & Drop addresses on 
TO, CC, BCC field (in gray) of 

Send Dialog! 
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Tip: To select all addresses (e-Parcel ID) at once on the lists “All Addresses”, 
“Favorites” or “Group”, right-click on the Address List in the right pane of 
Address Book dialog and then select the “Select All” from the pop-up menu. 
Additionally, the Address Book provides the “Group” function (Grouping) which 
is able to categorize addresses into the multiple “Group” lists as sub folders 
under the “All Addresses” list as needed. You can apply the multiple addresses 
of the pre-created “Group” lists to create new item easily by using the menu 
“Select All” on a group. 
*Refer to P246 6-6-2. Select all addresses from Group list 
*The “Grouping” function has been provided on the Address Book since 

e-Parcel VCN-CommCenter 7.0.7020 (Released in August 2018). 

 

 

 

 

④The specified e-Parcel ID as recipients are set into any of the “TO”, “CC” or “BCC” input fields 

on the Send Dialog depending on the previous choice. 

 

 

 

 

 

 

 

 

 

 

 

④Addresses are 
set in any of 

TO, CC or BCC of  
Send Dialog! 
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5-2. Select from Favorites list 
Without opening the address book, an e-Parcel ID of the “Favorites” list can be selected to send a 

new item. 

*Refer to P209 7. Address Book - 3. Show on / Hide from Favorites list 
*When you show addresses on the “Favorites” list of Address Book, those addressees will be shown 

on the Favorites view on the VCN-CommCenter GUI and the menu “Select from List” of TO, CC, 
BCC fields on the Send Dialog (P232 P233). 

 

5-2-1. Select an address from Favorites view on VCN-CommCenter GUI 
*By this way below to select from Favorites list, you can simply set e-Parcel ID as recipients without 

operation to open the Send Dialog. Just double-click an e-Parcel ID on the Favorites view to open 
the Send Dialog with address as TO. 

 

①Just double-click one e-Parcel ID as a recipient on the Favorites view at the lower-left pane of 

VCN-CommCenter GUI. (Single choice only & add as To only) 

 

 

 

①Double-click 
one address on 
Favorites view! 
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②The Send Dialog opens automatically. The specified e-Parcel ID as a recipient is set into the 

“TO” input field on the Send Dialog. 

 

 

 

 

 

 

②Send Dialog 
opens with TO! 
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5-2-2. Select addresses from Favorites view on VCN-CommCenter GUI 
*By this way below to select from Favorite list, you can simply set e-Parcel ID as recipients without 

operation to open the Send Dialog. Select e-Parcel ID on the Favorites view to open the Send 
Dialog with addresses as TO, CC or BCC. 

 

①Select e-Parcel ID as recipients on the Favorites view at the lower-left pane of the 

VCN-CommCenter GUI. (Multiple choices allowed) 
*To select multiple e-Parcel ID at once, hold down the <Shift> or <Ctrl> key while selecting 

e-Parcel ID by using your mouse button. 
 

②Right-click on the selected addresses of the Favorites view to open the pop-up menu. Select 

any of the menu “Add as TO”, “Add as CC” and “Add as BCC”. 

 

 

 

 

 

①Select  
Addresses on 

Favorites view! 
②Right-click and 

add from the 
pop-up menu! 
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③The Send Dialog opens automatically. The specified e-Parcel ID as recipients are set into any of 

the “TO”, “CC” or “BCC” input fields on the Send Dialog depending on the previous choice. 

 

 

 

 

 

 

 

 

③Send Dialog 
opens with  

TO, CC or BCC! 
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5-2-3. Drag & Drop addresses from Favorites view on VCN-CommCenter GUI 
*By this way below to select from Favorite list, it may useful in the case that the Send Dialog has 

already opened. Select e-Parcel ID on the Favorite view to set the addresses as TO, CC or BCC on 
the Send Dialog. 

 

①Click the “Create New” button on the VCN-CommCenter GUI to open the Send Dialog in 

advance. 

 

② Select e-Parcel ID as recipients on the Favorites view at the lower-left pane of the 

VCN-CommCenter GUI. (Multiple choices allowed) 
*To select multiple e-Parcel ID at once, hold down the <Shift> or <Ctrl> key while selecting 

e-Parcel ID by using your mouse button. 
 

③Drag the selected addresses to any of the “TO”, “CC”, “BCC” fields (in gray) on the Send Dialog. 

When the envelope icon shows ＋plus mark (in green), drop on the field of the Send Dialog. 

 

 

 

 

 

 

 

 

 

①On VCN-CommCenter, 
click “Create New” to 
open Send Dialog! 

②Select  
Addresses on 

Favorites view! 
③Drag & Drop addresses on 
TO, CC, BCC field (in gray) of 

Send Dialog! 
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④The specified e-Parcel ID as recipients are set into any of the “TO”, “CC” or “BCC” input fields 

on the Send Dialog depending on the previous choice . 

 

 

 

 

 

 

 

 

 

 

④Addresses are 
set in any of 

TO, CC or BCC of  
Send Dialog! 
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5-2-4. The menu ”Select from List” on Send Dialog 
*By this way below to select from Favorite list, it may useful in the case that the Send Dialog 

already has opened. You can show the favorite e-Parcel ID on the Send Dialog to set the address 
as TO, CC or BCC without the Address Book opened. 

 

①Click the “Create New” button on the VCN-CommCenter GUI to open the Send Dialog in 

advance. Right-click on any of the “TO”, “CC” and “BCC” fields to open the menu. 

 

②When you mouse over “Select from List”, addresses (e-Parcel ID) of the “Favorites” list in 

Address Book will appear on the pop-down menu.  

 

③Click an e-Parcel ID as a recipient in the pop-down menu displaying the “Favorites” list. 

 
 

 

④The selected e-Parcel ID as a recipient is set into any of the “TO”, “CC” or “BCC” input fields on 

the Send Dialog depending on the previous choice . 

 

 

 

 

①Right-click on 
any of  

TO, CC or BCC  
in Send Dialog! 

②Move the cursor 
to this menu! 

③Select an address 
from Favorites list! 

④Address is set 
in any of 

TO, CC or BCC of  
Send Dialog! 
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5-2-5. Show Favorites from pull-down menu on Send Dialog 
*By this way below to select from Favorite list, it may useful in the case that the Send Dialog 

already has opened. You can show the favorite e-Parcel ID on the Send Dialog to set the address 
as TO, CC or BCC without the Address Book opened. 

 

①Click the “Create New” button on the VCN-CommCenter GUI to open the Send Dialog in 

advance. Double-click any of the “TO”, “CC” and “BCC” fields. 

 

 

②A cursor flash up in the “TO”, “CC” or “BCC” input fields (in white) requesting a new recipient 

e-Parcel ID.  

 

 

 

③When you click the arrow at the right side or enter an initial letter, addresses (e-Parcel ID) of 

the “Favorites” list in Address Book will appear on the pull-down menu. Click an e-Parcel ID as 

a recipient in pull-down menu displaying the “Favorites” list. 

 

 

①Double-click on 
any of  

TO, CC or BCC on 
Send Dialog! 

②Input field is 
enabled in any of  
TO, CC or BCC on 

Send Dialog! 

③Enter an initial letter 
OR 

Click the arrow! 
↓ 

Select an address from 
the pull-down menu 

displaying Favorites list! 
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④The selected e-Parcel ID as a recipient is set into any of the “TO”, “CC” or “BCC” input fields on 

the Send Dialog depending on the previous choice. 

 

 

 

 

④Address is set 
in any of  

TO, CC or BCC on 
Send Dialog! 
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6. Group List 

 

In the beginning, when the VCN-CommCenter gets started, a “New Group” will be shown as a sub 

folder under the “All Addresses” list on the Address Book. The Address Book provides the “Group” 

function (Grouping) which is able to categorize addresses into the multiple “Group” lists as needed. 

The maximum 30 “Group” lists are available to create new on the Address Book. For example, 

on the Address Book, you can apply the multiple addresses of the pre-created “Group” lists to 

create new item easily by using the menu “Select All” on a group. This section will introduce you to 

operate and use the “Group” lists on the Address Book in details.  

 

 

Note: [Attention users of e-Parcel VCN-CommCenter 7.0.7019 or earlier] 
The “Grouping” function has been provided on the Address Book since e-Parcel 
VCN-CommCenter 7.0.7020 (Released in August 2018). If users of ver.7.0.7019 
or earlier wish the “Grouping” function, update the program. It is available to 
obtain the latest VCN-CommCenter from the e-Parcel download site below.  
URL：https://www.e-parcel.ne.jp/ 
*Refer to P433 12. Updating Software 

 

 

The “Group” list:  
Maximum 30 groups are 
available to create new. 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

236 
Copyright© e-Parcel Corporation All rights reserved. 

 

6-1. Create New Group 
 

On the Address Book by default, one “New Group” has been already created as a sub folder under 

the “All Addresses” list. Take the procedures below to additionally create new “Group” lists on 

the Address Book. 

 

 

Note: The “Group” lists are available to create the maximum thirty (30) 
groups on the Address Book. 

 

 

 

 

①Select the “All Addresses” list at the left pane of Address Book dialog and then right-click to open 

the pop-up menu. Select the “Create New Group” menu.  
*On the other hand, the “Create New Group” pop-up menu which has been already disabled with 

grayed-out effect due to the maximum 30 groups created will be enabled after an unnecessary 
“Group” list is deleted.  

 

 

 

 

 

 

①Select “All Address” 
list, and right-click! 

Select  
“Create New Group” 

from the pop-up menu! 
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②A “New Group” list is additionally created as a sub folder under the “All Addresses” list at the left 

pane of Address Book. 

 

 

 

 

 

 

 

 

Next, let’s proceed to rename a “New Group” list on the Address Book.  

 

 

 

 

 

 

 

 

 

 

 

②A ”New Group”  
list is added! 
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6-2. Rename Group 
 

When new “Group” list is created on the Address Book, the name “New Group” is usually assigned 

to a group list name as default value. Take the procedures below to rename the “Group” list. 

 

 

①Select a “New Group” list at the left pane of Address Book dialog and then right-click to open the 

pop-up menu. Select the “Rename” menu. 

 

 

 

 

 

 

②This “New Group” list is enabled to input into the field requesting a new group name.  

 

 

 

 

 

①Select  
“New Group” list, 
and right-click! 

Select  
“Rename”  

from the pop-up menu! 

②This field is 
enabled to input! 
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③While ② above, change it to a new group name as needed. 

 

 

 

 

 

 

 

 

 

④When change is made, press the <Enter> key on the keyboard to apply.  

 

 

 

 

 

 

 

Next, let’s proceed to categorize addresses into the “Group” lists on the Address Book. (Grouping) 

 

 

③Charge a “Group” 
list name! 

④When changed, 
press <Enter> key 
on the keyboard! 
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6-3. Copy addresses to Group (Grouping) 
 

When new “Group” lists as sub folders are created under the “All Addresses” on the Address Book, 

you can categorize addresses (e-Parcel ID) into the several “Group” lists (Grouping) as needed. 

Take the procedures below to copy addresses from the “All Addresses” to the “Group” lists. 

 

 

Note: It is able to copy an address (e-Parcel ID) from the “All Addresses” list to 

the multiple “Group” lists on the Address Book. 

 (Belong to multiple groups allowed) 

 

 

 

①Select the “All Addresses” list at the left pane of Address Book dialog to show the addresses. 

 

②Select addresses from the Address List at the right pane of Address Book dialog (Multiple choices 

allowed), and then right-click to open the pop-up menu.  

Scroll your cursor down to the menu “Copy to”. All names of the “Group” lists created will be listed 

on the pop-up menu. 

 

③Select one from the “Group” lists shown on the pop-up menu. 

 

 

①Select  
“All Address” list! 

②Select addresses, 
and right-click! 

↓ 
Move the cursor to the 

“Copy to” menu! 

③Select  one 
from Group lists! 
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Note: At the Address List (the “All Addresses” list) at the right pane of Address 
Book dialog, to select multiple addresses (e-Parcel ID) at once, hold down the 
<Shift> or <Ctrl> key while selecting the addresses (e-Parcel ID) by using your 
mouse button.  
Or, to select all addresses (e-Parcel ID) at once, right-click on the Address List 
in the right pane of Address Book dialog and then select the “Select All” from 
the pop-up menu. 

 

 

 

④Select the specified “Group” list at the left pane of Address Book dialog to confirm the addresses 

copied successfully. 

 

 

 

 

 

 

⑤In addition, an address (e-Parcel ID) is available to belong to the multiple “Group” lists on the 

Address Book. When you wish to copy an address to the several “Group” lists, repeat the 

procedures ①～④ above. 

 

 

④Select  
a “Group” list  

which you copied to! 

Confirm 
the address copied  

to the specified “Group” list. 
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6-4. Move addresses to Group 
 

Once addresses (e-Parcel ID) have been copied to the any “Group” lists, take the procedures below 

to move addresses to the other “Group” lists. 

 

①Select a “Group” list at the left pane of Address Book dialog to show the addresses. 

 

②Select addresses from the Address List at the right pane of Address Book dialog (Multiple choices 

allowed), and then right-click to open the pop-up menu.  

Scroll your cursor down to the menu “Move to”. All names of the “Group” lists created will be 

listed on the pop-up menu. 

 

③Select one from the “Group” lists shown on the pop-up menu. 

 

 

 

 

 

Note: At the Address List (the “Group” list) at the right pane of Address Book 
dialog, to select multiple addresses (e-Parcel ID) at once, hold down the 
<Shift> or <Ctrl> key while selecting the addresses (e-Parcel ID) by using your 
mouse button.  
Or, to select all addresses (e-Parcel ID) at once, right-click on the Address List 
in the right pane of Address Book dialog and then select the “Select All” from 
the pop-up menu. 

 

①Select  
a “Group” list! 

②Select addresses, 
and right-click! 

↓ 
Move the cursor to the 

“Move to” menu! 

③Select  one 
from Group lists! 
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④The previous “Group” list shows the specified addresses no longer. On the other hand, select the 

specified “Group” list at the left pane of Address Book dialog and then confirm the addresses 

moved successfully.  

 

Move from the [Group] list 

 

 

 

 

 

 

Move to the [Group] list 

 

 

 

 

 

The address is  
no longer shown on  

the previous “Group” list. 

④Select  
a “Group” list  

which you moved to! 

Confirm 
the address moved  

to the specified “Group” list. 
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6-5. Delete address from Group 
 

Once addresses have been copied or moved to the any “Group” lists, take the procedures below to 

delete addresses from the “Group” lists. 

 

①Select a “Group” list at the left pane of Address Book dialog to show the addresses. 

 

②Select addresses shown at the right pane of Address Book dialog (Multiple choices allowed), and 

then right-click to open the pop-up menu. Select the “Delete” menu to execute. 

*Attention: Upon the “Delete” menu, promptly execute to delete the addresses from a group. 

 

 

 

 

 

Note: At the Address List (the “Group” list) at the right pane of Address Book 
dialog, to select multiple addresses (e-Parcel ID) at once, hold down the 
<Shift> or <Ctrl> key while selecting the addresses (e-Parcel ID) by using your 
mouse button.  
Or, to select all addresses (e-Parcel ID) at once, right-click on the Address List 
in the right pane of Address Book dialog and then select the “Select All” from 
the pop-up menu. 

 

①Select  
a “Group” list! 

②Select addresses, 
and right-click! 

↓ 
Select “Delete” from 
the pop-up menu! 
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③The specified “Group” list shows those addresses no longer. Confirm the addresses deleted 

successfully.  

 

 

 

 

 

 

The address is  
no longer shown on  

the previous “Group” list. 
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6-6. Use Group list when sending 
 

 

6-6-1. Select addresses from Group list 

Once addresses have been copied or moved to the any “Group” lists, these “Group” lists can be 

used to select addresses (e-Parcel ID) as recipients when you create new item to send on the Send 

Dialog.  
*Refer to P220 7. Address Book - 5-1. Select from Address Book 

 

6-6-2. Select all addresses from Group list 

In addition, once addresses have been copied or moved to the any “Group” lists, you can apply 

the multiple addresses of the “Group” lists to create new item easily by using the menu 

“Select All” on a group. Take the procedures below. 

 

①Select a “Group” list at the left pane of Address Book dialog to show the addresses. 

 

②Right-click on the Address List in the right pane of Address Book dialog to open the pop-up menu. 

Select the “Select All” menu. 

 

 

①Select  
a “Group” list! 

②Right-click on 
Address List! 

↓ 
Select “Select All” from 

the pop-up menu! 
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③While ② above, to apply all addresses (e-Parcel ID) of a group as recipients to the Send 

Dialog, take any of three (3) ways.  

 

Way1: When all addresses selected, the “Add as TO” button will be activated. Click ▼ at the 

right of the “Add as TO” button to open the pull-down menu. Select any of the “Add as TO”, 

“Add as CC” or “Add as BCC” from the pull-down menu. 

 

 
OR 

 

Way2: When all addresses selected, right-click to open the pop-up menu and then select any of 

the “Add as TO”, “Add as CC” or “Add as BCC”. 

 

 

③Way1: 
Click! 

Add from the 
pull-down 

menu. 

③Way2: 
Right-click and 
add from the 
pop-up menu! 
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OR 
 

*By this way3 below, it may useful in the case that the Send Dialog already has opened. 
Way3: When all addresses selected, drag those to any of the “TO”, “CC”, “BCC” fields (in gray) 

of the Send Dialog. When the envelope icon shows ＋plus mark (in green), drop on the field of 

the Send Dialog. 

 

 

 

 

 

 

 

 

 

* When Send Dialog opened 
by “Create New” button on 

VCN-CommCenter. 

③Way3:  
Drag & Drop the selected all 
addresses on TO, CC, BCC 

field (in gray) of Send Dialog! 
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④The Address Book dialog closes and the Send Dialog opens automatically. All e-Parcel ID of a 

“Group” list specified as recipients are set into any of the “TO”, “CC” or “BCC” input fields on 

the Send Dialog depending on the previous choice. 

*By the way3 above, at this point, in the case that the Send Dialog has opened in advance, 
the Address Book dialog doesn’t close automatically. 

 

 

 

 

 

 

 

 

 

The procedures completed. You could apply the pre-created “Group” lists to create new item to 

all addresses of a group easily by using the menu “Select All” on a group. 

 

④All addresses 
of a “Group” list 
are set in any of  
TO, CC or BCC of 

Send Dialog! 
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6-7. Move up/down Group position 
 

The multiple “Group” lists created under the “All Address” list are displayed in order of time created 

on the Address Book. The display position of the multiple “Group” lists can be changed on the 

Address Book. For example, you can move up the frequently used “Group” list or display the 

multiple “Group” lists in alphabetical order on the Address Book. Take the procedures below to 

move up/down the “Group” list position. 

 

①Select a “Group” list at the left pane of Address Book dialog and then right-click to open the 

pop-up menu. Select either the menu “Move Up” or “Move Down”. 

 

 

 

 

 

 

 

Note: Under the “All Addresses” list on the Address Book, the “Move Up” 
pop-up menu is disabled with grayed-out effect according as the first “Group” 
list is selected. The “Move Down” pop-up menu is disabled with grayed-out 
effect according as the last “Group” list is selected. 

 

①[For example]  
Right-click on 

the third “Group” list! 

Select either one from 
the pop-up menu! 
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②The specified “Group” list will be moved up/down under the “All Addresses” list. Confirm the 

display position changed on the Address Book. 

 

When the menu “Move Up” selected, the specified “Group” list is displayed in the one position 

up.  

 

 

 

OR 
 

 

When the menu “Move Down” selected, the specified “Group” list is displayed in the one 

position down.  

 

 

 

 

 

 

②[For example]  
The specified “Group” list is 

moved up to display the 
second! 

②[For example]  
The specified “Group” list is 
moved down to display the 

fourth! 
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6-8. Delete Group 
 

Once the “Group” lists have been created as a sub folder under the “All Addresses” list on the 

Address Book, take the procedures below to delete the “Group” lists. 

For example, if the thirty (30) groups have been already created on the Address Book, the “Create 

New Group” pop-up menu is disabled with grayed-out effect. In this case, it will be enabled 

according as an unnecessary “Group” list is deleted. 

 

 

Note: The “Group” lists are available to create the maximum thirty (30) 
groups on the Address Book. 

 

 

①Select a “Group” list at the left pane of Address Book dialog and then right-click to open the 

pop-up menu. Select the “Delete” menu. 

*Attention: When click the “Delete” menu, promptly execute to delete a group. 

 

 

 

 

 

 

 
Caution: Once the “Group” list has been deleted, it never been restored on the 

Address Book. Please remind that before deleting the “Group” lists. 

 

①Right-click on 
a “Group” list! 

*Attention: Make sure 
and then 

Select “Delete” from the 
pop-up menu! 
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②The specified “Group” list is no longer shown on the Address Book. Confirm the Group” list deleted 

successfully. 

 

 

 

 

 

 

The specified “Group” 
list is no longer shown 
on Address Book. 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

254 
Copyright© e-Parcel Corporation All rights reserved. 

 

For your information: Group e-Parcel ID (Additional Option) 
 

*To use Group e-Parcel ID, the registrations are required in advance upon your request. 

The e-Parcel secure data delivery service provides the additional option function with the ability to 

create new item easily to the multiple e-Parcel ID assigned by just set one e-Parcel ID registered as 

a “Group e-Parcel ID”. If you wish to use the “Group e-Parcel ID” function, the registrations for both 

e-Parcel ID as a parent and children are required in advance. 

 

What’s Group e-Parcel ID? 

The “Group e-Parcel ID” is an e-Parcel ID as a parent which multiple e-Parcel ID as children belong 

to. This parent e-Parcel ID should be defined as the “Group e-Parcel ID”. When you send an item to 

a “Group e-Parcel ID” as a parent, this item will be delivered to all e-Parcel ID as children who 

belong to a “Group e-Parcel ID”. The “Group e-Parcel ID” is available to manually add to the 

Address Book instead of the “Group” list created. This function may be useful for some of the 

customers who often wish the broadcast transmissions through the e-Parcel secure data delivery 

service. 

 

 

Caution: When you wish to use the “Group e-Parcel ID” function, the 
registration for both e-Parcel ID as a parent and children are required 
in advance. Also, when you wish to change the e-Parcel ID as a parent and 
children registered, upon your request, we will change or edit the registered 
e-Parcel ID. Please contact the e-Parcel Customer Support by e-mail 
(support@e-parcel.co.jp). 

 

Caution: When you send new item to the “Group e-Parcel ID”, please 
be sure that all e-Parcel ID as children who belong to the “Group e-Parcel ID” 
must complete installation in advance. If sending new item to a “Group 
e-Parcel ID” including e-Parcel ID as children who is not completed installation 
yet, the delivery status will be "Unknown Recipient" in outbox. This item is 
failed in sending to all e-Parcel ID as children. 

 

Add Group e-Parcel ID to Address Book 

The “Group e-Parcel ID” is available to add to the Address Book by the ways described in the above 

section. 

*Unregistered e-Parcel ID and unknown ID will NOT be added to the Address Book. 

Once you have sent an item to a “Group e-Parcel ID”, only e-Parcel ID as children are added 

automatically to the Address Book. (In this case, a “Group e-Parcel ID” as a parent is NOT added to 

the Address Book.) 

To add a “Group e-Parcel ID” as a parent to the Address Book, manually add as new address to the 

Address Book. In this case, a “Group e-Parcel ID” as a parent only is added. 
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7. Edit Template 

 

Once new addresses (e-Parcel ID) have been added to the “Address Book”, the template function is 

available to each address of Address Book. The templates can be applied to the subject and 

message on the Send Dialog when you create new item. This function may be useful for some of 

the customers who periodically send items like as the monthly or weekly reports. 

This section introduces the operations how to edit and apply the template (subject and message) 

on the Address Book.  

 

 

Note: On the Address Book, you can create and save one template for each 

address (e-Parcel ID).  

 

[Input Sample: Edit Template dialog] 

 
 

 

The VCN-CommCenter usually send message in simple text format by default. If the setting 

“Sending message decoration” has been enabled, message can be decorated in rich text format 

after the template is applied to the Send Dialog. 
*Attention: [For HotFolder function] 

Message of the Template in Address Book is in simple text format every time files and folders 
are sent by HotFolder function. Even though if the setting “Sending message decoration 
(disabled by default)” is enabled, message can’t be decorated on the “Edit Template” dialog. 
Refer to P174 4. Option Configuration – 12. Sending message decoration with rich text format 
Refer to P190 6. Automation (Option Config) – 1. HotFolder configuration 
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7-1. How to edit template 
 

Once new addresses (e-Parcel ID) have been added to the Address Book, take the procedures 

below to create and edit the template (subject and message) on the Address Book. 

 

 

①Select any of the lists “All Addresses”, “Favorites” or “Group” at the left pane of Address Book 

dialog to show the addresses. 

 

 

 

 

 

 

 

 

①Select one of 
the lists on 

Address Book! 
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②Select an address (e-Parcel ID) from the Address List at the right pane of Address Book. 

 

 

 

 

 

③When an address selected, the “Edit Template” button will be enabled. Click the “Edit 

Template” button.  

Or, right-click to open the pop-up menu and then select the “Edit Template” menu. 

 

 
 

 

 

Way1 
③Click the button! 

Way2 
③Right-click and 
select from the 
pop-up menu! 

②Select an 
address from 
Address List! 
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④The “Edit Template” dialog opens. Confirm the “Recipient” field (user name <e-Parcel ID>) 

shown. 

 

 

⑤Enter the template (subject and message) on the “Edit Template” dialog. 

⑥When entered, the “Save” button will be enabled. Click the “Save” button to take effect. 

 

④Confirm 
Recipient! 

⑤Enter subject 
and message! 

⑥Save! 
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⑦When the template is saved, the “Save” button will be disabled with grayed-out effect. 

 

 
 

 

 

When you finish editing the template, click the “Close” button to exit the “Edit Template” dialog.  

 

Or, when you wish continuously to edit the template for other addresses, don’t close the “Edit 

Template” dialog. Proceed to the next procedures below.  

 

 

 

 

 

 

⑦When finished, 
close!  
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7-2. Switch the display “Edit Template” 
In the case that multiple addresses (e-Parcel ID) have been added to the lists “All Addresses”, 

“Favorites” or “Group” on the Address Book, the “Edit Template” dialog provides switching screen 

function to easily transit among multiple addresses without each time closing the dialog. Take the 

procedures below. 

 

 

 

Caution: Before switching the display to another recipient, don’t 

forget to save a template for the current recipient address shown now. If 

not saved, the any changes for a template cannot be restored. 

 

①To switch the display for other recipients, click the either button ▲▼ at the bottom left corner of 

the “Edit Template” dialog. If there is no recipient shown on the Address List, both or either 

button ▲▼ may be disabled with grayed-out effect. 

 

This address list 
selected now! 

While “Edit Template” 
for this recipient 

①To switch display 
for other recipients,  
click ▲▼ button! 
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②A recipient who is shown next above (or below) on the Address List will be displayed on the 

“Edit Template” dialog. 

 

 

 

 

Continuously switch the display for other recipients to edit the template (subject and message) as 

needed. Then, click the “Save” button on the “Edit Template” dialog. 

When you finish editing the template, click the “Close” button to exit the “Edit Template” dialog.  

 

 

②A next recipient  
on the Address List 
will be displayed. 
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7-3. Apply Template when sending 
 

Once a template for address (e-Parcel ID) as recipient is saved on the “Edit Template” dialog of the 

Address Book, the template (subject and message) can be applied to the Send Dialog when you 

create new item. Take the procedures below. 

 

①Select any of the lists “All Addresses”, “Favorites” or “Group” at the left pane of Address Book 

dialog to show the addresses. Select an address (e-Parcel ID) which you saved the template from 

the Address List at the right pane of Address Book. (Multiple choices allowed) 
*To select multiple e-Parcel ID at once, hold down the <Shift> or <Ctrl> key while selecting 

e-Parcel ID using your mouse button. 
*Refer to P220 7. Address Book - 5-1. Select from Address Book 

 

 

 

 

 

 

 

Note: On the Address List (the lists “All Addresses”, “Favorites” or “Group”) at 

the right pane of Address Book, when you select multiple addresses (e-Parcel 

ID) and apply a template, select them including at least one address which you 

edited a template.  

 

This address list 
selected now! 

①Select 
addresses from 
Address List! 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

263 
Copyright© e-Parcel Corporation All rights reserved. 

 

②When addresses selected, the “Add as TO” button will be enabled. Click ▼ at the right of the 

“Add as TO” button to open the pull-down menu. Select any of the “Add as TO”, “Add as CC” or 

“Add as BCC” from the pull-down menu. 

 

 

 

OR 
 

 

Or, right-click to open the pop-up menu and then select any of the “Add as TO”, “Add as CC” or 

“Add as BCC”. 

 

 

Way1 
②Click! 

Add from the 
pull-down menu. 

 

Way2 
②Right-click and 

add from the 
pop-up menu! 
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③The Send Dialog opens automatically. The specified e-Parcel ID as recipients are set into any of 

the “TO”, “CC” or “BCC” input fields of Send Dialog depending on the previous choice.  

Right-click on a recipient (e-Parcel ID) which has been saved the template, and select the 

“Apply Template” from the pop-up menu. 

 

 
 

 

 

 

Caution: If the “Apply Template” menu is disabled with grayed-out 

effect, there is no template for a recipient (e-Parcel ID) specified on the 

Address Book. To apply template requires in advance to save template for 

recipients in the “Edit Template” dialog of the Address Book. 

*Refer to P255 7. Address Book - 7. Edit Template 

 

③Right-click on 
the address 

↓ 
Select  

“Apply Template” 
from the pop-up 

menu! 
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④A template (subject and message) saved by the “Edit Template” dialog on the Address Book will 

be applied to the applicable fields on the Send Dialog. 

 

 

Note: At this point, in the case of multiple recipients on the Send Dialog, if you 

right-click on another recipient (e-Parcel ID) which has been saved a template, 

and then select the menu “Apply Template” again, the previous template 

applied will be replaced with the later one on the Send Dialog.  

 

  

 

The “Send” button will be enabled according as the “To” input field and the files/folders 

attached must be applied on the Send Dialog. Click the “Send” button to send new item. 

④Confirm the 
template applied! 
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8. Export List 

 

Once addresses (e-Parcel ID) have been added to the Address Book, the address lists of Address 

Book are available to export (save) as a file in CSV [comma separated value/UTF-8] format.  

 

This function may be useful for some of the customers who save the address lists of Address Book 

as a backup file, or copy (import) to the Address Book of other e-Parcel VCN-CommCenter without 

manual operation to add new addresses. 

This section introduces the operations how to export the address list on the Address Book.  

 

 

 

Warning: Don’t open and edit any CSV file of address list exported. It 

may cause error when importing address list as a file in CSV format. Therefore, 

this CSV file exported must include the significant attribute code assigned 

automatically by the e-Parcel system.  

When you wish to change the contents of address list, please be 

advised that you must operate through the “Address Book” dialog 

before exporting list. On the Address Book, add new address, show on/hide 

from the “Favorites” list, show/hide address, copy/move/delete the “Group” list, 

edit template or etc. in advance. For more details, refer to the page below of 

the section for Address Book. 
 
*Refer to P200 6. Address Book 

P204 2. Add New Address 
P209 3. Show on / Hide from Favorites list 
P214 4. Show / Hide Address 
P235 6. Group List 
P255 7. Edit Template 
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8-1. Confirmation before exporting list 
 

Before exporting the address list, select one of the lists “All Addresses”, “Favorites” or 

“Group” at the left pane of Address Book dialog to show the addresses which you wish to export. 

Confirm the Address List at the right pane of Address Book dialog in advance.  

 

If you need to change the contents of address list, you must take any operations 

through the “Address Book” dialog such as to add new address, show on/hide from the 

“Favorites” list, show/hide address, copy/move/delete the “Group” list, edit template or etc. before 

exporting list. 

 

 

 

The “All Addresses” list (Recommended) 

When you wish to export all addresses added to the Address Book except the “Hidden” addresses, 

select the “All Addresses” list.  

Unless there is some particular reason, we recommend the “All Addresses” list for exporting list.  

In the case of exporting the “All Addresses” list for backup, it will able to make the same Address 

Book as before including the attribute information which those addresses belong to the “Favorites” 

and/or “Group” lists when importing list later. 

*If you wish the addresses to belong to the same “Group” as before when importing list later, you 
also need to export group from the same Address Book as you export list. It is described in the 
later section below. 
Refer to P280 7. Address Book – 10. Export Group 

 

 

 

The “Favorites” list 

When you wish to export the limited addresses added to the Address Book, select the “Favorites” 

list. The favorite addresses only shown on the Address List at the right pane of Address Book can 

be exported as a file. 

When you wish to change the favorite addresses, you must show on/hide from the “Favorites” list 

through the “Address Book” dialog before exporting list.  

*Refer to P209 7. Address Book - 3. Show on / Hide from Favorites list 
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The “Group” lists 

When you wish to export the limited addresses copied to the groups, select any of the “Group” lists. 

The grouped addresses only shown on the Address List at the right pane of Address Book can be 

exported as a file. 

When you wish to change the grouped addresses, you must copy to/move to/delete from the 

“Group” lists through the “Address Book” dialog before exporting list.  

*Refer to P235 7. Address Book – 6. Group List 
*If you wish the addresses to belong to the same “Group” as before when importing list later, you 

also need to export group from the same Address Book as you export list. It is described in the 
later section below. 
Refer to P280 7. Address Book – 10. Export Group 

 

 

 

For reference: About the “Hidden” addresses 
*The “Hidden” list has not been shown on the Address Book since e-Parcel VCN-CommCenter 8.0.8021 (Released in 

October 2019). When hidden, the specified addresses are promptly disappeared from the Address Book. 

The “Hidden” addresses are not included in the “All Addresses” list regardless of the addresses 

added to the Address Book.  

*Refer to P214 7. Address Book - 4. Show / Hide Address 
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8-2. How to export list 
 

①Select one of the lists “All Addresses”, “Favorites” or “Group” at the left pane of Address Book 

dialog to show the addresses which you wish to export. 

 

  

 

 

①Select one of 
the lists on 

Address Book! 

[Address List] 
Confirm 
before 

exporting! 
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②Click ▼ at the right of the “New Address” button to open the pull-down menu. Select the “Export 

List” menu. 

 

 

 

 

 

②Click! 
Select from 

the pull-down 
menu. 
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③The “Export List” dialog appears. Select a destination folder on the desktop or another 

convenient location to “Save” for exporting as a file in CSV format. 

  

 

④Enter a file name in the “File name” field of Export List dialog. 

 

⑤When entered in both the “Save in” and “File name”, click the “Save” button to export list.  

 

③Select  
a destination folder 

to save! 

⑤Save! 

④Enter  
a file name! 
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⑥Locate a destination folder specified and then confirm to export (save) the addresses list as a file 

in CSV [comma separated value/UTF-8] format. 

*Attention: Don’t open and edit any CSV file exported. Therefore, this CSV file exported must 
include the significant attribute code assigned automatically by the e-Parcel system. When you 
wish to change the contents of a file, please be advised that you must operate through the 
“Address Book” dialog. 

  

 

 

 

 

⑥Confirm address 
list as a file!  

(in CSV format) 
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9. Import List 

 

As described in the previous section just above, once address list has been exported (saved) as a 

file in CSV [comma separated value/UTF-8] format, a file of address list is available to import on 

Address Book of e-Parcel VCN-CommCenter. 

 

This function may be useful for some of the customers who save the address list of Address Book as 

a backup file, or copy (import) to the Address Book of other client software; e-Parcel 

VCN-CommCenter without add new address. 

This section introduces the operations how to import the address list on the Address Book.  

 

 
Warning: When you import the address list to the Address Book, the 

VCN-CommCenter is required to be online because it will be polling to the 

e-Parcel server to verify the registration of addresses (e-Parcel ID). 

 

 

Warning: Don’t open and edit any CSV file of address list exported. It 

may cause error when importing address list as a file in CSV format. Therefore, 

this CSV file exported must include the significant attribute code assigned 

automatically by the e-Parcel system. 

When you wish to change the contents of address list, please be 

advised that you must operate through the “Address Book” dialog 

after importing list. On the Address Book, add new address, show on/hide 

from the “Favorites” list, show/hide address, copy/move/delete the “Group” list, 

edit template or etc. For more details, refer to the page below of the section for 

Address Book. 
 
*Refer to P200 6. Address Book 

P204 2. Add New Address 
P209 3. Show on / Hide from Favorites list 
P214 4. Show / Hide Address 
P235 6. Group List 
P255 7. Edit Template 
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9-1. Confirmation before importing list 
 

Before importing the address list as a file in CSV [comma separated value/UTF-8] format, 

please be sure to read carefully about the addresses on the Address Book described below.  

 

 

Caution: Attention 1: Please be aware that importing address list as a file 
including revoked e-Parcel ID or unregistered ID must cause the 
process to be error.  

Under this situation, it will fail in importing the corresponding addresses in the 
list. On the other hand, the other addresses (the registered e-Parcel ID) in the 
list will be imported normally. 

*It is recommended to hide the corresponding addresses from the “Address 
Book” before exporting (save) list. And then, try to import the addresses list. 

*Refer to P214 7. Address Book - 4. Show / Hide Address 
*The “Hidden” list has not been shown on the Address Book since e-Parcel 

VCN-CommCenter 8.0.8021 (Released in October 2019). When hidden, the specified 
addresses are promptly disappeared from the Address Book. 

 

Caution: Attention 2: When importing address list as a file including same 
e-Parcel ID which have already existed on Address Book, the existing 
template of same e-Parcel ID must be overwritten with the imported 
new template. If the template is blank in the imported file, the existing 
template of same e-Parcel ID is replaced with blank as well. 

 

Note: ※1 First Name and Last Name of User Info registered with 

e-Parcel server will be automatically assigned to the addresses (e-Parcel) 

on the Address Book regardless of the imported address list as a file in CSV 

format.  

*Refer to P458 Appendix 1. The e-Parcel Secure Enterprise - Web Browser 

 

Note: If you wish the addresses to belong to the same “Group” as before when 
importing list on new Address Book, you also need to export group from the 
same Address Book as you export list (addressees). And then, import group on 
new Address Book. 
When both address list and group exported from the same Address Book have 
been imported on new Address Book, those addresses will belong to the 
appropriate “Group” base on the attribute information of both address list and 
group exported from the previous Address Book.  
*Refer to P235 7. Address Book – 6. Group List 
*Refer to P280 7. Address Book – 10. Export Group 
*Refer to P285 7. Address Book – 11. Import Group 
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Addressees before / after “Import List” 
On the Address Book, confirm the addresses in the case of ①～④ before importing list.  

(Online required) 
 
【In the case of importing list including new addresses (e-Parcel ID) non-existed on Address Book】 
① Revoked e-Parcel ID included in a CSV file  
→ Importing the unregistered e-Parcel ID is unavailable. 

Attention 1: Error occurs 
*Despite this situation, the other addresses (the registered e-Parcel ID) in the list will be imported normally. 

 
②New registered e-Parcel ID included in a CSV file  
→ New addresses will be added. ※1 

 
【In the case of the existing addresses (e-Parcel ID) on Address Book】 
③The existing e-Parcel ID on Address Book is also included in a CSV file 
→ It will be overwritten with information of the imported same e-Parcel ID. ※1 

Attention 2: Overwrite template 
 
④The existing e-Parcel ID on Address Book is NOT included in a CSV file 
→ It won’t be changed. 

 

About addressees before / after “Import List” on Address Book 

Case ① ② ③ ④ 

Address Book ×Not exist ×Not exist ○Exist ○Exist 

Address file 

for Importing List 

(CSV/UTF-8) 

(Online required) 

○Exist ○Exist ○Exist ×Not exist 

Revoked, 
unregistered  
e-Parcel ID 

(Registered e-Parcel ID with the e-Parcel service) 

↓↓ ↓↓ ↓↓ ↓↓ 

After importing list 

(New) 

Address Book 

× 
Unavailable 

Error Detail dialog 
“Specified address is 

not found in the 
global directory.” 

○ 

New address 

added 

○ 

Existing address 

overwritten 

○ 

Existing address 

unchanged 

Attention 1: 
If error occurs,  

it fails in importing 
the unregistered 

e-Parcel ID. 

※1 Each name of 
addresses will be 

assigned the 
registered name 
with the e-Parcel 

server.  

※1 Attention 2: 
The existing 

template will be 
overwritten with 
new one for the 
imported same 

address. 

It won’t be 
changed.  

It doesn't affect 
the existing 
e-Parcel ID. 
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Attention users of e-Parcel VCN-CommCenter 7.0.7019 or earlier 
The Address Book has been added functionality since e-Parcel VCN-CommCenter 7.0.7020 

(Released in August 2018). 

When updating the software from e-Parcel VCN-CommCenter 7.0.7019 or earlier, please be sure to 

read carefully the following two descriptions.  

 

 

Note: [Attention users of e-Parcel VCN-CommCenter 7.0.7019 or earlier] 
*The “Grouping” function has been provided on the Address Book since e-Parcel 

VCN-CommCenter 7.0.7020 (Released in August 2018). If users of ver.7.0.7019 
or earlier wish the “Grouping” function, update the program. It is available to 
obtain the latest VCN-CommCenter from the e-Parcel download site below.  
URL：https://www.e-parcel.ne.jp/ 

*Refer to P433 12. Updating Software 
 
1. Maintain the existing Address Book (in a same computer): 
When you update to the e-Parcel VCN-CommCenter 7.0.7020 or later in a same 
computer, it can continuously maintain your Address Book of the existing 
VCN-CommCenter 7.0.7019 or earlier. In addition, at the previous version 
7.0.7019 or earlier, the hidden addresses have been shown on the “All 
Addresses” list of Address Book. However, since version 7.0.7020 or later, the 
hidden addresses will be hidden from Address Book. 
*When you update the e-Parcel VCN-CommCenter in another computer and migrate histories 

and configurations, it can continuously maintain your Address Book as well.  

 
2. Import list of the existing Address Book (in another computer): 
When you install the e-Parcel VCN-CommCenter 7.0.7020 or later in another 
computer and then import the address list as a file in the previous CSV format 
which exported from the previous version 7.0.7019 or earlier, all addresses 
(e-Parcel ID) imported will be added to both “All Addresses” and “Favorites” 
lists. 
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9-2. How to import list 
 

①First, make sure that the VCN-CommCenter must be online and then open the Address Book 

dialog. (Online required) 

*Refer to P201 7. Address Book - 1. Open Address Book 

 

 

②To import the address list as a file in CSV [comma separated value/UTF-8] format exported at the 

previous section above, click ▼ arrow next to the “New Address” button to open the pull-down 

menu. Select the “Import List” menu. 

 

 

 

 

 

 

 

②Click! 
Select from 

the pull-down 
menu. 

①When VCN-CommCenter 
GUI shows online,  

open “Address Book”! 
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③The “Import List” dialog is opened. Locate a storage folder where a CSV file of address list has 

been saved in your computer. 

 

④Select a CSV file of address list in a storage folder specified on the “Import List” dialog. 

 

⑤When selected, confirm a file name displayed in the “File name” field. 

 

⑥To start importing list, click the “Open” button. 

 

 

 

 

 

 ⑥Open! 

④Select a file of 
address list in 
CSV format! 

(UTF-8) 

⑤Confirm “File Name” 
displayed! 

③Locate  
a storage folder! 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

279 
Copyright© e-Parcel Corporation All rights reserved. 

 

⑦The “Import List” dialog close. When the address list as a file has been imported successfully, the 

imported addresses are listed on the any of the lists “All Addresses”, “Favorites” or “Group” of 

Address Book. 

* When address list as a file imported on the Address Book, the addresses will belong to the 
appropriate lists (the lists “All Addresses”, “Favorites”, “Group”) base on the attribute information 
of the address list as a file in CSV format at the time exported. 
Refer to P267 7. Address Book – 8-1. Confirmation before exporting list 

 

* If you wish the addresses to belong to the same “Group” as before when importing list on new 
Address Book, you also need to export group from the same Address Book as you export list 
(addressees). And then, import group on new Address Book. 
Refer to P235 7. Address Book – 6. Group List 
Refer to P280 7. Address Book – 10. Export Group 
Refer to P285 7. Address Book – 11. Import Group 

 

 

 

 

⑦The addresses 
imported are shown. 
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10. Export Group 

 

In the beginning, when the VCN-CommCenter gets started, a “New Group” will be shown as a sub 

folder under the “All Addresses” list on the Address Book. The Address Book provides the “Group” 

function (Grouping) which is able to categorize addresses into the multiple “Group” lists as needed. 

You can create the maximum 30 “Group” lists on the Address Book.  

 

Once the “group” lists have been created as sub folders under the “All Addresses” list of Address 

Book, the groups as sub folders are available to export (save) as a file in CSV [comma separated 

value/UTF-8] format.  

 

This function may be useful for some of the customers who save the groups of Address Book as a 

backup file, or copy (import) to the Address Book on the e-Parcel VCN-CommCenter in another 

computer without operation to create new groups as sub folders. 

This section introduces the operations how to export the groups on the Address Book.  

 

To export the groups will output as a file including the attribute information of groups such as group 

name and position as sub folders. (Note that a CSV file of groups exported doesn’t include the 

information to which addresses belong.)  
*If you wish the addresses to belong to the same “Group” as before when importing group later, 

you also need to export list from the same Address Book as you export group. It is described in 
the previous section below. 
Refer to P266 7. Address Book – 8. Export List 

 

 

 

 

 

 

The “Group” list:  
Maximum 30 groups are 
available to create new. 

↓ 
Groups as sub folders are 

available to export as a file!  
(in CSV format) 
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Note: [Attention users of e-Parcel VCN-CommCenter 7.0.7019 or earlier] 
The “Grouping” function has been provided on the Address Book since e-Parcel 
VCN-CommCenter 7.0.7020 (Released in August 2018). If users of ver.7.0.7019 
or earlier wish the “Grouping” function, update the program. It is available to 
obtain the latest VCN-CommCenter from the e-Parcel download site below.  
URL：https://www.e-parcel.ne.jp/ 
*Refer to P433 12. Updating Software 

 

 

Warning: Don’t open and edit any CSV file of groups exported. It may 

cause error when importing groups as a file in CSV format. Therefore, this CSV 

file exported must include the significant attribute code assigned automatically 

by the e-Parcel system.  

When you wish to change the contents of groups, please be advised 

that you must operate through the “Address Book” dialog before 

exporting groups. On the Address Book, create new group, delete group, 

rename group, move up/down group position or etc. in advance. For more 

details, refer to the page below of the section for Address Book. 
*Refer to P235 7. Address Book – 6. Group List  
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How to export group 
 

①On the Address Book dialog, click ▼ at the right of the “New Address” button to open the 

pull-down menu. Select the “Export Group” menu. 

 

 

 

 

 

②The “Export Group” dialog appears. Select a destination folder on the desktop or another 

convenient location to “Save in” for exporting as a file in CSV format. 

 

  

 

①Click! 
Select from 

the pull-down 
menu. 

②Select  
a destination folder 

to save! 
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③Enter a file name in the “File name” field of Export Group dialog. 

 

 

 

④When entered in both the “Save in” and “File name”, click the “Save” button to export list. 

 

 

 
④Save! 

③Enter  
a file name! 
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⑤Locate a destination folder specified and then confirm to export (save) the groups as a file in CSV 

[comma separated value/UTF-8] format. 

*Attention: Don’t open and edit any CSV file exported. Therefore, this CSV file exported must 
include the significant attribute code assigned automatically by the e-Parcel system. When you 
wish to change the contents of a file, please be advised that you must operate through the 
“Address Book” dialog. 

 

 

 

➄Confirm groups 
 as a file!  

(in CSV format) 
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11. Import Group 

 

As described in the previous section just above, once groups have been exported (saved) as a file 

in CSV [comma separated value/UTF-8] format, a file of groups is available to import on Address 

Book of e-Parcel VCN-CommCenter. 

 

This function may be useful for some of the customers who save the groups of Address Book as a 

backup file, or copy (import) to the Address Book of other client software; e-Parcel 

VCN-CommCenter without operation to create new groups as sub folders. 

This section introduces the operations how to import the groups on the Address Book.  

 

To import the groups will be created new groups as sub folders under the “All Addresses” list of 

Address Book. The existing all groups must be overwritten with the imported new groups 

completely. (Note that a CSV file of groups exported doesn’t include the information to which 

addresses belong.)  

 

 

Note: [Attention users of e-Parcel VCN-CommCenter 7.0.7019 or earlier] 
The “Grouping” function has been provided on the Address Book since e-Parcel 
VCN-CommCenter 7.0.7020 (Released in August 2018). If users of ver.7.0.7019 
or earlier wish the “Grouping” function, update the program. It is available to 
obtain the latest VCN-CommCenter from the e-Parcel download site below.  
URL：https://www.e-parcel.ne.jp/ 
*Refer to P433 12. Updating Software 

 

 

Note: If you wish the addresses to belong to the same “Group” as before when 
importing group on new Address Book, you also need to export list (addresses) 
from the same Address Book as you export group. And then, import list 
(addresses) on new Address Book. 
When both address list and group exported from the same Address Book have 
been imported on new Address Book, those addresses will belong to the 
appropriate “Group” base on the attribute information of both address list and 
group exported from the previous Address Book.  
*Refer to P235 7. Address Book – 6. Group List 
*Refer to P266 7. Address Book – 8. Export List 
*Refer to P273 7. Address Book – 9. Import List 
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Warning: Once the groups have been imported as sub folders under the “All 

Addresses” list of Address Book, the existing all groups must be overwritten 

with the imported new groups completely. You no longer return the existing 

groups. As needed, export the existing groups as a file in advance.  

*Refer to P280 7. Address Book – 10. Export Group 

 

 

Warning: Don’t open and edit any CSV file of groups exported. It may 

cause error when importing groups as a file in CSV format. Therefore, this CSV 

file exported must include the significant attribute code assigned automatically 

by the e-Parcel system. 

When you wish to change the contents of groups, please be advised 

that you must operate through the “Address Book” dialog after 

importing groups. On the Address Book, create new group, delete group, 

rename group, move up/down group position or etc. For more details, refer to 

the page below of the section for Address Book. 
*Refer to P235 7. Address Book – 6. Group List  
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How to import group 
 

①Open the Address Book dialog. 

*Refer to P201 7. Address Book - 1. Open Address Book 

 

 

②To import the groups as a file in CSV [comma separated value/UTF-8] format exported at the 

previous section above, click ▼ arrow next to the “New Address” button to open the pull-down 

menu. Select the “Import Group” menu. 

 

 

 

 

 

 

②Click! 
Select from 

the pull-down 
menu. 

①On VCN-CommCenter,  
open “Address Book”! 
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③The “Import Group” dialog is opened. Locate a storage folder where a CSV file of groups has 

been saved in your computer. 

 

④Select a CSV file of groups in a storage folder specified on the “Import Group” dialog. 

 

⑤When selected, confirm a file name displayed in the “File name” field. 

 

⑥To start importing groups, click the “Open” button. 

 

 

 

 

 

 

 

 

 

 

③Locate  
a storage folder! 

④Select a file of 
groups in CSV 

format! 
(UTF-8) 

⑤Confirm “File Name” 
displayed! 

⑥Open! 
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⑦The “Import Group” dialog close. When the groups as a file have been imported successfully, the 

imported new groups are created as sub folders under the “All Addresses” list of Address Book. 

The existing all groups must be overwritten with the imported new groups completely. 

*If you wish the addresses to belong to the same “Group” as before when importing group on 
new Address Book, you also need to export list (addresses) from the same Address Book as you 
export group. And then, import list (addresses) on new Address Book. 
Refer to P235 7. Address Book – 6. Group List 
Refer to P266 7. Address Book – 8. Export List 
Refer to P273 7. Address Book – 9. Import List 

 

  

 

 

⑦The groups  
imported are shown 

as sub folders. 
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12. Close Address Book 

 

To close the “Address Book” dialog by either of the following two (2) ways. 

 

Way 1. Close from the button 
Click the  Ｘ  button at the top right corner of the “Address Book” dialog. 

 

Way 2. Close from the pop-up menu 

Right-click on the “All Addresses” list in the left pane of the “Address Book” dialog. Select “Close 

Window” from the pop-up menu. 

 

 
 

Way1 
Click to close! 

Way2 
Right-click on the 
“All Addresses” 

list. 
Select “Close Window” 
from the pop-up menu! 
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８．Sending 

The e-Parcel VCN-CommCenter provides users for sending secure data to the registered e-parcel 

recipients. The operations on the VCN-CommCenter GUI are similar to any e-mail approbation which 

users may be familiar with. 

 

However, the e-Parcel VCN-CommCenter provides the abilities of authentication, encryption, integrity, 

audit etc. for secure delivery the large data which any standard e-mail applications do not have. 

 

This section explains the steps to create new item, view Outbox, operate the Parcel Detail dialog in 

outbox and etc. on the VCN-CommCenter GUI in detail. 

 

 

Caution: If you want to send files and folders to recipients who include not 

only users of the e-Parcel software but also users of “The e-Parcel Secure 

Enterprise - Web Browser (e-Parcel VCN-Web)”, and if their OS 

language is different between a sender and recipients, files and folders 

may not be completed to deliver normally. For the affected users, please be 

advised that file and folder name must NOT contain any other 

characters than alphanumeric to attach on the Send dialog when sending 

new items. 

 

８ 
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1. New Item Creation 

 

How to open Send Dialog 
*If the existing VCN-CommCenter has not already been started, to start the program, double-click 

the “e-Parcel x.x” shortcut icon on the desktop. The VCN-CommCenter GUI will open. 
 

When you wish to send files and folders, click the “Create New” button found on the tool bar of 

VCN-CommCenter GUI. 

*This behaves similarly to the menu bar Message > “Create New”. 

 

 

 

 

 

Click! 
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The Send Dialog 
The “Send Dialog” dialog opens by the above way. 

This dialog provides you with all the options necessary to create a new item, select recipients 

from Address Book, enter subject and message, attach files and folders, and click Send button. 
*Attention: When both “TO” and “Item (files/folders attached)” boxes are entered on the Send 

Dialog, the “Send” button will be enabled (in color). [*Required] 
 

 

 
*The “Message decoration with rich text format” function has been provided since e-Parcel VCN-CommCenter 

8.0.8023 (Released in March 2022). When the setting “Sending message decoration (disabled by default)” is 
enabled, the message decoration tool bar is shown additionally at the top of the message box on Send dialog.  
Refer to P174 4. Option Configuration – 12. Sending message decoration with rich text format 

 

Attach Folder 
button 

（P310） 

Attach File 
button 

（P310） Address box 
（P294） 
*Required 

Item box 
(List of attached files/folders)  
（P310, P328, P330） 

*Required 
 

Subject & Message 
box 

（P308） 

Account 
Information
（P329） 

Send button 
（P331） 

*To send new, both To and 
Item attached are required. 
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1-1. Enter the recipients 
First, you must enter the recipients of new items. There are three (3) ways; Recipients can be 

manually added by entering their e-Parcel ID. You can also select recipients from the Address Book 

or Favorites address list. 

 

How to add TO・CC・BCC 
 

1-1-1. Enter TO, CC, BCC ⇒ Refer to P296 

In the case of soon after software installation, your address book is not added any e-Parcel ID as 

recipients. At this point, enter manually recipients e-Parcel ID into the “TO”, “CC”, “BCC” fields of 

the “Send Dialog”. 

 

1-1-2. Select from Address Book ⇒ Refer to P299 (P220 6. Address Book – 5-1) 

Once you have sent or received items through the e-Parcel software, the e-Parcel ID of recipients 

to whom you sent and sender who sent to you are automatically added to your address book.  
 
*By the ways ①②③ below to select from Address Book, you can simply set e-Parcel ID as recipients 

without operation to open the Send Dialog.  

①Select one from Address List → Double- click! (Single choice only & add as To only) 

②Select from Address List ＋ Click Add as TO! (Multiple choices allowed & add as TO, CC, BCC) 

③Right-click on addresses ＋ Select Add as TO! (Multiple choices allowed & add as TO, CC, BCC) 

④Select from Address List ＋ Drag & Drop on TO, CC, BCC fields of Send Dialog 
*To select all e-Parcel ID of address list displayed (All Addresses, Group, and Favorites), 

right-click on Address List box to open the pop-up menu. Select the “Select All”. And then take 
any of ways ②③④ above. 
This way will be useful for customers who wish to use the grouping function of Address Book.  

 

1-1-3. Select from Favorites list ⇒ Refer to 303 (P226 6. Address Book - 5-2) 

When e-Parcel ID as recipients sent frequently exist, use the “Favorites” list of Address Book. 
 
*By the ways ①② below to select from Address Book, you can simply set e-Parcel ID as recipients 

without operation to open the Send Dialog.  

 [A. Select from Favorites view on VCN-CommCenter GUI] 

①Select one from Favorites view → Double- click! (Single choice only & add as To only) 

②Right-click on Favorites ＋ Select Add as TO!! (Multiple choices allowed & add as TO, CC, BCC) 

③Select from Favorites view ＋ Drag & Drop on TO, CC, BCC fields of Send Dialog 
 

[B. Select from Favorites list on Send Dialog] 

④Right-click on TO, CC, BCC fields of Send Dialog→“Select from List”→Select from Favorites list 

⑤Double-click on TO, CC, BCC fields of Send Dialog→A cursor flash up→click the arrow to open 

the pull-down menu→Select one from Favorites list 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

295 
Copyright© e-Parcel Corporation All rights reserved. 

 

 

Warning: Before sending and receiving data via the e-Parcel service, both 
sender and recipient must register an e-Parcel ID each with the e-Parcel service 
and must complete to install the e-Parcel client certificate and software in a 
computer each in order to ensure the high security levels in advance. 
Therefore, you can NOT send data to the e-Parcel ID that is not 
registered or has not completed installation yet. If addresses include 
such an e-parcel ID without satisfaction of the above conditions, the delivery 
status will be "Unknown Recipient" in outbox to fail in sending. (In the case 
of multiple destination e-Parcel ID including the correct ID, you fail in sending 
this item to all recipients when the delivery status "Unknown Recipient".) 
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1-1-1. Enter TO, CC, BCC 
Enter manually recipients e-Parcel ID into the “TO”, “CC”, “BCC” fields of the Send Dialog. 

follow the procedure ①～④ below. 

 

①Double-click the “TO”, “CC”, “BCC” fields (in gray) on the Send Dialog.  

 

 

OR 
 

Or right-click on the “TO”, “CC”, “BCC” fields (in gray) of the Send Dialog to open the pop-up 

menu and then select the menu “Input New Address”. 

 

 

 

①Double-click the 
“TO” field (in gray)! 

①To open the pop-up 
menu, right-click on the 

“TO” field (in gray)! 
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②A cursor flash up in the “TO”, “CC”, “BCC” input fields (in white) requesting a new recipient 

e-Parcel ID. 

 

 

 

 

 

③Enter a new recipient e-Parcel ID in the “TO”, “CC”, “BCC” input fields (in white). 

 
 

 

 

Tip: Once e-Parcel ID has been added to the “Favorites” list of Address Book, 

the pull-down menu opens automatically on the “TO” field upon entering a 

letter. At this point, you can also select an e-Parcel ID from the “Favorites” list of 

Address Book. 

 

③Enter! 

②Enable to 
enter! 
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④When a new recipient e-Parcel ID is entered in the “TO”, “CC”, “BCC” input fields (in white), 

press the <Enter> key on the keyboard. 

 

 

 

*To enter manually multiple recipients into the “TO”, “CC”, “BCC” fields, repeat the procedure 

 ①～④ above. 

 

 

 

④Press  
<Enter> key on 
the keyboard! 
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1-1-2. Select from Address Book 
When you create a new item to send, the “Address Book” can be used to select recipients e-Parcel 

ID. To enter manually recipients into the “TO” field, take the procedure below. 
*For more details about the “Address Book”, refer to the section below. 

Refer to P220 7. Address Book - 5-1. Select from Address Book 
 

①Click the “Address Book” button on the Send Dialog. 

 

 

 

 

OR 
 

 

Or right-click on the address box of the Send Dialog to open the pop-up menu. Click the menu 

“Open Address Book”. 

 

 

①Click! 

①To open the pop-up 
menu, right-click on 

the address box! 
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②The “Address Book” dialog opens. 

The “All Addresses” will be shown as default view. Select one of the address lists (All Addresses, 

Favorites, and Group) as needed. 

 

  

 

 

 

Tip: To simply add an e-Parcel ID as TO, just double-click an e-Parcel ID on the 

Address Book. An e-Parcel ID is added as “To” on the “Send Dialog”. 
*Refer to P220 7. Address Book - 5-1-1. Select one address from Address Book 

 

②Address Book 
*”All Addresses” list is 
shown as default list. 
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③Select e-Parcel ID as recipients from the “Address Book”. (Multiple choices allowed) 
*To select multiple e-Parcel ID at once, hold down the <Shift> or <Ctrl> key while selecting 

e-Parcel ID by using your mouse button. 
*To select all e-Parcel ID of address list displayed (All Addresses, Group, and Favorites), 

right-click on Address List box to open the pop-up menu. Then select the “Select All”.  
This way will be useful for customers who wish to use the grouping function of Address Book. 
For more details about the Grouping function, see the section below. 
Refer to P235 7. Address Book – 6. Group List 

 

④When addresses selected, the “Add as TO” button will be activated. Click this or click ▼ arrow 

next to the “Add as TO” button to open the pull-down menu. Select either menu “Add as CC” or 

“Add as BCC”. 

 

 

OR 
 

Or when addresses selected, right-click to open the pop-up menu and then select any of the 

“Add as TO”, “Add as CC” or “Add as BCC”. 

 

 

③Select 
and 

④Click! 
Add from the 

pull-down 
menu. 

③Right-click 
on e-Parcel ID! 

④Add from 
the pop-up 

menu! 

* To select all e-Parcel ID of 
address list displayed, 
③”Select All” and 
④Add from the pop-up menu! 
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⑤The recipients e-Parcel ID selected will be set in any of the “TO”, “CC” or “BCC” field of the 

“Send Dialog” depending on your choice. 

 

 

 

 

 

 

Tip: There is one more way to set the recipients e-Parcel ID of the Address 

Book into the Send Dialog. Select e-Parcel ID as recipients from the Address 

Book and then drag and drop to any of the “TO”, “CC” or “BCC” fields of the 

Send Dialog. 
*Refer to P224 7. Address Book - 5-1-3. Drag & Drop addresses from Address Book 

 

⑤Confirm to 
add as To! 
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1-1-3. Select from Favorites list 
Using the “Favorites” list of Address Book, the recipients e-Parcel ID added to Address Book can 

be set on the Send Dialog without open Address Book. We recommend that you add recipients 

e-Parcel ID which often send to the “Favorites” list of Address Book. 

For more details about the Address Book, see the section below.  
*Refer to P226 7. Address Book - 5-2. Select from Favorites list 

 

A. The “Favorites” view of VCN-CommCenter GUI 
The e-Parcel ID in the “Favorites” list of Address Book is shown in the “Favorites” view of the 

VCN-CommCenter GUI. You can simply select addresses when send new item without open 

Address Book. 
*By Way A-1 and Way A-2, once e-Parcel ID selected from the “Favorites” view, the Send Dialog 

will automatically open. 
 

Way A-1. 

Double-click an address on the “Favorites” view. You can simply 

add an address as “To” on the Send Dialog. 

(Single choice only & add as To only) 

 

 

Way A-2. 

Right-click on addresses of the “Favorites” view to open the 

pop-up menu. Select any of the menu “Add as TO”, “Add as CC” 

or “Add as BCC”. 

(Multiple choices allowed & add as TO, CC, BCC) 

 

 

 

 

 

 

 

Tip: There is one more way to set the recipients e-Parcel ID of the “Favorites” 

view into the Send Dialog. Select e-Parcel ID as recipients from the “Favorites” 

view and then drag and drop to any of the “TO”, “CC” or “BCC” fields of the 

Send Dialog. 
*Refer to P230 7. Address Book - 5-2-3. Drag & Drop addresses from Favorites 

view on VCN-CommCenter GUI 

 

Way A-1.  
Double-click  
an address! 

Way A-2.  
Right-click on addresses! 

Select from the pop-up menu. 
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B. The “Favorites” list of Send Dialog 
By Way B-1 and Way B-2, the e-Parcel ID in the “Favorites” list of Address Book is shown on the 

Send Dialog. You can simply select addresses when send new item without open Address Book. 

 

 

Way B-1. 

①Right-click on any of the “TO”, “CC” and “BCC” fields on Send Dialog to open the pop-up 

menu.  

 

②Move the cursor to the menu “Select from List”.  
*If the “Select from List” menu is inactive with grayed-out effect, there is no address (e-Parcel 

ID) in the “Favorites” list of Address Book to be shown.  
 

③The e-Parcel ID of the “Favorites” list of Address Book will be shown additionally on the 

pop-up menu. Select an e-Parcel ID as recipient. 

 

 
 

Way B-1. 
①Right-click on 

any of  
TO, CC or BCC  
in Send Dialog! 

 

②Move the cursor 
to this menu! 

③Select a recipient 
from Favorites list!! 
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Way B-2. 

①Double-click the “TO”, “CC”, “BCC” fields (in gray) on the “Send Dialog”.  

A cursor flash up in the “TO”, “CC”, “BCC” input fields (in white) requesting a new recipient 

e-Parcel ID. 

 

 

 

 

②At this point, enter only an initial letter of e-Parcel ID, or click the arrow at the right to open 

the pull-down menu. Addresses (e-Parcel ID) will be shown in order of the “Favorites” list of 

Address Book. Select an e-Parcel ID as a recipient from the “Favorites” list. 

 

 

 

 

 

③The selected e-Parcel ID as a recipient is entered in the “TO”, “CC”, “BCC” input fields. 

 

 

Input field is 
enabled! Way B-2. 

①Double-click 
any of  

TO, CC or BCC 
of Send Dialog! 

 (in gray) 

③Confirm to 
add as To! 

②Enter an initial letter 
OR 

Click the arrow! 
↓ 

Select a recipient from the 
pull-down menu showing 

Favorites list! 
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Edit TO, CC, BCC 
If you want to edit the recipients e-Parcel ID entered into the “TO”, “CC” and “BCC” input fields of 

the “Send Dialog”, Double-click a recipient e-Parcel ID entered into the “TO”, “CC” and “BCC” 

input fields. 

 

 

 

 

 

 
Note: If you want to edit an e-Parcel ID entered, double-click on the “TO”, 

“CC”, ”BCC” input fields. The recipient icon of the “TO”, “CC”, ”BCC” input fields 

will change to the recipient icon with a pencil. 

 

Double-click on the 
“TO” input field! 

↓ 
Edit address! 
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Delete TO, CC, BCC 
To delete the recipients e-Parcel ID entered into the “TO”, “CC” and “BCC” input fields of the 

“Send Dialog”, you can delete the e-Parcel ID entered by either of the following two (2) ways. 

 

A. Press Delete key 
①Select a recipient e-Parcel ID entered into the “TO”, “CC” and “BCC” input fields.  

②Press the <Delete> key on the keyboard. 

 
 

 

 

 

B. Delete from the menu  
①Select a recipient e-Parcel ID entered into the “TO”, “CC” and “BCC” input fields.  

②Right-click to open the pop-up menu. Select the menu “Delete Address”. 

 

 

①Select an address! 

②Press <Delete> key 
on the keyboard. 

①Select an address 
and right-click! 

②Select  
“Delete Address” from 

the pop-up menu! 
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1-2. Enter Subject and Message 
Next, enter a subject and message into the “Subject” and “Message” fields. 

The VCN-CommCenter usually send the message in simple text format by default. When you wish 

to decorate the message with rich text format on the Send Dialog, Option Config can be changed. 
*The “Message decoration with rich text format” function has been provided since e-Parcel VCN-CommCenter 

8.0.8023 (Released in March 2022). When the setting “Sending message decoration (disabled by default)” is 
enabled, the message decoration tool bar is shown additionally at the top of the message box on Send dialog. 
Refer to P174 4. Option Configuration – 12. Sending message decoration with rich text format 

 
 
*[For users of “ID Sharing” function] The “Message decoration with rich text format” function has been provided for 

VCN-CommCenter 8.0 ID Sharing Client interlocked with e-Parcel VCN-AX 6.0 / 5.0.5013 (Released in August 
2022) or later. 
Refer to P102 2. VCN-CommCenter View - 2. Menu Bar - 2-3. Tools - 2-3-5. Register ID Sharing 

 

 

Enter Subject! 

Enter Message! 
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Printing message 
When message is entered on the Send Dialog, you can print it out. 

*The “Message printing” function has been provided since e-Parcel VCN-CommCenter 8.0.8023 (Released in March 
2022). The “Page Setup” and “Print” dialog opens additionally.  

*To modify the page setting for printing message, right-click on the message box and select the “Page Setup” menu. 
The “Page Setup” dialog opens. 
Refer to P79 2. VCN-CommCenter View – Menu Bar - File 2-1-3. Page Setup 

 

To print the message entered on the Send Dialog, right-click on the message box and select the 

“Print” menu. The “Print” dialog opens. 

 

Also, when the “Message decoration with rich text format” function is enabled, click the “Print” 

icon in the message decoration tool bar.  

 

 

 

 Print 
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1-3. Attach Files & Folders 
To attach at least a file or a folder to the “Send Dialog” is required to send an item. When files and 

folders accompany an item, the VCN-CommCenter provides the ability to attach files and folders as 

well as encrypting these attachments with an item. 

To attach single file or multiple files to a new “Send Dialog”, follow the procedure ①～⑥ below. 

 

 

How to attach Files & Folders 
 

1-3-1. Press the button “Select File”, “Select Folder” ⇒ Refer to P311 

To attach files and folders, simply click the tool button “Select File” or “Select Folder” on the Send 

Dialog. 

 

1-3-2. Select from pop-up menu “Select File”, “Select Folder”  ⇒ Refer to P319 

To attach files and folders, right-click on the item box of Send Dialog to open the pop-up menu. 

Then select the menu “Select Files” or “Select Folders” 

 

1-3-3. Drag & Drop to Send Dialog ⇒ Refer to P320 

Drag and drop files and folders directly on the Send Dialog to attach. 

 

1-3-4. Copy & Paste on item box of Send Dialog ⇒ Refer to P321 

Copy and paste files and folders directly on the item box of Send Dialog to attach. 

 

1-3-5. Windows Context menu “Send to” ⇒Refer to P322 

Use Windows context menu (Shortcut menu) to attach both files and folders on the Send Dialog 

at once. Right-click on files and folders to open the context menu (Shortcut menu). Select the 

“Send to” > “e-Parcel Recipient”. 
*Note: This function requires NOT to open the Send Dialog in advance. 
 

1-3-6. Drop on the desktop icon ⇒Refer to P325 

Use Windows desktop icon (Shortcut icon) to attach both files and folders on the Send Dialog at 

once. Drag files and folders on the desktop icon “e-Parcel x.x” to show “+ Open with 

VCN-CommCenter x.x”, and then drop. 
*Note: This function requires NOT to open the Send Dialog in advance. 
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1-3-1. Press the button “Select File” and “Select Folder” 
To attach files and folders to a new “Send Dialog” by the tool button, take the procedure below. 

 

Attach by the “Select File” button 

①Click the “Select File” button on the Send Dialog. 

 

 

 

②The “Select Files” dialog is opened. Locate the folder where you stored the attachment files. 

 

 

Click! 

Locate a storage folder! 
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③Select file(s) and click the “Open” button to attach. (Multiple choices allowed) 

 

 
 

 

 

 

Note: To select multiple files at one time, hold down the <Shift> or <Ctrl> key 

while selecting files by using your mouse button. 

 

Select files! 

Open! 
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④The specified file(s) are attached on the item box of Send Dialog. Confirm to show the “Item 

Name” and “Size” of the file(s) attached. 

 

 

Confirm file(s) 
attached! 
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⑤If you want to add file(s) from other locations, repeat the above operation ①②③ to attach. 

 

 

⑥At this point, it’s ready to send a new item. (Both “To” and attachments required). The “Send” 

button is enabled. To send the attached file(s), simply click the “Send” button on the Send 

Dialog. 

 

 

 

Warning: When click the “Send” button, the application will start the 
preparations for uploading processes. Therefore, carefully note that you must 
NOT move or delete the attached files and folders from the 
destination directory until the Send Dialog close automatically 
(Uploading processes start). If do so, the application must fail in detecting 
the attached files and folders for initializing and encrypting as preparations.  
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Attach by the “Select Folder” button 

①Click the “Select Folder” button on the Send Dialog. 

 

 

 

②The “Select Folders” dialog is opened. Locate the folder where you stored the attachment folders. 

 

 

Click! 

Locate a storage folder! 
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③Select a folder and click the “Select Folder” button to attach. 

 

 

 

 

 

Select a folder! 

Click  
“Select Folder”! 
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④The specified folder is attached on the item box of Send Dialog. Confirm to be show the “Item 

Name” and “Size” of the attached folder. 

 

 

 

 

Caution: It normally ends in a few seconds to attach a folder. However, in the 

case that many files are included in a folder specified as an attachment, it may 

take a long time to calculate the total size of attachments during processing to 

attach. Please wait for a while until a folder icon selected appears on the item 

box of the Send Dialog. 

 

Confirm a folder 
attached! 
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⑤If you want to attach multiple folders from other locations, repeat the above operation ①②③ 

to attach. 

 

 

⑥At this point, it’s ready to send an new item. (Both “To” and attachments specified). The “Send” 

button is enabled. To send the attached folder(s), simply click the “Send” button on the Send 

Dialog. 

 

 

 

Warning: When click the “Send” button, the application will start the 
preparations for sending processes. Therefore, carefully note that you must 
NOT move or delete the attached files and folders from the original 
locations until the Send Dialog automatically close (Sending 
processes start). If do so, the application will fail in detecting the files and 
folders for initializing and encrypting as preparations.  
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1-3-2. Select from pop-up menu “Select Files” and “Select Folders” 
To attach files and folders to a new “Send Dialog” from the menu, take the procedure below. 

 

 

Attach from the “Select Files” menu 

Right-click on the item box of Send Dialog to open the pop-up menu. Click the “Select Files” menu. 

The “Select Files” dialog appears to attach.  

 

 

Attach from the “Select Folders” menu 

Right-click on the item box of Send Dialog to open the pop-up menu. Click the “Select Folders” 

menu. The “Select Folders” dialog appears to attach.  

 

 

 

 

 

①Right-click 
on Item box! 

②Select from the 
pop-up menu! 
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1-3-3. Drag & Drop to Send Dialog 
On the previous of this section, how to attach files or folders each to the Send Dialog has been 

explained. Moreover, here goes to introduce the fore (4) efficient ways to attach both files and 

folders at the same time. The customer can easily and conveniently send a large number of files 

and folders at once by those ways. 

 

Drag & Drop to the Send Dialog to attach 

In your computer, locate and select files and folders from a directory. Drag and drop to the Send 

Dialog directly to attach. The files and folders attached are shown on the item box of Send Dialog. 

Confirm the “Item Name” and “Size” of the attachments. 

 

 

 

①Select  
files & folders 
from a storage 

folder! 

②Drag & Drop 
to Send Dialog! 
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1-3-4. Copy & Paste on item box of Send Dialog 
It is available to copy and paste both files and folders on the item box of Send Dialog at once. 

 

Copy & Paste on the item box of Send Dialog to attach 

In your computer, locate and copy files and folders from a directory. Right-click on the item box of 

Send Dialog to open the pop-up menu, and then select the menu “Paste Items” to attach. The 

files and folders attached are shown on the item box of Send Dialog. Confirm the “Item Name” 

and “Size” of the attachments. 

 

 

 

①Select  
files & folders 
from a storage 
folder, copy! 

②Right-click 
on Item box! 

③Select “Paste Items” 
from the pop-up menu! 
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1-3-5. Context menu “Send to” 
This section will introduce to use Windows context menu (Shortcut menu) to attach both files and 

folders on the Send Dialog at once. 
*Note: This function requires NOT to open the Send Dialog in advance. 

 

Windows Context menu “Send to” > “e-Parcel Recipient” 

In your computer, locate the folder where you stored the attachment files and folders. And then 

select and right-click on the files and folders to open the context menu (Shortcut menu). Select 

the “Send to” > “e-Parcel Recipient” from the pop-up menu. 

 

 

 

 

 

 

①Select items and 
right-click! 

②Select “Send to” from 
the pop-up menu! 

③e-Parcel Recipient! 
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*For only users who have set up multiple e-Parcel ID (client digital certificates) to one 

VCN-CommCenter GUI, the “e-Parcel Sender” dialog opens. Select one e-Parcel ID as a sender 
from the pull-down menu and then click the “OK” button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*If you have set up  
multiple e-Parcel ID  

to one VCN-CommCenter GUI, 
select one ID  

as a “e-Parcel Sender”. 

When selected, 
click OK! 
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The Send Dialog automatically opens. The files and folders attached are shown on the item box 

of Send Dialog. Confirm the “Item Name” and “Size” of the attachments. 

 

 

 

 
Note: In the case that the VCN-CommCenter doesn’t run, first the software will 

automatically get started and then the Send Dialog will open with the attached 

files and folders. 

 

Caution: If the Send Dialog has already opened, this function doesn’t work. 

The selected files and folders are not attached on the existing Send Dialog. 

 

⑤Send Dialog opens 
with the files & folders 

attached. 
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1-3-6. Drop on the desktop icon 
This section will introduce to use Windows desktop icon (Shortcut icon) to attach both files and 

folders on the Send Dialog at once. 
*Note: This function requires NOT to open the Send Dialog in advance. 

 

Drop on the e-Parcel desktop icon 

In your computer, locate the folder where you stored the attachment files and folders. And then 

select and drag the files and folders to the desktop icon “e-Parcel x.x” in your computer. When it 

shows “+ Open with VCN-CommCenter x.x”, drop on it. 

 

 

 

 

 

 

 

 

 

 

+ Open with VCN-CommCenter 8.0  

①Select  
files & folders 
from a storage 

folder! 

②Drag to the 
desktop icon 

“e-Parcel 8.0”! 

③When “+ Open with …” 
shown on the desktop icon,  

Drop! 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

326 
Copyright© e-Parcel Corporation All rights reserved. 

 
*For only users who have set up multiple e-Parcel ID (client digital certificates) to one 

VCN-CommCenter GUI, the “e-Parcel Sender” dialog opens. Select one e-Parcel ID as a sender 
from the pull-down menu and then click the “OK” button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*If you have set up  
multiple e-Parcel ID  

to one VCN-CommCenter GUI, 
select one ID  

as a “e-Parcel Sender”. 

When selected, 
click OK! 
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The Send Dialog automatically opens. The files and folders attached are shown on the item box 

of Send Dialog. Confirm the “Item Name” and “Size” of the attachments. 

 

 

 

 
Note: In the case that the VCN-CommCenter doesn’t run, first the software will 

automatically get started and then the Send Dialog will open with the attached 

files and folders. 

 

Caution: If the Send Dialog has already opened, this function doesn’t work. 

The selected files and folders are not attached on the existing Send Dialog. 

 

⑤Send Dialog opens 
with the files & folders 

attached. 
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1-4. Delete Attachments 
To delete the attached files and folders on the item box of Send Dialog, take either of the following 

two (2) ways before send. 

 

Press Delete key 

On the item box of Send Dialog, select the attached files and folders, and then press the 

<Delete> key on the keyboard. 

 
 

 

 

Delete from the menu 

On the item box of Send Dialog, select the attached files and folders and right-click to open the 

pop-up menu. Select the menu “Delete Items from List”. 

 
 

 

 

Note: To select multiple files at one time, hold down the <Shift> or <Ctrl> key 

while selecting files by using your mouse button. 

 

②Press <Delete> key 
on the keyboard. 

①Select items! 

①Select items and 
right-click! 

②Select “Delete Items” 
from the pop-up menu! 
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1-5. Account 
The “Account” field of the Sent Dialog displays the account information (company name, account 

name, parcel size limit) to which an e-Parcel ID belongs.  

 

 

Default Account 
On the “Account” field, the default account (P152) which has been configured to the User 

Configuration must be displayed. Once an item is sent through the e-Parcel service, this account 

will be charged for the data delivery. 

 

*Only for an e-Parcel ID which belongs to the multiple accounts, it provides you with selecting 
from the pull-down menu. the default account is listed on the top of the pull-down menu. To 
change an account charged on each transmission, select another account from the pull-down 
menu. This change must affect only this data delivery which you open the Send Dialog. When 
the “Account” field is changed, click the “Send” button. 

 

 

Parcel Size Limit 
You can also verify parcel size limit of your account. It displays maximum total data volume of 

attachments a delivery along with account information. (Parcel Size Limit: ○○） 

 

 

 

 

In the case that the account is not assigned the data volume limit a delivery, the “Account” field 

shows (Parcel Size Limit: Unlimited) below. 

 

Default Account 
(Parcel Size Limit a delivery) 
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Total Size 
Total size of the attached files and folders will be displayed at the bottom left corner of the Sent 

Dialog. Total data volume of attachments must be less than or equal to parcel size limit of your 

account. 

 
*Attention: If total data volume of attachments exceeds parcel size limit, the “Send” button will 

be disabled with grayed-out effect. 
 

 

 

 

Default Account 
(Parcel Size Limit a delivery) 

Total Size 
Total volume of files and folders attached. 
（Total size > Parcel size limit: NG to send!） 
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1-6. Send Item 
When you set “TO” field, attach files/folders and enter other fields as necessary on the Send Dialog, 

the “Send” button is enabled. It’s ready for sending a new item. 
*When both the “TO” and “Item (files and/or folders attached)” boxes are entered on the Send 

Dialog, the “Send” button will be enabled (in color). [*Required] 
 

There are the following two (2) ways to send a new item.  

 

Upon clicking the “Send” button, the VCN-CommCenter starts the preparations for uploading 

processes. When the Send Dialog is closed automatically, new entry will be added to outbox on the 

VCN-CommCenter GUI. Then, this item will be encrypted automatically before uploading. You can 

track the delivery status of this item on outbox. 

*Refer to P334 8. Sending - 2. Outbox 

 

 

Warning: After sending operation (click the “Send” button), it should be 

avoided to move or delete the files/folders attached from the original 

storage location in your computer until the Send Dialog is closed 

automatically (until uploading processes started). If do so, application will 

suspend compressing and archiving items as the preparation processes before 

starting to encrypt and upload. 

 

 

Press the “Send” button 

To send a new item, just click the “Send” button on the Send Dialog. 

 

 

Select the “Send” menu 

Right-click on the address box of Send Dialog to open the pop-up menu.  

And then, select the “Send” menu. 

 

 

Caution: Just after sending new items, please be advised you not to exit 
(shutdown) application until the status “Waiting Download” in 
outbox. (*Uploading processes confirmed) 
*For your information, VCN-CommCenter provides the automatic restart function 
(intermission delivery and auto resume function). If you might exit application 
while processing upload (status “Uploading xx%”), it suspends to upload new 
items. However, it will automatically resume to upload new items on re-startup 
application. You don’t need the resend operation. 
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Caution: When both the “TO” and “Item (files and/or folders attached)” boxes 

are entered on the Send Dialog, the “Send” button and menu will be enabled. 

 

Way1 
Click 

“Send” button! 

Way2 
Right-click  

in address box. 
↓ 

Select “Send” from 
the pop-up menu! 
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1-7. Close Send Dialog 
To close the Send Dialog box before send operation, there are the following two (2) ways.  

 

Close by the button 
Click the  Ｘ  button at the top right corner of the Send Dialog. 

 

Close from the menu 

Right-click on the address box of Send Dialog to open the pop-up menu. And then click the menu 

“Close Window”. 

 

 

 

Way1 
Click to close! 

Way2 
Right-click on 
address box. 

↓ 
Select  

“Close Window” 
from  

the pop-up menu! 
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2. Outbox 

The sending items are listed up in Outbox of the VCN-CommCenter GUI. You can view the delivery 

status of sending items (Tracking) in Outbox. 

*Note: You cannot open the files/folders attached from the outbox “Parcel Detail” dialog. 

 

2-1. Display Outbox 
To view the list of sending items on the List view, firstly click the “Outbox” of the tree view at the 

upper-left pane of the VCN-CommCenter GUI.  

 

View 
Outbox! 

The Current Status 

Uploading 
Upon clicking the “Send” button, first an 
item is compressed and encrypted before 
uploading. [Initializing] – [Encrypting xx%] 
 
On the status column of Outbox, when 
encryption has been completed, the current 
status will be updated to [Waiting Upload] – 
[Upload Start] – [Uploading xx%] – [Upload 
Complete]. 
 
When upload confirmed, the current status 
will show [Waiting Download].  
 
*If you want to exit (shutdown) the 

VCN-CommCenter while an item 
uploading, please be advised you to wait 
until upload confirmed. (The status will be 
updated to [Waiting Download].) 

 

Downloading 
[Waiting Download] has been displayed on the 
status column of the Outbox before recipients 
start to download. 
 
On the status column of Outbox, when 
recipients start to download, the current status 
will be updated to [Ready To Download] – 
[Download Start] – [Download Complete]. Just 
after downloaded, an item will be decrypted 
and extracted. 
 
When download confirmed, the current status 
will show [Delivery Confirmed]. 
 
Then, the current status will be updated to 
“Item Opened” when recipients open an item 
and to “Item Moved” when recipients move the 
attachments of an item. 

Date Created 
(Create New) 

*Date & Time when the 
sending processes start. 

To open the 
“Parcel Detail” dialog, 

double-click! 
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2-2. Current Status 
The “Status” column in Outbox will show the current status of sending items.  

*Refer to P481 Appendix 3. Delivery Status 

 

About the “Status” column in Outbox 

The transmission processes are started according as a sender clicks the “Send” button on the Send 

Dialog. At the beginning, data compression completed as the first process for the transmission, the 

Send Dialog automatically closes. Then a new item is recorded in Outbox.  

 

When a new item starts uploading, the “Status” column of Outbox usually makes progress 

through “Initializing” “Encrypting xx %” → “Waiting Upload” → “Upload Start” “Uploading xx%” 

→ “Upload Complete” → “Waiting Download”. 

When upload confirmed, the “Status” column of Outbox will show “Waiting Download”. 

 

 

 

 

When recipients start downloading an item, the “Status” column of Outbox usually makes 

progress through “Waiting Download (Ready To Download)” → “Download Start” → “Download 

Complete” → “Delivery Confirmed”. 

When download confirmed, the “Status” column of Outbox will show “Delivery Confirmed”.  
*In the case of recipients who use the “e-Parcel Service - Web Browser (e-Parcel VCN-Web)" client, 

the last delivery status shows “Download Complete” when downloading processes complete. 
 

When recipients open the Parcel Detail dialog from inbox afterward, the “Status” column will be 

updated to “Item Opened”.  

When recipients move (save) the attachments of an inbox item afterward, the “Status” column will 

be updated to “Item Moved”. 
*When sending to multiple recipients, the “Status” column of outbox will show the latest status of a 

recipient. To view the delivery status of all recipients, double-click on an outbox item to open the 
“Parcel Detail” dialog. 
Refer to P338 8. Sending – 3. Outbox Parcel Detail 

Outbox 
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Caution: Just after sending new items, please be advised you not to exit 
(shutdown) application until the status “Waiting Download” in 
outbox. (*Uploading processes confirmed) 
*For your information, VCN-CommCenter provides the automatic restart function 
(intermission delivery and auto resume function). If you might exit application 
while processing upload (status “Uploading xx%”), it suspends to upload new 
items. However, it will automatically resume to upload new items on re-startup 
application. You don’t need the resend operation. 

 

Caution: When click the “Send” button, the application will start the 
preparations for uploading processes. Usually new items will be encrypted just 
before starting to upload. Carefully note that you must NOT exit (shutdown) the 
VCN-CommCenter while the status “Encrypting xx %” on outbox. If do so, the 
data may corrupt and then it causes delivery error. Please be advised you to 
wait until the status should be “Waiting Download” on outbox. (Uploading 
processes complete) 

 

 

 

Note: When you wish to switch the current view of outbox/inbox to another 

while processing upload/download, please wait a few moments for the 

VCN-CommCenter to complete the processes. 

The status on outbox should be “Waiting Download” when uploading processes 

complete. The status on inbox should be “Delivery Confirmed” when 

downloading processes complete. 

 

Note: In the case that items are sent to e-Parcel ID for the “e-Parcel Secure 

Data Delivery Service - Web Browser (e-Parcel VCN-Web)", the delivery status 

shows “Download Complete” as the last status when recipients have completed 

downloading processes. 

 

 

 

Tip: Make it a habit to track delivery status to ensure that all recipients receive 

your deliveries. 
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2-3. Pop-up menu on outbox items 
To open the pop-up menu, right-click on the items listed in Outbox.  

 

 

 

2-3-1. Open Parcel 
The “Open Parcel” menu will open the “Parcel Detail” dialog. 

*Refer to P338 8. Sending – 3. Outbox Parcel Detail 

 

2-3-2. Resend Selected Parcels 
The “Resend Selected Parcels” menu will resend same item(s) (subject, message, attachments) 
to same recipient(s) within the resend period from date created. This menu will be enabled only 
when you select outbox items which are confirmed to upload (from the status “Waiting 
Download” onward). Once an item(s) has been resent, this menu will be disabled for this outbox 
item(s) with grayed-out effect. 
*This behaves similarly to the menu bar Message > “Resend”. 
*This behaves similarly to the “Resend” button on the outbox Parcel Detail dialog. 
*This behaves similarly to the right-click menu “Resend Selected Parcels” of outbox items. 
*Attention: Items which are canceled to send while encrypting will NOT be able to resend. 
*Attention: On the Option Config (the menu bar “Tools” > “Option”), the “Resend” function 

requires the setting “Enable Resend” to be enabled (set checked: Yes) with initial choice. 
(Default: Enable Resend: Yes / Resend Period: For 14 days) 
Refer to P165 4. Option Configuration - 4. Resend Setting 

 

2-3-3. Delete Selected Parcels 
The “Delete Selected Parcels” menu will delete an item(s) from outbox. This command will be 

enabled only when you select outbox items which are uploaded (from the status “Upload 

Complete” onward). Once an item(s) has been deleted, this item(s) is never restored. 
*This behaves similarly to the menu bar Message > “Delete”. 
*This behaves similarly to the “Delete” button on the tool bar of VCN-CommCenter. 
*For your information: Despite deleting items from inbox/outbox on application, Web pages for 

each user are available to just view the inbox/outbox histories recorded in the e-Parcel server 
for the selected period (until month before last or target date). Launch a computer in which you 
imported the e-Parcel client digital certificate in advance, and then access URL of “The e-Parcel 
Secure Enterprise - Web Browser” at https://secure.e-parcel.ne.jp/. 
Refer to P458 Appendix 1. e-Parcel Secure Enterprise - Web Browser 

①Select items 
and right-click! 

②Select from the 
pop-up menu! 
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3. Outbox Parcel Detail 

The VCN-CommCenter provides the outbox “Parcel Detail” dialog which displays information on the 

details of an item. The “Parcel Detail” dialog contains four (4) tool buttons, item details and the 

progress status of sending items (Tracking).  

*Note: You cannot open the files/folders attached from the outbox “Parcel Detail” dialog. 

 

 

3-1. Open the outbox Parcel Detail 
 

How to open the Parcel Detail dialog in outbox 
There are the following two (2) ways to open the “Parcel Detail” dialog. 

 

Way1. Double-click an outbox item 

Select and double-click an item listed in outbox. The “Parcel Detail” dialog opens. 

 

 

Way2. Right-click on an outbox item 

Right-click on an item listed in outbox to open the pop-up menu. Select the “Open Parcel” menu. 

The “Parcel Detail” dialog opens. 

 

[Outbox] 

 
 

 

 

 

 

 

Way1. 
Double-click! 

Way2. 
①Right-click 
to open the 

pop-up menu! 

②Open Parcel! 
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The Parcel Detail dialog in outbox 
The “Parcel Detail” dialog displays an item detail about your recipient’s e-Parcel ID or name 

(Refer to P171), Date Created, the progress status of recipients (Tracking), account information, 

subject, message, attachments (Files/Folders), and parcel ID.  
*Refer to P174 4. Option Configuration - 12. Sending message decoration with rich text format 

 

 

 

 

 

 

Recipient’s 
e-Parcel ID 
or name 
(P171) 

Parcel ID 
Each parcel is numbered by 
an individual ID automatically 
when sending an item. 

Item Box 
The attached file(s)/Folder(s) are shown. 
*You can not open File(s)/Folder(s) attached 

from this item box. 

Recipient’s 
Progress Status 

(Tracking) 

Create New 
(Date Created) 

*Create New: Sender 
started the sending 
processes for a new item. 

*Only a status “Create New” 
has been displayed until a 
recipient will be notified 
and ready to download. 
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3-2. Tracking Display 
The tracking information can be found in the event view of the outbox “Parcel Detail” dialog, which 

lists the Time Stamp and Progress Status (Tracking) of recipients. The information found here will 

provide you with insight as to who has received, opened, moved, deleted, canceled, and/or aborted 

a delivered item.  

*Refer to P481 Appendix 3. Delivery Status 

 

“Create New”: Only the status “Create New” has been displayed until a recipient will be notified and 

be ready to download. (Date Created) 

*The software of recipients has not started the downloading processes yet.   

 

 

When recipients detect transmission items pending delivery and start the downloading processes, 

the status proceeds to “Waiting Download (Ready To Download)” which is displayed additionally. 

When recipients start downloading items, the status progress through "Waiting Download (Ready 

To Download)" → “Download Start” → “Download Complete” → “Delivery Confirmed”.  

On the event view of the Parcel Detail dialog, the status of the latest line will be automatically 

updated afterward to “Item Opened”, “Item Moved”, “Cancelled”, “Download Aborted”, “Item 

Deleted” and etc. 
*The software of recipients has not confirmed the downloading processes yet before the delivery 

status shows “Download Complete”.  
*In the case of the “e-Parcel Service - Web Browser (e-Parcel VCN-Web)" client as recipients, the 

last delivery status shows “Download Complete” when downloading processes complete. 

 
 

 

Create New 
(Date Created) 

*Create New: Sender started 
the sending processes for a 
new item. 

*Only a status “Create New” 
has been displayed until a 
recipient will be notified and 
be ready to download. 

 

In the case of multiple recipients 
Select one recipient to display 
tracking info to the next event 
window of the Parcel Detail. 

Recipient’s 
Progress Status 

(Tracking) 

“Delivery Confirmed” 
Downloading processes 

successfully done 

Waiting Download 
(Ready To Download) 

*When recipients start, 
Progress Status 

(Tracking) 
will be added. 
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Usually, the Progress Status (Tracking) will be updated by auto polling.  

(Default: 5 minutes polling interval) 

In addition, the “Reload” button on the “Parcel Detail” dialog will promptly refresh the delivery 

status for only that item which you open now. 

*Refer to P345 8. Sending - 3. Outbox Parcel Detail - 3-3. Tool Bar on the outbox Parcel Detail 

 

 

 

 

When recipients open the Parcel Detail dialog from inbox afterward, the “Status” column will be 

updated to “Item Opened”.  

 
 

 

 

 

When recipients move (save) the attachments of an inbox item afterward, the “Status” column will 

be updated to “Item Moved”. 

 
 

 

“Item Opened” 
Recipient opened  

the Parcel Detail dialog  
from inbox. 

“Item Moved” 
Recipient moved 

attachments  
from inbox. 
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Warning: Downloading data must be made within 31 days from the 

date of item sent (item created). After expired, the unreceived items will 

automatically be deleted from the e-Parcel server. Therefore, you can NOT 

download the expired items any longer. Also, the delivery statuses of the 

expired items will be no longer updated. 

 

Warning: After 31 days from the date of item sent (item created), those 

expired items will be excluded from tracking target through the e-Parcel 

service. 

 

 

 

Note: In the case that items are sent to e-Parcel ID for the “e-Parcel Secure 

Data Delivery Service - Web Browser (e-Parcel VCN-Web)", the delivery status 

shows “Download Complete” as the last status when recipients have completed 

downloading processes. 

 

 

 
Tip: Make it a habit to track delivery status to ensure that all recipients receive 

your deliveries. 
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List of Progress Status (Tracking) 
 

The main Progress Statuses (Tracking) of recipients displayed on the event pane of the outbox 

“Parcel Detail” dialog are briefly explained below. 

 

The status with *(asterisk) below will be replaced with the latest delivery status. 

 

 Create New 

Date created of a new item: After clicking the “Send” button by sender, a new item is registered 

with the e-Parcel server to start the sending processes. 
*Attention: Only a status “Create New” has been displayed until a recipient will be notified and 

be ready to download a new item. 
 

 Waiting Download (Ready To Download) 

Recipient is notified and then ready to download a new item. 

 

 Download Start 

Recipient starts to download. 

 

 Downloading xx%* 

Recipient is downloading. 
* The downloading progress of recipient side has been displayed since e-Parcel VCN-CommCenter 7.0.7020 

[Released in August 2018]. (This change doesn't affect use of the existing software ver. 7.0.7019 or earlier.) 

 

 Download Complete 

Recipient just finishes downloading. 

Then, application of recipient is decrypting and extracting an item. (Downloading processed) 
* Attention: Recipients have not confirmed successfully the downloading processes yet until the 

status is shown “Download Complete”.  
 

 Delivery Confirmed* 

The application of recipient has confirmed to download an item with integrity verified. 

(Downloading processes done successfully) 
*In the case that items are sent to e-Parcel ID for the “e-Parcel Secure Data Delivery Service - 

Web Browser (e-Parcel VCN-Web)", the delivery status shows “Download Complete” as the 
last status when recipients have completed downloading processes. 
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 Item Opened* 

Recipient opened an item which the status is “Delivery Confirmed”. (To open the inbox “Parcel 

Detail” dialog.) 

 

 Item Moved* 

Recipient has completed to move the attached files/folders of an item which the status is 

“Delivery Confirmed” or “Item Opened”. 

 

 Cancelled* 

Sender has canceled to send an item which the status must be from “Initializing” to “Delivery 

Confirmed” (Before “Item Opened” or “Item Moved”). 

*Refer to P345 8. Sending - 3. Outbox Parcel Detail - 3-3. Tool Bar on the outbox Parcel Detail 

 

 Download Aborted* 

Recipient has aborted to receive an item which the status must be from ‘’Waiting Download” to 

“Delivery Verifying” (Before “Delivery Confirmed”). 
*Refer to P373 9. Receiving - 3. Inbox Parcel Detail - 3-3. Tool Bar on the inbox Parcel Detail 

 

 Item Deleted* 

Recipient has deleted an inbox item which the status must be “Delivery Confirmed” when an 

item has not been opened or moved yet (Before “Item Opened” or “Item Moved”). 

*Refer to P362 9. Receiving - 2. Inbox - 2-3-3. Delete Selected Parcels 
*Refer to P117 2. VCN-CommCenter View - 3. Tool Bar – 3-6. Delete 
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3-3. Tool Bar on the outbox Parcel Detail 
The tool bar including four (4) buttons is displayed on top of the outbox “Parcel Detail” dialog. 

 

 

The “Resend” button will be enabled only when the status of a sending item is from “Waiting 

Download” onward (After upload confirmed), or “Cancelled”.  

*Attention: An item which is canceled to send while encrypting will NOT be able to resend. 

 

The “Cancel Send” button will only be enabled before an item is opened or moved by recipients. 

 

On the “Parcel Detail” dialog, the “Reload” button will promptly refresh the delivery status for only 

that item which you open now. When you click the “Reload” button, the delivery status of this item 

will be updated to the latest status of each recipient. 

 

 

 

 

 

 

The “Set Priority” button will only be enabled when the status of a sending item is from ‘’Waiting 

Upload” to “Uploading xx %” (Before an item has completed to upload). 

 

 
 

 

 

The “Print” button will open the Print dialog to print message displayed on the Parcel Detail dialog. 

 

Parcel Detail dialog in outbox 
(After uploaded) 

 
Click a button 

on the tool bar! 

Parcel Detail dialog in outbox 
(Before uploaded) 

 
Click a button 

on the tool bar! 
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3-3-1. Resend 
The “Resend” button will be enabled only when you select the outbox items which are confirmed 

to upload (from the status “Waiting Download” onward). 

The “Resend” function is able to resend the same items (subject, message, attachments) to same 

recipients within the resend period from date created. Once the items have been resent, the 

“Resend” button will be disabled for these outbox items with grayed-out effect. 
*This behaves similarly to the menu bar Message > “Resend”. 
*This behaves similarly to the “Resend” button on the tool bar of VCN-CommCenter. 
*This behaves similarly to the right-click menu “Resend Selected Parcels” of outbox items. 
*Attention: Items which are canceled to send while encrypting will NOT be able to resend. 
*Attention: On the Option Config (the menu bar “Tools” > “Option”), the “Resend” function 

requires the setting “Enable Resend” to be enabled (set checked: Yes) with initial choice. 
(Default: Enable Resend: Yes / Resend Period: For 14 days) 
Refer to P165 4. Option Configuration - 4. Resend Setting 
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3-3-2. Cancel Send 
The “Cancel Send” button is enabled only when the status of a sent item is from “Initializing” to 

“Delivery Confirmed”. (Before the status is “Item Opened” or “Item Moved” by recipients.) 

 

 

To cancel a sending item, click the “Cancel Send” button on the tool bar of the outbox “Parcel 

Detail” dialog. 

 
 

 

 

The delivery status of outbox usually makes progress through “Cancel Requested” → 

“Canceling” → “Cancelled” for the cancelling processes. 

When cancelled send successfully, the status field of Outbox will be updated to “Cancelled”. 

Note that it may take a while before “Cancelled” depending on the circumstances of recipients’ 

application. 

When cancelled, an item is deleted from inbox if recipients start to download an item. 
*After cancel requested, it might take a while before an item is cancelled. For example, if 

recipients start to download an item and exit (shutdown) the application, the cancelling 
processes cannot be executed until after recipients start the application. 

 

 

 

 

Click! 

“Cancelled” 
Cancel send 
complete! 
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3-3-3. Set Priority 
The “Set Priority” button will be enabled only when the status of an outgoing item is from 

“Waiting Upload” to “Uploading xx %” (Before an item has been completed to upload).  

The VCN-CommCenter usually starts to upload multiple items in order of date created. However, 

it provides the “Set Priority” function to be able to set priority on outgoing item(s) which you want 

to upload on ahead. 

For example, it enables an urgent file to cut ahead of large volume data while uploading. 

 

How to set priority on an item 

To set priority on an outgoing item, double-click an item to open the “Parcel Detail” dialog in 

outbox. Then click the “Set Priority” button. An outgoing item will start to upload on ahead. The 

delivery status of outbox should make progress through “Waiting Upload” → “Upload Start” → 

“Uploading xx %”.  
*Once an outgoing item has been set priority, the button display will turn to the “Set Normal” 

button on the outbox “Parcel Detail” dialog. 

 

 

[For example] 

①Sender is sending five (5) items in order of date created normally. 

The first and second items show the status “uploading”. 

The later three items show the status “Waiting Upload”. 

At this time, when you wish to upload the fourth item on ahead, double-click the fourth item 

to open the “Parcel Detail” dialog in outbox. 
*The VCN-CommCenter can establish the parallel connection when sending and receiving 

multiple items at the same time.  
 

 

[(Before) Outbox: Uploading in normal order] 

 
 

 

 

When you wish to set priority 
uploading on the 4th item, 

↓ 
①Double-click the 4th item to 

open the outbox “Parcel Detail”. 

The 3rd to 5th 
items: 

“Waiting Upload” 

The 1st & 2nd 
items: 

“Uploading” 
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②The outbox “Parcel Detail” dialog for the fourth item opens. Click the “Set Priority” button. 

 

 

 

 

Once the fourth item has been set priority uploading, this button display will turn to the “Set 

Normal” button on the “Parcel Detail” dialog. 

 

 

 

 

③Close the “Parcel Detail” dialog and then see the items in outbox.  

Confirm that the fourth item is uploading on ahead of other items. The status should proceed 

to “Uploading xx%” upward. 
*The either first or second item is interrupted uploading temporally and the status will return 

to “Waiting Upload”. When the fourth item which set priority has been completed uploading, 
an item which has been interrupted uploading will restart to upload automatically. (The 
different status may be displayed depending on the progress of uploading items.) 

 

[(After) Outbox: Set Priority uploading] 

 

 

 

 

 

*This button is shown 
during Set Priority 

uploading! 

③Close! 

The 4th item: 
Set priority uploading! 

②To set priority, 
Click! 

The 2nd, 3rd, 5th 
items: 

“Waiting Upload” 

The 1st & 4th 
items: 

“Uploading” 
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How to set priority on multiple items 

To set priority on multiple outgoing items, click the “Set Priority” button on the “Parcel Detail” 

dialog in order of priority upload. The outgoing items will start to upload in order of the “Set 

Priority” earlier. 

 

 

 

Set Normal (Reset priority) 

To reset priority on an outgoing item which has been set priority, double-click an item to open the 

“Parcel Detail” dialog in outbox. Then click the “Set Normal” button. Once an outgoing item has 

been reset priority uploading, this button display will return to the “Set Priority” button on the 

“Parcel Detail” dialog. 
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3-3-4. Reload 
On the “Parcel Detail” dialog, the “Reload” button will promptly refresh the delivery status for only 

that item which you open now. 

 

 
*Attention: This function of “Reload” button above on only the Parcel Detail dialog has been changed since e-Parcel 

VCN-CommCenter 7.0.7020 (Released in August 2018). When click the “Reload” button above on only the Parcel 
Detail dialog, the delivery status will be refreshed for only that item.  
(Therefore, note that this must NOT behave like the function of both the menu “File > Reload” and the “Reload” 
button of tool bar on VCN-CommCenter GUI. This “Reload” button above on only the Parcel Detail dialog dose 
NOT promptly checks for any other items pending delivery and track the latest status by polling manually to the 
e-Parcel server.)  
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3-3-5. Print 
To print the message displayed on the Parcel Detail dialog, click the “Print” button. The “Print” 

dialog opens. 
*This behaves similarly to the right-click menu “Print” on the message box of the Parcel Detail 

dialog. 
*The choice of “Print range” provides only “All” on the “Print” dialog. 

 

 
*The “Message printing” function has been provided since e-Parcel VCN-CommCenter 8.0.8023 (Released in March 

2022). The “Page Setup” and “Print” dialog opens additionally.  
*To modify the page setting for printing message, right-click on the message box and select the “Page Setup” menu. 

The “Page Setup” dialog opens. 
Refer to P79 2. VCN-CommCenter View – Menu Bar - File 2-1-3. Page Setup 

 

 
 

 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

353 
Copyright© e-Parcel Corporation All rights reserved. 

 

3-3-6. Error Detail 
The “Error Detail” button will only be displayed when an error occurs while sending an item. Upon 

the “Error Detail” button, the “Error Detail” dialog opens. This dialog provides the valuable error 

messages, such as the following case, for example. 

 

 

 

Example of what is applicable in a certain case: “Unknown Recipient” 
 

 

 

 

For example, if the delivery status “Unknown Recipient” is shown in outbox, these outbox items 

have been failed in sending to all recipients. 

 

For your information, in this error case, to investigate what caused it to be error, the two types of 

error messages could be found from the “Error Detail” button below on the Parcel Detail dialog in 

outbox. 

 

Refer to the following two “Error Detail” dialogs. 
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Error Detail 1: Cause of the status "Unknown Recipient" in outbox 

Recipients e-Parcel ID have not completed the software installation yet. 
You may input the e-Parcel ID as recipients who have not completed the software installation yet 
despite the registered e-Parcel ID. When the delivery status shows “Unknown Recipient” in 
outbox, these outbox items have been failed in sending to all recipients.  
 
Solution: 
Please contact recipients to ask the software installation. When you confirmed all recipients to 
complete the software installation, try to send items again.  

 

[Parcel Detail dialog in outbox]  

 

①Click! 

②Error Detail 
Carefully read the 
error message! 
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Error Detail 2: Cause of the status "Unknown Recipient" in outbox 

Recipients e-Parcel ID are not registered with the e-Parcel service. 
You may input the e-Parcel ID as recipients who are not registered with the e-Parcel service. Also, 
you may misspell the e-Parcel ID in the Send Dialog. When the delivery status shows “Unknown 
Recipient” in outbox, these outbox items have been failed in sending to all recipients.  
 
Solution: 
Confirm whether you entered the unregistered or invalid e-Parcel ID (including misspelled ID). 
If e-Parcel ID is not registered with the e-Parcel service, would you please consult your 
company's administrator or our customer support about e-Parcel ID registration?  

 

[Parcel Detail dialog in outbox] 

 

①Click! 

②Error Detail 
Carefully read the 
error message! 
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3-4. Close the outbox Parcel Detail 
To close dialog, click the  Ｘ  button at the top right corner of the “Parcel Detail” dialog. 

 

 

 

 

To close, 
Click! 
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９．Receiving 

To receive items through the e-Parcel, start the application; VCN-CommCenter. The e-Parcel icon 

appears in Windows taskbar notification area. 

 

This section explains the steps to move attachments, view Inbox, operate the Parcel Detail dialog in 

inbox and etc. on the VCN-CommCenter GUI in detail. 

 

1. Receiving Item 

The VCN-CommCenter automatically starts to receive (download) items without 

operation by recipient while the application is running to be online status. 

 

After just close the window to run the application as background application (the  e-Parcel icon 

appears in Windows taskbar notification area), the VCN-CommCenter can starts to receive items 

automatically. 

*Refer to P169 4. Option Configuration – 7. Background Application 

 

If the e-Parcel VCN-CommCenter is shutdown (Exit), to start the e-Parcel VCN-CommCenter, 

double-click the “e-Parcel x.x” shortcut icon on the desktop or select “e-Parcel” from Windows “Start” 

menu. The incoming items will get started to download upon starting the VCN-CommCenter. 
*Refer to P70 2. VCN-CommCenter View – 1. Start/Exit/Open/Close the VCN-CommCenter 
 

Inbox of the VCN-CommCenter GUI will show the delivery status of the receiving items. 

*Refer to P358 9. Receiving – 2. Inbox 

 

When Inbox of the VCN-CommCenter GUI will show the delivery status “Delivery Confirmed”, it is 

available to open and move (save) the attached files and folders on the inbox Parcel Detail dialog. 
*Refer to P366 8. Receiving - 3. Inbox Parcel Detail - 3-2. Move Attached Files (Save) 
 

 

Warning: Downloading data must be made within 31 days from the 

date of item sent (item created). After expired, the unreceived items will 

automatically be deleted from the e-Parcel server. Therefore, you can NOT 

download the expired items any longer. Also, the delivery statuses of the 

expired items will be no longer updated. 

９ 
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2. Inbox 

The receiving items are listed up in Inbox of the VCN-CommCenter GUI. You can open the “Parcel 

Detail” dialog to move (save) the files/folders attached from inbox. Also, you can view the delivery 

status of receiving items. 

*Once item moved, you no longer open the files/folders on the inbox “Parcel Detail” dialog. 

 

2-1. Display Inbox 
To view the list of receiving items on the List view, firstly click the “Inbox” of the tree view at the  

upper-left pane of the VCN-CommCenter GUI. 

 

View 
Inbox 

Timing to start downloading 
When auto polling to the e-Parcel server, the 
VCN-CommCenter will automatically start the 
downloading processes for items. 
(When clicking the “reload” button, it’s also 
promptly polling.) 
 
Once an item has been confirmed to download 
with integrity verified, the current status will 
show [Delivery Confirmed]. 
 
* If you want to exit (shutdown) the 

VCN-CommCenter while an item 
downloading, please be advised you to wait 
until download confirmed. (The status will be 
updated to [Delivery Confirmed]. 

Downloading 
When download notified at the VCN-CommCenter, the 
status column of Inbox shows [Waiting Download]. 
 
Then, it gets started to download an item, the current 
status will be updated to [Download Start] – 
[Downloading xx%]. Just after [Download Complete], it 
proceeds to decryption [Decrypting xx%], extract 
[Extracting xx%] and [Delivery Verifying] processes.  
 
When download confirmed, the current status will show 
[Delivery Confirmed]. 
 
Subsequently, the current status will be updated to “Item 
Opened” when recipients open an item, and to “Item 
Moved” when recipients move the attachments of an item. 

The Current Status 

Date Created 
(Create New) 

*Date & Time when the 
sending processes start. 

To open the 
“Parcel Detail” dialog, 

double-click! 
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2-2. Current Status 
The “Status” column in Inbox will show the current status of receiving items. 

*Refer to P481 Appendix 3. Delivery Status 

 

About the “Status” column in Inbox 

Whenever the application on recipient site is periodically polling to the e-Parcel server and then it 

detects new incoming items, the VCN-CommCenter automatically starts to work the downloading 

processes. 

*Refer to P164 4. Option Configuration - 3. Polling Interval (Default: 5 minutes) 

 

When the application on recipient site starts the downloading processes, it will be ready 

to download new items. The “Status” column of Inbox shows “Waiting Download (Waiting 

Process)” → "Waiting Download (Ready To Download)".  

Then, it gets started to download items. The current status will be updated to “Download Start” → 

“Downloading xx %”; the download percentage progresses.  

 

Soon after “Download Complete” (just downloaded), items will be decrypted, extracted and verified. 

The “Status” column of Inbox will progress through “Decrypting xx %” → “Extracting xx %” → 

“Delivery Verifying”; integrity of downloaded items must be verified. 

 

 

 

When the application on recipient site ends the downloading processes, the “Status” 

column of Inbox will show “Delivery Confirmed”. The delivered items have been confirmed to 

download with integrity verified. 

When recipients open the Parcel Detail dialog from inbox afterward, the “Status” column will be 

updated to “Item Opened”.  

When recipients move (save) the attachments of an inbox item afterward, the “Status” column will 

be updated to “Item Moved”. 

Inbox 
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Warning: Downloading data must be made within 31 days from the 

date of item sent (item created). After expired, the unreceived items will 

automatically be deleted from the e-Parcel server. Therefore, you can NOT 

download the expired items any longer. Also, the delivery statuses of the 

expired items will be no longer updated. 

 

 

 

Caution: Just after starting to download items, please be advised you not 

to exit (shutdown) application until the status “Delivery Confirmed” 

in inbox. (*Downloading processes confirmed) 
*For your information, VCN-CommCenter provides the automatic restart function 
(intermission delivery and auto resume function). If you might exit application 
while processing download (status “Downloading xx%”), it suspends to download 
items. However, it will automatically resume to download items on re-startup 
application. 

 

Caution: Normally, just after the status “Download Complete” displayed, 

VCN-CommCenter will proceed to decrypt and extract an item. Therefore, 

please wait until the status “Delivery Confirmed” in inbox. Note that you should 

not to exit (shutdown) application while the status “Decrypting xx %” and 

“Extracting xx %” in inbox. If do so, it may cause to be data corruption. 

 

 

 

Note: When you wish to switch the current view of outbox/inbox to another 

while processing upload/download, please wait a few moments for the 

VCN-CommCenter to complete the processes. 

The status on outbox should be “Waiting Download” when uploading processes 

complete. The status on inbox should be “Delivery Confirmed” when 

downloading processes complete. 

 

Note: In the case that items are sent to e-Parcel ID for the “e-Parcel Secure 

Data Delivery Service - Web Browser (e-Parcel VCN-Web)", the delivery status 

shows “Download Complete” as the last status when recipients have completed 

downloading processes. 
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2-3. Pop-up menu on inbox items 
To open the pop-up menu, right-click on the items listed in Inbox.  

 

 

 

 

 

 

Open Parcel 
The “Open Parcel” menu will open the “Parcel Detail” dialog. 

*Refer to P363 9. Receiving - 3. Inbox Parcel Detail 

 

 

 

Move Attached Files 
The “Move Attached Files” menu will move (save) the attached file(s)/folder(s) to a directory 

where you specify. This menu will be enabled only when the attached file(s)/folder(s) has not 

been moved yet (The status “Delivery Confirmed” or “Item Opened”). Once attachments have 

been moved (The status “Item Moved”), this menu will be disabled (grayed-out effect). 
*Refer to P366 9. Receiving - 3. Inbox Parcel Detail - 3-2. Move Attached Files (Save) 

 

 

①Select items 
and right-click! 

②Select from the 
pop-up menu! 
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Delete Selected Parcels 
The “Delete Selected Parcels” menu will delete an item(s) from inbox. This command will be 

enabled only when you select inbox items which are confirmed to download (from the status 

“Delivery Confirmed” onward). Once an item(s) has been deleted, this item(s) is never restored. 
*When recipient delete an inbox item “Delivery Confirmed” (which has not been opened or 

moved yet), the status of a sender’s outbox will be updated to “Item Deleted”. 
*This behaves similarly to the menu bar Message > “Delete”. 
*This behaves similarly to the “Delete” button on the tool bar of VCN-CommCenter. 
*For your information: Despite deleting items from inbox/outbox on application, Web pages for 

each user are available to just view the inbox/outbox histories recorded in the e-Parcel server 
for the selected period (until month before last or target date). Launch a computer in which you 
imported the e-Parcel client digital certificate in advance, and then access URL of “The e-Parcel 
Secure Enterprise - Web Browser” at https://secure.e-parcel.ne.jp/. 
Refer to P458 Appendix 1. e-Parcel Secure Enterprise - Web Browser  

 

 

Warning: If the attached files/folders have not been moved from 

inbox yet (the status is “Delivery Confirmed” or “Item Opened”.), upon 

clicking the “Delete” menu/button, the attached files/folders promptly 

are also deleted at the same time. Therefore, please be advised you to 

move (save) the attached files/folders from inbox before operation “Delete”. 
*Refer to P366 9. Receiving - 3. Inbox Parcel Detail - 3-2. Move Attached Files(Save) 

 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

363 
Copyright© e-Parcel Corporation All rights reserved. 

 

3. Inbox Parcel Detail 

The VCN-CommCenter provides the inbox “Parcel Detail” dialog which displays information on the 

details of an item. The “Parcel Detail” dialog functions as the secure message viewer. Also, you can 

operate to move (save) the files/folders attached from inbox.  

*Once item moved, you no longer open the files/folders on the inbox “Parcel Detail” dialog. 

 

 

3-1. Open the inbox Parcel Detail 
 

How to open the Parcel Detail dialog in inbox 
There are the following two (2) ways to open the “Parcel Detail” dialog. 

 

Way1. Double-click an inbox item 

Select and double-click an item listed in inbox. The “Parcel Detail” dialog opens. 

 

 

Way2. Right-click on an inbox item 

Right-click on an item listed in inbox to open the pop-up menu. Select the “Open Parcel” menu. 

The “Parcel Detail” dialog opens. 

 

[Inbox] 

 

 

 

 

 

 

Way1. 
Double-click! 

Way2. 
①Right-click 
to open the 

pop-up menu! 

②Open Parcel! 
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The Parcel Detail dialog in inbox 
The “Parcel Detail” dialog displays an item detail about recipient’s e-Parcel ID or name (Refer to 

P171), sending information (sender e-Parcel ID and name, upload status, size, date created), 

receiving progress, account, subject, message, attachments (Files/Folders) and parcel ID.  
*Refer to P175 4. Option Configuration - 12. Sending message decoration with rich text format - About the text 

format of receiving message in inbox items 

 

 

 

 

 

Received Item Box 
The attached file(s)/Folder(s) are shown. 
*Note: After delivery confirmed, attachments 

icons will appear on the inbox Parcel Detail 
dialog. 

*The colored icons: not moved files yet 
*Grayed-out icons: already moved files 
*Once items moved, you can not open the 

files/folders attached from inbox. 

Recipient’s 
e-Parcel ID 
or name 
(P171) 

Receiving Progress 
on Inbox 

Timestamp of “Waiting Download” 
Timestamp of “Delivery Confirmed” 

*Accepted: Recipient started the 
receiving processes for a new item. 

*Confirmed: Recipient confirmed to 
receive a new item with integrity 
verified. 

 

Sending information 
Sender info 

Upload Status 
*Created: Sender 

started the sending 
processes for a 
new item. 

Parcel ID 
Each parcel is numbered by 
an individual ID automatically 
when sending an item. 
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Sending Information 

The “Parcel Detail” dialog displays the sending information. 

 (sender e-Parcel ID and name, upload status, data size of attachments, date created) 

 

Upload Status：The uploading progress of sender side is displayed such as the status “Upload 

Start” → “Uploading xx %” → “Uploaded”.  

(*The status “Upload Interrupted” may be shown when download aborted by 
recipient while sender is uploading an item. etc. depending on progress.) 

*The “Status” display has been changed to the “Upload Status” since e-Parcel VCN-CommCenter 7.0.7020 
[Released in August 2018]. (This change doesn't affect use of the existing software ver. 7.0.7019 or earlier.) 

 

Created：After clicking the “Send” button by sender, a new item is registered with the e-Parcel 

server to start the sending processes. 

 

Receiving Progress 
Accepted：The application of recipient detects new incoming items in the e-Parcel server. (Status: 

“Waiting Download”) Then, it will be ready to download. The application of recipient 

automatically will start the downloading processes. 

 

Confirmed：The application of recipient has confirmed to download when the integrity of a 

received item has been verified. (Status: “Delivery Confirmed”) 

 

*Refer to P481 Appendix 3. Delivery Status 

 

When recipients open the Parcel Detail dialog from inbox, the status “Delivery Confirmed” will 

proceed to “Item Opened”.  

 

[Inbox: Before open the “Parcel Detail” dialog] 

 
↓ 

[Inbox: After open the “Parcel Detail” dialog] 
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3-2. Move Attached Files (Save) 
 

The item box on the inbox Parcel Detail dialog 

When delivery confirmed, the attached file(s) and/or folder(s) icons are displayed in the item box 

on the inbox “Parcel Detail” dialog. You can open or move (save) the attached file(s) and/or 

folder(s). 

 

 

Caution: The color icons of attached file(s)/Folder(s) must be shown 

after items have been confirmed to download (from the status 

“Delivery Confirmed” onward). If the attached file(s)/Folder(s) have not 

been moved yet (The status should be “Delivery Confirmed” or “Item 

Opened”.), please be advised that you move (save) the attachments from inbox 

to a destination folder specified. 

 

 

 

[Parcel Detail: Before moving the attachments (Status: “Delivery Confirmed” or “Item Opened”)] 

 

 

 

Display before moving 
Attachments icon is displayed in color. 
Open file: OK 
Move file: OK 

Before the file(s)/folder(s) 
have been moved, 
double-click the 

file(s)/folder(s) icon to 
open. 
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[Parcel Detail: After moving the attachments (Status: “Item Moved”)] 

 

 

 

 

 

 

 

 

Display after moving 
Attachments icon is turned gray in color. 
Open file: NG 
Move file: NG 

After the file(s)/folder(s) have 
been moved, if double-clicking 
the disabled icon, it displays 
the information “Files/folders 
are already moved.” at the 
bottom left corner of the 

“Parcel Detail” dialog in inbox. 



e-Parcel VCN-CommCenter 8.0 Users Manual EN                                                     EP-PM-MN-0383 

           
 

368 
Copyright© e-Parcel Corporation All rights reserved. 

 

How to move (save) the attached files/folders 
 

The “Move File” tool button on the inbox Parcel Detail dialog 

When the attached file(s)/Folder(s) of items have not been moved (saved) yet from inbox (the 

status “Delivery Conformed” and “Item Opened”), the “Move File” button is enabled on the tool 

bar of the inbox Parcel Detail dialog. Once the attachments have been moved to save in a 

destination folder, this button will be disabled (grayed-out effect). 

 

For more details about move (save) the attached files and folders from inbox, see the next page. 
*This behaves similarly to the right-click menu “Move Attached Files” of inbox items. 

 
 

 

Caution: Note that the “Move File” operation is effective only once. 

The operation “Move File” is available during the button is enabled in color. 

When you have moved the attached file(s) and/or folder(s), this button will 

be disabled (grayed-out effect). Because those are no longer stored in the 

e-Parcel system folder. 

 

Caution: When you want to forward the attachment(s) from Inbox, please 

be advised you to forward the attachment(s) before moved.  

If you click the “Forward” button after moved the attached attachment(s), the 

“Send Dialog” for forwarding will open without attachment(s). You can no 

longer forward the attachment(s) from Inbox. (You need to reattach 

files/folders from a specified destination directory where you have moved to.) 

 

Caution: On the “Option Config”, the checkbox “Allow overwrite…” 

has been checked as default setting. When you move file, it will 

overwrite the existing file of same name in a specified destination directory. 

When unchecked in the checkbox “Allow overwrite…”, the application not to 

allow overwrite. If at least one file of same name (same relative path) has 

already existed in a destination directory where is specified to move the 

attachments, it will NOT overwrite a file of same name and show the “Error 

Detail” dialog when you click the “Move File” button. All attachments will NOT 

be moved to a specified destination directory. 

（The Option Configuration (Default): Allow overwrite）  
*Refer to P167. 4. Option Configuration - 5. Overwrite setting when moving files 
(Default: Allow overwrite when move files) 
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Move (save) the attached files and folders 
To move the attached file(s) / folder(s) from Inbox, follow the procedures ①～③ below. 

 

①Select an item (the status “Delivery Confirmed” or “Item Opened”) in Inbox, and double-click 

to open it. 

 
 

②On the inbox “Parcel Detail” dialog, click the “Move File” button on the tool bar. 

 

Click! 

Item Box 
Before moved, 

attachments icons are 
displayed in color. 

Move: OK 

Double-click! 
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③The dialog opens to brows a directory. It's prompting you to select a destination directory for 

moving (saving) the attachments. When selected, click the “Select Folder” button to start 

moving. 

 
 

 

 

 

Wait while the attached files and folders are being moved (saved) to the specified destination 

directory. 
*Wait for a while. It may take several minutes for moving large volume attachments to the 

specified destination directory.   

 
 

Select a destination 
folder to move 

(save)! Select Folder to 
start moving! 
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④When a file(s)/folder(s) has been completed to move, the “Move File” button and the 

attachments icon will be disabled (grayed-out effect) on the inbox “Parcel Detail” dialog. The 

“Move File” operation is effective only once. 
*Once you have moved the attached file(s) and/or folder(s), it is no longer attached to an item 

in Inbox. The attached file(s) and/or folder(s) have been moved from the location “Data 
Storage Path” to a destination directory assigned. Therefore, you can no longer open and 
move the attachment(s) of an item from Inbox. 

*Refer to P154 3. User Configuration - 7. Data Storage Path 
 

 

 

 

This button is 
disabled after 

moved. 

Item Box 
After moved, 

attachments icons are 
disabled. 

(grayed-out effect) 
Move: Complete! 

To close, 
Click! 
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Also, when the attachments have been completed to move, the status of an item will be 

updated from “Delivery Confirmed” or “Item Opened” to “Item Moved”. 

 

 

 [Inbox: Before move the attachments] 

 
 

↓ 

 

 [Inbox: After move the attachments] 
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3-3. Tool Bar on the inbox Parcel Detail 
The tool bar including four (4) buttons is displayed on top of the inbox “Parcel Detail” dialog. 

 

Before the status “Delivery Confirmed” in inbox 

While the status “Waiting Download” to “Delivery Verifying” (Before to be “Delivery Confirmed”) in 

inbox, the buttons “Abort Receive”, “Set Priority” and “Reload” button will be shown on the tool bar 

of the inbox “Parcel Detail” dialog.  
 
The “Abort Receive” button will be enabled only until “Delivery Verifying” (Before “Delivery 

Confirmed”).  
 
The “Set Priority” button will be enabled only until “Downloading xx %” (Before “Download 

Complete”). 
 
On the “Parcel Detail” dialog, the “Reload” button will promptly refresh the delivery status for only 

that item which you open now. When you click the “Reload” button, the delivery status of this item 

will be updated to the latest status.  

 
 

 

 

 

After the status “Delivery Confirmed” in inbox 

When items have been confirmed to download with integrity verified (After to be “Delivery 

Confirmed” onward) in inbox, the buttons “Move File”, “Reply”, “Reply All” and “Forward” will be 

shown on the tool bar of the inbox “Parcel Detail” dialog. 
*Attention: Once the attachments have been moved to save in a specified directory, the “Move File” 

button will be disabled (grayed-out effect). 

 
 

 

 

The “Print” button will open the Print dialog to print message displayed on the Parcel Detail dialog. 

Parcel Detail dialog in inbox 
(Before “Delivery Confirmed”) 

 
Click a button 

on the tool bar! 

Parcel Detail dialog in inbox 
(After “Delivery Confirmed”) 

 
Click a button 

on the tool bar! 
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3-3-1. Move File 
The “Move File” button provides to move (save) the attached file(s)/folder(s) to a preferred 

location from Inbox. The “Move File” button is enabled only when the attachments accompany an 

item (The status “Delivery Confirmed” or “Item Opened”). Once a file(s)/folder(s) has been 

moved (The status “Item Moved”), this button will be disabled (grayed-out effect). For more 

details about move file, see the section below. 
*Refer to P366 9. Receiving - 3. Inbox Parcel Detail - 3-2. Move Attached Files (Save) 
*This behaves similarly to the right-click menu “Move Attached Files” of inbox items. 

 

 

 

 

3-3-2. Reply 
The “Reply” button will be enabled only when an item has been confirmed to download (after the 

status “Delivery Confirmed” onward). When you want to respond to a sender, simply click the 

“Reply” button. The “Send Dialog” box will open with the original message.  
*This behaves similarly to the menu bar Message > “Reply”. 
*This behaves similarly to the “Reply” button on the tool bar of VCN-CommCenter. 

 

 

 

 

3-3-3. Reply All 
The “Reply All” button will be enabled only when an item has been confirmed to download (after 

the status “Delivery Confirmed” onward). When you want to respond to not only a sender but 

also all e-Parcel ID including TO, CC recipients, simply click the “Reply All” button. The “Send 

Dialog” box will open with the original message.  
*This behaves similarly to the menu bar Message > “Reply All”. 
*This behaves similarly to the “Reply All” button on the tool bar of VCN-CommCenter. 
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3-3-4. Forward 
The “Forward” button will be enabled only when an item has been confirmed to download (after 

the status “Delivery Confirmed” onward). When you want to forward an item to other recipients, 

simply click the “Forward” button. The “Send Dialog” box will open with the original message. 

Enter e-Parcel ID of recipients to forward. 
*This behaves similarly to the menu bar Message > “Forward”. 
*This behaves similarly to the “Forward” button on the tool bar of VCN-CommCenter. 

 

 

 

Caution: When you want to forward the attachments from inbox, please be 

advised you to forward the attachments before operation “Move File”.  

Once you have moved the attached files and folders (“Item Moved”), upon 

clicking the “Forward” button, the “Send Dialog” for forwarding will open 

without attachments. You can no longer forward these attachments from inbox. 

(When forwarding inbox items, if attachments already have been moved, attach 

files and folders saved in a destination directory specified.) 
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3-3-5. Abort Receive 
The “Abort Receive” button will be enabled only when the status of incoming items are from 

"Waiting Download (Ready To Download)" to “Delivery Verifying”. (Before “Delivery Confirmed”) 

 

 

For example, when a recipient does not wish to receive a large volume data in processing 

download, a recipient can abort an incoming item. In this case, open the “Parcel Detail” dialog 

from inbox and simply click the “Abort Receive” button. Once an incoming item has been aborted 

to download, the status will be updated to “Download Aborted”. 

 

 

Caution: Once you have aborted an item on inbox, this item is no 

longer downloaded. If you need it, you must ask a sender to resend. 

Therefore, please carefully remind that before you click the “Abort Receive” 

button. 

 

 

[Parcel Detail dialog in inbox] 

 
 

 

 

[Inbox] 

 

 

 

Abort Receive! 

Download Aborted! 
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3-3-6. Set Priority 
The “Set Priority” button will be enabled only when the status of an incoming item is from 

"Waiting Download (Ready To Download)" to “Downloading xx %” (Before an item has been 

completed to download).  

The VCN-CommCenter usually starts to download multiple items in order of incoming earlier. 

However, it provides the “Set Priority” function to be able to set priority on incoming item(s) 

which you want to download on ahead. 

For example, it enables an urgent file to cut ahead of the large volume data while downloading. 

 

How to set priority on an item 

To set priority on an incoming item, on Inbox, double-click an item to open the “Parcel Detail” 

dialog in inbox. Then click the “Set Priority” button. An incoming item will start to download on 

ahead. The delivery status of inbox should make progress through "Waiting Download (Ready To 

Download)" → “Download Start” → “Downloading xx %”.  
*Once an incoming item has been set priority, the button display will turn to the “Set Normal” 
button on the inbox “Parcel Detail” dialog. 

 

 

[For example] 

 ①Recipient is receiving five (5) items in order of incoming earlier normally. 

The first and second items show the status “downloading”. 

The later three items show the status "Waiting Download (Ready To Download)". 

At this time, when you wish to download the fourth item on ahead, double-click the fourth 

item to open the “Parcel Detail” dialog in inbox. 
*The VCN-CommCenter can establish the parallel connection when sending and receiving 

multiple items at the same time.  
 

[(Before) Inbox: Downloading in normal order] 

 
 

 

 

When you wish to set priority 
downloading on the 4th item, 

↓ 
①Double-click the 4th item to 
open the inbox “Parcel Detail”. 

The 3rd to 5th items: 
“Waiting Download” 

(Ready To Download) 

The 1st & 2nd 
items: 

“Downloading” 
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②The inbox “Parcel Detail” dialog for the fourth item opens. Click the “Set Priority” button. 

 

 

 

 

Once the fourth item has been set priority downloading, this button display will turn to the 

“Set Normal” button on the “Parcel Detail” dialog. 

 

 

 

 

③Close the “Parcel Detail” dialog and then see the items in inbox.  

Confirm that the fourth item is downloading on ahead of other items. The status should 

proceed to “Downloading xx%” upward. 
*The either first or second item is interrupted downloading temporally and the status will 

return to "Waiting Download (Ready To Download)". When the fourth item has been 
completed downloading, an item which has been interrupted downloading will restart to 
download automatically. (The different status may be displayed depending on the progress 
of downloading items.) 

 

 

[(After) Inbox: Set Priority downloading] 

 

 

 

 

 

②To set priority, 
Click! 

*This button is shown 
during Set Priority 

downloading! 

③Close! 

The 4th item: 
Set priority downloading! 

The 2nd, 3rd, 5th items: 
“Waiting Download” 

(Ready To Download) 

The 1st & 4th 
items: 

“Downloading” 
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How to set priority on multiple items 

To set priority on multiple incoming items, click the “Set Priority” button on the “Parcel Detail” 

dialog in order of priority download. The incoming items will start to download in order of the “Set 

Priority” earlier. 

 

 

 

Set Normal (Reset priority) 

To reset priority on an incoming item which has been set priority, double-click an item to open the 

“Parcel Detail” dialog in inbox. Then click the “Set Normal” button. Once an incoming item has 

been reset priority downloading, this button display will return to the “Set Priority” button on the 

“Parcel Detail” dialog. 
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3-3-7. Reload 
The “Reload” button is enabled only when the status of an incoming item is from "Waiting 

Download (Ready To Download)" to “Delivery Verifying”. (Before “Delivery Confirmed”) 

On the “Parcel Detail” dialog, the “Reload” button will promptly refresh the delivery status for only 

that item which you open now. 

 

 
*Attention: This function of “Reload” button above on only the Parcel Detail dialog has been changed since e-Parcel 

VCN-CommCenter 7.0.7020 (Released in August 2018). When click the “Reload” button above on only the Parcel 
Detail dialog, the delivery status will be refreshed for only that item.  
(Therefore, note that this must NOT behave like the function of both the menu “File > Reload” and the “Reload” 
button of tool bar on VCN-CommCenter GUI. This “Reload” button above on only the Parcel Detail dialog dose 
NOT promptly checks for any other items pending delivery and track the latest status by polling manually to the 
e-Parcel server.)  
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3-3-8. Print 
To print the message displayed on the Parcel Detail dialog, click the “Print” button. The “Print” 

dialog opens. 
*This behaves similarly to the right-click menu “Print” on the message box of the Parcel Detail 

dialog. 
*The choice of “Print range” provides only “All” on the “Print” dialog. 

 

 
*The “Message printing” function has been provided since e-Parcel VCN-CommCenter 8.0.8023 (Released in March 

2022). The “Page Setup” and “Print” dialog opens additionally.  
*To modify the page setting for printing message, right-click on the message box and select the “Page Setup” menu. 

The “Page Setup” dialog opens. 
Refer to P79 2. VCN-CommCenter View – Menu Bar - File 2-1-3. Page Setup 
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3-3-9. Error Detail 
The “Error Detail” button will only be displayed when an error occurs while receiving an item. 

Upon the “Error Detail” button, the “Error Detail” dialog opens. This dialog provides valuable error 

messages, such as the following case, for example. 

 

 

Example of what is applicable in a certain case: “Delivery Error” 
 

 

 

If the status “Delivery Error” has been shown in inbox, this item failed in reception. In this 

situation happened, it may be difficult to investigate what caused it to be error. Therefore, the 

causes are considered by many situations such as computer, hardware, network environment, 

human operation error and etc. Accordingly, reception of this item is no longer possible. 

 

For example, the e-Parcel secure data delivery service provides that the pretender is prevented 

strongly using the automatic operation of mutual recognition between the server and a client. 

The e-Parcel server usually authenticates the validity of user. Therefore, one e-Parcel ID must be 

set up to the e-Parcel client software in only one computer. (Multiple computers are invalidated) 

In addition, on the e-Parcel client software, items usually are encrypted just before uploading at 

sender side. Also, items usually are decrypted and extracted just after downloaded at recipient 

side. (It usually takes few seconds to encrypt, decrypt and extract small-volume data (xx MB). 

However large-volume data may take longer than usual depending on data volume and PC spec.) 

 

If you change and migrate the previous histories to new PC while the status “downloading xx %” 

at recipient side, an error may be detected while verifying integrity. This item fails in decrypting, 

and then shows the status “Delivery Error”.  

 

For your information, in this error case, the error message could be found from the “Error Detail” 

button below on the Parcel Detail dialog in inbox. 
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Solution: 

In the case of the status “Delivery Error” shown in inbox, we are afraid that you must ask a 

sender to create new item again. A sender must operate to click the “Create New” button and 

then reattach same files/folders on the Send Dialog. 

(Attention: Don’t ask a sender to click the “Resend” button when sending same items under this 

situation happened.) 

 

[Parcel Detail dialog in inbox] 

 

 

①Click! 

②Error Detail 
Carefully read the 
error message! 
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3-4. Close the inbox Parcel Detail 
To close dialog, click the  Ｘ  button at the top right corner of the “Parcel Detail” dialog. 

 

 

 

 

To close, 
Click! 
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10．Password Protect function 

The purpose of the “Password Protect” function is to authenticate the user based on password 

when the e-Parcel VCN-CommCenter login to the e-Parcel server. 

 

The “Password Protect” function is disabled (set “No”) with the default setting.  

(It doesn’t authenticate login password when the e-Parcel software login to the e-Parcel server.) 

The e-Parcel client software is able to login to the e-Parcel server without login password. 

* Refer to P147 3. User Configuration - 5. Login Password Authentication 

 

When you want the “Password Protect” function to be enabled (set “Yes”), the following 

steps of this section will guide you in details. 

 

 

 

1. What’s Password Protect? 

 

Once the “Password Protect” function is enabled (set “Yes”), whenever the e-Parcel 

VCN-CommCenter login to the e-Parcel server, login password authentication is required. 

For example, when you install or start the e-Parcel software, auto-setup, import certificate and etc., 

the e-Parcel “Server Login Required” dialog will appear to authenticate. 

(In addition, once a login password is saved in the VCN-CommCenter, it could be automatically 

authenticated with credential whenever login to the e-Parcel server.) 

10 
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2. Configure Password Protect 

 

When you want to enable the “Password Protect” function to authenticate login password, you are 

required to operate the two procedures below. 

 

 
2-1．First, access URL of “The e-Parcel Secure Enterprise - Web Browser”. 

Enable the “Password Protect” function (set “Yes”) on the User Info menu in 

advance. 

⇒ See below P387 
*Attention: To access URL of “The e-Parcel Secure Enterprise - Web Browser”, your 

e-Parcel client digital certificate is required to install in OS in advance when you sign 
in Windows with a user account which use the e-Parcel service. Usually, you have already 
installed a certificate in Windows when starting the e-Parcel service in a computer. (Refer to 
the section for Downloading and Installing client digital certificate of this manual.) 

 

 

2-2．Next, configure to the e-Parcel VCN-CommCenter. 

Set (save) login password in the User Configuration pane. 

⇒ See below P392 

 

 

From the next page will explain how to configure password protect function in details. Take the 

following procedure 2-1 and 2-2. 
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2-1. Enable Password Protect function 
 

Access URL of “The e-Parcel Secure Enterprise - Web Browser” 

First, enable the “Password Protect” function (set “Yes”) on the User Info menu in advance. 
*Attention: To access URL of “The e-Parcel Secure Enterprise - Web Browser”, your 

e-Parcel client digital certificate is required to install in OS in advance when you sign in 
Windows with a user account which use the e-Parcel service. Usually, you have already installed a 
certificate in Windows when starting the e-Parcel service in a computer. 
(Refer to the section for Downloading and Installing client digital certificate of this manual.) 
 

①Launch browser application (Microsoft Edge is recommended). Visit URL just below. 
*To launch Edge, click icon on the taskbar, double-click the desktop shortcut icon, or access the 

"Start" menu > M > Microsoft Edge for Windows 10 or later. 
 

“The e-Parcel Secure Enterprise - Web Browser” URL: https://secure.e-parcel.ne.jp/ 
 
Your certificate is required for authentication. Select your e-Parcel client digital certificate 

installed in Windows and then click the “OK” button.  

 
 

*If multiple e-Parcel client digital certificates are shown on the "Select a certificate" window, 
select a certificate of your e-Parcel ID and then click the “OK” button. 

 
*If the “Password Protect” function already has been enabled, the “Authentication Required” 

dialog may appear prompting to enter e-Parcel ID and login password. 

Select and then 
Click "OK"! 

Click to select 
a certificate. 
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②“The e-Parcel Secure Enterprise - Web Browser” opens. See the “User Info” page appeared 

with your profile. 

 

 
 

User Info 
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Caution: If you encounter a problem accessing URL of “The e-Parcel Secure 

Enterprise - Web Browser”, your client digital certificate may not have been 

installed in Windows appropriately. Or, the local security policy or domain 

security policy of your company may not allow the certificate installation in 

Windows or browser applications. 

First, ensure that your client digital certificate has been correctly installed by 

reviewing the section below. Also, you may need to check the security settings 

and the proxy server settings in browser applications, computer or network. 
Refer to P40 [If failed in access “The e-Parcel Secure Enterprise - Web Browser”] 

 

Note: If your account administrator for the e-Parcel service has managed the 

password protect function, the “Password Protect” field may not be shown on 

the menu “User Info” of “The e-Parcel Secure Enterprise - Web Browser”. In this 

case, the “Password Protect” function already has been activated (“Yes”). You 

are not able to change the setting “Password Protect” on this site. Please  

consult your company's administrator or contact our e-Parcel customer support. 
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③On the “User Info” page, it allows you to modify the “Password Protect” setting.  

 

The “Password Protect” function has been already disabled (set “No”) with initial setting. In 

the “Password Protect” field, select “Yes” from the pull-down menu. 

 

When change is made, click the “Update” button. 

 

 
 

 
Update! 

Select “Yes” 
in Password Protect. 
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④The process result “OK” should usually appear. The “Password Protect” setting has been 

updated successfully. When confirmation is made, click the "Back" button or close web browser. 

 
*Once the “Password Protect” function is enabled (set “Yes”), when you access URL of “The 

e-Parcel Secure Enterprise - Web Browser”, the e-Parcel “Authentication Required” dialog will 
appear prompting to enter e-Parcel ID and login password. 

 

 

 

Warning: When the “Password Protect” function is enabled (set 
“Yes”) according as the User Info is changed on “The e-Parcel Secure 
Enterprise - Web Browser”, you are required to enter your password in the 
“Login Password” field on the e-Parcel software. If you don’t, the 
e-parcel software will be shutdown with fail in login to the e-Parcel server. In 
this situation, enter login password in the e-Parcel “Server Login Required” 
dialog which will appear when the e-Parcel software gets started. 

 

Warning: When users who the “Password Protect” function has been 
already enabled (set “Yes”) will change password according to the User 
Info on the “The e-Parcel Secure Enterprise - Web Browser”, please be aware 
that you are also required to change your password to new one in the 
“Login Password” field on the e-Parcel software. If you don’t, the 
e-parcel software will be shutdown with fail in login to the e-Parcel server. In 
this situation, enter login password in the e-Parcel “Server Login Required” 
dialog which will appear when the e-Parcel software gets started. 
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2-2. Set Login Password on the software 
 

Configure to the e-Parcel VCN-CommCenter. 

Next, set (save) login password in the User Configuration pane of VCN-CommCenter GUI for 

authentication required. 

*Refer to P147 3. User Configuration - 5. Login Password Authentication 

 

 

⑤Click your e-Parcel ID (Display Name) of the folder tree shown on the tree view at the 

upper-left pane of the VCN-CommCenter GUI. The User Configuration appears at the right 

pane. 
* If the existing VCN-CommCenter has not already been started, to start the program, 

double-click the “e-Parcel x.x” shortcut icon on the desktop. The VCN-CommCenter GUI will 
open. When starting the program, the e-Parcel “Server Login Required” dialog below may 
appear authenticating login password. Enter a password, set checked to remember this and 
then click the “OK” button. Those will be also set (saved) in the User Configuration. 

 

 
 

Login Password Authentication 

⑤Click! 
↓ 

Show “User 
Configuration” 

window. 
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⑥Enter your own password in the “Login Password” field on the User Configuration pane.  

 

⑦When you want to save login password in the software, place a check in the checkbox “Save 

login password”.  
*Once login password is saved, the “Server Login Required” dialog will appear no longer. It 

could be automatically authenticated with credential whenever login to the e-Parcel server. 
Refer to P147 3. User Configuration - 5. Login Password Authentication 

 

⑧When entered, click the “Save” button at the bottom right to take effect. 
*For e-Parcel VCN-CommCenter 7.0.7020 or earlier, if set unchecked in the “Save login 

password”, upon click the “Save” button, the e-Parcel “Server Login Required” dialog appears 
prompting to enter login password. Enter and then click the “OK” button. 

 

 

 

 
 
 
 
 
 
 

 

[Login Password Authentication] 
⑥Enter login password! 

⑦Set checked to save 
login password! 

⑧Once 
settings are 
changed, the 
“Save” button 

will be enabled. 
Click! 
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⑨When the Information dialog “Configuration Saved” appears, click the “OK” button to 

complete. 

 

 

 

 

 

⑩ The system status “Online” should normally be shown on the bottom-right of 

VCN-CommCenter GUI. Your login password has been successfully authenticated in the 

e-Parcel server.  
*If the “Offline” is shown, verify your own password entered correctly and try again. 

 

 

 

 

 

You have successfully completed to configure the Password Protect function (Login Password). 

 

 

⑨OK! 

Check 
“Online”! 
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Warning: When the “Password Protect” function is enabled (set 
“Yes”) according as the User Info is changed on “The e-Parcel Secure 
Enterprise - Web Browser”, you are required to enter your password in the 
“Login Password” field on the e-Parcel software. If you don’t, the 
e-parcel software will be shutdown with fail in login to the e-Parcel server. In 
this situation, enter login password in the e-Parcel “Server Login Required” 
dialog which will appear when the e-Parcel software gets started. 

 

Warning: When users who the “Password Protect” function has been 
already enabled (set “Yes”) will change password according to the User 
Info on the “The e-Parcel Secure Enterprise - Web Browser”, please be aware 
that you are also required to change your password to new one in the 
“Login Password” field on the e-Parcel software. If you don’t, the 
e-parcel software will be shutdown with fail in login to the e-Parcel server. In 
this situation, enter login password in the e-Parcel “Server Login Required” 
dialog which will appear when the e-Parcel software gets started. 

 

 

 
*If set unchecked in the “Save login password (Remember this authentication info.)”, whenever 

login to the e-Parcel server in restarting the VCN-CommCenter etc., the “Server Login 
Required” dialog below appears prompting to enter e-Parcel ID and login password. Enter 
and then click the “OK” button. 
Refer to P147 3. User Configuration - 5. Login Password Authentication 

 

 

 

 

 

*When login password 
has not been saved,  
the “Authentication 

Required” dialog 
appears.  

Enter login password! 
↓ 
OK! 
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11．Edit / Exchange / Add Digital Certificate 

For our customers who have already run the e-Parcel VCN-CommCenter, 

Case 1. When you want to edit the existing e-Parcel ID, 

(It is possible to recover the existing settings and histories.) 

Case 2. When you want to register another new e-Parcel ID and exchange ID for new, 

(It is NOT possible to recover the existing settings and histories.) 

In these cases of 1 and 2 above, first, obtain new client digital certificate from the e-Parcel web site 

and install new client digital certificate in Windows. And then, you must exchange your existing 

e-Parcel client digital certificate for new one on the existing VCN-CommCenter by setup function. 
 
Furthermore, e-Parcel VCN-CommCenter provides the ability to set up multiple client digital 

certificates (multiple e-Parcel ID) to one VCN-CommCenter GUI.  

Case 3. When you want to add new e-Parcel ID and use multiple e-Parcel ID, 

In this case, first, obtain new client digital certificate from the e-Parcel web site and install new client 

digital certificate in Windows. And then, you must add your new e-Parcel client digital certificate on 

the existing VCN-CommCenter by setup function. 

For example, this case enables you to handle multiple e-Parcel ID for each transmission by partner 

companies on one VCN-CommCenter GUI. 
 
The following procedures in this section will explain to edit, exchange or add a client 

digital certificate on the VCN-CommCenter. Especially at the additional procedure 5 

below, please be aware that the different procedures are described depending on the 

cases 1, 2 or 3 above.  

*Refer P427～432 5. After Edit, Exchange or Add e-Parcel ID 
 

【About Procedures 1～5 of this section】 

Procedures 1～4：In the case of all above, first take these procedures.(P398～426) 

Procedure 5. After Edit, Exchange or Add e-Parcel ID (P427～432) 

At last, depending on cases 1, 2 or 3, proceed to the appropriate procedure below. 

Case 1. When you want to edit the existing e-Parcel ID 

→Proceed to P428 Procedure 5-1. 
 

Case 2. When you want to register another new e-Parcel ID and exchange ID for new 

→Proceed to P430 Procedure 5-2. 
 

Case 3. When you want to add new e-Parcel ID and use multiple e-Parcel ID 

→Proceed to P432 Procedure 5-3. 

11 
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Caution: The “Auto Setup” function of e-Parcel software will attempt to 

automatically detect a client digital certificate and your network settings from 

Windows. Therefore, the “Auto Setup” function requires to install (import) a 

client digital certificate in Windows in advance. 

 

 

Warning: If you exchange the existing client digital certificate for new one 

after registering another new e-Parcel ID (NOT edit the existing e-Parcel ID), it 

is unable to recover the previous inbox and outbox histories. 

 

 

Warning: When you want to edit the existing e-Parcel ID, please note that 

sending and receiving data through the e-Parcel service is temporally 

suspended for the operational reason of ID edited until you complete to 

auto-setup new certificate on the e-Parcel VCN-CommCenter. 

 

 

Warning: Please be advised that you should not configure a client digital 

certificate by “Auto Setup” or “Import Certificate” while the e-Parcel 

VCN-CommCenter is processing to upload and download data. Wait for 

the delivery status to be “Waiting Download” in outbox or “Delivery Confirmed” 

in inbox. 
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1. Edit, Exchange or Add e-Parcel ID 

 

When you want to edit or exchange your existing e-Parcel ID or add new e-Parcel ID, e-Parcel 

Corporation usually edit or register e-Parcel ID upon your request. Please contact us to 

e-mail below. (When inquiring, we would appreciate if you let us know your existing e-Parcel ID.) 

 

Case 1. When you want to edit the existing e-Parcel ID 

Case 2. When you want to register another new e-Parcel ID and exchange ID for new 

Case 3. When you want to add new e-Parcel ID and use multiple e-Parcel ID 

 
*Usually, upon your application for the e-Parcel service, we register an e-Parcel ID which is the same as 

your e-mail address. In addition, the e-Parcel ID works only in the e-Parcel secure data delivery 
service. The e-Parcel ID is not compatible with any mail applications. Even though if your e-mail 
address is changed, it doesn't affect any data delivery through the e-Parcel software. However, it may 
affect some services such as the e-mail notification upon the online password request. So, it is 
recommended that you request us to edit the existing e-Parcel ID when your e-mail address changed.   

 

 

 

 

When edit or registration of e-Parcel ID completed, we will notify our customers by the e-mail 

notification. 

 

 

Note: When you want to edit or exchange your existing e-Parcel ID or add new 

e-Parcel ID, please contact the e-Parcel Customer Support by e-mail 

(support@e-parcel.co.jp) with specifying your existing e-Parcel ID.  

(Business Hours: 9:00-17:00JST/Mon-Fri) 

*Please let us know the name and e-Parcel ID of the individual when inquiring. 
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2. Downloading client digital certificate 

In the beginning, to obtain a client digital certificate from e-Parcel, visit URL of “The e-Parcel 

Secure Enterprise - Software Download Site”. 

 

①First, sign in Windows with a user account which runs the VCN-CommCenter. Launch 

browser application (Microsoft Edge is recommended). Visit URL just below.  
* To launch Edge, click icon on the taskbar, double-click the desktop shortcut icon, or access the 

"Start" menu > M > Microsoft Edge for Windows 10 or later. 
 

“The e-Parcel Secure Enterprise - Software Download Site” URL: https://www.e-parcel.ne.jp/ 

 

Click the site menu “e-Parcel Enterprise Service Menu”, see the page appeared and then click the 

“Download Client Certificate” button. 

*To proceed to “Auto Setup” at the later step, a client digital certificate is required to install (import) in Windows 
in advance when you sign in Windows with a user account which runs the e-Parcel VCN-CommCenter. 

 
 

 

 

 

 

 

Click the button 
on the middle of 
this webpage! 

Select this menu. 
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②The Re-download a client digital certificate – “STEP1. Login” page appears. Enter your e-Parcel 

ID and password (or default password [*as notified by e-mail when e-Parcel ID registered]) 

and then click the “Login” button. 

 
*In the case of the existing e-Parcel ID edited (Edit), if you have already changed a password to 

your own password, enter your own password to login when downloading a client digital 
certificate. 

 
*In the case of new e-Parcel ID registered (Exchange, Add), a password has been set the default 

password at beginning. Please be advised you to change a password through “The e-Parcel 
Secure Enterprise - Web Browser” after you complete to install new client digital certificate in 
Windows. 

 

 

 

 

 

 

 

When entered, 
Login! 
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③ The “STEP2. Select e-Parcel client software.” page appears. Select the “e-Parcel 

VCN-CommCenter 8.0 / 7.0” which you have used and then click the “Next” button. 

 

 

 

 
Next! 

Select  
the e-Parcel 

VCN-CommCenter 8.0 / 7.0 
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④The “STEP3. Check the security of web site …” page appears. Confirm the security of the 
web site for your secure downloading.  
 
In this webpage which you are visiting, do you see the Trusted Web Seal that Cybertrust (The 
certificate authority which validate EV SSL certificate) issued to “e-Parcel Corporation” (The 
organization name of the web site)? 
 

 

 

 

 
 

 

 

 

 

When your confirmation is made, click the “Next” button. 

 

 

 

Check the web seal! 

Next! 
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⑤The “STEP4. Download and install a client digital certificate” page appears.  

 

 

Choose one depending on your client software version of e-Parcel VCN-CommCenter. 

[For users of e-Parcel VCN-CommCenter 7.0.7015 (Jan. 1. 2015 released) or later]： 

On the “Client Digital Certificate” field, make sure the “For new users” selected. Usually, leave 

this field with initial choice and then click the “Download” button. 
*When the “For new users” selected, a SHA2 signed digital certificate will be downloaded. Note 

that e-Parcel VCN-CommCenter 7.0.7015 (released in Jan. 1. 2015) or later supports SHA2 
signed digital certificate.  

 

 

 

 

Download! 

For users of 
VCN-CommCenter 
7.0.7015 or later 
(Normal choice) 
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 [Only for users of e-Parcel VCN-CommCenter 7.0.7014 or earlier]： 

Change to the lower choice “*If you use the previousrelease …” on the Client Digital Certificate 

field. To download, click the “Cert for previous versions” button appeared. 
*When the “For users of previous versions” selected, a SHA1 signed digital certificate will be 

downloaded. （*Recommendation for users of previous versions: Updating your client software 
to the latest version of e-Parcel VCN-CommCenter is recommended.） 

 

 

Download! 

*only for users of  
previous versions; 
VCN-CommCenter 
7.0.7014 or earlier 
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⑥A File Download dialog appears. Verify a file name of your client digital certificate must be 

“e-Parcel _your e-Parcel ID.p12”. 
 
○For “Auto Setup”: proceed to next page P406. (Recommended) 

*Normally take this procedure “For Auto Setup” of this section. Also, the e-Parcel software 
download site which you are visiting will guide you by this procedure. 

 

 

○For “Import Certificate” (setup manually), proceed to P407. 
*Attention: If the local security policy or domain security policy of your company may not allow 

the certificate installation in Windows or browser applications, try another way (Save new client 
digital certificate and then import it directly on the client software). 
When a file of new client digital certificate is saved in your computer at this procedure, please 
note that the different procedures will be shown in the later procedure P425 “4. Setup e-Parcel 
client software” of this section. Proceed to “Import Certificate (For setup manually)” instead of 
“Auto Setup”. 
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For “Auto Setup” (Recommended): 

Upon clicking the “Download” button, in the download notification bar, select “Open file” or 

"Open". 

 

[For Microsoft Edge] 

 

 

 

 

 

 

OR 
 

 

 

 

 

 

 

 

Proceed to P409 3．Installing client digital certificate and carefully take the procedure.  

 

Open! 

Open file! 

A file name of  
your certificate 
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For “Import Certificate”: 

Upon clicking the “Download” button, in the download notification bar, save a client digital 

certificate. 

 

[For Microsoft Edge] 

In Windows, the certificate file is often saved automatically to This PC > “Downloads” folder with 

the default setting. 

(Or in the download notification bar of the browser which ask you, select "Save as" or “Save”) 
*If you select “Save as” in the download notification bar, leave the default file name. 
*Note: When downloading, please be aware that you must save a file of your client digital 
certificate in your computer in advance. In this case, you do not need to install it in Windows. 
(No need to “Open file”.) 

 

 

 

 

 

 

OR 
 

 

 

 

 

 

 

A file name of  
your certificate 

File saved automatically 

Save as 
or 

Save 
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[Certificate file] 

Download location (Default): C:¥Users¥(Windows user account name)¥Downloads 

File name: e-Parcel_your e-Parcel ID.p12 
*If you have changed Download Location in the browser settings “Downloads”, it might be saved 

to another location where you specified. 
 

Confirm a file of your client digital certificate saved in the “Downloads” folder. It is recommended 

that you move a certificate file to another location where is easy to find such as Desktop in your 

computer. 

 

 

 

 

The next procedure is to manually import a client digital certificate on the e-Parcel client 

software. 
Proceed to P426 4. Setup client digital certificate - 4-2. Import Certificate (For setup manually) 

 
*When you choose to proceed to “Import Certificate” (For setup manually), you do NOT need to 

install a client digital certificate in Windows at next procedure 3. (In addition, carefully note that 
you cannot access URL of "The e-Parcel Secure Enterprise - Web Browser" without the 
certificate installation in Windows.) 

 

Move (Save) 
a certificate file 

from the 
“Downloads” 

folder to desktop 
on your PC! 
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3. Installing client digital certificate 

Execute to install (import) the e-Parcel client digital certificate in Windows. 

 

①The Certificate Import Wizard opens. Proceed to install to click the “Next” button.  

*For Windows 10 or later, choose the “Current user” as a storage location. 
 

[For Windows 10 or later] 

 

 

 

 

Next! 

Windows 10 or later: 
Choose “Current User” 
in the Store Location and 
then Next. 
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②The File to Import dialog appears. Specify the file you want to import. （*Leave the default file 

name of your certificate.）Click the “Next” button to proceed.  

 

 

 

 

 

Warning: 
Don’t change a file name. 

Next! 
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③The Password dialog appears. First, enter your own password or the default password [*as 

notified by e-mail when e-Parcel ID registered] (*You must enter the same password as you 

previously applied at STEP 1. Login to the web site.). And then you must place a check in the 

box “Make this key as exportable. This will allow you to back up or transport your keys at a 

later time.”. 
*In the case of the existing e-Parcel ID edited (Edit), if you have already changed a password to 

your own password, enter your own password to login when downloading a client digital 
certificate. 

 
*In the case of new e-Parcel ID registered (Exchange, Add), a password has been set the default 

password at beginning. Please be advised you to change a password through “The e-Parcel 
Secure Enterprise - Web Browser” after you complete to install new client digital certificate in 
Windows. 

 

 

Confirm to be validated (set checked: on) in the checkbox “Make this key as…”, then 
click the “Next” button to proceed.  
*Attention: With the checkbox “Make this key as exportable. …” invalidated (set unchecked: off), 

you will fail in auto-setup a client digital certificate on the e-Parcel software at the later step. The 
applications will come up with the error while auto-setup. 

 

 

 

Attention: 
You must place a check 
in the “Make this key as 
exportable…” checkbox. 

Next! 

Enter password! 
*This must be the 

same password 
as you enter at 
STEP 1. Login. 
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④The Certificate Store dialog appears. Confirm that the “Automatically select the certificate 

store based on the type of certificate” is selected as initial choice. Just leave it, click the 

“Next” button.   

 

 

 

 

Next! 

Attention: 
You must select this! 
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⑤When “Completing the Certificate Import Wizard” is shown, click the “Finish” button to proceed. 

 

 

 

 

Finish! 
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⑥The Security Warning dialog may appear. Therefore, CA certificate is installed at the same time, 

click the “Yes” button to allow it. 

 
 

 

 

⑦The “The import was successful.” dialog appears. Click the “OK” button to exit the Wizard.  

 

 

 

 

The Certificate Import Wizard closes. You have done to install (import) a client digital certificate in 

Windows. 

 

Yes! 

OK! 
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If you are not allowed to import certificate in Windows 

 

While the installation of the e-Parcel client digital certificate through the Certificate Import Wizard, 

when it shows "Completing the Certificate Import Wizard" upon the "Finish" button, some of the 

customers may fail in the certificate installation with the error message. It happens often that the 

local security policy or domain security policy of your company may not allow the 

certificate installation in Windows. 

 (For example, the error message "An error occurred during the addition of a certificate to the 

Trusted Root Certification Authorities store.")  

However, you may have some difficulty to change the security policy of you. To get started the 

e-Parcel software, we show you another procedure (manual setup) which the software directly 

imports your certificate instead auto setup. Pleas carefully take the following procedures. 

 

→Back to P405 “2. Downloading client digital certificate” ⑥, and then take the 

another procedures “For “Import Certificate” (setup manually)”. 

 

STEP4 of Web site:  

P407 Just “Save” the e-Parcel client digital certificate on your computer.  →Next! 

 

STEP5 of Web site:  

Skip! (You cannot access URL of "The e-Parcel - Web Browser".) →Next! 

 

STEP6 of Web site:  

P426 “4. Setup e-Parcel client software” 4-2. Import Certificate (For setup manually). 

At this point, let's begin to import your certificate directly on the e-Parcel client software. 

 

Start VCN-CommCenter, access menu Tool > Import Certificate. 

OR select from Windows “Start” menu. 
[For Windows 10 or later]  
Select from Windows “Start” menu > e-Parcel > “Import Certificate” 
[For Windows 8 or earlier]  
Select from Windows “Start” menu > All Programs > e-Parcel > VCN-CommCenter x.x >  
“Import Certificate” 

And then, select a file of your e-Parcel client digital certificate which has been saved at the 

previous STEP 4 to import. 
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⑧Return to web site the “STEP4. Download and install a client digital certificate” page.  

 

 

 

 

 

 

 

On the STEP 4, scroll down to the bottom of the web page. Then click the “Next” button to proceed. 

 

 

 

 

 

 

Next! 
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⑨The “STEP5. Access the URL of e-Parcel Secure Enterprise - Web Browser…” page 
appears.  

 

 

 

Access “The e-Parcel Secure Enterprise - Web Browser” to ensure a client digital certificate import 

in Windows appropriately. Also, you can change a password on the web site. Once “The e-Parcel 

Secure Enterprise - Web Browser” window opens, you have successfully installed the e-Parcel 

client digital certificate in Windows. 

 

 

 
 
 
①Scroll down to the middle of the web page and then click the red button below.  

 

 

 

 

Click! 
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⑩The site requires your certificate for authentication. Select your e-Parcel client digital certificate 

installed in Windows and then click the “OK” button. 

 

 
*If multiple e-Parcel client digital certificates are shown on the "Select a certificate" window, 

select a certificate of your e-Parcel ID and then click the “OK” button. 
 

 

And then 
click "OK"! 

Click to select 
a certificate. 
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⑪“The e-Parcel Secure Enterprise - Web Browser” new window is opened. 

“The e-Parcel Secure Enterprise - Web Browser” URL: https://secure.e-parcel.ne.jp/ 

 

If you succeed it, see the User Info menu. 

 

 
 

 

Caution: If you were rejected to access URL of “The e-Parcel Secure 

Enterprise - Web Browser”, a client digital certificate may not have been 

installed in Windows appropriately. First, ensure that a client digital certificate 

has been correctly installed by reviewing the section below. Also, you may need 

to confirm the settings of your computer, the proxy server or network 

environment not to configure the access control such as block or analysis of 

HTTPS request to the domains of our service. 
Refer to P40 [If failed in access “The e-Parcel Secure Enterprise - Web Browser”] 

 

* Attention: Don’t send any data if 
the menu "Create New" appears. 
This menu is provided for only users 
of the e-Parcel web browser client. 
(For users of the e-Parcel client 
software, we provide the higher 
security and the lager data delivery 
service) In addition, once the 
software has installed, the menu 
"Create New" is no longer shown. 

User Info 
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⑫The “User Info” page appears including your e-Parcel Profile. It allows you to change the default 

password as needed.  

 

 
 

 

 

About New password 

If a password should be changed, enter the new password in the New Password field and the 

New Password (re-enter) field, and then click the “Update” button. A password must be between 

8 - 20 half-width alphanumeric characters. Note that password is case-sensitive, and contains no 

spaces.  
*In the case of new e-Parcel ID registered, a password has been set the default password we 

inform you by e-mail notification at beginning. Please be advised you to change a password 
through the “The e-Parcel Secure Enterprise - Web Browser”. 

 

A password  
must be 

between 8 - 20 
half-width 

alphanumeric 
characters. 

Enter new password! 

When entered, 
click "Update"! 

User Info 
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About User Name 

The "User Name" of User Info is automatically shown as "Sender name" and "Recipient name" on 

inbox, outbox and address book of the e-Parcel client software. When you wish to change "User 

Name", edit a user name on both fields "first name (the upper field)" and "last name (the lower 

field)", and then click the "Update" button. The fields "first name" and "last name" of a user name 

must be input using less than 60 characters each. (For example, John Parcel as "first name" and 

Design department as "last name" are inputted.) 

 

 
*Attention: Don’t send any data if the menu "Create New" appears. This menu is provided for users 

of e-Parcel web browser client. (Therefore, we provide the higher security and the lager data 
delivery service for users of the e-Parcel client software. The menu "Create New" will be hidden 
after software installation complete.) 

 
*The Password Protect field may be set "No" as default. Once the “Password Protect” function has 

been enabled ("Yes"), it is required to authenticate a login password when the VCN-CommCenter 
login to the e-Parcel server upon installation, startup, auto-setup, import certificate and etc. 
Refer to P385 10. Password Protect function 

 
*Warning: For users who the Password Protect field has been set "Yes". 

If you want to change your password though “The e-Parcel Secure Enterprise - Web Browser”, 
you make sure to re-setup the new login password to your e-Parcel Client Software. Therefore, 
you are required to re-authenticate new password in the e-Parcel server when your password 
updated. 
Refer to P147 3. User Configuration - 5. Login Password Authentication 

 
*When you wish to view / edit user information or change password, launch browser application in 

a computer which has been imported your e-Parcel client digital certificate. And then, access URL 
of "The e-Parcel Secure Enterprise - Web Browser" at https://secure.e-parcel.ne.jp/. On the 
"User Info" menu, you can view / edit user information registered and change password. Also, it 
is available to inquire into "Inbox" / "Outbox" histories recorded for the selected period (until 
month before last or target date) online. (Please be advised to add to favorites on browser 
application.) 
Refer to P458 Appendix 1. e-Parcel Secure Enterprise - Web Browser  
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⑬The Process Result “OK” should usually appear. Your password has been updated successfully. 

Close this new tab of the browser as needed. 
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⑭Return to web site the “STEP5. Access the URL…” page.  

 

 

 

 

 

On the STEP5, scroll down to the bottom of the web page and then click the “Next” button to 

proceed.  

 

 

 
Next! 
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⑮The “STEP6. The e-Parcel Client Software” page appears.  

 

 
 

 

Pleas be aware that you must read carefully the attentions described on the webpage. 

 

 
 

 
The next procedure will be set up the e-Parcel client software. Double-click the "e-Parcel x.x" 

shortcut icon on the desktop to start the VCN-CommCenter. 

 

The next procedure is to auto-setup a client digital certificate on the e-Parcel client software.  
Proceed to P425 4. Setup client digital certificate - 4-1. Auto Setup (For setup automatically) 
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4. Setup e-Parcel client software 

Next, begin to set up a client digital certificate to the e-Parcel VCN-CommCenter. 

To edit, exchange or add a client digital certificate on the VCN-CommCenter, the “Auto Setup” and 

manually “Import Certificate” functions are provided for setup a client digital certificate to the 

e-Parcel client software. Select either one of the two functions depending on your choice at the 

previous procedure 2. (P405) of this section. The “Auto Setup” has been normally selected. 

 

 

4-1. Auto Setup (For setup automatically) 
The “Auto Setup” function (Recommended) automatically configures to the e-Parcel client 

software. This command is functional when a client digital certificate has been installed in Windows 

at the previous procedure 2～3. (P399～P414) of this manual. The VCN-CommCenter attempts 

automatically to detect your network settings and a client digital certificate from Windows.  

 

To auto setup, select from the menu “Tools” > “Auto Setup” on the VCN-CommCenter 

GUI. Usually, the auto-setup function starts automatically.  

For more details on the “Auto Setup” function, refer to the following section of this manual. 

*Refer to P88 2. VCN-CommCenter View - 2. Menu Bar - 2-3. Tools – 2-3-3. Auto Setup 

 

 

 
*If the "Confirm Certificate" or the "Select a Certificate" dialog appears, select an e-Parcel client 

digital certificate of your e-Parcel ID and then click the “OK” button to begin auto-setup. 
[For Windows 10 or later] Click “More choices” on the “Select a Certificate” dialog to view all 
certificates. Then, select one. 

 

 

 

At the end, to complete all procedures, proceed to P427 5. After Edit, Exchange or Add e-Parcel ID. 

Select from the menu 
Tools > Auto Setup! 
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4-2. Import Certificate (For setup manually) 
Some of the customers may fail in the certificate installation in Windows with the error message 

dialog shown. It happens often that the local security policy or domain security policy of your 

company may not allow the certificate installation in Windows. If you are not allowed to import 

certificate in Windows, the “Import Certificate” function may be helpful to directly configure a 

certificate to the e-Parcel client software. In advance, you must download(save) an e-Parcel client 

digital certificate in your computer at the previous procedure 2. (P399～P408) of this manual. The 

“Import Certificate” function prompts to set up a certificate to VCN-CommCenter. 

 

To import certificate, select from the menu “Tools” > “Import Certificate” on the 

VCN-CommCenter GUI.  

Or, also access from Windows “Start” menu below. 

[For Windows 10 or later] Select from Windows “Start” menu > e-Parcel > “Import Certificate” 
[For Windows 8 or earlier] Select from Windows “Start” menu > All Programs > e-Parcel > 
VCN-CommCenter x.x > “Import Certificate” 

 

 

 

And then, select a file of your e-Parcel client digital certificate which has been saved previously. 

[A file name of the e-Parcel client digital certificate is “e-Parcel_ your e-Parcel ID.p12”] 

 

For more details on the “Import Certificate” function, refer to the following section of this manual. 

*Refer to P93 2. VCN-CommCenter View - 2. Menu Bar - 2-3. Tools - 2-3-4. Import Certificate 

 

 

 

At the end, to complete all procedures, proceed to P427 5. After Edit, Exchange or Add e-Parcel ID. 

 

Select from the menu 
Tools > Import Certificate! 
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5. After Edit, Exchange or Add e-Parcel ID 

 

After a new client digital certificate has been set up to the VCN-CommCenter, to complete all 

procedures, carefully take the additional procedure or confirm depending on the three (3) cases 

below.  

 

 

Case 1．When you want to edit the existing e-Parcel ID, 

(It is possible to recover the existing settings and histories.) 

→ Proceed to P428 Procedure 5-1． 

 

 

Case 2．When you want to register another new e-Parcel ID and exchange ID for new 

one, (It is NOT possible to recover the existing settings and histories.) 

→ Proceed to P430 Procedure 5-2． 

 

 

Case 3．When you want to add new e-Parcel ID and use multiple e-Parcel ID, 

→ Proceed to P432 Procedure 5-3． 
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5-1. Existing e-Parcel ID (Edit) 
For our customers who have already run the e-Parcel VCN-CommCenter, 

When you want to edit the existing e-Parcel ID, it will overwrite the existing e-Parcel ID 

with the edited e-Parcel ID upon setup a new client digital certificate to the VCN-CommCenter.  

(A new folder tree for the edited e-Parcel ID is not added on the tree view.) The edited e-Parcel ID 

is possible to recover the settings and inbox/outbox histories recorded by the existing e-Parcel ID. 

 

①Confirm that it has replaced the existing e-Parcel ID with the edited e-Parcel ID 

[Display Name] on the tree view of VCN-CommCenter GUI.  

 

[Ex.：Edit e-parcel ID FROM test-epi2@e-parcel.co.jp TO test-epid1@e-parcel.co.jp] 

 

 

 

 

 

 

 

 

[Before setup] 
The existing e-Parcel ID 

[After setup] 
The edited e-Parcel ID 
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Note: When you edit the existing e-Parcel ID, the existing client digital certificate 

configured to the VCN-CommCenter will be overwritten by setup new client 

digital certificate of the edited e-Parcel ID. Therefore, it is not necessary to 

disable the existing e-Parcel ID configured to the VCN-CommCenter. 

However, you need to remove the existing client digital certificate from 

Windows by the following procedures. 

 

 

②Remove the existing e-Parcel client digital certificate from Windows 

At last, to remove the existing e-Parcel client digital certificate installed from 

Windows, take the procedures just below. 

 

1. For Windows 10 or later, access the “Start” menu > Windows System > Control Panel > 

Network and Internet > "Internet Options". 

2. On the “Internet Properties” dialog, select the “Content” tab and click the "Certificates" button 

in the Certificates category. 

3. The “Certificates” dialog is opened. The “Personal” tab will list your client digital certificate. 

Select the existing e-Parcel ID from the “Issued To” column and then click the “Remove” button 

in the “Personal” tab. 

4. The “… Do you want to delete …?” dialog appears prompting either “Yes” or “No”. Select the 

“Yes” button after your confirmation. 

5. the existing e-Parcel client digital certificate is removed from the “Personal” tab of a 

“Certificates” dialog. Click the “Close” button and then click the “OK” button on the “Internet 

Properties (Internet Options)” dialog to close. 
 

To open the “Certificates” dialog from Microsoft Edge 
Launch Microsoft Edge. On toolbar at the upper-right, click […] (Settings and more) > Settings (gear 
mark) > Privacy, search, services > Security > Manage certificates > [Certificates] dialog 
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5-2. New e-Parcel ID (Exchange) 
For our customers who have already run the e-Parcel VCN-CommCenter, 

When you want to register another new e-Parcel ID and exchange ID for new one, a 

new folder tree of another new e-Parcel ID will be added on the tree view upon setup a new client 

digital certificate to the VCN-CommCenter. Confirm another new e-Parcel ID [Display Name] 

to be shown on the tree view of VCN-CommCenter GUI.  

 

When another new e-Parcel ID has been registered and set up to the VCN-CommCenter instead of 

the existing e-Parcel ID, another new e-Parcel ID is not possible to recover the settings and 

inbox/outbox histories recorded by the existing e-Parcel ID. Therefore, it will not overwrite the 

existing e-Parcel ID with another new e-Parcel ID upon setup a new client digital certificate to the 

VCN-CommCenter. 

 

In this case, the existing e-Parcel ID is usually revoked from the registration on the e-Parcel server. 

Finally, you also must take the additional procedures to revoke (remove) the existing 

old e-Parcel ID from both the VCN-CommCenter and Windows. 

 

[Ex.：Remove e-parcel ID test-epid2@e-parcel.co.jp and exchange it for new test-epid1@e-parcel.co.jp] 

 

 

 

 

Disable the existing old 
e-Parcel ID! 

*Refer to the next page. 

[After setup] 
New e-Parcel ID 
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①Disable the existing e-Parcel ID on the VCN-CommCenter 

Disable the existing old e-Parcel ID configured to the VCN-CommCenter. 

 

Right-click on the existing old e-Parcel ID [Display name] on the tree view to open the pop-up 

menu. Select “Disable this ID”. 

For more details in the “Disable this ID” function, refer to the following section of this manual. 
*Refer to P123 2. VCN-CommCenter View – 4. Tree View – 4-1. Display Name – 4-1-2. Disable e-Parcel ID 

 

 
 

②Remove the existing e-Parcel client digital certificate from Windows 

At last, to remove the existing e-Parcel client digital certificate installed from 

Windows, take the procedures just below. 

 

1. For Windows 10 or later, access the “Start” menu > Windows System > Control Panel > 

Network and Internet > "Internet Options". 

2. On the “Internet Properties” dialog, select the “Content” tab and click the "Certificates" button 

in the Certificates category. 

3. The “Certificates” dialog is opened. The “Personal” tab will list your client digital certificate. 

Select the existing e-Parcel ID from the “Issued To” column and then click the “Remove” button 

in the “Personal” tab. 

4. The “… Do you want to delete …?” dialog appears prompting to either “Yes” or “No”. Select the 

“Yes” button after your confirmation. 

5. The existing e-Parcel client digital certificate is removed from the “Personal” tab of a 

“Certificates” dialog. Click the “Close” button and then click the “OK” button on the “Internet 

Properties (Internet Options)” dialog to close. 
 
To open the “Certificates” dialog from Microsoft Edge 
Launch Microsoft Edge. On toolbar at the upper-right, click […] (Settings and more) > Settings (gear 
mark) > Privacy, search, services > Security > Manage certificates > [Certificates] dialog 

Right-click 
on the existing old e-Parcel ID 
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5-3. Multiple e-Parcel ID (Add) 
For our customers who have already run the e-Parcel VCN-CommCenter, 

When you want to add new e-Parcel ID and use multiple e-Parcel ID, a new folder tree 

for new e-Parcel ID will be added on the tree view upon setup a new client digital certificate to the 

VCN-CommCenter.  

 

Confirm new e-Parcel ID [Display Name] to be shown under the existing e-Parcel ID 

on the tree view of VCN-CommCenter GUI. 
*In addition, when multiple e-Parcel ID (client digital certificates) have been configured to the 

VCN-CommCenter, the display order of multiple folder trees can be changed on the tree view. 
Refer to P125 2. VCN-CommCenter View – 4. Tree View – 4-1. Display Name – 4-1-3. Move Up/Down 
e-Parcel ID position 

 

[Ex.：Add new e-parcel ID test-epid1@e-parcel.co.jp and use both new ID and test-epid2@e-parcel.co.jp] 

 

 

 

 

In the case of use multiple e-parcel ID on one VCN-CommCenter, please carefully note that you 

select Inbox or Outbox of a correct sender's e-Parcel ID on the tree view in advance whenever 

"Create New" for transmission. 

 

Note: When you wish to switch the current view of outbox/inbox to another 

while processing upload/download, it is recommended to wait a few moments 

for the VCN-CommCenter to complete the processes. 

The status in outbox should be “Waiting Download” when uploading processes 

complete. The status in inbox should be “Delivery Confirmed” when 

downloading processes complete. 

 

Existing e-Parcel ID is 
also used. 

[After setup] 
New e-Parcel ID added 
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12．Updating Software 

We provide the latest e-Parcel software information on our Home page for customers. 

e-Parcel Corporation Home page URL: http://www.e-parcel.co.jp/ 

 

To update the e-Parcel VCN-CommCenter in a computer, you should obtain the latest software from 

“The e-Parcel Secure Enterprise - Software Download Site”. 

 

The following steps will guide you in updating software for the VCN-CommCenter. 

Choose either A or B procedure below depending on your circumstances. 

 

A. Reinstalling in a same PC (Not replace PC / Maintain history) 

→ Proceed to P434 

 

 

B. Reinstalling in another PC (Replace PC) 

→ Proceed to P439 

 

12 
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A. Reinstalling in a same PC (Not replace PC / Maintain history) 
 

When you update the e-Parcel VCN-CommCenter in a same computer, proceed to this procedure for 

updating the software.  

 

In this case, just download and install the latest version of the e-Parcel VCN-CommCenter in a same 

computer.  
*Update from e-Parcel VCN-CommCenter 7.0 to 8.0 is available. The data delivery on ver.8.0 is also 

available as usual. 
 

You can continuously maintain the existing configuring, outbox/inbox histories in the 

VCN-CommCenter after updating.  

 

*In addition, at the same time that you update the software in a same computer, you want to change 
(Edit) the existing e-Parcel ID, also follow this procedure below. 

 

 

Warning: Please be advised that you should not update the software 

while the e-Parcel VCN-CommCenter is processing to upload and 

download data. Wait for the delivery status to be “Waiting Download” in 

outbox or “Delivery Confirmed” in inbox. 

 

When starting your computer, follow the procedure below for updating the software. 

 

Caution: The software installation requires administrative privilege. 

If you sign in Windows with a standard user account without the 

administrative privilege, you are required to input an administrator 

account name (administrator ID) and password to User Account Control 

(UAC) dialog when executing installation. Prepare information in advance. 

[For Windows 2000, XP, 2003]  
Log on Windows with either an administrator account or a user account with the 
administrative privilege in advance. 
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1. Launch browser application (Microsoft Edge is recommended). Visit URL just below.  
*To launch Edge, click icon on the taskbar, double-click the desktop shortcut icon, or access the 

"Start" menu > M > Microsoft Edge for Windows 10 or later. 
 

“The e-Parcel Secure Enterprise - Software Download Site” URL: https://www.e-parcel.ne.jp/ 

 

2. See the page appeared, select the site menu “Download & Install Software” and then click the 

“Download e-Parcel Software” button on the bottom of this webpage. 

 

 

 

 

 

 

Click the button 
on the bottom of 

this webpage! 

Select this menu. 
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3. Follow the procedure on the web site 

Download and install just the latest client software in the case of continuously using the 

existing same e-Parcel ID in a same computer.  

 

[In the case of continuously using the existing same e-Parcel ID] 

Certificate instillation: Not required  
*You do not need to download and install a client digital certificate on the way to the procedures 

according the “e-Parcel software download site”. Because our customers usually have installed 
(imported) a client digital certificate in Windows at the beginning of the software installation in a 
same computer. 

 

[In the case of the existing e-Parcel ID changed (Edit)] 

Certificate instillation: Required  
* Some of the customers who changed (Edit) the existing e-Parcel ID need to obtain new client 

digital certificate. In this case, it is required to install (import) a client digital certificate in 
Windows on the way to the procedures according the “e-Parcel software download site”. (At last, 
after update software complete, to set up new client digital certificate to the software, access the 
VCN-CommCenter menu bar “Tools” > “Auto Setup”.) 
Required only in the case of the existing e-Parcel ID changed (Edit) 
Remove the existing e-Parcel client digital certificate installed in Windows. 
Refer to P428 5-1. Existing e-Parcel ID (Edit) 
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On the “e-Parcel software download site”, Follow the description on the web site STEP 1～6.  

(See below ①～⑥ steps) 
* For more information regarding how to download the client software, see the section below of 

this manual. 
Refer to P19-68 1. Preparations for the e-Parcel Service 

 

[STEP 1～6 on the “e-Parcel software download site”] 

①P21-23 / on the web - STEP1. Login 

 

②P24 / on the web - STEP2. Select the e-Parcel client software 
*Update from e-Parcel VCN-CommCenter 7.0 to 8.0 is available. The data delivery on ver.8.0 is 

also available as usual. 
 

③P25 / on the web - STEP3. Check the security of web site 

 

 
*Once a client digital certificate of your e-Parcel ID have been installed (imported) in Windows 

at the beginning of the software installation, you do not need to STEP 4～5 in this time. Skip 
forward to STEP 6 to download the latest e-Parcel client software. 

④P35 / on the web - STEP4. → to the Next step (Usually done in a same PC. Skip ④) 
Required only in the case of the existing e-Parcel ID changed (Edit)  
[P26 Download and install a client digital certificate] 

⑤P49 / on the web - STEP5. → to the Next step (Usually done in a same PC. Skip ⑤) 
Required only in the case of the existing e-Parcel ID changed (Edit)  
[P37 Access URL of the e-Parcel Secure Enterprise - Web Browser] 

 

 

⑥P50～68 / on the web - STEP6. Download and Install e-Parcel client software. 

Follow the [Instruction for installing e-Parcel Client Software] described on the web - STEP 6 

to begin software installation.  

Usually, when you double-click the executable file and follow the instruction, after 

automatically uninstalling the existing software*, the latest software installation will begin. 

Refer to P438 *Attention: Some users of e-Parcel VCN-CommCenter 8.0.8023 

 
*In the beginning of installation, if you have run the e-Parcel VCN-CommCenter, the dialog 

“The following applications should be closed…” will appears. Select the “Automatically close 
applications and attempt …” and then click the “OK” button to shut down the e-Parcel 
VCN-CommCenter. After automatically uninstall the existing software, the latest software 
installation will begin. 

 
*On the above dialog, even though you click the “OK” button to shut down the software, you 

may need to manually exit (shutdown) the existing e-Parcel client software. Access the 
VCN-CommCenter menu bar “File” > “Exit” to shut down. 
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*Attention: Some users of e-Parcel VCN-CommCenter 8.0.8023 
[About reinstalling software in a same computer] 
Upon double-clicking the executable file downloaded (saved) to open, if InstallShield 
Wizard shows ”… will allow you to modify, repair, or remove e-Parcel 
VCN-CommCenter 8.0. To continue, click Next.”, 
1. Click “Next” button to continue. Firstly, follow the removal procedures below through 

InstallShield Wizard. After uninstalling (removing) the existing software, you can begin to 
reinstall the latest software. 

2. On [Program Maintenance], select “Remove” and click “Next” button. 
3. On [Remove the Program], click “Remove” button to execute. 
4. The ”User Account Control (UAC)” dialog is shown. In the case of sign in Windows with 

an administrator account, select the “Yes (Allow)” button to allow. Or, in the case of sign 
in Windows with a standard account without the administrative privilege, an 
administrator account name (administrator ID) and password are required to input. 

*If the existing software is running, before uninstalling (removing), InstallShield Wizard may show [Files in 
Use]. To continue, select the “Automatically close and attempt to restart applications.” and click “OK” 
button. 

5. Please wait while uninstalling (removing) the existing software. 
When “InstallShield Wizard Completed” is shown, click “Finish” button to exit. 

6. Then, to reinstall the latest software, double-click the executable file again to begin and 
follow the instruction described on the web - STEP 6.  

 

 

4. When installation of the latest the VCN-CommCenter has been successfully completed, it should 

come online. Check that the system status “Online” is shown on the bottom-right of the 

VCN-CommCenter GUI.  
 
Required only in the case of the existing e-Parcel ID changed (Edit) 
* After customer who the existing e-Parcel ID has been changed (Edit) updates the software in a 

same computer, to set up new client digital certificate to the software, access the 
VCN-CommCenter menu bar “Tools” > “Auto Setup”.) 
Refer to P428 5-1. Existing e-Parcel ID (Edit) 

 

Procedure A for updating software is completed. 
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B. Reinstalling in another PC (Replace PC) 
 

Upon updating the e-Parcel VCN-CommCenter, if you want to replace the computer with another, 

choose either B-1(Not Migrate history) or B-2(Migrate history) procedure below. 

*Update from e-Parcel VCN-CommCenter 7.0 to 8.0 is available by the procedures below as usual. 

 

Warning: Please be advised that you should not update the software 
while the e-Parcel VCN-CommCenter is processing to upload and 
download data. Wait for the delivery status to be “Delivery Confirmed” in 
inbox and outbox. 

 

 

*Choose either B-1(Not Migrate history) or B-2(Migrate history) below. 
Unless there is some particular reason, we recommend the procedure (B-1) for just newly installing 

in another new computer without the previous histories etc. migrated. 

 

 

B-1. Reinstalling in another PC (Replace PC / Not Migrate history) 

When you want to replace the computer with another for the VCN-CommCenter, usually proceed 

to the procedure (B-1) for updating the e-Parcel client software. 

(On the new computer, take the procedure similarly to the first installation of the e-Parcel 

VCN-CommCenter.) 

→ Proceed to P440. Refer to the procedure B-1. (Recommended) 
 

 

OR 
 

 

B-2. Reinstalling in another PC (Replace PC / Migrate history) 

As long as there is a special reason for Migration of history, if you want to replace the computer 

with another and maintain the histories recorded on the previous VCN-CommCenter, proceed to 

the procedure (B-2) for updating the e-Parcel client software. 

(However, please note that the performance is not completely guaranteed in a new computer 

with the migration of the existing inbox/outbox histories and the configurations by the procedure 

of the section below. We are afraid that any problem caused by the migration is not included in 

our customer support.) 

→ Proceed to P443. Refer to the procedure B-2. 
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B-1. Reinstalling in another PC (Replace PC / Not Migrate history) 
 

Upon updating the e-Parcel VCN-CommCenter, when you want to replace the computer with another 

for the VCN-CommCenter, usually proceed to this procedure for just newly installing in another new 

computer. (Recommended) 

*Update from e-Parcel VCN-CommCenter 7.0 to 8.0 is available by the procedures below as usual. 

 

 

B-1-1. Procedure for the previous computer (Old PC) 

Start your previous computer which you have installed and use the e-Parcel software on. 
*If the existing VCN-CommCenter has not already been started, to start the program, double-click 

the “e-Parcel x.x” shortcut icon on the desktop. The VCN-CommCenter GUI will open. 
 

 

Warning: Please be advised that you should not update the software 

while the e-Parcel VCN-CommCenter is processing to upload and 

download data. Wait for the delivery status to be “Delivery Confirmed” in 

inbox and outbox. 

 

1. [*As necessary] If the current values of the “Option Config” have been changed from default, 

open the “Option Config” dialog from the menu bar “Tools” > “Option” of the VCN-CommCenter 

GUI. Then, make a note of the configuration values from the "General", "e-Mail Notification" and 

“Automation” tabs as needed. (At the later step, change the “Option Config” in a new computer.) 

 

 

Caution: When you want to replace the computer with another, before 

uninstalled the existing VCN-CommCenter from old PC, make a note of the 

“Option Config” (from the menu bar “Tools” > “Option”) for your 

memorandums. However, if it’s running with initial settings, you don’t need 

that. 

 

 

2. [*As necessary] Normally, addresses are added to the “Address Book” when sending/receiving 

items. Additionally, if you wish to migrate the existing “Address Book” to a new computer, click 

the arrow at the right of the “New Address” button to open pull-down menu on the “Address 

Book” dialog. Select the menu “Export List” and “Export Group” as needed to save as a file in CSV 

format. (At the later step, migrate these files to a new computer.) 

*Refer to P266 7. Address Book - 8. Export List 
*Refer to P280 7. Address Book - 10. Export Group 
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3. Proceed to [New PC Procedures] to install the latest version of the e-Parcel client software. 

→ Proceed to P442 [B-1-2. Procedure for a current computer (New PC)] 
*Note that the existing e-Parcel client software will be offline (inactive) in a previous computer 
just after the same e-Parcel ID has been set up to the software in a new computer. (Refer to 
P17) 

 

4. At last, uninstall (Delete) the existing e-Parcel client software from the previous computer.  

Select from Windows “Start” menu > e-Parcel > “Uninstall VCN-CommCenter x.x”. 
[For Windows 8 or earlier] Select from Windows “Start” menu > All Programs > e-Parcel > 
VCN-CommCenter x.x > “Uninstall VCN-CommCenter x.x”. 

*Refer to P452 13. Uninstalling Software (Delete) 
 
*However, if you cannot uninstall the existing e-Parcel client software for the reason that the 
previous computer was broken or abandoned, just take the procedures for a new computer to 
newly install the certificate and software. 

 
*Attention: Before you start to uninstall (delete) the software, check the inbox items of "Delivery 
Confirmed" and then move (save) the files as necessary. 

 

 

Warning: The e-Parcel service has adopted the client digital certificate for 
mutual recognition between the server and a client. (Authentication) Therefore, 
you can NOT set up a same e-Parcel ID (e-Parcel client digital certificate) to the 
e-Parcel VCN-CommCenter in multiple computers. 
One e-Parcel ID must be available to use in only one 
computer. 
If a same e-Parcel ID (e-Parcel client digital certificate) is set up to the e-Parcel 
client software in one computer, it is made unavailable in the other computer. 
That must cause the previous installation dysfunctional (offline). Also, the 
unreceived items which are not started to download during the previous 
installation will be the delivery status "Download aborted" and no longer 
possible to download. 
* If you have set up a same e-Parcel ID (e-Parcel client certificate) to the 

e-Parcel client software in multiple computers, we are afraid that any 
problems caused by multiple installations above are NOT included in the 
e-Parcel Customer Support. Accordingly, you need to clearly understand 
the installation with your e-Parcel ID for appropriate use.  
Refer to P17 Attention on using software 
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B-1-2. Procedure for a current computer (New PC) 

Download and install both a client digital certificate and the latest client software. 

 

1. On the new computer, take the procedure similarly to the first installation of the e-Parcel 

VCN-CommCenter. 

→ Return to P19 1. Preparations for the e-Parcel Service 
*Attention: Carefully read the following. While auto-setup in the software at STEP 6 

described on the webpage, the Confirmation "Previous installation found…." dialog below is 
shown. At this point, click the "OK" button to proceed setup. 

 

 

2. If you have a note of the previous "Option Config" at [Old PC Procedure 1.], open the "Option 

Config" dialog from the VCN-CommCenter menu bar "Tools" > "Option" to configure. When 

changes are made, click the "Save" button to take effect. 
*The changes for some settings in the Option Config dialog requires restarting the software to 

take effect. In this case, on the VCN-CommCenter GUI, access menu bar "File" > "Exit". After 
you shut it down, double-click the "e-Parcel x.x" shortcut icon on the desktop to restart the 
VCN-CommCenter. 

 

 

3. If you have the files exported from the previous “Address Book” at [Old PC Procedure 2.], click 

the arrow at the right of the “New Address” button to open pull-down menu on the “Address 

Book” dialog. Select the menu “Import List” and “Import Group” as needed to import as a file in 

CSV format. 

*Refer to P273 7. Address Book - 9. Import List 
*Refer to P285 7. Address Book - 11. Import Group 

 

 

4. Return to the [Old PC Procedure 4.] to uninstall (delete) the existing software from old PC.  

→ Return to P441 [4 of B-1-1. Procedure for the previous computer (Old PC)] 
*Note that the existing e-Parcel client software will be offline (inactive) in a previous computer 
just after the same e-Parcel ID has been set up to the software in a new computer. (Refer to 
P17) 

 

Procedure B-1 for updating software is completed. 
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B-2. Reinstalling in another PC (Replace PC / Migrate history) 
 

Upon updating the e-Parcel VCN-CommCenter, if you want to replace the computer with another and 

maintain the User Configuration, inbox and outbox histories recorded on the previous 

VCN-CommCenter, proceed to this procedure for updating the e-Parcel client software. 

*Update from e-Parcel VCN-CommCenter 7.0 to 8.0 is available by the procedures below as usual. 

 

However, unless there is some particular reason, we recommend the procedure (B-1) for just newly 

installing in another computer without the previous histories etc. migrated. 

 

 

Caution: Please note that the performance is not completely 

guaranteed in another computer with the migration of the existing 

inbox/outbox histories and the configurations by the operation 

procedures（B-2） introduced in this manual. We are afraid that any problem 

caused by the migration is not included in our customer support. 

Hereafter, you are responsible for operating the procedures below. 

 

 

In this case, when you replace the computer with another and install the latest version of the 

e-Parcel VCN-CommCenter, you are required the additional procedures to migrate the previous 

configurations, inbox and outbox histories recorded. Carefully take the following procedure. 

 

*In addition, at the same time that you update the software in another computer, you want to change 

(Edit) the existing e-Parcel ID, also follow this procedure below. 
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B-2-1. Procedure for the previous computer (Old PC) 

Start your previous computer which you have installed and use the e-Parcel software on. 
*If the existing VCN-CommCenter has not already been started, to start the program, double-click 

the “e-Parcel x.x” shortcut icon on the desktop. The VCN-CommCenter GUI will open. 
 

 

Warning: Please be advised that you should not update the software 

while the e-Parcel VCN-CommCenter is processing to upload and 

download data. Wait for the delivery status to be “Delivery Confirmed” in 

inbox and outbox. 

 

 

1. If the current values of the “Option Config” have been changed from default, open the “Option 

Config” dialog from the menu bar “Tools” > “Option” of the VCN-CommCenter GUI. Then, make a 

note of the configuration values from the both “General” and “e-Mail Notification” tabs. (At the 

later step, change the “Option Config” in a new computer.) 
*The previous configuration values of the "Automation" tab will be migrated to a new computer when 

you have done the operations described below. 

 

Caution: When you want to replace the computer with another, before 

uninstalled the existing VCN-CommCenter from old PC, make a note of the 

“Option Config” (from the menu bar “Tools” > “Option”) for your 

memorandums. However, if it’s running with initial settings, you don’t need 

that. 

 

 

2. Exit (shutdown) the existing e-Parcel client software. Access the VCN-CommCenter menu bar 

“File” > “Exit” to shut down. 

 

 

3. In the previous computer, copy ①a folder below (Database folder/Data storage folder) as your 

backup. (At the later step, migrate this folder to a new computer.) 

①Default location is C:¥e-Parcel¥VCN-CommCenter 
 

*Once the location has been changed, copy two folders below (②¥db: Database folder/③¥data: 
Data storage folder) as your backup.  
If ②③ folders are located in a same folder, copy a parent folder including two folders (①
¥VCN-CommCenter) as your backup.  

②Database folder : (Default folder path is C:¥e-Parcel¥VCN-CommCenter¥db） 
③Data storage folder : (Default folder path is C:¥e-Parcel¥VCN-CommCenter¥data） 
* Refer to P154 3. User Configuration - 7. Data Storage Path 
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4. To restart the existing e-Parcel client software, double-click the “e-Parcel x.x” shortcut icon on 

the desktop. 

 

 

5. Proceed to [New PC Procedures] to install the latest version of the e-Parcel client software. 

→ Proceed to P446 [B-2-2. Procedure for a current computer (New PC)] 
*Note that the existing e-Parcel client software will be offline (inactive) in a previous computer 
just after the same e-Parcel ID has been set up to the software in a new computer. (Refer to 
P17) 

 

 

6. At last, uninstall (Delete) the existing e-Parcel client software from the previous computer.  

Select from Windows “Start” menu > e-Parcel > “Uninstall VCN-CommCenter x.x”. 
[For Windows 8 or earlier] Select from Windows “Start” menu > All Programs > e-Parcel > 
VCN-CommCenter x.x > “Uninstall VCN-CommCenter x.x”. 

*Refer to P452 13. Uninstalling Software (Delete) 
 

*Attention: Before you start to uninstall (delete) the software, check the inbox items of "Delivery 
Confirmed" and then move (save) the files as necessary. 

 

 

Warning: The e-Parcel service has adopted the client digital certificate for 
mutual recognition between the server and a client. (Authentication) Therefore, 
you can NOT set up a same e-Parcel ID (e-Parcel client digital certificate) to the 
e-Parcel VCN-CommCenter in multiple computers. 
One e-Parcel ID must be available to use in only one 
computer. 
If a same e-Parcel ID (e-Parcel client digital certificate) is set up to the e-Parcel 
client software in one computer, it is made unavailable in the other computer. 
That must cause the previous installation dysfunctional (offline). Also, the 
unreceived items which are not started to download during the previous 
installation will be the delivery status "Download aborted" and no longer 
possible to download. 
* If you have set up a same e-Parcel ID (e-Parcel client certificate) to the 

e-Parcel client software in multiple computers, we are afraid that any 
problems caused by multiple installations above are NOT included in the 
e-Parcel Customer Support. Accordingly, you need to clearly understand 
the installation with your e-Parcel ID for appropriate use.  
Refer to P17 Attention on using software 
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B-2-2. Procedure for a current computer (New PC) 

Download and install both a client digital certificate and the latest client software. 

(At the same time that you update the software in another computer, you want to change (Edit) the 

existing e-Parcel ID, also you need to download and install both.) 

 

 

Caution: The client digital certificate installation in Windows requires to 

sign in Windows with a user account which runs the e-Parcel 

VCN-CommCenter. 

 

Caution: The software installation requires administrative privilege. 

If you sign in Windows with a standard user account without the 

administrative privilege, you are required to input an administrator 

account name (administrator ID) and password to User Account Control 

(UAC) dialog when executing installation. Prepare information in advance. 

[For Windows 2000, XP, 2003]  
Log on Windows with either an administrator account or a user account with the 
administrative privilege in advance. 

 

1. In a new computer, launch browser application (Microsoft Edge is recommended). Visit URL 

just below. 
* To launch Edge, click icon on the taskbar, double-click the desktop shortcut icon, or access the 

"Start" menu > M > Microsoft Edge for Windows 10 or later. 
“The e-Parcel Secure Enterprise - Software Download Site” URL: https://www.e-parcel.ne.jp/ 

 

2. Click the menu “Download & Install Software”. 

See the page appeared and then click the “Download e-Parcel Software” button. 

 

On the “e-Parcel software download site”, Follow the description on the web site STEP 1～6.  

(See below ①～⑥ steps) 
* For more information regarding how to download the client software, see the section below of 

this manual. 
Refer to P19-60 1. Preparations for the e-Parcel Service 
 

[The procedure on the “e-Parcel software download site”] 

①P21-23 / on the web - Web site STEP1. Login 

②P24 / on the web - STEP2. Select the e-Parcel client software 

③P25 / on the web - STEP3. Check the security of web site 

④P26-36 / on the web - STEP4. Download and Install a client digital certificate 

⑤P37-49 / on the web - STEP5. Access the URL of e-Parcel Secure Enterprise - Web Browser 
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⑥P50-60 / on the web - STEP6. Download and Install e-Parcel client software. (*Note: below) 

 

*Attention 1: Attention: Carefully read below. While the Install Shield Wizard of the software at 
STEP 6 of the web site described, when you wish to change the location of Database 
folder and/or Data storage folder in a new computer in processing software installation 
(on the Install Shield Wizard "Database Folder" and "Data Folder" location ), specify each 
folder location where you wish in a new computer (click Next to set default folder / 
click Change to select another folder). And then, proceed installation.  

*Note: When the locations of Database folder and/or Data storage folder changed, please 
carefully note that Windows user account must hold permissions to "Modify" the assigned 
folders. 

 
*Note: Carefully read that this operation below is different from the web site described at STEP 

6 (P58) at the end of the Install Shield Wizard. 
When the "Install Shield Wizard Completed" dialog appears, set unchecked (No) 
in the checkbox "Launch the program".   
(Default: checked (Yes)) 
Confirm it to be changed, and then click the "Finish" button. The e-Parcel VCN-CommCenter 
is installed then shutdown. 
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[Only users who migrate histories: see procedures 3～7 below]  

To migrate the previous configurations, inbox and outbox histories to another 

computer when installing the software, carefully take the following additional 

procedures. 

*Note: The performance is not completely guaranteed in a new computer with the migration of the 
existing inbox/outbox histories and the configurations by the operation procedures introduced in 
this manual. We are afraid that any problem caused by the migration is not included in our 
customer support. Hereafter, you are responsible for operating the procedures below. 

 
*Note: At the same time that you update the software in another computer, you want to change 

(Edit) the existing e-Parcel ID, also follow this additional procedure below. 
 
*Note: In the case of using another new e-Parcel ID (Exchange), you can NOT migrate the sending 

and receiving histories recorded in the previous e-parcel ID any longer to another new e-Parcel 
ID. 

 

 

 

If the e-Parcel VCN-CommCenter gets started after installation complete in a new computer, access 

the VCN-CommCenter menu bar “File” > “Exit” to shutdown it. 

 

 

3. In a new computer, locate ① a new folder (Database folder/Data storage folder) below and 

then replace it with the existing folder copied previously as your backup in the previous computer.  

Warning：Don’t overwrite! Delete new folder and then save the old one copied 
previously. (Replace: Delete new ① → Save old ①) 

① Default location is C:¥e-Parcel¥VCN-CommCenter 

 
*Attention 2: If you have changed the location of Database folder and/or Data storage folder in a 

new computer while software installation, locate two new folders (②¥db: Database folder/③
¥data: Data storage folder) where you have specified in a new computer and then replace 
[Don’t overwrite!] them with the existing folders copied previously as your backup in the 
previous computer.  
(If ②③ folders are located in a same folder, replace [Don’t overwrite!] a new parent 
folder(①¥VCN-CommCenter) with the existing parent folder copied previously.) 

②Database folder : (Default folder path is C:¥e-Parcel¥VCN-CommCenter¥db） 

③Data storage folder : (Default folder path is C:¥e-Parcel¥VCN-CommCenter¥data） 
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4. To run the VCN-CommCenter, double-click the “e-Parcel x.x” shortcut icon on the desktop. The 

VCN-CommCenter GUI will open. Access the VCN-CommCenter menu bar “Tools” > “Auto Setup”. 

The auto-setup begins. 

*Refer to P88 2. VCN-CommCenter View - 2. Menu Bar - 2-3. Tools – 2-3-3. Auto Setup 
 
*If the "Confirm Certificate" or the "Select a Certificate" dialog appears, select an e-Parcel client 

digital certificate of your e-Parcel ID and then click the “OK” button to begin auto-setup. 
[For Windows 10 or later] Click “More choices” on the “Select a Certificate” dialog to view all 
certificates. Then, select one. 

 
*If the proxy server configured to your computer’s proxy settings (Windows) requires user 
authentication, the "Proxy Authentication Required" dialog may appear upon auto-setup. Take 
either one below depending on the proxy authentication methods. 
Refer to P138 3. User Configuration – 4. Proxy Settings – 4-1. Automatic Proxy Settings 
Refer to P143 3. User Configuration – 4. Proxy Settings – 4-3. Proxy Authentication 

 
[In the case of NTLM Authentication or Integrated Windows Authentication] 
Leave blank in the proxy credentials (User name, Password, Checkbox “Remember this…”). 
Then, click the "OK" button. (Because when it is not given any proxy credentials, Windows 
Single Sign On function will work to automatically apply Windows user account name and 
password for proxy authentication.) 

 
[In the cases of the other authentication methods than the above] 
Input the proxy credentials (user name and password) and then click the “OK” button to 
authenticate. 
 
If you are not sure of the proxy credentials, contact your network administrator to obtain the 
correct information. 

 

 

While auto-setup, when the Confirmation "Previous installation found. Proceeding setup may 

cause it dysfunctional." dialog is shown, click “OK” to proceed setup. 
*In the case of database created since the e-Parcel VCN-CommCenter 8.0.8021 (Released in October 2019), the 

above dialog will appear when database is migrated to ver.8.0 in another computer. (In the case of database 
created by ver.7.0.7020 or earlier, it won’t appear when database is migrated to ver.8.0 in another computer.) 

*In the case of database created by the e-Parcel VCN-CommCenter 7.0.7020 (Released in August 2018), the 
above dialog will appear when database is migrated to ver.7.0.7020 in another computer. (In the case of 
database created by ver.7.0.7019 or earlier, it won’t appear.) 

 

 

 

5. When auto-setup is completed successfully, the system status "Online" should normally be 

shown on the bottom-right of the VCN-CommCenter GUI. Confirm that the previous inbox and 

outbox histories have been shown and recovered in inbox and outbox in a new computer. 
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6. Click e-Parcel ID shown on the tree view at the upper-left pane on the VCN-CommCenter GUI. 

The User Configuration appears at the right pane. Depending on the cases below, confirm or 

change (take either A or B) the setting "Data Storage Path". 

 
 

[A. The "Data storage folder" has been set as a same location as the previous computer  
while software installation in a new computer] 

→It should be shown correctly. Confirm that the setting "Data Storage Path" is a correct location on 
the User Configuration pane. And then proceed to the procedure 7. 
 (Either ③folder below or a location where you have specified should be shown.) 
②  Data storage folder :(Default folder path is C:¥e-Parcel¥VCN-CommCenter¥data) 

 

 

[B. The "Data storage folder" has been set a different location from the previous computer  
while software installation in a new computer] 

→At this point, the setting "Data Storage Path" has shown still an old location of the previous 
computer on the User Configuration pane.  
You must change the setting "Data Storage Path" to a new folder location. Carefully 
take the procedure of Attention 3 just below. 
 
*Attention 3: In the case that the "Data storage folder" has been set a different location from the 

previous computer while software installation in a new computer, you must change the 
setting "Data Storage Path" to a new folder location where has been already replaced 
at [New PC Procedure 3. ③Data storage folder]. And then click the "Save" button.  

 
How to change the setting "Data Storage Path" 
1) Show the User Configuration pane. Click the folder icon at the right of the "Data Storage 

Path" field. The Browse for Folder dialog appears.  
2) Select a folder (③¥data) which has been already replaced at [New PC Procedure 3.] and 

then click the button.  
*Make sure that it must be as a same folder (③¥data) as "Data Folder" location specified at 

[New PC Procedure 2.] software installation. 
3) Confirm that the setting "Data Storage Path" shows a correct new location. Then, click the 

"Save" button to take effect. 
 

*Refer to P154 3. User Configuration - 7. Data Storage Path 
*Note: When the locations of Data storage folder changed, please carefully note that Windows 

user account must hold permissions to "Modify" the assigned folders. 
 
*Note: Don't obtain any data directly within a folder specified as the "Data storage path". 

Therefore, this system folder has been managed by the e-Parcel system. When you wish to 
change the setting, move (save) files from inbox or etc., please be sure that you must operate 
through the VCN-CommCenter GUI. 
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7. If you have a note of the previous “General” and “e-Mail Notification” tabs in the “Option Config” 

at [Old PC Procedure 1.], open the “Option Config” dialog from the VCN-CommCenter menu bar 

“Tools” > “Option”. When changes are made in the “Option Config” dialog, click the “Save” 

button. 

*Refer to P157 4. Option Configuration 
*The changes for some settings in the Option Config dialog requires restarting the software to 

take effect. In this case, on the VCN-CommCenter GUI, access menu bar "File" > "Exit". After 
you shut it down, double-click the "e-Parcel x.x" shortcut icon on the desktop to restart the 
VCN-CommCenter. 

 

In addition, when you have done the above operations described, the previous configuration 

values of the "Automation" tab should be migrated to a new computer. Confirm that the previous 

values have been shown correctly in the "Option Config" dialog. 

 

 

8. Return to the [Old PC Procedure 6.] to uninstall (delete) the existing software from old PC.  

→ Return to P445 [6 of B-2-1. Procedure for the previous computer (Old PC)] 
*Note that the existing e-Parcel client software will be offline (inactive) in a previous computer 
just after the same e-Parcel ID has been set up to the software in a new computer. (Refer to 
P17) 

 

 

 

Procedure B-2 for updating software is completed. 
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13．Uninstalling Software (Delete) 

To uninstall the e-Parcel VCN-CommCenter on your computer, follow the procedure below. The 

following steps will guide you in uninstalling software for the VCN-CommCenter.  

 

 

Caution: When you want to replace the computer with another, before 

uninstalled the existing VCN-CommCenter from the previous computer (old 

PC), make a note of the “Option Config” (from the menu bar “Tools” > 

“Option”) for your memorandums. However, if it has been started with initial 

settings, you don’t need that. 

 

Warning: Please be advised that you should not uninstall the software 

while the e-Parcel VCN-CommCenter is processing to upload and 

download data. Wait for the delivery status to be “Waiting Download” in 

outbox or “Delivery Confirmed” in inbox. 

In addition, it is recommended that you should move (save) files of inbox items 

which the status is “Delivery Confirmed” or “Item opened” before the software 

uninstalled (deleted). 

 

 

 

 

13 
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1. How to uninstall the e-Parcel client software 

To uninstall the e-Parcel VCN-CommCenter, follow the procedure ①～⑤ below. 

 

①If the e-Parcel VCN-CommCenter runs, to shut down, access menu bar “File” > “Exit” on the 

VCN-CommCenter GUI. 

 

②Select from Windows “Start” menu. 

[For Windows 10 or later]  

Select from Windows “Start” menu > e-Parcel > “Uninstall VCN-CommCenter x.x” 
[For Windows 8 or earlier]  
Select from Windows “Start” menu > All Programs > e-Parcel > VCN-CommCenter x.x  >  
“Uninstall VCN-CommCenter x.x” 

[For Windows 10 or later] 

 

 

 

Select from 
Windows 

“Start” menu! 

Select E > e-Parcel > 
> Uninstall VCN-CommCenter 8.0! 
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③The uninstall confirmation dialog appears prompting to either “Yes” or “No”. Select the “Yes” 

button if continuing. 

 

 

 

 

 
*If you have not shutdown the e-Parcel VCN-CommCenter yet at the previous step ①, the dialog 

below will appears. Check the “Automatically close applications and attempt …” selected with 
the default and then click the “OK” button to shut down the e-Parcel VCN-CommCenter. 

 

 

 

 
*[For Windows Vista or later] The ”User Account Control (UAC)” dialog appears. In the case of sign 

in Windows with an administrator account, select the “Yes (Allow)” button to allow. Or, in the case 
of sign in Windows with a standard account without the administrative privilege, an administrator 
account name (administrator ID) and password are required to input.  
[For Windows 2000, XP, 2003] Log on Windows with an administrator account or a user account with the 
administrative privilege. And then, try to uninstall again. 

 
*If the Security Warning dialog appears prompting you to install this application, click the “Run” 

button to allow executing. 
 

Yes! 
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④Please wait while uninstalling the e-Parcel VCN-CommCenter. 

 
 

 

⑤When uninstalling is completed, the above dialog ④ will close. Confirm that the “e-Parcel x.x” 

shortcut icon on the desktop and the  e-parcel icon in Windows taskbar notification area are 

removed. 
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2. After Uninstalling Software 

After uninstall the e-Parcel VCN-CommCenter, take the procedure A, B or C depending on your 

circumstances below. 

 

 

[Reinstall and use software (Updating etc.)] 
 

Refer to 12. Updating Software 

A. Reinstalling in a same PC (Not replace PC / Maintain history)  

→ Proceed to P434 

 

 

B. Reinstalling in another PC (Replace PC) 

→ Proceed to P439 

 

 

 

 

[Delete history (Refresh and then newly install) or Not use software] 
 

Refer to 13. Uninstalling Software (Delete) 

C. Not maintain history or Not use software (Delete history)  

→ Proceed to P457 
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C. Not maintain history or Not use software (Delete history) 
 

In the case of the followings… 

・[Not maintain history (Refresh configurations/history and then newly install)]  

Although you reinstall the software later, you wish to delete the previous configurations, inbox 

and outbox histories of VCN-CommCenter. 

・[Not use software] When you end using the software in a computer, you wish to delete the 

configuring, sending and receiving history of VCN-CommCenter. 

 

After uninstall the e-Parcel VCN-CommCenter, follow the procedure below to complete. 

 

 [Delete folders] 

After uninstall the software, delete two (①②) folders below. 

①Install destination folder 

(Default folder path is C:¥Program Files¥e-Parcel¥VCN-CommCenter x.x） 
* Normally an install destination folder will be deleted when the software is uninstalled. If 

exist, delete this folder.  
 

②Database folder/Data storage folder 

(Default folder path is C:¥e-Parcel¥VCN-CommCenter） 
 

* When the location has been changed, delete two (③④) folders below in the location 
where you specified.  
 
③Database folder :  

(Default folder path is C:¥e-Parcel¥VCN-CommCenter¥db） 
 
④Data storage folder :  

(Default folder path is C:¥e-Parcel¥VCN-CommCenter¥data） 
* Refer to P154 3. User Configuration - 7. Data Storage Path 
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Appendix 1. The e-Parcel Secure Enterprise - Web 

Browser 

When the e-Parcel client software users wish to view/edit your user information, change 

password, configure the “Password Protect” option and inquire into inbox/outbox histories 

recorded online, visit URL of “The e-Parcel Secure Enterprise - Web Browser” through browser 

application in a computer which has been imported your e-Parcel client digital certificate. 
 
To view/edit your user information, access the “User Info” page. To inquire into inbox/outbox 

histories recorded for the selected period (until month before last or target date) online, access the 

“Inbox” or “Outbox” page. Please be advised to bookmark this site for your convenience. 
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1. Access the URL of “The e-Parcel Secure Enterprise - 

Web Browser” 

①Launch browser application (Microsoft Edge is recommended). Visit URL just below. 
* To launch Edge, click icon on the taskbar, double-click the desktop shortcut icon, or access the 

"Start" menu > M > Microsoft Edge for Windows 10 or later. 
 

“The e-Parcel Secure Enterprise - Web Browser” URL: https://secure.e-parcel.ne.jp/ 
 

*Attention: To access URL of “The e-Parcel Secure Enterprise - Web Browser”, your e-Parcel client 
digital certificate is required to install in OS or browser application in advance when you sign in 
Windows with a user account which use the e-Parcel service. Usually, you have already installed 
a certificate in Windows when starting the e-Parcel service in a computer. 
 (Refer to P399 the section for Downloading and Installing client digital certificate.) 

*Caution: Please be sure that you are required to install your e-Parcel client digital certificate 
again if Windows user account is changed in spite of a same computer. 

 

②The site requires your certificate for authentication. Select your e-Parcel client digital certificate 

installed in Windows and then click the “OK” button. 

 

 
*If multiple e-Parcel client digital certificates are shown on the "Select a certificate" window, 

select a certificate of your e-Parcel ID and then click the “OK” button. 
 
*If the “Password Protect” function already has been enabled, the “Authentication Required” 

dialog may appear prompting to enter e-Parcel ID and login password. 

And then 
click "OK"! 

Click to select 
a certificate. 
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③“The e-Parcel Secure Enterprise - Web Browser” new window is opened. Click the “User Info” 

on the top navigation menu.  

 
 

Click any one 
of menus 
“Inbox”, 
“Outbox”  

or  
“User Info”. 

* Attention: Don’t send any data if 
the menu "Create New" appears. 
This menu is provided for only users 
of the e-Parcel web browser client. 
(For users of the e-Parcel client 
software, we provide the higher 
security and the lager data delivery 
service) In addition, once the 
software has installed, the menu 
"Create New" is no longer shown. 
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Caution: If the menu "Create New" appears on "The e-Parcel Secure 

Enterprise - Web Browser", don’t send any data from it. (This menu is 

provided for users of web browser client.) In the case of software installation 

uncompleted, this menu may appear. Usually, users of software must send 

data on e-Parcel client software GUI after installation complete. 

(Therefore, we provide the higher security and the lager data delivery service 

for users of the e-Parcel Secure Enterprise - Software.) 
*Since April 1st, 2017, due to end of the send function by "The e-Parcel Secure Enterprise - 

Web Browser" for users of "e-Parcel Secure Enterprise - Software", the "Create New" menu 
has NOT been displayed on the Web Browser.  

 

 

Caution: If you were rejected to access URL of “The e-Parcel Secure 

Enterprise - Web Browser”, a client digital certificate may not have been 

installed in Windows appropriately. First, ensure that a client digital certificate 

has been correctly installed by reviewing the section below. Also, you may need 

to confirm the settings of your computer, the proxy server or network 

environment not to configure the access control such as block or analysis of 

HTTPS request to the domains of our service. 
Refer to below. 
*P40 [If failed in access “The e-Parcel Secure Enterprise - Web Browser”] 
*For more details, visit the Q&A page of the site（URL：

https://www.e-parcel.ne.jp/epvcn/en/FAQ/answer1.php）and carefully read the 
description. It is also described additionally check points about the security settings and 
the proxy server settings in Windows. 

 

 

Caution: If your computer or network environment (the proxy server, firewall, 

any applications for security measures or etc.) have any access control such as 

block or analysis of SSL connections, you need to allow (exclude from 

target) HTTPS protocol communications [Port=443] to the e-Parcel service 

domains as of [https://*.e-parcel.ne.jp] and [https://*.e-parcel.com] 

(Wildcard domain: Asterisk mark [*] would be replaced with name of multiple 

servers via the e-Parcel service.). 

If you are not clear about that, please consult your network administrator to 

modify the network settings. 
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2. Edit User info / Change Password 

 

Upon your application, e-Parcel Corporation usually register your e-Parcel ID and user information 

such as your name, company name and contact telephone number etc. To edit your user 

information, we provide the “User Info” page by accessing URL of “The e-Parcel Secure Enterprise 

- Web Browser”. 

 

Also, you can change a password and configure the “Password Protect” on the “User Info” page. 
For more details about the “Password Protect”, see the section below of this manual. 
*Refer to P385 10. Password Protect function 
 

This section will guide you to edit your user information and change password. 

 

How to edit user information and change password 
 

To edit the user information and change password, launch browser application in a computer which 

has been imported your e-Parcel client digital certificate. And then, access URL just below. Then, 

take the procedures ①～⑤ below. 

“The e-Parcel Secure Enterprise - Web Browser” URL: https://secure.e-parcel.ne.jp/ 

 
*Attention: To access URL of “The e-Parcel Secure Enterprise - Web Browser”, your e-Parcel client 

digital certificate is required to install in OS or browser application in advance when you sign in 
Windows with a user account which use the e-Parcel service. Usually, you have already installed 
a certificate in Windows when starting the e-Parcel service in a computer. 
 (Refer to P399 the section for Downloading and Installing client digital certificate.) 

*Caution: Please be sure that you are required to install your e-Parcel client digital certificate 
again if Windows user account is changed in spite of a same computer. 

 

①“The e-Parcel Secure Enterprise - Web Browser” window opens. Click the “User Info” on the top 

navigation menu.  

 

②The “User Info” page shows your profile registered. 

 

③It allows you to edit your user information and change password.  

(To edit your e-Parcel ID is not allowed.) 

 

④Make the necessary changes and then click the “Update” button. 
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[User Info on the e-Parcel Secure Enterprise - Web Browser] 

 
 

 

 

 

 

Note: If you want to edit the existing e-Parcel ID or register another new 

e-Parcel ID, please contact the e-Parcel Customer Support by e-mail 

(support@e-parcel.co.jp) with your e-Parcel ID specified.  

(Business Hours: 9:00-17:00JST/Mon-Fri) 

Refer to P396 11. Edit / Exchange / Add Digital Certificate 

 

When changes are made, 
click “Update”! 

User Info 

A password  
must be 

between 8 - 20 
half-width 

alphanumeric 
characters. 

Enter new password! 

*Enter your company 
name in the 
“Description” field. 

Edit user information! 
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Descriptions of the “User Info” 

The following contents on the “User Info” window are allowed to edit.  

The contents with an asterisk (*) below do not directly affect the e-Parcel client software. 

 

 User Name 

Your name. Enter the first name in the upper field and the last name in the lower field. 
*The "User Name" of User Info is automatically shown as "Sender name" and "Recipient name" 

on inbox, outbox and address book of the e-Parcel client software. The fields "first name" and 
"last name" of a user name must be input using less than 60 characters each. (For example, 
John Parcel as "first name" and Design department as "last name" are inputted.) 

 

 Description 

Your company name. 

 

 Contact Tel 

Your daytime numbers. 

 

 Language*  

This field is provided for users of “The e-Parcel Secure Enterprise - Web Browser”. 

(The e-Parcel client software is not affected by value change in this field.) 

Your standard language is displayed on the e-mail notification through the service of “The 

e-Parcel Secure Enterprise - Web Browser”. 

 

 Time Zone* 

This field is provided for users of “The e-Parcel Secure Enterprise - Web Browser”. 

(The e-Parcel client software is not affected by value change in this field.) 

Your standard time zone is displayed on the page of the Inbox and the Outbox in “The 

e-Parcel Secure Enterprise - Web Browser”. 

 

 Daylight Savings* 

This field is provided for users of “The e-Parcel Secure Enterprise - Web Browser”. 

(The e-Parcel client software is not affected by value change in this field.) 

Once daylight savings field is configured for the countries and regions practicing Daylight 

Savings Time, it effects on the page of the Inbox and the Outbox in “The e-Parcel Secure 

Enterprise - Web Browser”. 
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 New Password & New Password (re-enter)  

If a password should be changed, enter the new password in the “New Password” field, and 

then confirm the new password by re-entering it in the “New Password (re-enter)” field. 

(*If e-Parcel “Password Protect” function has been set “Yes” and when an e-Parcel 

password is changed, you must re-authenticate the new password on your e-Parcel Client 

Software such as the following procedure.） 

 

 

Caution: A password must be between 8 - 20 half-width alphanumeric 
characters. Note that password is case-sensitive, and contains no spaces. 

 

Warning: When users who the “Password Protect” function has been 
already enabled (set “Yes”) will change password according to the User 
Info on the “The e-Parcel Secure Enterprise - Web Browser”, please be aware 
that you are also required to change your password to new one in the 
“Login Password” field on the e-Parcel software. If you don’t, the 
e-parcel software will be shutdown with fail in login to the e-Parcel server. In 
this situation, enter login password in the e-Parcel “Server Login Required” 
dialog which will appear when the e-Parcel software gets started. 
For more detail regarding how to set the login password, see below. 
*Refer to P147 3. User Configuration - 5. Login Password Authentication 

 

 Password Protect 

The “Password Protect” function is usually disabled (“No”) with initial choice.  

If the “Password Protect” function will be changed to be enabled (“Yes”), you also must set 

a “Login Password” on your e-Parcel client software. Therefore, the software is required to 

authenticate a login password whenever login to the e-Parcel server in the cases of 

installation, starting the software, configuration, Auto Setup, Import Certificate and etc.  

(When you access URL of “The e-Parcel Secure Enterprise - Web Browser” at 

https://secure.e-parcel.ne.jp/, the “Authentication Required” dialog will also appears 

prompting to enter e-Parcel ID and login password.) 

*Refer to P385 10. Password Protect function 

 

 

Warning: When the “Password Protect” function is enabled (set 
“Yes”) according as the User Info is changed on “The e-Parcel Secure 
Enterprise - Web Browser”, you are required to enter your password in the 
“Login Password” field on the e-Parcel software. If you don’t, the 
e-parcel software will be shutdown with fail in login to the e-Parcel server. In 
this situation, enter login password in the e-Parcel “Server Login Required” 
dialog which will appear when the e-Parcel software gets started. 
For more detail regarding how to set the login password, see below. 
*Refer to P147 3. User Configuration - 5. Login Password Authentication 
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 Monthly Total 

It displays total data volume of this month which has been sent by your e-Parcel ID. Once 

“Monthly Size Limit” is set on the e-Parcel ID or the account to which the e-Parcel ID belong, 

it will restrict total data volume of this month to a prescribed value or less. 
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⑤The process result “OK” should normally appear. Your user information has been updated 

successfully. After confirmation, click the “Back” button. 

 

 

 

 

 

Check! 
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3. View Inbox/Outbox on the web site 

 

Users of the software usually send, receive data and check the delivery status of the transmission 

items listed in Inbox/Outbox on the VCN-CommCenter GUI. 

 

Moreover, according to access URL of “The e-Parcel Secure Enterprise - Web Browser” through 

browser application in a computer which has been imported your e-Parcel client digital certificate, 

you can also view the transactions recorded in the e-Parcel server. View the “Inbox” and “Outbox” 

page on the web site. 
*Users of the software are invalidated to send and receive data on “The e-Parcel Secure Enterprise 

- Web Browser”. 
 

The “Inbox” and “Outbox” page on the Web Browser will show the delivery histories until 

month before last or target date.  

 

For example, to be useful, if you have deleted the items from inbox and outbox on the 

VCN-CommCenter GUI, the items are never restored on the client software. However, you can view 

the transaction histories on the Web Browser. 

 

This section will guide you to view Inbox/Outbox on the web site. 
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How to view Inbox/Outbox on the web site 
For the software users, to view the inbox/outbox item histories (until month before last or target 

date) on the web site, access URL just below. Then, follow the procedure ①～⑦ below. 

“The e-Parcel Secure Enterprise - Web Browser” URL: https://secure.e-parcel.ne.jp/ 
 

*Attention: To access URL of “The e-Parcel Secure Enterprise - Web Browser”, your e-Parcel client 
digital certificate is required to install in OS or browser application in advance when you sign in 
Windows with a user account which use the e-Parcel service. Usually, you have already installed 
a certificate in Windows when starting the e-Parcel service in a computer. 
 (Refer to P399 the section for Downloading and Installing client digital certificate.) 

*Caution: Please be sure that you are required to install your e-Parcel client digital certificate 
again if Windows user account is changed in spite of a same computer. 

 

①“The e-Parcel Secure Enterprise - Web Browser” window opens. Click the “Inbox” or “Outbox” 

on the top navigation menu.  

 

②The “Inbox” or “Outbox” page appears. The today’s items (Created Date) are listed up on 

either “Inbox” or “Outbox” which you choose. (Figure below) 

 

[“Inbox” on the e-Parcel Secure Enterprise - Web Browser] 

 

 

 

 

 

①Click 
“Inbox” 

②The today’s items  
(Created Date) of 

inbox are listed up. 
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[“Outbox” on the e-Parcel Secure Enterprise - Web Browser] 

 

 

 

 

 

 

①Click 
“Outbox” 

②The today’s items 
(Created Date) of 

outbox are listed up. 
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③If you want to change the “Search Period” to view on the “Inbox” or “Outbox”, click ▼ at the 

right of the “Search Period” field to open the pull-down menu and select a “Search Period”. 

(Figure below) 

 

④When selection is made in the “Search Period” field, click the “Search” button. 

 

⑤The “Inbox” or “Outbox” page is reloaded. The item histories appear in the search for the 

“Search Period”. 
*In the case of selecting “Custom” for “Search Period”, select a target date from the date 

drop-down list, and click the “Search” button again. 
 

[For example: Outbox] 

 

 

④Click the 
“Search” button 
when a search 
period selected. 

③Click 
here to 

open the 
pull-down 

menu! 

⑤Check this page 
reloaded. 

To “Export CSV”, 
click this button 
to save the list. 
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The “Search Period” pull-down menu 

According to the pull-down menu “Search Period”, the choice made will search for “Today” 

through “Month before last” when items created. Moreover, if you wish to search for items 

which have been transmitted on a particular date or before the month before last, select to 

search for “Custom (Target date)” when items created for a specified day period. 

The item histories appear in the search for the “Created Date” on the “Inbox” or “Outbox” 

page on the Web Browser.  

 

The standard time on the Web Browser is affected by the “Time Zone” setting on the “User 

Info” page.  

*The e-Parcel client software is not affected by value change in the “Time Zone” setting. 
In addition, to search for items by UTC in this time, set checked in the checkbox ☑ “Use UTC”.  

 

 [ Search Period：(For example) When today is 13 May, 2021(Thursday) ] 

 Today 

(ex.) from: 05-13-2021 00:00:00 to: 05-13-2021 23:59:59 

 Last 3 days: For three days until today 

(ex.) from: 05-11-2021 00:00:00 to: 05-13-2021 23:59:59 

 This week: This Monday to this Sunday 

(ex.) from: 05-10-2021 00:00:00 to: 05-13-2021 23:59:59 

 Last 7 days: For seven days until today 

(ex.) from: 05-07-2021 00:00:00 to: 05-13-2021 23:59:59 

 Last week: Last Monday to last Sunday 

(ex.) from: 05-03-2021 00:00:00 to: 05-09-2021 23:59:59 

 Last 2 weeks: For 14 days until today 

(ex.) from: 04-30-2021 00:00:00 to: 05-13-2021 23:59:59 

 This month: The 1st of this month to today 

(ex.) from: 05-01-2021 00:00:00 to: 05-13-2021 23:59:59 

 Last 1 month: For 31 days until today 

(ex.) from: 04-13-2021 00:00:00 to: 05-13-2021 23:59:59 

 Last month: For last month 

(ex.) from: 04-01-2021 00:00:00 to: 04-30-2021 23:59:59 

 Month before last: For month before last 

(ex.) from: 03-01-2021 00:00:00 to: 03-31-2021 23:59:59 

 Custom: Target date [(For example) When 24 December, 2020 is specified] 

(ex.) from: 12-24-2020 00:00:00 to: 12-24-2020 23:59:59 
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The “Reload” menu 

To refresh the items list on the “Inbox” or “Outbox” page, click a “Reload” menu. 

 

 

The “Export CSV” menu 

Once the items have been listed up in “Inbox” or “Outbox”, the item histories listed are available 

to export as a file in CSV format [comma separated value/UTF-8]. 

 

①Click the “Export CSV” menu.  

In Windows, the executable file is often saved automatically to This PC > “Downloads” folder 

with the default setting. 

(Or in the download notification bar of the browser window, select "Save as") 
*If you have changed Download Location in the browser settings “Downloads”, it might be 

saved to another location where you specified. 
 

②When download complete, in the download notification bar, click "Save "Open file".  

Or, locate “Downloads” folder in your PC to open a file directly. 

 

[List of Inbox / Outbox: CSV file] 

Download location (Default): C:¥Users¥(Windows user account name)¥Downloads 

Inbox/CSV file name (default)：list_parcel_inbox.csv 

Outbox/CSV file name (default)：list_parcel_outbox.csv 

 

 

The items list file in CSV format [comma separated value/UTF-8] is exported below. 
*All values of an item are exported as single line. 
*A part of values is enclosed in double quotation mark. 
 

Inbox/CSV file name (default)：list_parcel_inbox.csv 

[Inbox item / Output description in CSV format (UTF-8)] 

"Parcel ID","Sender FirstName LastName","Sender e-Parcel ID ","Subject",Status Code*1, 

File Size (Bytes),Account GID*2,"Crated Date","File Name"*3 

 

[For example: Inbox item / Output in CSV] 

"8b67a4e9-f52d-c245-a74c-a0341cf5062b","test epid2","test-epid2@e-parcel.co.jp", 

"Order sheet-2",130,35,16777222,"09-30-2020 01:55:43","File_2.txt,Folder_2¥" 
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Outbox/CSV file name (default)：list_parcel_outbox.csv 

[Outbox item / Outbox descriptions in CSV format (UTF-8)] 

"Parcel ID","Recipients e-Parcel ID ","Subject",Status Code*1, 

File Size (Bytes),Account GID*2,"Crated Date","File Name"*3 

 

[For example: Outbox item / Output in CSV] 

"48f811cc-dade-ce4d-8c61-d1dcc37b8662","test-epid2@e-parcel.co.jp,test-epid1@e-parcel.co

.jp","Order sheet-1",130,34,16777221,"09-30-2020 08:07:16","Company A¥,Order Sheet 

1.txt" 

 

 

*1 Refer to P482 Appendix 3. Delivery Status - 2. Delivery Status List 
*2 Account charged for data delivery service (The account ID numbered automatically) 
*3 Attached files/folders name are output of up to 120 characters. 
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How to track delivery on the web site 
 

In addition, you can track the delivery status of the transmitted items on the Web Browser. Take 

the procedures below after an item is listed on the “Outbox” page. 

 

①Click a “Status” column (Link) of an item listed on the “Outbox” page.  

 

[For example: Outbox] 

 

 

 

 

①Furthermore, 
click here  
to track  
delivery! 

Outbox 
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②The “Track Delivery” page for a selected item opens. This page shows the “parcel details” as 

outbox item information which data is transmitted. Then, on the “Recipients” field, you can 

track the delivery status in every recipient shown on the “Download Status”.  

*To refresh tracking, click the “Reload” button or “Parcel ID” (Link) field. 

 

 

[For example: Outbox/Track Delivery] 

 

 

 

 

The “track delivery” 
of every recipient. 

*To refresh tracking, 
click “Reload” button. 

②The “parcel details” 
of an outbox item. 
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Appendix 2. Request Password 

When you forgot your own password which has been registered with the e-Parcel secure date 

delivery service, select either procedure A or B below depending on your e-Parcel ID.  
*Unless there is some particular reason, we usually register your e-mail address as an e-Parcel ID 

for using the e-Parcel secure data delivery service. In this normal case, the online password 
request function is available. You can take the procedure (A). 

 

Did you register an e-mail address as your e-Parcel ID?  
Yes. ⇒ Proceed to A. (Online password request available) 
No. ⇒ Proceed to B. (Change password by yourself) 

 

A. Your e-Parcel ID is the same as your e-mail address. (in normal case) 
In the case that your e-Parcel ID is the same as your e-mail address (a receivable e-mail address), 

online password request is available. Usually proceed to the procedure (A).  

Upon your password request online at the “e-Parcel Secure Enterprise - Software Download Site”, a 

password notification will automatically be sent you by e-mail. The target e-mail address must be 

your e-mail address registered as your e-Parcel ID. 

→ The procedure A. How to request password online (Proceed to P478)  
 

B. Your e-Parcel ID is different from your e-mail address. 
Due to your operational reasons for e-Parcel ID registration, if your e-Parcel ID is different 

from your e-mail address, online password request is unavailable. (For example, in the 

case that an e-Parcel ID is no longer existed as a receivable e-mail address or just any characters 

exceptionally.) Proceed to the procedure (B-1). 

→ The procedure B-1. Change password by yourself 

Refer to P458 Appendix 1. The e-Parcel Secure Enterprise - Web Browser 
*To change your own password by yourself, launch your computer, sign in Windows with user 

account which has been imported the e-Parcel client digital certificate. Then, visit URL of “The 
e-Parcel Secure Enterprise - Web Browser” at https://secure.e-parcel.ne.jp/. Select the menu 
“User Info” to change password. 

 
However, in the case the “Password Protect” function which is disabled by default has been already 

enabled according as set “Yes”, your current password is required to authenticate when access URL 

of “The e-Parcel Secure Enterprise - Web Browser” above. In this case, proceed to the procedure 

(B-2). 

→ The procedure B-2. Request to reset password 
*To request to reset password, contact the e-Parcel customer support by e-mail 

(support@e-parcel.co.jp) with your e-Parcel ID specified. Upon your request, we will reset 
password. We are afraid that reset password is available during our business hours. (Business 
Hours: 9:00-17:00JST/Mon-Fri) 
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A. How to request password online 

When you forgot your own password which has been registered with the e-Parcel secure date 

delivery service, in the case that your e-Parcel ID is the same as your e-mail address, take the 

procedure below.  

On the “e-Parcel software download site”, the “Request Password” function is provided. 

 

Caution: When your e-Parcel ID is the same as your e-mail address (a 
receivable e-mail address), the online password request function is 
available. We usually register your e-mail address as your e-Parcel ID for 
using the e-Parcel secure data delivery service. 
As long as there is a special reason for e-Parcel ID registration, if your 
e-Parcel ID is different from your e-mail address, the online 
password request function is unavailable. (For example, in the case that 
an e-Parcel ID is no longer existed as a receivable e-mail address or just any 
characters exceptionally.) In this case, proceed to the procedure (B) in the 
previous page to change password. 

 

①Visit URL just below and then click the menu “e-Parcel Enterprise Service Menu”. See the 

page appeared and then click the “Request Password” button.  

“The e-Parcel Secure Enterprise - Software Download Site” URL: https://www.e-parcel.ne.jp/ 

 
 Click! 

Select this menu. 
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②The “Request Password Form” page appears. Enter your e-Parcel ID (*It must be the same as 

your e-mail address) and click the “Confirm” button.  

 

 

 

 

 

③The “Request Password Confirmation” page appears. Confirm and then click the “Submit” 

button to request password. 

 
 

When entered, 
confirm! 

When confirmed, 
submit! 
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④The “Request Password Completed” page appears. The password notification will automatically 

be sent you by e-mail. You should soon be receiving an e-mail notification of your password. 

Check it in the e-mail application. The target e-mail address must be your e-mail address 

registered as e-Parcel ID. 
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Appendix 3. Delivery Status 

1. Refresh Tracking 

On the VCN-CommCenter GUI, the current delivery statuses of items are shown on the “Status” 

column of the Outbox (P334), Outbox Parcel Detail (P339), Inbox (P358) and on the “Upload 

Status” of Inbox Parcel Detail (P364). 

The delivery status for tracking will be refreshed by the following two (2) functions. 

1. Auto Polling: at regular intervals 
2. Manually Polling: The “Reload” button on the tool bar of VCN-CommCenter GUI 

(OR the menu bar File > “Reload”) 
Also, upon polling, the VCN-CommCenter detects new incoming items and then starts to work the 

downloading processes. 

 

Warning: Downloading data must be made within 31 days from the 

date of item sent (item created). After expired, the unreceived items will 

automatically be deleted from the e-Parcel server. Therefore, you can NOT 

download the expired items any longer. Also, the delivery statuses of the 

expired items will be no longer updated. 

 

Warning: After 31 days from the date of item sent (item created), those 

expired items will be excluded from tracking target through the e-Parcel 

service. 

 

Auto Polling 
The VCN-CommCenter is auto-polling periodically to the e-Parcel server at regular intervals for 
checking external events such as tracking the latest delivery status and detecting the existence of 
unreceived items while the application is running to be online. (Default: 5 minutes polling interval) 
*Refer to P164 4. Option Configuration - 3. Polling Interval 
 

Reload 
The “Reload” button on the tool bar of VCN-CommCenter GUI will provide you with real time 

tracking capabilities. When click the “Reload” button, the VCN-CommCenter promptly poll to the 

e-Parcel server for checking external events such as track the latest delivery status and any items 

pending delivery. 
*Refer to P119 2. VCN-CommCenter View - 3. Tool Bar - 3-9. Reload 
*This behaves similarly to the menu bar File > “Reload”. 
*Attention: This function of “Reload” button on only the Parcel Detail dialog has been changed since e-Parcel 
VCN-CommCenter 7.0.7020 (Released in August 2018). When click the “Reload” button on only the Parcel Detail 
dialog, the delivery status will be refreshed for only that item.  
(Therefore, note that this must NOT behave like the function of both the menu “File > Reload” and the “Reload” 
button of tool bar on VCN-CommCenter GUI. This “Reload” button on only the Parcel Detail dialog dose NOT 
promptly checks for any other items pending delivery and track the latest status by polling manually to the e-Parcel 
server.) 
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2. Delivery Status List 

 

 

Notice of change the delivery statuses for e-Parcel VCN-CommCenter 8.0 
 

The delivery statuses written in blue bold below have been changed since ver.8.0.8021 [Released 
in October 2019]. 
(This change doesn't affect use of the existing software ver. 7.0.7020 or lower.) 
 

 

 

Old: ver.7.0.7019 or lower 
Code Delivery Status Outbox Inbox 

10 Waiting Process ○ ○ 

100 Waiting Download  ○ ○ 

 

 

Old: ver.7.0.7020 

Code Delivery Status Outbox Inbox 

10 Initializing ○  

80 Waiting Download ○ ○ 

100 Ready To Download ○ ○ 

 

 

 

 

 

New: ver.8.0.8021 

Code Delivery Status Outbox Inbox 

10 Initializing ○  

80 Waiting Download ○ ○ 

100 Waiting Download ○ ○ 

 

 

 

* For more details, refer to the Delivery Status List for each e-Parcel VCN-CommCenter 8.0 / 7.0. 
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Delivery Status List (e-Parcel VCN-CommCenter 8.0) 
 

Code Delivery Status Outbox Inbox 

10 Initializing ○  

20 
Initializing ○  

Encrypting xx % ○  

30 Waiting Upload ○  

40 
Upload Start ○  

Uploading xx % ○  

50 Upload Complete ○  

55 Waiting Approval ○  

60 Waiting Download *  

80 Waiting Download ○ ○ 

90 Upload Interrupted ○  

100 Waiting Download ○ ○ 

110 
Download Start ○ ○ 

Downloading xx %  ○ 

120 
Download Complete ○ ○ 

Decrypting xx %  ○ 

125 
Extracting xx %  ○ 

Delivery Verifying  ○ 

130 Delivery Confirmed ○ ○ 

190 Request Error ○ ○ 

200 Item Opened ○ ○ 

210 Item Moved ○ ○ 

290 Cancel Requested ○  

300 Canceling ○ ○ 

310 Cancelled ○  

320 Upload Error ○  

410 Delivery Denied ○  

420 Download Aborted ○ ○ 

430 Item Deleted ○ * 

440 Delivery Expired *  

500 Delivery Error ○ ○ 

510 Unknown Recipient ○  
※[*] mark delivery status are used by only the e-parcel system. 
※The delivery statuses written in blue above have been displayed since ver.8.0.8021 (Released in Oct. 2019) 
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Delivery Status List (e-Parcel VCN-CommCenter 7.0.7020) 
 

Code Delivery Status Outbox Inbox 

10 Initializing ○ ― 

20 
Initializing ○  

Encrypting xx % ○  

30 Waiting Upload ○  

40 
Upload Start ○  

Uploading xx % ○  

50 Upload Complete ○  

55 Waiting Approval ○  

60 Waiting Download *  

80 Waiting Download ○ ○ 

90 Upload Interrupted ○  

100 Ready To Download ○ ○ 

110 
Download Start ○ ○ 

Downloading xx %  ○ 

120 
Download Complete ○ ○ 

Decrypting xx %  ○ 

125 
Extracting xx %  ○ 

Delivery Verifying  ○ 

130 Delivery Confirmed ○ ○ 

190 Request Error ○ ○ 

200 Item Opened ○ ○ 

210 Item Moved ○ ○ 

290 Cancel Requested ○  

300 Canceling ○ ○ 

310 Cancelled ○  

320 Upload Error ○  

410 Delivery Denied ○  

420 Download Aborted ○ ○ 

430 Item Deleted ○ * 

440 Delivery Expired *  

500 Delivery Error ○ ○ 

510 Unknown Recipient ○  
※[*] mark delivery status are used by only the e-parcel system. 
※The delivery statuses written in blue above have been displayed since ver.7.0.7020 (Released in Aug. 2018) 
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Delivery Status List (e-Parcel VCN-CommCenter 7.0.7019 or lower) 
 

Code Delivery Status Outbox Inbox 

10 Waiting Process ○ ○ 

20 
Initializing ○  

Encrypting xx % ○  

30 Waiting Upload ○  

40 
Upload Start ○  

Uploading xx % ○  

50 Upload Complete ○  

55 Waiting Approval ○  

60 Waiting Download ○  

90 Upload Interrupted ○  

100 Waiting Download ○ ○ 

110 
Download Start ○ ○ 

Downloading xx %  ○ 

120 
Download Complete ○ ○ 

Decrypting xx %  ○ 

125 
Extracting xx %  ○ 

Delivery Verifying  ○ 

130 Delivery Confirmed ○ ○ 

190 Request Error ○ ○ 

200 Item Opened ○ ○ 

210 Item Moved ○ ○ 

290 Cancel Requested ○  

300 Canceling ○ ○ 

310 Cancelled ○  

320 Upload Error ○  

410 Delivery Denied ○  

420 Download Aborted ○ ○ 

430 Item Deleted ○ * 

440 Delivery Expired *  

500 Delivery Error ○ ○ 

510 Unknown Recipient ○  
[*] mark delivery statuses are not displayed in outbox and inbox. These are used by only the e-parcel system. 
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Relevant Web Sites 

“The e-Parcel Secure Enterprise - Software Download Site” 
 

We provide the “e-Parcel Secure Enterprise - Software Download Site” that is available to our 

customers only in any of the following cases. Please be advised to add (bookmark) this site to 

favorites for your convenience. 

 

・To download and install the e-Parcel client digital certificate and software in the beginning of the 

e-Parcel service 

・To re-configure the e-Parcel client digital certificate in the case of using another e-Parcel ID 

(Register new, Add, Edit). 

・To update the e-Parcel client software 

・To request password if you forget your own password 

・To download the user manuals of the e-Parcel software (PDF) 

・To refer the Frequently Asked Question (Q&A) 

 

・  

 

 

 

 

 

  
The e-Parcel Secure Enterprise - Software Download Site 

URL：https://www.e-parcel.ne.jp/ 
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“The e-Parcel Secure Enterprise - Web Browser” 
 
To view & edit User Info, change password, view Inbox & Outbox histories 
 
*Attention: To access URL of “The e-Parcel Secure Enterprise - Web Browser”, your e-Parcel client 

digital certificate is required to install in OS or browser application in advance when you sign in 
Windows with a user account which use the e-Parcel service. Usually, you have already installed 
a certificate in Windows when starting the e-Parcel service in a computer. 
 (Refer to P399 the section for Downloading and Installing client digital certificate.) 

*Caution: Please be sure that you are required to install your e-Parcel client digital certificate again 
if Windows user account is changed in spite of a same computer. 

 

When you wish to view and edit user information, change password, configure the “Password 

Protect” option and view the inbox/outbox item histories on the web site, access URL of the 

“e-Parcel Secure Enterprise - Web Browser” just below. The menu "User Info" allows you to view 

and edit user information, change password. Also, The menu "Inbox" and “Outbox” show the inbox 

and outbox item histories (until month before last or target date). Please be advised to add 

(bookmark) this site to favorites for your convenience. 

 

 

 

 

  
The e-Parcel Secure Enterprise - Web Browser 

URL：https://secure.e-parcel.ne.jp/ 
*Attention: To visit the above URL, the e-Parcel client digital certificate 

 is required to install in OS or browser application in advance. 
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Frequently Asked Question (Q&A) URL 

The Frequently Asked Question (Q&A) 

To view the Frequently Asked Question (Q&A) pages, access URL of “The e-Parcel Secure Enterprise 

- Software Download Site” at https://www.e-parcel.ne.jp/ and then click the “FAQ (Q&A)” menu. 

Or, directly access the FAQ page URL https://www.e-parcel.ne.jp/epvcn/en/FAQ/ 

You may find some hints to solve the problems or troubles in the FAQ pages placed in response to the 

frequent inquiries from our customers. 
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e-Parcel Support Information 

e-Parcel Support Information on Home Page 

To view the latest support information page, access the e-Parcel Corporation home page (URL: 

http://www.e-parcel.co.jp/) and then click “Support” on the menu bar. (Or, simply access the page 

URL http://www.e-parcel.co.jp/en/support/) The web pages are provided for our customers such 

as “Customer Support general Information”, “Notice”, “Software Upgrade Information” and 

“Information of the e-Parcel Server Operations”. Also, the operation manuals (PDF) of the e-Parcel 

products are available to download from the web site. 
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Contact Us 

Inquiry about the e-Parcel secure data delivery service 
 

Home Page - e-Parcel Corporation 

We provide the latest information on the e-Parcel Corporation home page with the content of our 

service, notice, support info, software update info and etc. Also, you can contact us by the inquiry 

form. Please be advised to add (bookmark) our home page to favorites for your convenience. 

 

 

 

 

 

e-Parcel Sales division 

For any inquiry or request about e-Parcel service and products, please contact our sales division or 

representatives by e-mail. 

 

 

 

 

 

 

e-Parcel Customer Support 

For technical inquiries, troubleshooting from our customers, please contact the e-Parcel Customer 

Support by e-mail with your e-Parcel ID (User ID) specified. If you have any technical question, 

please contact the e-Parcel customer support by e-mail. (Email in Japanese or English only) 

We are afraid that the inquiries outside of our business hours will be replied on the next 

business day, and the inquiries congestion may cause not to be replied promptly even 

though 24-hour reception for the inquiries by e-mail or the inquiry form on our home page. 

 

 

 

 

 

 

 

 

 

e-Parcel Customer Support 
E-mail：support@e-parcel.co.jp 

Business hours：9：00am～17：00pm JST 
(Not including Saturdays, Sundays and national holidays) 

*Please email us with your name and e-Parcel ID specified. 

 
e-Parcel Corporation Home Page 

URL：http://www.e-parcel.co.jp/ 

 

 

e-Parcel Sales division 
E-mail：sales@e-parcel.co.jp 

*Request for the trial of our service is available at any time. 
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